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Documentation Updates

The title page of this document contains the following identifying information:
® Software Version number, which indicates the software version.
® Document Release Date, which changes each time the document is updated.
® Software Release Date, which indicates the release date of this version of the software.
To check for recent updates or to verify that you are using the most recent edition of a document, go to: http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html|
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage
your business. As a valued support customer, you can benefit by using the support web site to:

®  Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your
business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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About this PDF Version of Online Help

This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple topics from the help information or read the online help in
PDF format. Because this content was originally created to be viewed as online help in a web browser, some topics may not be formatted properly. Some interactive
topics may not be present in this PDF version. Those topics can be successfully printed from within the online help.
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Introduction to Inventory Tools

Universal Discovery offers standalone tools to help you analyze your scan data:

o Analysis Workbench

o Viewer

o SAl Editor

Analysis Workbench

Analysis Workbench is one of the key components in the inventory process. This is where results
are consolidated and quality tested, various analysis tasks are performed and exports of the
inventory data are produced.

The basic analysis of data usually consists of viewing and querying three types of information:
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o Software files that are recognized as belonging to a particular application.
« Unidentified software and files that may belong to unrecognized applications.
e Hardware and asset data.

Analysis Workbench uses a Software Application Index (SAI) containing application and version
descriptions to identify the files found during the inventory. When scan results are loaded, each file
is checked against this database and this is how DDM Inventory performs software identification.
Any unrecognized files can be tagged for further investigation, and when identified, their details can
be added to the SAl file so they will be correctly identified in the future.

Analysis Workbench provides several ways of viewing the data, using a series of different views of
results, that is, by machine, applications, file or directories.

All the information required for the analysis and consolidation of data collected for a computer
population is contained in the population of scan files created when every computer is scanned.

Viewer

The Viewer is a stand-alone program aimed at technical support and Help Desk staff who need
detailed configuration analysis and diagnostics. (There is also the Scan Data Viewer, available
through the web user interface.)

Viewer provides a convenient way of displaying all of the software, hardware and asset information
collected for an individual computer, and allows a detailed comparison of two scan files to be
performed.

The Viewer quickly and conveniently displays:

o Details of all software scanned, presented in an explorer style view.
¢ User-entered asset information.

¢ Detailed and summarized hardware and configuration information.

o The contents of key files collected during the inventory, such as system configuration files
(Config.sys and Autoexec.bat).

o Details of all logical drives scanned.
o Details of any applications recognized.

Each scan file is loaded into a new window, enabling multiple scan files to be viewed at the same
time. This allows for a direct comparison between two scan files to be made.

Application Recognition

Application recognition is the process of determining what software is installed on a machine. The
process takes place after scanning, when a scan file is loaded into the Viewer or Analysis
Workbench components, or when it is processed by the XML Enricher.
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The recognition process is driven by a Recognition Engine built into the components mentioned
previously, which makes use of the Application Library supplied with the product. The Application
Library stores the information required by the Recognition Engine to determine which applications
are installed on a machine. It is updated on a regular basis.

Application Recognition is always done using one or more SAl (Software Application Index) files.
DDM Inventory ships with 5 Master SAl files (containing libraries for English/International, French
and German applications, UNIX® applications, and a rule-based SAIl containing rules for base
UNIX/Linux OS packages), as well as an empty User SAI.

To extend the application library, the simplest way is to use Analysis Workbench or SAI Editor to
add entries to the User SAI.

SAIl Editor

The SAI Editor presents a view of Software Application Index (SAl)files. It enables you to:
¢ View and edit a collection of SAl files

o Create new User SAls

« Move and Copy items between SAls (you can only edit User SAls)

o Deleteitems in SAls

o Export the contents of an SAI to XML format, either as a summary or the entire contents.
o Display license relationships.

o Add and edit existing license relationships.

The SAI Editor is available as a standalone tool from the Start menu or from Analysis Workbench,
where it can be used to review and edit work on SAls during a teaching session.

If the SAls change on the Data Flow Probe server, the Administrator must update the SAls on all
systems that have the client tools installed.

Analysis Workbench Overview

The Analysis Workbench enables you to consolidate results, perform analysis and produce
exports.
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The basic analysis of data usually consists of viewing and querying three types of information:
Software files that are recognized. These are usually designated as applications.

Unidentified software and files that may be unrecognized applications.

Hardware and asset data.

Analysis Workbench uses a database called the Software Application Index (SAl). The SAI
contains application and version descriptions that are used to identify files found during the
inventory. When scan results are loaded, each one is checked against this database, and this is
how Universal Discovery performs software identification. Any files that are unrecognized can be
tagged for further investigation; when identified, their details can be added to the database.

Refer to Application Recognition for further information about software management and application
recognition.

Analysis Workbench provides a series of different views of results: by machine, by directory, by
application, or by file.

All the information required for the analysis and consolidation of data collected for a computer
population, is contained in the group of scans created when each computer is inventoried.

System Requirements

The minimum resolution required to run Analysis Workbench is 1024x768.
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Starting Analysis Workbench

To start Analysis Workbench:
From the Windows Start menu, select:
Programs > HP UCMDB > Inventory Tools > Analysis Workbench

When Analysis Workbench is started for the first time, the Analysis Workbench Quick Config
Dialog Box is displayed automatically.

Analysis Workbench Quick Config Dialog Box

The Analysis Workbench Quick Config dialog box is displayed when you start Analysis
Workbench. It provides four Preset Analysis Modes that are optimized for common analysis tasks.

Each of these modes is described in the dialog box (and later in this chapter). Select the mode that
you want to use, and click OK. If you do not want to start Analysis Workbench with any of these
settings, click Cancel.

An error message is displayed if the age limit on the Master SAIl you are using has been exceeded.
You can obtain the latest Master SAI (updated monthly) by contacting HP Customer Support.

Starting the Analysis Workbench Quick Config Dialog
Box

There are two ways to start the Analysis Workbench Quick Config dialog box:

Automatically on starting Analysis Workbench. To disable this feature, clear the Show at startup
check box.

In Analysis Workbench, by selecting File > Quick Config.

Preset Analysis Modes

The four preset analysis modes are:

» Executive Summary from Enriched Scan Files
* Summary Reports

* Application Teaching

* Detailed Analysis

Executive Summary from Enriched Scan Files

This setting enables you to use enriched application data and disables loading of file data. This
method is extremely fast.
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It is assumed that you want to load xsf scan files that have already been processed by the XML

Enricher.
Load Option Settings Used
Load Filter No files are loaded
No directories are excluded
Recognition Uses Installed applications recognition
Asset Fields No asset fields loaded
Display Filter Recognized Main files are shown

Uncertain files are shown as “Treat as unidentified” The Business view is loaded

Memory The following file data is loaded:
o Signatures
o Modified time

o Type

The following Machine data is loaded
Asset and hardware data

No directory data is loaded

File Version Data No file version data is loaded

Summary Reports

This setting loads only summary information about each machine. This is useful for quickly
obtaining an overview of a large population.

Load Option Settings Used

Load Filter Only executable files are loaded
No directories are excluded

Recognition SAl recognition is used

Asset Fields No asset fields loaded
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Load Option Settings Used

Display Filter Recognized Main files are shown
Uncertain files are shown as Treat as unidentified
The Business view is loaded

Memory The following file data is loaded:
¢ Signatures

Modified time

o Accessedtime

Type
o Attributes

The following Machine data is loaded:

Asset and hardware data
No directory data is loaded

File Version Data No file version data is loaded

Application Teaching

This setting loads all data necessary for application recognition and adding custom applications to
the Software Application Index.

o Executable and command files are loaded
o No analysis asset fields are defined

No file version data is loaded

Only those directories that contain loaded files are loaded

o No SMBIOS machine data is loaded
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Load Option

Load Filter

Recognition
Asset Fields

Display Filter

HP Universal CMDB (10.10)

Settings Used

Files with the following extension are loaded:
e exe

e CcOM

o dil

e 0CX
Executable files are loaded
No directories are excluded
SAl recognition is used
No Asset Fields loaded

The following Recognized files are shown:
e Main
o Associated

o 3rd party files

Uncertain files are shown as CheckVer

The following Unrecognized file types are shown:

o Unidentified
e Unprocessed

¢ Auto-identified

The Operational View is loaded
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Load Option Settings Used

Memory The following file data is loaded:
o Signatures

Modified time

Type

Attributes

The following Machine data is loaded:

Asset and Hardware data

Only those directories that contain loaded files are displayed

File Version Data The following file version data is shown:
o Company Name
o Product Name

o Product Version

Detailed Analysis

This setting is appropriate for populations of fewer than 100 machines. All available data for each
machine is loaded. This allows powerful detailed analysis to be performed, but requires significant
memory for large numbers of machines.

All files are loaded

o Nofile version data is loaded
o All directories are loaded

o All machine data is loaded

Load Option Settings Used
Load Filter All files are loaded

No directories are excluded
Recognition SAl recognition is used

. Asset Fields No Asset Fields are loaded
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Load Option Settings Used

Display Filter The following Recognized files are shown:
= Main
= Associated

= 3rd party files
Uncertain files are shown as CheckVer

The following Unrecognized file types are shown:
= Unidentified
= Unprocessed

= Auto-identified
The Operational View is shown

Memory The following file data is loaded:
= Signatures
= Modified time
= Accessedtime
= Type
= Attributes

The following Machine data is loaded:
= Asset and Hardware data

= SMBIOS Data

All directories are loaded
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Load Option Settings Used

File Version Data The following file version data is shown:
= DOS 8.3 Name
= Real Name
= Description
= Company Name
= File Description
= File Version
= Internal Name
= Legal Copyright
= Original Filename
= Product Name

= Product Version

Exiting

You can exit Analysis Workbench at any time. This has the following effects:

¢ Closes all open windows and saves their position.

o Asks you if you want to save any modifications made to asset data in the Machines window.

o Exits the application.

To exit Analysis Workbench:

1.

2.

Select the Exit command from the File menu.
A confirmation message is displayed.

Click Yes to exit, or No to remain in Analysis Workbench. The purpose of this confirmation
message is to prevent you from accidentally exiting from Analysis Workbench and losing work.

To disable the confirmation message, so that it is no longer displayed when exiting Analysis
Workbench, select the Don’t ask again check box.
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The Analysis Workbench User Interface
Shortcut Menus

To access a selection of commands related to your current activities (a shortcut menu), position the
mouse cursor in the appropriate area of the screen and click on the right mouse button. Analysis
Workbench displays a list of commands and you can select the one you want.

There are three types of shortcut menu available for the information windows:
Window title bar shortcut menu

Right-clicking on an information window title bar displays a menu with the following options:

Shortcut
Menu
Item Function

Maximize = Maximizes the window. Also activated by:
Window
o Clicking the Maximize button in the top right corner of the window.

o Double-clicking the title bar.

Equalize = Makes all windows the same size. Also activated by selecting the Equalize
Windows | command inthe Window menu.

Move up Moves the window up a position in the workspace.

Move Moves the window down a position in the workspace.

down

Toggle Hides the toolbar if it is currently displayed in the window and vice versa. Also
toolbar activated by clicking the Toggle button in the top right corner of the window.

Close (X)  Closes the window. Also activated by:
¢ Clicking the Close button in the top right corner of the window.
e Using the CTRL+F4 keyboard shortcut.

Column header shortcut menus

Right-click on a column header in an information window to display shortcut menus with the
following options:
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Query This option is only available for the Machines information window. It displays the

Complex Query dialog box which enables multiple tagging query criteria to be
specified from a section of categories,. These categories are defined by the
information collected across the computer population.

Contains | This option displays a dialog box which allows you to search for a specified string in

the column.
Tagall Applies a tag to all entries in the column.
Untag all Removes all tags from entries in the column.

Toggle all = Toggles the tag status of all entries in the column. If an entry is tagged then, the tag
is removed and vice versa.

Duplicates = Tags any duplicate entries in the column.

Uniques Tags all entries that are unique.

e Find

Allows you to find a particular entry in the active window.
See Locating Specific Entries in a Window for further information.

e Sum

This option is available only if all the contents of a column are numerical. It displays a message
showing the sum of the numerical contents of that column.

e Lock

When this option is selected, the column clicked and all columns to the left of it are ‘locked’ and
will not scroll left or right.

¢ Unlock

This option is used to remove a lock from a column. To set a different lock, select lock on a
different column.

e Chart

This option is not available for the Directories information window.
It displays a graphical representation of the selected column statistics.

¢ Sort Ascending

Sorts text alphabetically, numerically, or by date in ascending order (A to Z, ato z or zero to 9).
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o Sort Descending

Sorts text alphabetically, numerically, or by date in descending order (Z to A, z to a or 9 to zero).

Information window cell shortcut menus

Right-click in a cell in the information windows to display a shortcut menu with the following

options.

Menu Option
Tag All

Current
row

Rows
above

Rows
below

<Variable
row>

Untag All

Current
row

Rows
above

Rows
below

<Variable
row>

HP Universal CMDB (10.10)

Function
Tags all the visible entries in the active window.

Tags the currently highlighted row.

Tags rows above the currently highlighted row.

Tags rows below the currently highlighted row.

Tags any entries in the window that match the cell specification. This
option changes to reflect the cell that the mouse was right-clicked in. For
example, if the mouse was right-clicked in a cell in the Main Processor
(CPU) column and the cell contains the following information: Main
Processor (CPU) of Pentium Il Then this option will read Main Processor
(CPU)is Pentium Il. All entries in the window that have a Pentium Il
CPU will be tagged. Pressing the SHIFT key at the same time as right-
clicking on a cell inverts the option. For example, in the previous case it
will read Main Processor (CPU) is not Pentium 1.

Removes tags from any tagged entries in the active window.

Removes the tag from the currently highlighted row.

Removes tags from the rows above the currently highlighted row.

Removes tags from the rows below the currently highlighted row.

Remove tags from any entries in the window that match the cell
specification. This option changes to reflect the cell that the mouse was
right-clicked in. For example, if the mouse was right-clicked in a cell in
the Computer Manufacturer column and the row highlighted has a
computer manufacturer of DELL, then any entries in the window that
have a DELL computer make are untagged. Pressing the SHIFT key at
the same time as right-clicking in a cell inverts the criteria. For example,
in the previous case it will read Computer Manufacturer is not DELL.
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Menu Option

Toggle All

Current
row

Rows
above

Rows
below

<Variable
row>

Rows Tag

Above
Untag

Toggle

Rows Tag

Below
Untag

Toggle

<Variable Tag

option>
Untag
Toggle
View
Scan File

HP Universal CMDB (10.10)

Function

Toggles the tag status of all entries in the active window. If an entry is
tagged, the tag is cleared and vice versa.

Toggles the tag status of the currently highlighted row. That is, if it is
tagged, the tag is removed and vice versa.

Toggles the tag status of the rows above the currently highlighted row. If
an Entry is tagged, then the tags are removed and vice versa.

Toggles the tags status of the rows below the currently highlighted row. If
an entry is tagged, the tag is removed and vice versa.

Toggles the tag status of any entry in the window that matches the cell
specification.For example, if the mouse was right-clicked in a cell in the
PEC number column and the row highlighted has PEC 102, then any
entries that have a PEC number of PEC 102 are toggled. Pressing the
SHIFT key at the same time as right-clicking on a cell inverts the
option.For example, in the previous case it will read PEC number is not
102.

Tags the rows above the currently highlighted row.

Removes the tags from any tagged entries above the currently
highlighted row.

Toggles the tag status of any entries above the currently highlighted row.
That is, if an entry is tagged, then the tag is removed, and vice versa.

Tags the rows below the currently highlighted row.

Removes the tags from any tagged entries below the currently
highlighted row.

Toggles the tag status of any entries below the currently highlighted row.
That is, if an entry is tagged, then the tag is removed, and vice versa.

Tags any entry in the window that matches the cell specification.

Removes the tag from any tagged entry in the window that matches the
cell specification.

Toggles the tag status of any entry in the window that matches the cell
specification.

This option is available for the Machines window only.It opens the scan
file in the Viewer application.
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Locating Specific Entries in a Window

Incremental Column Search

The incremental column facility is used to locate an entry in a column in any window.
To Perform an Incremental Column Search:

Click on a column header in the active window and progressively type the word(s) or number(s) that
make up the entry that you want to locate.

The window automatically locates the closest existing value in the column. The progress of the
incremental search string is displayed on the active window titlebar in italic characters.

Find Facility
To use the find utility:

1. Right-click on the column header and select the Find option. A Find in “<column name>”
column dialog box appears.

2. Enterthe string to search for. If required, set the options to match on whole word and match
case.

3. Click Find Next.

The search direction is top to bottom of a column. To reverse the search, click on the column
header to reverse the sorting and use the Find option again.

Contains Option

This is used to find and tag multiple entries using a search string. It is of particularly use when you
are trying to find files with a specific file extension.

To use the Contains option:

1. Right-click on a column header and select the Tag > Contains option. A dialog box appears,
which is used to search for a specified string at the beginning, middle or end of entries in the
column.

2. Inthe Search String field enter the text that you want to locate.

3. You can also specify actions to be carried out, after the string has been located. That is:
= Tag
= Untag
= Toggle

4. Click OK.
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Displaying the Entry Names Contained in a Column

This is very useful for identifying the names of entries that you want to tag or untag.
1. Todisplay the entry names contained in a column:

2. Inthe window, right-click on the column header and select the Chart option. A column chart is
displayed.

3. Click the Options button, and set the Other group, % field to 0.
4. Click OK.

The chart will show the different entry names contained in the selected column in a list on the left
side.

Overview of the Columns in an Information Window

A selection of columns are available for each information window.

To check which columns are available for a particular window, click the Columns toolbar menuin
that window. A list of all columns available in that window is displayed. Currently selected columns
—that is, columns that are visible in the active window — are shown with a check mark next to them.

Some column names have additional information appended to them as follows:

If the column has the text ‘csv’ in brackets, this means that the column has been extracted from a
CSV file asset field and an option has been set to included this text in brackets. For more
information refer to CSV File Extract Asset Field on page 73.

For example, the column name Asset Number (csv) indicates that the information in the Asset
Number column was extracted from a CSV file asset field.

If a column name is shown with #n after it, where n is a number, this means that more than one
entry is available for this type of the data.

For example, if a computer has been scanned and has three network connections, then these are
shown as three separate columns called Network connection #1, Network connection #2 and
Network connection #3.

The sequence of the field entries is taken from the order they are found on a particular machine and
therefore cannot be relied upon to appear in the same column for all scan files.

Sorting Entries in a Column

There are two ways in which you can sort the contents of a column:

1. Click on a column header to sort the contents of that column. The default sort order is
ascending.

2. Right-click on a column header and select the Sort Ascending or Sort Descending command
from the shortcut menu.

This command sorts text alphabetically, numerically, or by date in ascending or descending order.
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Locking and Unlocking Columns

To lock a column:
1. Select the column which will be the leftmost column to be locked.

2. Right-click on the column header and select the Lock option. The selected column and
columns to the left of it are locked.

The locked columns are indicated by a grid around the entries.

To unlock all columns:

Right-click on a column header and select the Unlock option.

All columns are unlocked. The unlocked columns are returned to their normal display state.

Saving and Loading the Workspace Layout

The current workspace layout (for example, windows displayed, linked windows, columns, fonts)
can be saved, either as a new default workspace or as a named layout that can be reloaded at any
time.

The file can be stored as awdef.awl (Analysis Workbench Layout) or as another .awl file, which
holds layout information about the workspace.

The default location for the .awl files is:

C:\HP\UCMDB\DataFlowProbe\Tools\Inventory Tools\Analysis Workbench

To save or load a workspace layout:

Select the Layout command from the Window menu.

From this menu select further commands as required:
e Load

Loads a previously saved workspace layout.

e Save
Saves a new workspace layout.
e Save as

Saves the workspace layout as another .awl file

o Autosave

Sets autosave preferences to save the workspace layout automatically when you exit Analysis
Workbench or whenever the layout changes.
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Main Menu Bar

The Main Menu Bar is located at the top of the Analysis Workbench window. Most of the Analysis
Workbench commands are accessible from the main menu bar. Commands are grouped by
function (for example: File, Edit, or View). Menu commands can be activated with the mouse or the
keyboard.

It contains Analysis Workbench commands grouped by function.
Opening a Menu

To open a menu do one of the following:
o Click the menu name with the mouse (for example, File).

o Use the shortcut keys. Shortcut keys are shown to the right of the command in the menus. For
example, Alt-F4 is a shortcut used to exit the Analysis Workbench.

¢ Usethe access key, indicated by an underscore on the active letter. For example, the File menu
is accessed by pressing Alt-F.

o Usethe Altor F10 key to select the menu, the arrow keys to navigate and the Enter key to
select an entry.

Most menus invoke commands, however, some menu commands display a dialog box, indicated
by ... after the menu command. Other menu commands provide a submenu, containing further
commands.

The Menu Items

The following sections show tables of the main menu items and the functions that can be carried
out from them. Also shown, are references, indicating where you can find further information about
their functions

The File Menu

The File menu is used to:

Load data files that are used by the Analysis Workbench

Unload scans

Load the Quick Config dialog box

Set loading options

Load and save state images
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o Run script files

o EXxit the Analysis Workbench

Menu
Item

Load
Scan
Files...

Unload
Scan
Files

Quick
Config...

Load
Options...

Load
State...

Save
State...

Run
Script
file...

Exit

Function

Loads inventory data from XSF files.

Removes the details for a loaded scan file, from the Analysis Workbench

o Current (name of the current scan file selected)

Tagged (any tagged machines)

Untagged (any untagged machines)

o All (all entries)

Displays the Analysis Workbench Quick Config dialog box, which is also displayed
when Analysis Workbench is started up.

Displays the Analysis Workbench Load Configuration — Advanced dialog box, which
allows recognition, load filter, asset fields, display filter, memory and version options
to be set.

Loads a previously saved state (.aws file).

State images are always restored from a subdirectory called State Images.

A state can only be loaded if no data has been loaded into the Analysis Workbench.
Saves the current state of the Analysis Workbench to an .aws file.

This file stores the current state of all four data collections (Machines, Directories,
Applications and Files).

State images are always saved to a subdirectory called State Images.
Allows you to run a previously prepared script file (.awcs extension).

These scripts facilitate the automation of actions which are manually carried out
within the application (for example, loading, processing and outputting of information
from Analysis Workbench).

Exits the Analysis Workbench application.

The Edit Menu

The Edit menuis used to:
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o Set options for tagging and untagging entries in all information windows (even if they are not
displayed).

o Clear any filters that have been applied to any of the information windows.

e Save and cancel any changes made to asset data in the Machines window.

Menu Item Function
Tag All Global — applies a global tag to every item in all information windows.
Local — applies alocal tag to every item in all information windows

Both — applies both local and global tags to every item in all information
windows.

Untag Al Global — removes every global tag in all information windows.
Local — removes every local tag in all information windows.

Both — removes every local and global tag in all information windows.

Clearall Removes all filters that have been applied, from all windows.
Filters
The View Menu

The View menu provides commands for various statistics and charts to be displayed.

Menu
Item Function

Charts Scan File Age displays a bar chart showing a breakdown of the time elapsed
because the data was collected (in months).

Scan Method displays a pie chart showing a breakdown of the different Scanners
used for collecting data.

Recognition displays a pie chart showing a breakdown of the different types of file
data that was recognized.

Unrecognized/File Frequency displays a graph that can be used to determine the
quality of recognition on a population. This displays unrecognized files split by the
number of copies.

Recognized/ File Frequency displays a graph that can be used to determine the
quality of recognition on a population. This displays recognized files split by the
number of copies.

Audit Displays general data statistics, for example, the number of files scanned, the
Statistics = number loaded, the number recognized.
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The Recognition Menu

The Recognition menu provides commands for various application teaching related tasks. The
Recognition menu is used to:

« Define Recognition Objectives

o View the Objectives Summary

« Display the SAI Teaching Wizard used to teach applications to a User SAI

o Display SAI Teaching Mode Holding Area

« View and Edit entries in your User SAI

« Recalculate Recognition Objectives

o Set Objective options

Menu Item
Objectives

Objectives
Summary

SAI
teaching
Wizard

SAI
Teaching
Mode

View/Edit
User
SAls...

Recalculate
Objectives

Objectives
Options

Function
Set up and review your Recognition Objectives.

Displays a summary pie chart of the Recognition Objectives.

Having defined a set of objectives, the SAl Teaching Wizard can make use of the
objective information to choose which files to teach.

Simplifies the process of teaching new applications to the SAI.

A non-modal dialog box is displayed (the SAl Teaching Holding Area), which can
be used to hold information about the next application to be taught.

Displays a dialog box where the current content of the User SAIl can be viewed
and edited.

Recalculate the values for the Recognition Objectives.

You can set a number of options defining how Recognition Objectives are
managed.

The Exports Menu

The Exports menu provides export facilities for exporting data.

Menu Item

Machines

HP Universal CMDB (10.10)
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Exports data from a Machines window in CSV or text format.
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Menu Item  Function
Applications = Exports data from a Applications window in CSV or text format.

Directories  Exports data from a Directories window in CSV or text format.

Files Exports data from a Files window in CSV or text format.
Relational Exports data in a format that is supported by Relational Database Management
Systems (RDBMS).
Stored Files = Exports data from the stored files contained in the scan data as a text file or Hex
dump.
The Window Menu

The Window menu provides options for controlling the way windows are displayed in the Analysis
Workbench workspace and options for the configuration of the display.

Menu Item Function
Create Creates additional Files, Directories, Machines or Applications windows.
Equalize Equally sizes all open information windows.

Configuration... = Displays the Window layout dialog box, which provides options for the
configuration of the display font and color, columns and Detail window.

Layout Load Loads a previously saved window layout from an .awl file.
Save Saves the current window layout to the current layout file.
Save As... Saves the current window layout to a user specified .awl file.
Autosave Automatically saves the window layout:

None Disables the window autosave facility. Any window layout changes
must be saved manually.

When AW Exits Automatically saves the window layout when the Analysis
Workbench is shut down.

When Layout Changes The window layout is automatically saved when any
changes are made to the layout.

Log Window Displays the Analysis Workbench log.

The Help Menu

The Help menu provides help on all aspects of using the Analysis Workbench.
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Menu
Item Function

Contents = Displays the Help file table of contents.

About Displays information about the Analysis Workbench version, build and system
memory.

Toolbars

The Toolbars enable you to access various Analysis Workbench commands without using the
menu bar. Toolbars allow you to access various Analysis Workbench commands without using the
menu bar. They allow you to work faster and more visually.

When the mouse pointer passes over an icon, a tooltip appears indicating the command
corresponding to the icon.

Each of the four information windows in the Analysis Workbench (Files, Applications, Machines
and Directories) has a set of toolbar icons.

With the exception of the filter icons, each of the toolbar icons has a menu associated with it

Filters Toolbar Menu

Provides options for applying filters to the information windows, so that a subset of relevant
information is displayed.

Activating a Filter

To activate afilter:

Select the particular filter from the Filters toolbar menu.

When afilter is active in a window, visually this is indicated by a check mark (+) in the Filters

toolbar menu and on the associated filter icon. The filter icons are also highlighted in yellow.

Note: The exception to this is the Local Tags filter icon, which does not have a check mark
displayed on the icon.

Deactivating a Filter

To deactivate afilter:

Click on the filter icon again or deselect the filter from the Filters toolbar drop-down menu. The
appropriate check marks are cleared.

The Filter Icons

Filters can also be applied by clicking the following icons:
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 Machines filter CJ

o Applications filter (=
« Directories filter L]
o Files filter

e Local filter &l

When these icons are selected they are shown highlighted in yellow and with a check mark on them
(except the Local filter icon).

Columns Toolbar Menu

This is used to select the columns that you want displayed in the active window. When selected, a
check mark is displayed next to the column item in this menu.

In addition, the Machines window has an option which adds or removes columns in this toolbar
menu.

Tag Toolbar Menu

This menu provides various options for tagging entries in the active information window. The
following list shows options that are common to all windows.

e Tagall

Tags all visible entries in the active window.

e Untag all

Clears all visible tags in the active window.

e Toggle all

Toggles the tag status of all visible entries in the active window.

e Use Global Tags

Uses Global tags only for tagging items in the active window.

o Use Local Tags

Uses Local tags only for tagging items in the active window.

¢ Use Local Tags Once
Uses Local tags for the next tag operation, after which Global tags are used again for tagging.

Query Option

The Machines window has a Query option which allows machine queries to be performed.
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The Machines window has two extra tagging commands - Load Tags List and Save Tags List.
These will save or load a tag list file (.tag file) and tag matching machines. A .tagfile is a text file
containing the asset numbers of the tagged machines.

The Files window has an Add to SAI option which is used to ‘teach’ the application to recognize
files which it previously did not recognize or recognized incorrectly (that is, as a different
version/publisher).

This allows you to optimize the software analysis and consolidation capabilities of Analysis
Workbench to recognize unidentified files and applications.

This option is only enabled when a user editable SAl has been loaded (by selecting Load Options in
the File menu and clicking the Recognition tab) and the Files window contains at least one selected
entry.

Output Toolbar Menu

Export from window - Exports the contents of individual windows. This will display the Export to file
dialog box which allows you to export the contents of the window based on the current column
selection and filter settings.

Moving a Toolbar

A Docked toolbar is one that is attached to one edge of the program windows. You can dock a
toolbar below the window title bars or to the left of the window. When you drag a toolbar to the edge
of the window, the toolbar outline snaps into place along the length of the window edge.

A Floating toolbar is one that is not attached to the edge of the window.

Right-clicking on the toolbar menus and icons presents a menu with the following options:
o Floating

Floats the toolbar.

o Dock to top

Docks the toolbar to the top of the window, under the titlebar.

o Dock to left
Docks the toolbar to the left of the window.
To dock the toolbars to the appropriate window and save as default layout:
1. Double-click on the floating toolbars.
2. Select the Layout option from the Windows menu.
3. Select Save to keep this as the default layout whenever Analysis Workbench is started.

To manually move a toolbar:
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1. Click the ‘move’ handle on a docked toolbar, or double-click the title bar on a floating toolbar.

2. Drag the toolbar to a new location. If you drag the toolbar to the edge of the window, it becomes
a docked toolbar.

Resizing a Toolbar

To resize a floating toolbar:

Move the pointer over any edge until it changes to a double-headed arrow, and then drag the edge of
the toolbar.

Note: You cannot resize a docked toolbar.

Status Bar

The status bar displays information about each of the data collections. It shows a separate pane for
each of the four data collections (Files, Directories, Machines, Applications). It also contains
information about how many items are available and how many of them are tagged globally.

The format is:
Number of global tags/Number of items loaded into the window

This helps to provide a view of the global state of the data, irrespective of what views are open and
gives an up-to-date view of how many items of each kind are available/tagged.

Information Windows

The Information Windows are located on the left side of the Analysis Workbench window. They
contain detailed information about the following things: Files, Machines, Applications, and
Directories. Each information window contains a toolbar.

The Analysis Workbench workspace can contain four different types of information windows.
These windows are used to display and examine the scans containing the information about the
computer population.

This information is displayed in columns in the window. You can display multiple windows of each
kind, showing different column selections:

Files window

Displays information for all files in the population.

Machines window

Displays asset and hardware information about the computers in the population.
Applications window

Displays information about the software applications contained in the population.
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Directories window

Displays information about the directories contained in the population. This window is not shown by
default when Analysis Workbench is first started but can be displayed by selecting the Create >
Directory command in the Window menu.

Adding a New Window

To add a new information window to the workspace:
¢ From the Window menu, select the Create <window type> command.

Where <window type> is Files, Directory, Machine, or Application.

Note: You can display multiple views of the same window.

Resizing the Windows
All windows can be resized and positioned in the workspace.
To make a window active:
o Click the window title bar or anywhere in the window.
To select options for displaying windows in the workspace:

o Use the commands in the Window menu

The Window Title Bar

The title bar show the following information:

e The name of the window

o The number of the entry in the window that is currently highlighted. This is shown in the left
corner of the title bar.

o Forexample, [5 of 1542] means that the fifth entry in the window is currently highlighted out of a
total of 1542 entries displayed in the window.

Moving Within the Windows

You can use the mouse or keyboard to move within an information window as follows:

Control Function Keyboard Navigation

Next entry DOWN ARROW
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Control Function
Previous entry

Up one page

Down one page
Move to start of row
Move to end of row
Start/End of entries

Beginning/End of row

Keyboard Navigation
UP ARROW

PAGE UP

PAGE DOWN

HOME

END

CTRL+HOME/CTRL+END

CTRL+LEFT/RIGHT

Top/bottom of row currently displayed CTRL+UP/DOWN

Customizing Window Layouts

Choose one of the following methods to customize the layout of the windows:
¢ Select options from the Configure toolbar menu (available in every window).

This will display the Window Layout dialog box with the appropriate tab already selected (Fonts and
Colors, Columns or Details Window.

o Select the Configuration command from the Window menu. The Window Layout dialog box
appears.

The Load Defaults button in this dialog box reverts the window layout back to the default settings.

Customizing the Font and Color

The Font & Color tab of the Window layout dialog box is used to configure the font, style and color
for the different types of entries displayed in the workspace.As you specify and select parameters
in this dialog box, a sample text list gives you a preview of the applied changes.

Changing the Font Name and Size for All Entries Displayed in the
Workspace

To change the font name and size for all entries displayed in the windows in the workspace:
1. Select the font from the Font name drop-down list.

2. Specify the font size by using the arrows in the Base Font Size box.
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Changing the Style Settings for Specific Types of Entries

To change the style settings (color, style, background color or relative size) for specific types of
entries:

1. Inthe Sample list, click on the Style entry that you want to work with.

2. Select the color for the text from the Color drop-down list.

3. Select the style for the text from the Style drop-down list.

4. Select the background color of the windows from the Background color drop-down list.

5. Specify the relative size of the text to the window by using the arrows in the Relative size box.

6. Click OK to make the changes to the font and color or click Cancel to exit without making any
changes.

Customizing Columns

The Columns tab of the Windows layout dialog box is used to set options for the way columns are
displayed in the workspace. The columns in the windows can be automatically resized based on
the content, header, or both.

Setting Automatic Resizing Options for Columns

Select one of the following options in the Auto resize group:
e No.

Resizing is disabled. Columns must be manually resized by dragging the column boundary.

¢ On header text only.

Automatically changes the column width to fit the column header only.

o On data only.

Automatically changes the column width to fit the data in them.

¢ On both header and data.
Automatically changes the column width to fit both the column header and the data in them.

Setting Column Options

Select from the following check boxes in the Options group:
« Expand to window width

The columns are resized so that they fit the width of the window.
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o Apply to all windows

Any changes made to columns, are applied to all windows in the workspace.

This option is only available if the Window layout dialog box is invoked from within a window (that
is, from the Configure toolbar menu). If it is called from the Configuration command in the Window
menu, it is implicitly checked.

Setting the Number of Columns to Include in a Column Sort

In the Sorting group, use the slider to increase or decrease the number of columns that you want to
include in a sort. Move the slider to Sort disabled if you do not want sorting to occur.

Setting Column Grid Line Parameters

Select one of the following options in the Grid lines group:
e None

The grid lines for the columns are hidden.

o Vertical

The vertical grid lines for the columns are displayed.

e Horizontal

The horizontal grid lines for the columns are displayed.

o Both
Both horizontal and vertical grid lines for the columns are displayed.

Setting Grid Line Style
To set the grid line style:

Select one of the following options in the Grid line style group:
o Solid line

The grid lines are displayed as a solid line.

o Dotted line

The grid lines are displayed as a dotted line.

o Dashed line
The grid lines are displayed as a dashed line.

Setting Grid Line Color
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1. Select a color from the Grid line color drop-down list.

2. Click OK to make the changes to the columns or click Cancel to exit from the dialog box
without making any changes.

Detail Window

You can display additional details about the items listed in the Information windows by using the
Details Window located on the far right side of the Analysis Workbench window.

The Details windows are secondary windows located on the far right of the Analysis Workbench

window that display additional linked data about the selected item in each of the information
windows.

Displaying the Details Window

To display the Details window:

From the Configure toolbar menu in any Information window, select the Detail window link
command.

If you clear the Detail window link menu item for all the Information windows displayed, the
Information windows will span the entire width of the Analysis Workbench window.

Detail Window Customization
The Detail Window tab in the Window layout dialog box is used to set options for the display of the
Files, Machine, Directory and Application Details windows.
Setting Links to the Details Windows

Select any number of the following from the Detail Window Links group box:

File windows

Machine windows

Directory windows

Application windows

Specifying Data to be Displayed in Details Windows:

Select any combination of the options described in the following tables:
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File Details
Option Description

Asset Shows the asset number of the machines that the file resides on.
numbers

Directory = Shows the directory that the file resides in.
names

File sizes = Shows the size of each copy of a file within the population.

File o Shows the signatures found for each file within the population.

signatures
¢ It shows aline for each file found in the population.

o There can be multiple instances of the file on the same machine.

In this case there will be two lines for this machine in the Details window.

File Shows the date the file was last modified files if available.
modified
date

File Shows the last-accessed time stamp for files if available.
accessed
date

File usage Shows number of days since the file was last executed.

File Displays system attributes for afile.

attributes . . ) . .
The Attribute column along with normal file attributes includes the X (executable), |
(internal file) and D (device driver) information.

Version information (as per Windows Explorer) is available for all files having the
information | attribute.

Filetypes = Shows the type of file (for example, DOS executable file, Windows executable,
OS/2 DLL file).

Bottom pane
Unused The bottom pane of the File Details window will not be used for displaying any data.

Version This is the information that is embedded inside most Windows executables. It
Data describes the publisher, version and is extracted by the Scanners and stored as part
of the file datain the scan file.
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Machine Details
Option Description

Hardware Displays basic details of the hardware configuration scanned from the computer
summary as it is inventoried.

Provides details of the operating system, processor, type of screen, memory,
drives, directories and files as well as the total disk space and free space.

Applications = Displays details of the applications identified on the machine, including publisher
and version.

Recognition | Displays the total number of files on the highlighted machine, including a
statistics breakdown of the following both as an absolute number and as a percentage of the
total files:

¢ Main files
o Associated files
o Files that need the version checked

e Unrecognized files and unprocessed files

Directory Details
Option Description

File Displays a list of file names found within the directory, along with the size of the file.
names

Machine Displays a list of machines where the directory is found within the population, with
names the drive location for the directory.

Application Details
Option Description

Installed = The machine(s) that the application is installed on.
on
machines

Licensed = The details of the application suite that licenses the highlighted application (if
by applicable).For example, Word 97 is licensed by Microsoft Office 97 if installed on
the same machine.

Licenses = The details of any applications that the highlighted application licenses.For example,
Word 97 licenses Microsoft Photo Editor if installed on the same machine.
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State Images

A state image is the term describing the current ‘state’ of all data collections (that is, Files,
Applications, Directories and Machines). This includes the scan files that have been loaded into the
Analysis Workbench.

A state image is afile representing a ‘state’. It can be used to maintain an easy to load image of
your computer population.

State images are transitory in nature. If asset data is edited, even when the data has been loaded
from a state image, the original data source will be edited and not the state image itself.

The version of the state image changes with new releases of the software, and old state images
cannot be read by newer versions of the software.

The state image files are not backward compatible.

State images can be extremely useful in situations where a large amount of analysis work has been
carried out. The image can be easily reloaded at a later time. This is significantly quicker than
loading from the original data source.

Saving a State Image

The current state image of the Analysis Workbench can be saved to a .aws file. This file stores the
current state of all four data collections. State images are always stored to a subdirectory called
State Images.

To save a state image:

1. Click the Save State command in the File menu (or use the keyboard shortcut CTRL+s). The
Save Analysis Workbench State Image dialog box is displayed.

2. The Description box displays the date that the state image was generated. The text in this box
can be edited as required.

3. Inthe File name box specify the name of the file that the state image is to be saved to.

4. Click the Save button.
Loading a State Image

A previously saved state image can be loaded only when there is no data loaded in the Analysis
Workbench. State images are always restored from a subdirectory called State Images.

Toload a state image:
1. If datais already present in the Analysis Workbench, either restart Analysis Workbench, or

select the Unload Scans > All command from the File menu. All scans loaded into the
Analysis Workbench are now unloaded.
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2. Click the Load State command in the File menu (or use the keyboard shortcut CTRL+I). The
Load Analysis Workbench State Image dialog box is displayed.

3. Select a state image to load (.aws file).

4. Click the OK button.

Overview of Command Line Parameters

By using command line parameters, you can create shortcuts on your desktop that start Analysis
Workbench with specified state images, directories containing scan files or a specific scan file.

The command line parameters can be combined, so that you can for example, load a state image
and a directory of scan files or specific scan files.

This can be a very useful tool for cases where you have already loaded a large amount of data into
the Analysis Workbench workspace and have performed some analysis on this data. You can save
the state image of the session, and at the next session you can use command line parameters to
add any new scan files that have been found in your scan file repository directories.

Because Analysis Workbench does not load duplicate scan files (that is, an identical scan file), no
current data will be overwritten. Scan files are considered identical when the Asset Number field is
the same even if the scan file name is different.

You can also use a command line parameter to specify that all dates in Analysis Workbench use
the standard international date format instead of the one set up in Windows.

Creating a Shortcut on the Desktop

To create a shortcut on the desktop including parameters:
1. Create a shortcut without parameters first:
2. Dragthe Analysis Workbench icon onto the desktop with the right mouse button.

3. Select the Create shortcuts here option from the menu that is displayed when releasing the
mouse.

4. Right-click on the shortcut and open the properties dialog box.

5. Add any command line parameters to the end of the target field separated from the executable
name by a space.

Scan File Names Command Line Parameter

This is one or more scan file names. The following conditions apply:
Scan file names specified are loaded after a state image or a directory specified.

If the path to any parameter (specific scan files) contains spaces, it must be enclosed in the double
quotes.

Syntax

HP Universal CMDB (10.10) Page 45 of 311



Inventory Tools User Guide
Contents

The syntax for scan file command line parameter is as follows:
[Fully qualified scan file names separated by spaces]

Examples

Case 1: Path to the Scan File Does Not Contain Spaces
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\State Images
\Samples.AWS

Case 2: Name of One Scan File Contains Spaces

"C:\Inventory scans\LND 1250.xsf" E:\scans\Test.xsf

Standard International Date Command Line Parameter

When specified, all dates use the standard international date format instead of the one set up in
Windows. This is useful when setting up scripts for exports.

Syntax
The syntax for standard international date command line parameter is as follows:
[/STD_DATES]or[-STD_DATES]

The command line switch only turns on the standard international date format. There is no
command line switch to turn it off.

Using Combined Command Line Parameters

You can combine the three command line parameters so that Analysis Workbench can be started
with different datain it.

Specify the names of the scan files, or the state image you want to load. If a directory name is
specified, all the scan files in that directory are loaded. The command line parameter priority is
always:

o State Image

o Directories (only 1 is allowed)

o Scanfiles (multiple scan files can be specified)

Syntax
The syntax for combined command line parameters is as follows:

[Fully qualified directory name] [State image name] [Fully qualified scan file names separated by
spaces]

Examples

For example, you may want to load a saved state image and also include new scan files
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contained in your repository directory.
o Case 1: Path to the State Image and Scan File Directory Do Not Contain Space.

C:\states\State1.aws c:\NewScanfiles

e Case 2: The State Image and the Scan File Contains Spaces

” &

"C:\states\State 1.aws” “c:\New Scan Files"

Viewing Logs
Logs can be accessed from the Log Window command in the Windows menu.

The log file records information about the current session of Analysis Workbench. It can include
amongst other items; how many scan files were loaded and how long they took. It can also log
activity when editing SAl entries.

Shortcut Keys

You can quickly accomplish tasks you perform frequently by using shortcut keys.

Keyboard
Task Shortcut
Load State CTRL+I
Load Scan Files CTRL+o
Save State CTRL+s
Exit Analysis Workbench or close an active window ALT+F4
Tag all entries in an information window (can only be used from within the SHIFT+CTRL+a

window itself)

Untag all entries in an information (can only be used from within the window = SHIFT+CTRL+u
itself)

Setting Load Preferences

The Analysis Workbench Load Configuration Dialog Box

Set Loading preferences before you load data into the Analysis Workbench.
To load the Analysis Workbench Load Configuration Dialog Box:

Select the Load Options command from the File menu. The Analysis Workbench Load
Configuration dialog box appears.

This dialog box has six tabs which are used to set various options:
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o Load Filter

Specifies which files are to be loaded from selected scan files.

e Recognition

Specifies which recognition method to use and which files to pass through it.

o Asset Fields

Adds additional columns of asset data.

o Display Filter

To minimize the amount of data to be viewed, selections can be made after the files have been
processed. In addition, selected views can be chosen.

Business view - licensable applications

Operational view — all applications with partial or full identification
Memory

These are memory saving options. Includes options for selecting:

File attribute information to load
o Directories to load

¢ Machine data to load

¢ File Version Data

Configures loading of additional information collected at scan time.

Note: The Recognition, Memory and File Version Data settings are disabled and cannot be
changed while data is present in Analysis Workbench. To enable these settings, either unload
the data (select the Unload scans command from the File menu) or restart Analysis
Workbench with an empty workspace.

It is recommended that you check the load option settings before loading in data to the
Analysis Workbench. This will save you having to unload data if a setting needs to be changed.

Loading and Saving Options

Load configurations can be saved to or loaded from a LoadOptions.ini file (the default file name is
LoadOptions.ini) by using the Load and Save buttons available in every tab page of the Analysis
Workbench Load Configuration dialog box.

Filtering Levels

There are three levels of filtering in Analysis Workbench - and understanding this is key to
understanding how to use the application. Filtering takes place before the recognition phase and
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this determines which information will be displayed in Analysis Workbench and the status it will be
given.

Load Filter

This filter is used to decide which files to extract from the scan file for processing and/or displaying
by the recognition engine.

Recognition Filter

This filter determines which of the files that are passed through the load filter are also sent to the
recognition engine for processing. Sending too many files will make it slightly slower, however,
passing less files through the recognition engine will possibly result in inferior recognition.

This filter is different to the load filter in that a load filter might load .exe, .com and .dll files, but a
recognition filter might be limited to .exe and .com. This means that .dlls are loaded but not
recognized. This can be useful (depending on the Scanner configuration) since the .dll files will still
give version information without being recognized.

Display/Storage Filter
This filter is based on the recognition status. Recognition status can be:
Main

Main files identify the application. An application can have multiple main files, but normally there is
only one. If a Main file is found, the application is considered present.

Associated
Associated files are part of an application but not the main file.
3rd party

Files such as some DLL files that are technically used by the application, but are also distributed
freely and can be used by other applications.

CheckVer file

CheckVer files are files that are found in the Recognition library, but do not match any of the known
versions of an application. This usually indicates that it is a newer version. If this is the case, it
might be a good idea to obtain an updated Recognition Library from HP.

Unidentified file
These files cannot be identified.
Unprocessed file

These files have not been processed by the recognition engine. For example, they are passed to the
load filter, but not to the recognition filter.

Junk files

These files have been identified as junk files as set up in the Recognition tab page Advanced
options.

Auto-identified file
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These files are known to be a device driver file and were not recognized by the application library.
Files used as Device Drivers represent a large portion of the files that are not identified by the
Application Library. Being able to identify these automatically can significantly reduce the effort
required to achieve good recognition rates.

When performing analysis or recognition, it can be beneficial to allow everything to pass through the
display filter (apart from files you have designated as junk). This effectively causes the Analysis
Workbench to store and display information about all files, irrespective of their recognition status. In
this state, the file data that is needed to teach more applications is available.

Configuring Load Filter Settings

You can use these settings to determine which types of files will be loaded and optionally be
processed by the recognition engine. In addition, whole directories of files can be excluded from the
recognition process.

1. Inthe Analysis Workbench, select the Load Options command from the File menu.

2. Click the Load Filter tab in the Analysis Workbench Load Configuration—Advanced dialog box.

Selecting the Load Filters

To select the load filters:
1. Click the Files tab.
2. Inthe Files group box, select one from the following options:
= All files - Loads all files.
= No files - Nofiles are loaded. For example, use this for hardware only analysis.
= Some files - Enables the Some files options:

= By extension - This allows you to specify the extensions of any files that you want to be
included. Select the extensions from the drop-down list (this list maintains a history of
previously entered extensions) or type the extension directly in to the box. Multiple extension
must be separated by semicolons.

= Executable files - This will allow all executabile files to be processed against the recognition
engine. Executable files include *.exe, *.com and *.ddl and other files containing executable
code.

= Files within Archives - This will process any files in archive files (for example, Zip files,
CAB, LZH). When this option is checked, any files matching the other criteria (extension
and/or executable) are loaded, even if they are inside an archive. If the option is cleared, no
files within archives are loaded.

» If this is the only option enabled, nothing is loaded - it is not possible to load only files within
archives.
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Note: For obtaining the best recognition in as short a loading time as possible, enable the
Executable Files option only.

Specifying the Directories to Exclude

Examples of directories that you may want to exclude are shown in the following table:
Directory Reason

Temp/Tmp Temporary directory holding transient files.

Recycler/Recycled Recycle directory for C:, D: and so on. Stores files moved to the Recycle
bin.

DOS Operating system directory assuming that all these files are recognized.
1. Click the Directories tab.
2. Inthe Directories group box select the Exclude files in these directories check box.

3. Place the cursorin the list box and type in the path (do not include the drive letter) of the
directories to be excluded. An example of the format is as follows:

\WIinNT\$NTServicePackUninstall$

You can save the current list displayed in the list box. To do this, click the Save list button and
specify the file name and path of the text file to save to. The default file name is dirlist.txt.

You can load a previously saved text list file by clicking the Load list button to display a dialog box.
Enter the file name and path or navigate to the file to be loaded.

Recognition Overview

Analysis Workbench is able to perform application recognition on the software scanned, while the
data is being loaded from a scan file.

By default the Analysis Workbench uses Master Software Application Index files (Master SAIl) for
performing application recognition. The Master SAl files are read-only files that contain a database
of software applications.

There are multiple Master SAl files that can be used at the same time for recognition purposes:
o Master.zsai
e French.zsai

e German.zsai

HP Universal CMDB (10.10) Page 51 of 311



Inventory Tools User Guide
Contents

e Unix.zsai
o BaseUnixOS.zsai

All of these files can be found in the following location:
<DataFlowProbelnstallation>\Runtime\ProbeManager\DiscoverySaiResources\SaiRuntime

where <DataFlowProbelnstallation> is the installation location that you specified when you
installed the Data Flow Probe. By default, this is
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\State Images

By default, the Analysis Workbench is also configured to use the User SAl file. A User SAl file is
one that you, the customer, have customized with applications you have taught using Analysis
Workbench.

You can use multiple User SAl files for recognition purposes. Each User SAl created has a unique
identifier assigned to it.

Backward Compatibility

Backward compatibility has been maintained in this version of Universal Discovery.

A Summary of the Process

The process can be summarized as follows:
o Avrating is obtained for all versions that are possible matches.
o The version(s) with the best rating are found.

o If there is only one version, then the process goes no further, otherwise, it takes the language
(locale setting) of the operating system, if it is available in the scan.

o If the operating system locale setting is not available, it takes the setting you specified here in
the Preferred Language box.

Configuring Recognition
Displaying the Analysis Workbench Recognition Options Tab

To display the Analysis Workbench recognition options tab:

1. Select the Load Options command from the Files menu. The Analysis Workbench Load
Configuration dialog box is displayed.

2. Click the Recognition tab.

Disabling Application Recognition

This option is used to disable any application recognition. When recognition is disabled, loading is
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slightly faster but no application information is available.
To disable application recognition:
In the Recognition Method group, select the No recognition option.

Selecting the Installed Applications List As the Recognition Method

This method of recognition is based on the operating system’s internal list of applications. As such,
it is not recommended as the preferred recognition method, except for data from UNIX Scanners.

To select installed applications for the recognition method:

1. Inthe Recognition Method group, select the Installed Applications option. A further option is
activated.

2. Use Enriched application data if available

When this option is checked, Analysis Workbench uses the application data from the enriched scan
file instead of running ‘real’ recognition. If no file data is loaded, this is much faster.

Selecting the SAI As the Recognition Method
In the Recognition Method group, select the Software Application Index (SAI) option.

Click the Advanced button to set further options if required. The Advanced Configuration -
Software Application Index dialog box is displayed.

Setting Level of Recognition Used

To set the level of recognition used:
1. Select the General tab in the Advanced Configuration - Software Application Index dialog box.
2. Inthe Miscellaneous group, select options for the level of recognition used.

Level 3 recognition heuristics

If this option is enabled, the recognition engine defers its final recognition decision until all the files
in all the directories on the machine have been read. If disabled, machine-based recognition does
not take place and recognition data is returned after each directory is loaded. A time overhead of
about 10% is normal when Level 3 Recognition is enabled.

Auto-identify unrecognized device driver files

When enabled (by default), files that cannot be identified by standard SAI recognition and have the
Device Driver attribute will be marked as recognized. Files used as Device Drivers represent a
large portion of the files that are not identified by the Application Library. Being able to identify these
automatically can significantly reduce the effort required to achieve good recognition rates.

Setting the Preferred Language

If you are using a national SAl file, for example, german.zsai or french.zsai together with the
Master.zsai you will want to set this option.

Preferred language is used for cases when the recognition engine encounters more than one
language version of the same file— for example, Microsoft Word in English and in French. Because
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these versions are equally recognized, this setting instructs the recognition server on which of the
versions to select.

To set the language options:
1. Select a language from the drop-down list.
2. Check the Override OS Language box if you want the recognition engine to overlook the

operating system locale setting and take the setting you specified in the Preferred Language
box.

Note: This will only work if exactly one of the versions matches the language.
Adding, Creating or Removing SAls
The options on the SAls tab page allow you to:
o Add anew SAlfile to be used for application recognition.
 Remove an existing SAl file.
o Create a new empty User.zsai file.
The list box on this tab page displays the following information:
e The path to source files for the SAI — both read-only Master SAls and editable User SAls.
o The SAI ID number for User SAl files. Master SAl files do not have an ID.
o A description of the SAI files.
e The size of each SAl file (in kilobytes).
e The number of application versions in each SAI.
e The type of SAl file:
= Master - Read-only SAI (Master SAI)
= Editable - (User SAI)

= The creation date for a Master SAl file or for a User SAI, the date the file was last saved.

SAls Used to Store Rule-Created Items

Any items encountered by Analysis Workbench that were created by rules will be added to the SAI
file specified here. These rules are present within the SAl files themselves and additional rules can
be added using SAIl Editor.

Select the SAl file from the drop down list. The drop down list contains a list of the SAls currently
loaded.
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If this field is left blank, Analysis Workbench will create a file called Auto.zsai and put this in the
same location as the first SAl in the list.

Adding a New SAI File for Application Recognition

To add a new SAl file for application recognition:
1. Select the SAls tab in the Advanced Configuration - Software Application Index dialog box.
2. Click the Add button on this tab page.
3. Navigate to and select the SAI file (Master or User) you want to use for recognition.

The SAl file is added to the list box which means the file will be included in for application
recognition.

Removing an Existing SAI File
To remove an existing SAl file:
Select the file in the list box and click the Remove button.

Creating a New Empty User SAI

To create a new empty User.zsai:

1. Click the Create button. The Create a User dialog box is displayed. Enter or navigate to the
directory where the SAl file is to be created.

2. Enter a description for the file.
3. Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAl with the
same filename. If so, a Confirm message will be displayed.

A file named <filename> already exists in this directory. Overwrite this file?

Click Yes if you want to overwrite the existing SAI file or click No to retumn to the dialog box and
assign a new ID to the SAl file.

If you have made modifications to the cfgNextSAIID setting in the SAl.ini file, you may see the
following message. This happens when the value for the ID in the ini file is missing or lower than the
highest ID in the user SAls currently loaded. This message is for information only - the Universal
Discovery components will correct this situation automatically by inserting the correct ID value into
the ini file.

The next User SAI ID cannot be found in the settings file.

This probably means that you are using User SAls created with a different version of the software,
or created on a different machine.

Please take care to set the new ID to a value that is unique across your organization.
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Setting Filtering Options for the SAI
1. Select the Filtering tab in the Advanced Configuration - Software Application Index dialog box
2. Select the options as required:
3. Apply recognition to selected files only

This is a recognition filter that determines which of the files are sent to the recognition engine for
processing. Sending too many files can make it slightly slower.

By extensions

Allows you to type in the extensions of any files that you want processed against the recognition
engine. Select the extension from the drop-down list (this list maintains a history of previously
entered extensions) or type the extension directly in to the box. Multiple file types must be
separated by a semicolon.

Executable files

All executable files will be processed against the recognition engine. Executable files include *.exe,
*.com files, DLLs and other files containing executable code.

Files within Archives
Processes any files in archive files. The following archive file types are supported:

ARJ, ZIP v1, ZIP v2, LHA, LZH, ARC, CAB, TAR, GZIP, TAR/GZIP and PAK
Note: For the best application recognition, select the Executable Files option.

Junk Files

Some files may be executable but are of no interest for licensing or other purposes. These files are
often identifiable via the file name.

The Treat Files matching the following regular expressions as junk option is a way for the
recognition engine to ignore such files, by allowing one or more file name masks to be specified as
junk.

These files are not passed to the recognition engine and will be marked as junk. This is available in
the Display Filters tab page so junk files can be discarded and not shown.

When matching the junk file name against the junk filter regular expression, the file name is first
converted to lower-case. For this reason, all letters entered as part of the regular expression must
be in lower-case for a match to successfully occur.

To set junk filters:
1. Select the Treat Files matching the following regular expressions as junk option.

2. Type the file name masks you want to treat as junk.Use regular expressions.
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Regular Expressions
This section outlines some of the regular expressions commonly used.

Character Meaning

Match any character

+ Match one or more of the previous character.For example:A+ matches one or more
As

* Match zero or more of the previous character.For example:A* matches zero or more
As.

? Make the previous character optional. For example:assets? matches a string

containing either asset or assets.The ? only applies to single characters when there
are no enclosing parentheses.

A The characters after this symbol must appear at the beginning of the string. For
example:*xsf means that the string to be matched must start with the characters
xsf.

$ The characters before this symbol must appear at the end of the string. For

example:xsf$ means that the string to be matched must end with the characters xsf.

\ This removes the special meaning of a character. For example:\. matches the .
character, since the \ removes the special meaning of the . character.
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Character Meaning

1 Character class.Match one of the items contained in the square brackets. For
example:

o [123] will match eithera 1, or 2, or 3.
e [123]+, would match a sequence of 1's, 2's and 3's or any combination of them.

Note: Within a character class, the * character does not have its usual status but
means any character except those in the class.For example:

o A character class of [*123] will match any character that is not 1, 2 nor 3.

o A character class containing a - between two characters means a range of
characters. For example:

o The character class [c-h] means all the lower case letters starting from ¢ and
endingin h.

There are a number of additional special predefined character classes to represent
some commonly used groups of characters.

¢ [[:alnum:]] Any alphanumeric character
¢ [[:alpha:]] Any alphabetic character

¢ [[:blank:]] Space or horizontal tab

e [[:ctrl:]] Control character

o [[:digit:]] Decimal digit

¢ [[:lower:]] Lower case letter

¢ [[:punct:]] Punctuation character

o [[:upper:]] Upper case letter
0 Groups a set of characters together. For example:

(assets)? would make the entire word assets an optional part of the match.

Configuring Analysis Asset Fields

Analysis Workbench can be configured to construct any number of additional named asset fields.
These asset fields are constructed based on data collected at scan time. The analysis asset fields
defined here can be displayed as a column in the Machines window.

To customize the columns that are displayed, select the Edit Column option from the Columns
drop-down toolbar menu in the Machines window.
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Adding an Asset Field Extract

The fields are set up in a manner similar to that found in the Scanner Generator. Five different types
of fields can be constructed:

Text file Extract - Takes data from a plain text file (similar to File Extract Field of Scanner).
Ini Field Extract - Takes data from an ini file (no equivalent in Scanner).

CSV File - Takes data from CSYV files such as peripheral sheets (allows an external CSV file,
containing a list of data associated with asset numbers to be parsed and loaded along side the
other data).

Environment - Takes data from environment strings (equivalent to same field in Scanner).

Sequence - Takes data from a sequence of asset fields (equivalent to same field in Scanner).

To configure the asset field extract settings:

1.

2.

5.

6.

Select the Load Options command from the File menu.

Click the Asset Fields tab. The Asset Fields tab contains a pane with five columns:
= Caption - The caption as specified in the Asset Data page of the Scanner Generator.

Field - The number of the Analysis field (1 to 28)

Field Type - The type of field to extract the information

= Field Data - The source of the field information

Default - Any default value that has been set

Right-click anywhere in the pane to display a menu with the following options:
= Add - Adds a new analysis asset field.

= Edit - Edit the details for an existing asset field.

= Remove - Removes an existing asset field from the list.

Select the Add option. A New Analysis Asset Field dialog box is displayed.
Select the type of field to be extracted.

Use the controls on this page to configure the desired fields.

Text File Extract Asset Field

This field type extracts information from a single line in a named text file.

A useful file extract includes the predefined SMS file which extracts the SMS Unique Machine ID.

Note: The file you wish to extract from must be a file that is included in the Stored Files
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section. If the file is not there it will not work. In other words, the Scanner has to be set up to
store the file before you can extract from it in Analysis Workbench.

To set up a new text file extract asset field:

1.

2.

Select Text File Extract as the field type.
Assign a caption for the field if required, by typing it in the Caption field.

In the File Name box, specify the name of the text file that the information is to be extracted
from.

In the Search String box, specify the text string that is going to be located.
Assign the number for the analysis field by selecting it from the Field drop-down list.

Check the Remove leading blanks box, to remove blank spaces (if there are any) before the
search string located in the text file.

Check the Remove trailing blanks box, to remove blank spaces (if there are any) after the
search string located in the text file.

In the File Directory group box specify where to look for the file. This is a prioritized search
sequence list. Select one of the following options:

Use first occurrence Analysis Workbench uses the first match of the file that it encounters.

Use prioritized directory list A list box is enabled, which allows you to specify the priority of
directories where the file might be located. For example:

%BASEOS% (the base operating system directory)

C:\Winnt
This location will have the highest priority, that is, if the file is located in this directory, then this
file will be used.

%BASEOS%\System (the System directory in the base operating system directory)
C:AWinnt\System

If the file is not located in the %BASEOS% directory and is encountered in the
%BASEOS%\System location, then this location will have priority as the source for the text
file, and soon.

Specify any extract options as required by clicking the Options button. See Specifying Extract
Options for Text Files, ini Files, CSV Files and Environment Variables for information about
how to do this.
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CSV File Extract Asset Field

Allows an external Comma Separated Variable (CSV) file, containing a list of data associated with
asset numbers to be parsed and loaded alongside the other data.

1. Select CSV File as the field type.

2. Inthe CSV File box, navigate to the CSV file that is to be loaded.
Note: The first row of this file must contain column headers.

3. Enter the number of the column that contains the machine asset number (that is, the primary
identifier field). As the number changes so does the fields selection. For example, if the primary
identifier is column 2 in the CSV file, then specify this as the number ‘2" by either typing it
directly into the field or by using the arrows.

The fields contained in the CSV file are displayed in the Fields list box. Select the fields to be
included by selecting the check boxes next to the field names.

The primary identifier column (asset number field) check box is disabled and cannot be
deselected. This is because it is necessary to load this field.

4. Select the Append (csv) to column name option if you want the extracted asset fields to be
displayed with the word ‘(csv)’ after the column header name in the Machines window.

5. Specify any extract options as required by clicking the Options button. See Specifying Extract
Options for Text Files, ini Files, CSV Files and Environment Variables for information about
how to do this.

Environment Variable Asset Field

This type of field accepts data from a specified environment variable.

To set up an environment variable extract asset field:
1. Select Environment as the field type.

2. Enter the variable name in the Environment variable name field. An example of an environment
variable is:

ComSpec=C:\WinNT\System32\cmd.exe

You can check for environment variable names by looking in the Hardware > System tab in
Viewer.

3. Assign the number for the analysis field by selecting it from the Field drop-down list.
4. Assign a caption for the field if required, by typing it in the Caption field.
5. Specify any extract options as required by clicking the Options button. See Specifying Extract

Options for Text Files, ini Files, CSV Files and Environment Variables for information about
how to do this.
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Sequence Asset Field

This field type extracts information from one of up to ten specified fields. The value returned as the
results of the sequence field, will be the first of these fields which contains a non-blank value.

To set up a sequence asset field:
1. Select Sequence as the field type.
2. Inthe Field sequence box, click in the Field Name column and select the desired field.

3. Inthe Ignore strings group box, specify the criteria for a blank field using one or all of the
following methods:
= Inthe Matching box, enter a sequence of strings (case-sensitive) separated by semicolons.

If the content of the field matches (is equal to) any of the strings specified here, the field is
considered to be blank. For example, if the text string Not Found is entered here, then a field
that has the value ‘Not Found’ is considered to be blank.

Multiple entries must be separated by semicolons ( ;), for example:
‘Unknown;Not Tested’
= You can type a strings in the form: *STRING*

Here the asterisks (*) are ignored and any string that contains the text between the two
asterisks will be ignored too.

= Specify ignore strings that are less than ‘n’ characters.

In the Shorter than box, use the arrow keys or type in a number to specify the maximum
length of text strings that are to be used to define a blank field (between 1 and 255). If the
string is shorter than the specified number, then the field will be considered blank.

4. Assign the number for the analysis field by selecting it from the Field drop-down list.
5. Assign a caption for the field if required, by typing it in the Caption field.

6. Specify any extract options as required by clicking the Options button. See Specifying Extract
Options for Text Files, ini Files, CSV Files and Environment Variables information about how
to do this.

Specifying Extract Options for Text Files, ini Files, CSV Files and
Environment Variables

Text file, ini file and environment variable asset fields can be set up so that only part of the string is
extracted instead of the entire string.

They can also be set up, for example, to use the last part rather than the first part of the string. This
can be very useful for obtaining the last part of an automatic field that is too long.

In addition, a default value can be specified for situations where no matching data has been found.

To specify extract options for text, ini and environment variables:
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1. Click the Options button in the New Analysis Asset Field dialog box. The Asset Field Extract
Options dialog box appears.

2. Inthe Extract characters from group box, specify whether you want to use the last part or
the first part of the string. Select one of the following options:

Start - Uses the first part of the string. Use the arrows in the Skip characters box to specify how
many characters you want to skip from the beginning of the string.

End - Uses the last part of the string. Use the arrows in the Skip characters box to specify how
many characters you want to skip from the end of the string.

3. Inthe Options group box, select the options you want:

Convert to upper case - Select this option to convert the alphabetic characters to upper case.

Treat field as File Name - Select this option to treat the string in the asset field as a file name.
Some characters are however invalid in file names, so any invalid characters can be replaced
with the character specified in the Replace invalid characters with box.

For example, underscore ‘_’ is a valid file name character and can be used to replace invalid
characters.

Alternatively, invalid characters can be deleted by checking the Delete invalid characters box.

If the extracted field is empty oris not found (that is, there is no matching data), then a default
value for the string can be specified in the Default Value box.

For example, if the text string ‘Not Found' is entered in this box, then an empty field or a field
that has not been found will be displayed with this text.

Displaying the Additional Asset Fields

After the asset field extracts have been selected, the columns need to be displayed in the Machines
window. To do this:

Click the Columns toolbar button in the Machines window to display the Select columns to
display dialog box.

The additional extract fields are included in the Assets category.
Refer to The Machines Window for more detailed information about how to include columns to
display in the Machines window.

Note: Although these fields are in the Assets category, they are not editable.

Configuring Display Filter Settings

In the Analysis Workbench, select the Load Options command from the File menu. Click the
Display Filter tab

When files have been processed by the recognition engine, the following options can be used to
include only the files that are of interest, based on the recognition level.
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These files can be identified in two ways when displayed in the Files information window:
e The color of the entry
e The entry in the Status column

The following table shows the default color and the Status column entry for the five different file
recognition levels.

Recognition level Default color in Files window Status column entry in Files window

Main file Red 1 Main
Associated file Green 2 Assoc

3rd Party files Green 3 3rd Party file
CheckVerfile Purple 4 CheckVer
Unknown file Blue 5 Unknown
Unprocessed file Black 6 Unprocessed
Auto-identified Olive 7 Auto-id

Junk file Olive 8 Junk

The colors associated with these file recognition levels can be customized. See Customizing
Window Layouts.

Selecting the Files to be Displayed

In the Files group box, select the types of files to be displayed from the following three categories:
Recognized

This category deals with files that have been recognized. Select from the following:
¢ Mainfiles

The main files for an application, for example, Winword.exe are displayed in red (by default) in the
Analysis Workbench Files window.

They are used to determine how many copies of the application are found.
¢ Associated files

Files that are part of an application but not the Main file, for example, Printer.com are displayed in
green (by default) in the Analysis Workbench Files window.
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o 3rd Party Files

Files such as some DLL files that are technically used by the application, but are also distributed
freely and can be used by other applications as well. Another example of a 3rd Party File is
InstallShield, which is packaged with an application from a different vendor. The files are also
displayed in green (by default) in the Analysis Workbench Files window.

Uncertain

This category deals with files that have been partially recognized (that is, they have been identified
but the version cannot be established with certainty). Select one of the following:

o Treat as unidentified files
The files will be given an unidentified recognition level and will be treated as such.
¢ Display as CheckVer

No description or versions are given for these files, but the word <Check Ver> is shown in the
version column. This indicates that something is known about the file but it does not accurately
conform to the version information held for it, and the version should be checked.

o Do not display
The files will not be displayed in the Files window. In other words, they are ignored.

Unrecognized

This category deals with files that have not been recognized or have not been processed against
the recognition engine. Select from the following:

o Unidentified file

These files have been processed, but not recognized.

o Unprocessed files

These files have not been processed by the recognition engine. These files have been selected for
loading using the load filter, but have not been included in the recognition filter.

e Junk Files

These files have been set up to be treated as junk by the recognition engine (that is, recognition
does not occur on these files). Check this option if you want these files to be displayed. The
default is to have this option unchecked - that is they are not displayed.

o Auto-identified files

If this option is checked (the default), automatically identified files are loaded. If unchecked, these
files are not loaded into memory.
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Selecting the Application View

This is the same as globally tagging Main files in the Files window and applying a Files filter in the
Applications window. In effect, this reflects the contents of the SAls that have been recognized in
the current load set.

In the Applications group box, select one of the following:

o Load Business View

The business view displays only applications with a Main file (that is, applications that require a
license and have been recognized). Partially installed applications are not displayed.

o Load Operational View
The operational view displays all applications whether partially or fully identified. The Application

window essentially summarizes what has been recognized — irrespective of whether the
applications are recognized with a Main file (that is, licensable) or not.

Configuring File Version Settings

By setting file version options, extra data is made available in the Files window. Specific fields can
be selected to limit the amount of information loaded. This information can then be displayed by
selecting the column name in the Columns toolbar menu.

In the Analysis Workbench:
1. Select the Load Options command from the File menu.
2. Click the File Version Data tab.

3. Select an entry (a single-click in the check box) in the File Version Data page to include it.
Alternatively, right-click in the pane and select an option from the menu:

= Select All - Selects all the entries.

= Select None - Clears all of the entries.

Information Collected by Version Data

The following information can be collected using Version Data:
e DOS 8.3 Name
o Real Name

e Description
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e Company Name
o File Description
o File Version

¢ Internal Name

o Legal Copyright
o Original File Name
e Product Name

o Product Version

Configuring Memory Settings

Saving memory not only saves time at loading but also during sorting and selections, therefore it is
worth while considering selecting memory saving options. Because of the number of files that will
be loaded, removing unnecessary file detail can have significant impact on the time taken to load
and the amount of memory needed. This is particularly useful when loading a large quantity of scan
files.

When more than the physically available memory is needed, the Operating system uses a page file.
Access to this file is of course much slower than to real memory and therefore degrades
performance significantly.

In the Analysis Workbench:
1. Select the Load Options command from the File menu.

2. Click the Memory tab. This option allows you to specify which attributes are loaded for a file.
Specify the file details to load by selecting the following options as required:

n Size - Thefile size. This option is permanently disabled and cannot be unchecked. The
Analysis Workbench always loads the file size.

= Signature - The signature (checksum of the first 8 kb).
» Modified time - The time stamp indicating when the file was last modified.
= Accessed time - The time stamp indicating when the file was last accessed.

= Type - The type of file (for example, DOS executable file, Windows executable file, 0S/2
DLL file).

» Attributes - The system attributes for a file (for example, hidden, archive, read-only).
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= Software Utilization Data - The number of days that the application was used (as a
percentage) over a period of time.

3. Loading all directories and cross-referencing them with files, machines and applications can
take up a significant amount of memory. If only parts, or none of the information is required,
then select one the appropriate options:

= Load all directories
= Load only directories containing loaded files
» Do not load directory data

4. Select the machine data to be loaded. This is a memory saving option, which allows you to
load only some data for each machine. In the Machine data to load group box select from the
following options:
= Asset and Hardware data

Include Shortcut data

Include Services data

= Include Environment data

Include SMBIOS data

Loading Data from Scan Files

Process for Loading Data into Analysis Workbench

This section explains how you can load data into Analysis Workbench after you set the load options
manually or you have loaded a preconfigured option from the Quick Config dialog box.

Analysis Workbench is an analysis tool and requires data to analyze. This data can be loaded from
Compressed XML Files (XSF) scan files.

You can load files from the processed directory. Enriched scan files are created here. By default the
directory is in the following location:

c:\hp\UCMDB\DataFlowProbe\runtime\xmlenrichen\Scans\processed

The following diagram shows the process for reading in data
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et loading options from the File menu or
select a precenfigured configuration from
the Cuick Config dialog box

Load data from scan

files - 305F ( xsf)

Load from multiple
directories

Unloading Data from Analysis Workbench

There may be times when you need to unload scan files from the Analysis Workbench workspace.

For example:

¢ The Recognition, Memory and File Version Data load options are disabled and cannot be
changed whilst data is present in Analysis Workbench.

o A previously saved state image can be loaded only when there is no data loaded in the Analysis

Workbench.

To Unload Scans from the Analysis Workbench Workspace:

HP Universal CMDB (10.10)
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1. Select the Unload Scan Files > Current (name of scan) command from the File menu. The
data for the currently selected scan is unloaded. The name of the selected scan is displayed in
brackets next to the command.

2. Select the Unload Scan Files > Tagged command from the File menu. Scans that are tagged
in the Machines window are unloaded. This command is not available if there are no tagged
machines.

3. Select the Unload Scan Files > Untagged command from the File menu. All untagged scans
in the Machines window are unloaded.

Note: This option is not available if all machines are tagged.

4. Select the Unload Scan Files > All command from the File menu. All scans loaded into the
Analysis Workbench are now unloaded.

Loading Data from a Scan File

The Analysis Workbench provides various options for reading in scan files to analyze the data
collected for a computer population.

Scan files read into the Analysis Workbench are usually selected from a repository directory (or
directories) used to store all the scan files for a computer population.

To load data from a scan file perform the following steps:
1. Select the Load scan files command from the File menu.
The Open scan file dialog box is displayed.

2. Click the Options button to set the scan file load options. See Setting Scan File Load Options
on page 84.

3. Load the scan files in one of the two following ways:
» From a single directory
= From multiple directories

4. Load the scan files using one of the two methods:

» Select scan files directly from the directory where they are stored. This allows you to select
individual files, a group of files or all the files in the selected directories.

» Select scan files for specific computers using the hardware and asset data collected for each
computer. A query facility is used for this method, so that the files matching specified criteria
for the hardware and asset details recorded during the inventory, are selectively read in.

Whichever method is chosen, the Analysis Workbench reads in the software file information for
each scan file, according to specified load options.
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Setting Scan File Load Options

After the scan files or data to be loaded into Analysis Workbench have been selected, the software
information collected for each computer inventoried is read in according to the options selected for
processing information. These are referred to as the File Load Options.

Scan file load options are used to deal with situations that can arise when loading older scan files
and specify how to handle scan files with the same name.

Click the Options button on the Open scan file dialog box.

The File Load Options dialog box is displayed.

The following load options can be enabled or disabled:

Option
File Age Options

Load all possible files
(ignore age limit)

Ask what to do if file older
than limit

Ignore attempts to load
files older than limit

File Clash Options

Load newest file

Ask which file to load, if
different

Ignore attempts to load
duplicates

Load new scan file, unload
the current scan file

Files

Show hidden files

Scan file description
thread

Directory List

HP Universal CMDB (10.10)

Description

When selected, all scan files (regardless of the age of the scan file
itself) are loaded.

Selecting this option make the File age limit (months) box available.
Use the arrows to set the age limit in months.A prompt is displayed
when the file to be loaded is older than the specified file age limit.

Select this option to ignore any attempt to load a file that is older
than the age limit specified in the File age limit (months) box.

Select this option to allow the file with the newest date to be loaded,
if two files with the same name are loaded.

Select this option to allow a prompt to be displayed asking which of
the files to load, when two identical file names are encountered.

Select this option to exclude any duplicate files from being loaded.
The first file encountered is loaded.

Select this option to allow the file with the newest date to be loaded.
The file with the older date will be unload.

Select this option to show hidden files in the Open scan file dialog
box.

Select this option to display the descriptions of the data files in the
Load scan file dialog box.
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Option Description
Show by default Select this option to allow scan files to be loaded from multiple
directories when the File Load scan file command is selected from
the File menu.

Load default directory list = This option is only enabled when the Show by default option is
selected. Selecting this option will load the default directory list
when the Open scan file dialog box is opened.

Other Options

Set as default Select this option to enable the load options specified on this form
(Permanently change the  to be used as the default settings when scan files are loaded.

file load preferences to the

options above)

Loading Old Scan Files

If the Analysis Workbench encounters a file that is older than the age limit set in the file load options
(see Setting Scan File Load Options on page 84), an Old file found dialog box is displayed. The
name and path of the scan file is displayed along with some basic information. From within this
dialog box, you have the options to do the following:

o Ignore this file, as it is older than the limit set in the file load options.
o Load this file regardless of its age.

The Set as default option in this dialog box will permanently change the file load preferences to the
previous options.

You can change the default settings later by clicking the Options button in the Open scan file dialog
box (File > Load scan files...).

Selecting Files

In the Open scan files dialog box, clicking on a file entry in the bottom pane of either directory view
will highlight it in blue. However, this does not mean that the scan file will be automatically loaded.
For this to happen, the check box next to the scan file must be clicked. You can also use the space
bar to check and clear the box.

A scanfile in the list can be:

o Selected (highlighted in blue) and/or
o Checked (check mark set) or

o None or both of the above

Checked scan files will be loaded when the OK button is clicked.

By selecting files you can group them for operations carried out from the shortcut menu
(check/uncheck selected, remove selected, sort by selected).
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Multiple files can be selected by clicking on a file and using the the SHIFT or CTRL key at the same
time as clicking on other files. This allows the Open scan file dialog box to be more flexible.

For example, right-click on a scan file and select Check all from the menu, select a range of files
and then select Uncheck selected.

If you do not check any files, the Open scan file dialog box will ask to load either of the following:
o Allfiles, if no files or only a single file is selected.

o Selected files, if more than one is selected.

Note: You can use the drag/drop for loading in scan files. Drop any number of directories, scan
files, or a combination of both onto the Analysis Workbench window to load the scan files and
all files in the directories.

Checking Options

Checking options can be set by using the shortcut menu which is available by right-clicking
anywhere in the bottom pane. This menu allows you to:

Check all — Checks all entries in the list.

¢ Check none — Unchecks all entries in the list.

o Select all — Selects all entries in the list.

¢ Select none —Deselects all entries in the list.

¢ Check selected — Checks the selected entries in the list.

¢ Uncheck selected — Clears the check mark from selected entries in the list.

+« Remove selected from list — Removes any selected entries temporarily from the list. The file
entries are no longer displayed in the list, but are not deleted from the disk.

o Sort by checked — Moves all checked entries to the end of the list.
o Sort by selected — Moves all selected entries to the end of the list.
o Query Displays a Complex Query dialog box, which allows you to load scan files for specific

computers. See Selecting Scan Files for Specific Computers (Complex Queries) on page 88 for
more information.

Selecting Multiple Files

Multiple files can be selected by clicking on a file and using the SHIFT or CTRL key at the same
time as clicking on other files. This allows the Open scan file dialog box to be more flexible.

For example, right-click on a scan file and select Check all from the menu, select a range of files
and then select Uncheck selected.
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Loading Scan Files from a Single Directory

Scan files can be loaded from a single or multiple directories. By default the Open scan file dialog
box allows you to load scan files from a single directory.

To open scan files from a single directory:

1. Inthe top pane in the Open scan file dialog box, navigate to the directory that you want to load
the scan files from. Any scan files found in that directory will be displayed in the bottom pane.

As the mouse pointer is placed over a scan file in the bottom pane, details are displayed in the
status panel.

2. Check the box next to the scan file to include it for loading (you can also use the space bar to
check and clear the box). Checking options can also be set by using the shortcut menu which
is available by right-clicking anywhere in this pane. See Checking Options on page 86.

3. Set scan file load options if required by clicking the Options button in the Open scan files
dialog box.

4. Click the OK button to load the checked scan files. A progress indicator is shown.

If an error is encountered during loading, each error is logged in the Log window (Select the Log
Window command from the Window menu to display the Log window) and an error message is
displayed at the end of the load sequence.

Tip: To load only one scan file, double-click on it.

Toload scan files from multiple directories, click the Dir List button. See Loading Scan Files from
Multiple Directories for more details.

Loading Scan Files from Multiple Directories

Toload scan files from multiple directories, in the Open scan file dialog box (single directory view),
click the Dir List button.

An extra pane is displayed in the upper right area of the dialog box. This is the list of directories to
load. For each directory, this pane displays the following:

o The total number of files in the directory and their combined size.
e The total number of scan files to load and their combined size.
e The total number of scan files selected and their combined size.

The bottom pane displays all the scan files that are available in any of the included directories.

To load scan files from multiple directories:
1. Inthe Open scan file dialog box (single directory view), click the Dir List button.

2. Navigate to the directory you want to load the scan files from and use the buttons as follows.
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= Add Dirs Add this single directory to the list.

= Add w/Subdirs Include this directory/drive plus any subdirectories contained in that
directory/drive.

» Clear list Clear the list of directories.
» Load list Load a previously saved default directory list.
= Remove Dir Remove this directory from the list.

Any scan files contained in the selected directory (or directories) will be displayed in the bottom
pane. As the mouse pointer is placed over a scan file in the bottom pane, details are displayed on
the status panel.

3. Check the box next to the scan file to include it for loading (you can also use the space bar to
check and clear the box). Checking options can also be set by using the shortcut menu which
is available by right-clicking anywhere in this pane. See Checking Options on page 86.

4. Set scanfile load options if required by clicking the Options button in the Open scan files
dialog box.

5. Click the OK button to load the checked scan files. A progress indicator is shown.

If an error is encountered during loading, each error is logged in the Log window (select the Show
Log command from the Window menu to display the Log window) and an error message is
displayed at the end of the load sequence.

Toload scan files from a single directory, click the No Dir List button. See Loading Scan Files from
a Single Directory for more information.

Selecting Scan Files for Specific Computers (Complex
Queries)

Querying provides a way of selecting and reading in only those scan files for computers matching
specified search criteria.

This task is carried out using the Complex Query dialog box which allows multiple search criteria to
be specified from a selection of categories. These categories are defined by the hardware and asset
information collected across the computer population.

When the search criteria are fully specified, the query is invoked and all scan files that match the
query criteria are checked/unchecked. The Complex Query dialog box also allows defined queries
to be saved so that they can be loaded and used again.

Displaying the Complex Query Dialog Box

To begin creating a query, you need to display the Complex Query dialog box used to specify the
search criteria:

To display the Complex Query dialog box:
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1. Select the Load scan files command from the File menu to display the Open scan files dialog
box.

2. Right-click anywhere in the bottom list. A shortcut menu is displayed.

3. Select the Query option. The Complex Query dialog box is displayed. By default the Queries
tab is selected.

This dialog box has two tabs:
¢ Queries - Displays the hardware and asset fields and allows you to build up the query.

¢ Options - Sets up the logic, actions and format of the query.

The Queries Tab

The Queries tab in the Complex Query dialog box displays a page that contains the two
components:

o The available queries list
e The query grid

The Available Queries List

There are two categories of information that can be used to query data collected from a population
of computers:

o The asset data entered manually using the asset questionnaire.
o The hardware configuration details collected automatically for each computer as it is inventoried.

These categories of information are listed in the Available queries list on the left side of the dialog
box.

Available Query Categories

These categories are used to group the items into the outline used in query and column selection.
The following list shows the hardware fields that are collected during a scan:

Category Description

Asset Data  Items collected manually or automatically through the entry fields in the Scanner, or
items calculated using analysis-time asset fields.

CPU Data | Information about the processor(s) and coprocessor of the machine.

Bus Data Information pertaining the machine's bus. This category includes the Bus
architecture and a list of identified cards that are not Network cards, disk
controllers or video cards.
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USB Data

Machine
Window
Data
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Description

Data extracted from the machine's BIOS (Which is a read-only memory area,
typically located at the top of the first 1MB of memory in the machine).

Memory information: Physical amount of memory, partitioning of memory, swap file
(virtual memory) and so on.

Operating System information. This includes information about the OS running at
the time of the scan, name, version, and so on, as well as OS services, such as
user profiles, login name.

Provides details of the Video Display Adapter, which include the adapter type
(EGA, XGA, VGA and so on) and model/manufacturer. In Windows and OS/2, the
current desktop resolution and number of colors are also displayed.

Information about the machine's network connection. This includes a list of
network cards, as well as logical information (machine name, logon name, domain
name, addresses, shares and so on).

Whether a Mouse is connected. Whether a Keyboard is connected.

Information related to physical disk drives, CD-ROM drives, network drives and so
on, as well as information about logical partitioning of these. Also includes a list of
disk controllers.

Items specific to the scan file or scan (but, with the exception of the asset number,
without real relevance to the machine itself) including asset number, scan time,
time since scan, path to scan file, version of scan file and so on

Contains a list of parallel and serial ports.

Shows the name, vendor, revision and device host information for the storage
devices (such as hard drives, CD-ROMs, tape drives) that have been detected.

Information about peripherals, currently modems, sound cards and printer
information.

Information extracted from the machine's SMBIOS, if available.

This contains information about the USB (Universal Serial Bus) devices,
controllers, hubs and ports. USB is an external bus which supports plug and play. It
allows peripheral devices to be connected or disconnected from computers without
the need to shut down or rebooting. These peripheral devices include CD-ROM
drives, joysticks, speakers, cameras.

Shows information from the Analysis Workbench Machines window.
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The Query Grid

The query grid is displayed on the right side of the Queries page. Each query item is built up on a
separate row. A maximum of 250 different query items are allowed.

The query grid has four columns:
o #

The number of the query items set up on the options page. The maximum that can be configured is
250.

¢ Query

This column is reserved for items from the Available queries list. Double-clicking on an data field
in the Available queries list, moves the entry to this column of the query grid. Alternatively, you
can drag the data field from the Available queries list and drop it onto a row in the query grid.

e Operator

Many hardware fields can be queried against a set range of values. This columns shows pick lists
for the types of queries performed against the Asset fields and some hardware field values.

= Begins with

= Contains

= Does not equal

= Ends with

= Equals

= Greater than

= s not the same as another field
= |s the same as another field
m Lessthan

= Matches

+ Condition

This column is reserved for a parameter value that must be matched by the query.
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The Shortcut Menu

¢ Right-clicking on an entry in the query grid, displays a shortcut menu:

o Edit current query - To edit an existing query entry, right-click on the cell and select this
command from the shortcut menu.

o Clear Current Line - To delete an entry from the query grid, right-click on the entry and select
this command from the shortcut menu.

o Clear All - Select this option to delete all entries from the query grid.

The Query Grid Buttons

o Load - To use a saved query, click the Load button and select the saved query file (with a .awq
extension). The query files are loaded from the Queries directory in the Universal Discovery
installation path.

« Save - To save the query for future use, click the Save button. Enter a name for the query file
(with a .awq extension) and click OK. The query files are saved in the Queries directory in the
Universal Discovery installation path. Saved queries can be automatically selected and used
without having to define the query again.

¢ Add - Highlight the desired field and click the Add button to add the definition to the query grid.

Building a Query

Queries are built within the Query grid by clicking on any + sign in the tree. This expands the
relevant category and lists possible data fields.

1. Toselect adatafield in the Available queries list, do one of the following:
= Double-click on a data field in the Available queries list.
= Drag the data field and drop it onto the Query grid.
= Select the data field and click the Add button.

After you have done this, a Define properties for hardware query dialog box is displayed.

2. Inthis dialog box select the operator for the query.

3. Depending on the type of query you set up, enter a parameter value that must be matched by
the query.

4. Click OK. You are returned to the Complex Query dialog box.

5. If required, you can save the query by clicking the Save button.
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The Options Tab

In the Complex Query dialog box, click the Options tab.

This tab is used to do the following:

¢ Retain the last query or clear the existing query.

o Provide a description for the query.

o Set up the actions that are to be carried before the query has been made. That is, whether to
clear or set all existing tags, or to leave them untouched.

o Set up the logic that will be used to perform the query.

o Set up the actions that will be carried after the query has been made. That is, which tags will be
applied and under what conditions.

Option
Caching

Remember the last
query

Query Description

This is useful for
identifying stored
queries.

Before Querying
Do not change tags

Clear existing tags

Tag all items

Query Type
Run as an OR query

(at least one condition

must be met)

Run as an AND query

Description

If this option is checked, a query will be retained after it has been run. If
unchecked, the grid is cleared after the query has been run.

Allows you to enter a text description of the queries being made.

No actions are performed before the query is made.

All tags are cleared before the query is made. That is, all scan files are
deselected.

All entries in the Open scan file dialog box are tagged before the query is
made. That is, all scan files are selected.

When more than one query is specified, the match is made when either
one of them are true.

When more than one query is specified, the match is made when all

(all conditions must be = queries are fulfilled.

met)
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Option Description
Note: Only one of these logic rules can be applied to the same query.
They cannot be mixed.
Tagging
Set tag when After an entry is found that matches the parameters defined by the
condition is met query, atagis set onthat entry. That is, the scanfile is selected.
Clear tag when After an entry is found that matches the parameters defined by the
condition is met query, if it is tagged then this tag is cleared. That is, the scan file is

deselected if it was previously selected.

Example Complex Query

In this example, the query will be set up to select scan files for all machines that have a minimum
specification. This may be because you want to locate all those machines that need to have their
hardware and software upgraded in to be able to run a particular piece of software.

The machine that has the following minimum specifications:

e Pentium 4 processor AND

o 64 Mbytes or more of memory AND

o More than 200 Mbytes of space onits local hard disks AND
e Host operating system is Windows® XP

Step 1- Setting Query Parameters for Scan File Data

The first step for specifying the criteria for the query is to select the data items that need to be
matched by the information in the scan files.

1. Inthe Available queries list click on the + sign next to the CPU Data category. Click on the
CPUs subcategory.

2. Select CPU Type by double-clicking on it with the mouse or by dragging it to the grid. The
Define properties for hardware query dialog box is displayed.

3. Select is from the Operator or Query drop-down list and select Pentium 4 from the other drop-
down list

4. Click the OK button. You are returned to the Complex Query dialog box.
5. Inthe Available queries list, click on the + sign next to the Memory Data category.

Click the OK button. You are returned to the Complex Query dialog box.

6. Select by Total Memory (Mb) double-clicking on it with the mouse or by dragging it to the grid.
The Define properties for hardware query dialog box is displayed.
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7. Select >= from the Operator or Query drop-down list.
8. Type 64 directly into the Numeric Value field, or click the calculator icon and use the keypad.
9. Click the OK button. You are returned to the Complex Query dialog box.

10. Inthe Available queries list, click on the + sign next to the Disk data category. Click on the
Physical Disk Data subcategory and select Physical disk size (MB) by double-clicking on it
with the mouse or by dragging it to the grid. The Define properties for hardware query dialog box
is displayed.

11. Select > from the Operator or Query drop-down list.

12. Type 200 directly into the Numeric Value field, or click the calculator icon and use the
keypad.

13. Click the OK button. You are returned to the Complex Query dialog box.

14. Inthe Available queries list, click on the + sign next to the Operating System data category.

15. Select Host Operating System Name by double-clicking on it with the mouse or by dragging
it to the grid. The Define properties for hardware query dialog box is displayed.

16. Select the contains option from the Operator or Query drop-down lists.

17. Type XP directly into the String Value field.

18. Click the OK button. You are returned to the Complex Query dialog box. The final Query grid
should look as follows

19. Click Save (in the Queries tab) to save the query for future use. Enter a name for the query file

(with a .sgm extension).

Step 2 - Setting the Query Options

1.

2.

3.

4.

5.

Click the Options tab.

Select the Remember the last query option. This option allows any previous queries made to
be saved in the grid.

Enter a text description of the queries being made in the Query description box. For example,
you could enter something similar to the following:

‘Machines meeting a minimum standard’

In the Query type group, select Run as AND query. WWhen more than one query is specified,
the match is made when all queries are fulfilled.

After you have specified the query parameters, return to the Queries tab and click the OK
button to tag the scan files matching the query.
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Viewing Data
The Default Display

The basic analysis of data consists of viewing the hardware, software and asset information in the
scan files collected for a computer population, Analysis Workbench provides various windows to
display and view data.

Files

¢ Machines

Directories
o Applications

The default display view on starting Analysis Workbench consists of three windows: Files,
Applications and Machines. A Directory view can be displayed as well, but is not part of the default
screen layout.

Each window can be customized to show different columns and different levels of detail for each
line. The window contents can be sorted on any column displayed, by clicking on the column
headers.

In addition, each window features a Details window, where more details about the currently
selected item can be displayed.

Any number of windows, each displaying a different set of columns and sorted in different ways can
be opened at the same time.

The current workspace layout can be saved, either as the new default workspace or as a named
layout that can be reloaded at any time. The Layout command in the Window menu is used to save
anew or load a previously saved window layout. The default layout is stored in awdef.ini.

The user interface can be customized by using the options in the Configure drop-down toolbar menu
available in all the windows. For more information, see the section describing Customizing Window
Layouts.

The windows can be resized and positioned in the workspace to reflect your requirements. For more
information, see the section describing Information Windows.

Locking and Unlocking Columns
It is possible to ‘lock’ some of the leftmost columns of the main windows.

To do this, right-click on a column header, and select the Lock option. When this is done, the
column clicked and all columns to the left of it will be ‘locked’ and will not scroll left or right. To
remove a lock, select the Unlock option from the shortcut menu, and to set a different lock, simply
select Lock on a different column.

This feature can be used to make sure important columns, remain visible while scrolling through
detailed columns.
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The Machines Window

Information Available in the Machines Window

The Machines window displays the Machine ID (Asset Number) and various description fields for
computers within the inventoried population.

Included in this information is asset data. Asset data is data that was collected using the asset
questionnaire which collects customized asset information as each computer is scanned. The
asset questionnaire is configured in the Asset Data page of the Scanner Generator.

The information includes details about users, departments, physical assets, equipment, and any
other information that is useful to record.

User-defined and Automatic fields now show the actual caption displayed to the user. However, if
more than one scan is loaded into Analysis Workbench and they have different captions, only the
caption from the last scan loaded is shown.

The Machines window allows further details of the hardware, software and asset data collected for
a computer to be viewed, by providing a link to the Machine Details window. See page 99 for more
information about the Machines Details window.

Filtering Data in the Machines Window

Filters can be set (using the Filters drop-down toolbar menu or the filter icons) to provide additional
information in relation to the other windows in the workspace as follows:

Filter Shows
Machine Any tagged machines in the Machines window.
Application = Any machines that contain tagged applications.

It shows any machines that have the application installed.

Note: It does not show machines that have a partial installation (in other words,
machines where alicense is not needed).

Directory Any machines that contain tagged directories.
File Any machines that contain tagged files.

Local Any machines with Local tags.

Customizing the Columns Displayed in the Machines Window

To customize the columns displayed in the Machines window:

1. Click on the Columns drop-down toolbar menu. The Select Columns to Display dialog box is
displayed.

= The Available columns list shows all the available categories and fields. Clicking on the +
sign expands the category and shows the fields that are contained in it. A check box is
displayed next to each category and field. A dotted check box next to the category indicates
not all the fields in that category have been selected (that is, only some fields have been
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selected). Clicking on a partially checked category will select all fields in the category.
Clicking again will deselect all fields.

= The Selected columns list shows the fields that have been selected to be displayed as
columns in the Machines window.

= The Show only items in use option will ensure that only hardware items that actually exist in
one of the loaded scan files are shown in this tree.

2. Either drag a category from the left list to the Selected columns list, or select the check box
next to the category and click the >Add button. The functions of the other buttons are as
follows:

= To add all the available columns to the Selected columns list click the >>Add button.
= Toremove an entry from the Selected columns list click the Delete button.

= Todelete all entries in the Selected columns list click the Del All button.

Note: You can move the position of entries in the Selected columns list using the Up and
Down buttons.

3. Click OK after you have selected the columns. You are returned to the main workspace.

Note: Each data item collected is shown only once in the tree, even if multiple values for a
particular item are collected. Examples of this are CPU Speed (where one per CPU is
collected) and Card Class (which is collected for every card for every bus supported).

When a column such as this is chosen to be shown in the Machines window, Analysis
Workbench automatically figures out how many columns are required to show all of the
collected data and appends ‘Indexes’ to each column name.

For example, choosing the CPU Speed column will normally create just one column named
‘CPU Speed (0) (Index start at 0).

Now, if the data loaded includes at least one machine with two CPUs, Analysis Workbench
will create two columns instead, ‘CPU Speed (0) and ‘CPU Speed (1)

The number of columns necessary to show all data for all loaded machines is not recalculated
when new data is loaded or data is unloaded. To have Analysis Workbench refresh this, go into
the Column selection dialog box and click OK.

To enable or disable the display of a single one of these columns. For example to see just
‘CPU Speed (1), each column is available from the drop-down Column menu.

The Machine Details Window

The Machine Details window provides further information for each computer listed in the Machines
window.
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To display the Machine Details window in the Machines window do one of the following:
¢ Select the Detail window link option from the Configure drop-down toolbar menu.

o Select the Configuration option from the Window menu and check the Machine Windows box in
the Detail Window Link group.

The information to be displayed in the Machine Details window can be selected by doing one of the
following:

o Clicking on the Configure button and checking the Machine Windows box in the Detail Window
Link group.

o Selecting the Detail window option from the Configure drop-down toolbar menu and checking the
Machine Windows box in the Detail Window Link group.

Depending on what information was selected in the Window Layout dialog box, the Machines
Details window can show the following information:

o Hardware overview - The information displayed here depends on which option was selected in
the Configuration window.

o The default displays basic details of the hardware configuration scanned from the computer as it
is inventoried. Provides details of the operating system, processor, type of screen, memory,
drives, directories and files as well as the total disk space and free space.

o The Machine window data displays all columns as selected in the Machines window but
vertically rather than horizontally making it easier to read.

o Applications - Displays details of the applications identified on the machine, including the
publisher, applications and version.

o Recognition statistics - Displays the total number of files on the highlighted machine, including a
breakdown of Main files, Associated files, files that need the version checked, unrecognized
files and unprocessed files, both as a figure and as a percentage of the total files.

« The Machines Details — Application information links back to the Applications window, showing
details for that selected application entry. That is, if you click on an application in the Machines
Details window, the corresponding application will be located (and highlighted) in the Application
window.

The Applications Window

The Applications window displays a view of the applications within a population that have been
recognized.

The Applications window allows further details of the application license information collected for a
computer to be viewed, by providing a link to the Applications Details window.

The data displayed in the Applications window cannot be changed or altered in any way. The
Applications window provides the following information:
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Publisher
Application
App Type
Version
Release
OpSys

LangCode

Language

Description

Machines

Installs

Licenses

Files

Licenses
Apps

Licensed
By

Version Id
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Description

The name of the software publisher (for example, Microsoft, IBM).
The name of the software application.

The type of application (for example, Word processor, Spreadsheet).
The version of the software.

The release of the software.

The operating system the application runs on.

The ISO 639 Language — 3166 Country code of the application. This is the ISO
standard used to define languages. The format is as follows: <639 3166> for
example <EN-US> refers to English — USA.

The name of the language of the application.

Any additional relevant information and notes, (for example, that the application is
part of the Microsoft Office97 Suite of programs).

The number of machines on which the application is found. In the Operational
View, this includes machines on which a partial install (that is, one or more non
main files) is found. In the Business View, this column is the same as the Installs
column.

The number of installations of that particular application that have been found
throughout the population (that is, on how many machines the application is
installed). An application is defined as installed when at least one Main file has
been identified on a machine.

The number of licenses required for the application. This is the same as the Installs
column unless a license relation exists, in which case, the Licenses column may
contain a number smaller than the Installs number.

The number of files that are contained in that application (that is, how many files
have been identified as belonging to the application).

The number of other applications that the application is responsible for licensing.
For example, if Internet Explorer licenses NetMeeting on five machines and
RealPlayer on three machines, this column would contain a value of eight.

The number of owning applications (licensees) taking responsibility for licensing
this application. In the previous case, RealPlayer would have a count of three in
this column. If RealPlayer was licensed by some other application on another
machine, the count would be higher.

This column contains the ID uniquely identifying a given version.
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Column Description

Utilization = This shows the number of days that the application was used (as a percentage)
over a period of time. The period is calculated automatically depending on long the
application was used for. As a rough guideline the time periods are as follows:

o Application used for more than 3 months - utilization is calculated over the year.

o Application used for less than 3 months - utilization is calculated over a
quarterly period.

o Application used for less than one month - utilization is calculated monthly

You can drill down to the detail level to see the individual results in the Details
window.

Used on The machine the application was used on.

Filters can be set (using the Filters drop-down toolbar menu) to provide additional information in
relation to the other windows in the workspace as follows:

Filter Shows

Machine Any applications that are contained on tagged machines.
Application | Any tagged applications in the Application window.

Directory Any applications whose main file is contained in tagged directories.
File Any applications that contain tagged main files.

Local Any applications with Local tags.

You can use the locking feature to make sure important columns, such as Tag, Publisher and so on
remain visible while scrolling through detailed columns. For more information, see the section
describing Locking and Unlocking Columns.

Applications Details Window

To display the Applications Details window do one of the following:

o Inthe Applications window, select the Detail window link option from the Configure drop-down
toolbar menu.

o Select the Configuration option from the Window menu and check the Application Windows box
in the Detail Window Link group.

The information that is displayed in the Applications Details window can be selected by doing one
of the following:
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o Clicking the Configure button in the Details window.

o Selecting the Detail window option from the Configure drop-down toolbar menu. This will display
a Window Layout dialog box.

Depending on what information was selected in the Window Layout dialog box, the Applications
Details window can show the following information:

« Installed on machines - The machine(s) that the application is installed on.

o Licensed by - The details of the Application Suite that licenses the highlighted application (if
applicable). For example, Word 97 is licensed by Microsoft Office 97.

o Licenses - The details of any applications that the highlighted application licenses, for example,
Word 97 licenses Microsoft Photo Editor.

o The Applications Details — Installed on machines information links back to the Machines
window, showing details for that selected machine entry. That is, if you click on a machine in the
Applications Details window, the corresponding machine will be located (and highlighted) in the
Machines window.

o The Applications Details — Licensed by or Licenses information links back to the Applications
window and the Machines window, showing details for that selected application and the
machine it is located on.

The Directories Window

The Directories window provides a view of the directory names within a population containing
inventoried files. It displays a list of every unique directory of software files within the population,
and enables you to assess the conformance to standards for software installed across the
computer population. It does not take the drive into account, for example, e:\temp and c:\temp is
one line in this window.

The Directory window is particularly helpful for identifying configuration anomalies prior to, or after
installing new applications or upgrades. Any directory which resides in a different path will be
shown as a separate line item.

The Directories window allows further details of the Directories (including files contained in the
directory and machine name) to be viewed, by providing a link to the Directories Details window.

The Directories window provides the following information:

Column Description

Tag Global tag column
Ltag Local tag column
Name Name of the directory
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Column Description

Count Number of drives and machines a specific directory occurs on within the
population. The details of the Machines and drives the directory occurs on can be
seen in the Directory Detail window.

Main A check mark is shown in this column if the directory contains a Main file of an
application.

Tagged This column shows the number of tagged files contained in the highlighted

Files directory. The list of tagged files is displayed in the Directories Details window.

Tagged This column shows the number of tagged applications whose main link is

Applications = contained in the highlighted directory.

Filters can be set (using the Filters drop-down toolbar menu) to provide additional information in
relation to the other windows in the workspace as follows:

Filter Shows

Machine Any directories that occur on tagged machines.
Application | Any directories that contain tagged applications.
Directory | Any tagged directories in the Directories window.
File Any directories that contain tagged files.

Local Any directories with Local tags.

You can use the locking feature to make sure important columns, such as Tag, Name, Main remain
visible while scrolling through detailed columns. For more information, see the section describing
Locking and Unlocking Columns.

The Directories Details Window

The Directories Details window displays further information for each directory listed in the
Directories window.

To display the Directories Details window do one of the following:

¢ Inthe Directories window, select the Detail window link option from the Configure drop-down
toolbar menu.

o Select the Configuration option from the Window menu and check the Directory Windows box in
the Detail Window Link group.

The information that is displayed in the Directory Details window can be configured by doing one of
the following:
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o Clicking the Configure button in the Details window.

o Selecting the Detail window option from the Configure drop-down toolbar menu. This will display
a Window Layout dialog box.

Depending on what information was selected in the Window Layout dialog box, the Applications
Details window can show the following information:

Files - Displays a list of file names found within the directory, along with the size of the file.

Machines - Displays a list of machines where the directory is found within the population, with
the drive location for the directory.

The Directories Details — Files information links back to the Files window, showing details of a
particular files that resides in the highlighted directory.

The Directories Details — Machines information links back to the Machines window, showing
details of the machine that the directory is on.

The Files Window

The Files window displays information for all the inventoried files in the population. It allows further
details of the file information collected on a PC to be viewed, by providing a link to the File Details
window.

The Files window displays the following:

Column
Tag
LTag

Name

Size
Publisher

Application

Description
Global tag column
Local tag column

A full list of all the files selected for analysis within the population of scan files read
into the Analysis Workbench (known as the inventory files).

The files displayed in red are the Main executable files for an application.

The files displayed in green are the files associated with an application. They
belong to it but are not main files.

The files displayed in blue are unidentified or partially identified files. The files
displayed in purple are partially identified Main or Associated files.

Note: The colors referred to are the default and can be customized. For more
information, see the section describing Customizing the Font and Color.

Size of the file.
Name of the software publisher.

Type of application (for example, Games, Disk creation Utility).
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Version
Release
OpSys

LangCode

Language
Copies

# Sizes

#
Signatures
# Dates

# Attributes

# Types

Status

Description

Signature
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Description

File version number where a file is fully identified.

The release of the software.

Operating system under which the application the file belongs to operates.

The 1ISO 639 Language — 3166 Country code of the application. This is the ISO
standard used to define languages. The format is as follows: <639 3166> for
example <EN-US> refers to English — USA.

Name of the language of the application.
Shows the number of copies of each file within the population.

Number of sizes of a file with the same name that exist in a population of
machines.

Shows the number of signatures found for each file within the population.

Number of different dates for copies of the file within the population.
Number of different attributes for the file copies.

Number of different types found for this file name (for example, afile called
Setup.exe can be a DOS executable file or a Windows executable).

Whether thefile is a:

e Mainfile=1

o Associated file =2

o 3rd Party files =3

e CheckVerfile=4

e Unknownfile=5

¢ Unprocessed file = 6
o Auto-identified =7

e Junk=8

Version description as entered in the SAI. It is a separate field that can contain any

user description or comment.

The file Signature column (a number produced for each file by checking the first
8192 bytes) is usually sufficient to identify afile. If there is more than one
signature, an asterisk ' is also shown in the column to indicate this.
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Column Description
Modified The date the files were last modified.
Accessed | The date the files were last accessed.

Utilization = This shows the number of days that the application was used (as a percentage)
over a period of time. The period is calculated automatically depending on long the
application was used for. As a rough guideline the time periods are as follows:

Application used for more than 3 months - utilization is calculated over the year.

Application used for less than 3 months - utilization is calculated over a quarterly
period.

Application used for less than one month - utilization is calculated monthly.

You can drill down to the detail level to see the individual results in the Details
window.
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Column Description

Attribute The Attribute column along with normal file attributes includes the following:

r - Read-only files. Files marked read-only are protected from modification or
deletion.

h - Hidden files. Windows Explorer does not show hidden files by default unless
you tell it to do so.

s - System files.

u - Utilized file. This flag shows that this file was executed and the application
was used.

v - Volume Label. This contains no data and no more than one may exist ona
disk volume (and only in the root directory).

a - If it has the archive attribute of DOS or windows. The Archive attribute is
used to provide an automatic record of what files have been modified since the
last backup.

¢ - Compressed files. These are compressed files and folders. For example, if it
is a file on a compressed NTFS volume.

x - Ina UNIX system this represents a file with the executable attribute set.

| - Internal file. That is, if it has version data available for it. Version data (as per
Windows Explorer) is displayed for all files having this attribute.

L - Symbolic link in UNIX. Files (and directories) may be located on several
different file systems. To link files that are in different file systems a symbolic
link is made.

s - This is special case for UNIX for SetUid files. In UNIX scans, certain files
have special attributes that mean that they run with root privilege. Such files are
potentially a security risk and the Scanner assigns them the system attribute - s

A - This file has been identified as an archive.
C - This file has been identified inside an archive.
X - This file has been identified as an executable file.

D - This file has been identified as a device driver.

If there are more than one set of attributes, an asterisk **’ is also shown in the
column to indicate this.
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Column Description

File Type Shows the type of file (for example, DOS executable file, Windows executable,
OS/2 DLL file). If there is more than one file type, an asterisk ** is also shown in the
column to indicate this.

Filters can be set (using the Filters drop-down toolbar menu) to provide additional information in
relation to the other windows in the workspace as follows:

Filter Shows

Machine Any directories that occur on tagged machines.
Application | Any directories that contain tagged applications.
Directory  Any tagged directories in the Directories window.
File Any directories that contain tagged files.

Local Any directories with Local tags.

You can use the locking feature to make sure important columns, such as Tag, Name, Main remain
visible while scrolling through detailed columns. For more information, see the section describing
Locking and Unlocking Columns.

Adding Entries to the SAI

The Add to SAI option in the Tags drop-down menu allows you to ‘teach’ Universal Discovery to
recognize files which it previously did not recognize. This enables you to optimize the software
analysis and consolidation capabilities of the Analysis Workbench to recognize unidentified files
and applications. The same data can be used by the Viewer.

For more information, see the section describing Teaching Applications to the User SAI.

The File Details Window

The File Details window provides further information for each file listed in the window.

To display the File Details window do one of the following:

o Inthe Files window, select the Detail window link option from the Configure drop-down toolbar
menu.

o Select the Configuration option from the Window menu and check the File Windows box in the
Detail Window Link group.

The information that is displayed in the File Details window can be configured by:
o Clicking the Configure button in the Details window.

¢ Selecting the Detail window option from the Configure drop-down toolbar menu. This will display
a Window Layout dialog box.
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Depending on what information was selected in the Window Layout dialog box, the Files Details
window can show the following information:

o Asset numbers (Machine) - Shows the Asset number of the Machines that the file resides on.
o Directory names (Directory) - Show the directory that the file resides in.

o File sizes (Size) - Shows the size of each copy of a file within the population.

o File signatures (Signature) - Shows the signatures for each file within the population.

+ File modified date- Shows the date the file was last modified files if available.

o File Utilization - This shows the number of days that the application was used (as a
percentage) over a period of time.

o File accessed date- Shows the date that the file was last accessed.

o File attributes (Attributes) - Displays system attributes for a file. The Attribute column along
with normal file attributes includes the X (executable), | (internal file) and D (device driver)
information. For all files having the Information | attribute, version information (as per Windows
Explorer) is displayed.

o File type (Type) - Shows the type of file (for example, DOS executable file, Windows
executable, OS/2 DLL file).

« Version data - Version information (as per Windows Explorer Properties for afile) is available
for all files having the information | attribute.

o File Version data - Shows any version data that was collected for the file.

¢ The File Details — Machine information window links back to the Machines window by selecting
the machine that a selected file exists on. It also links back to the Directory window by selecting
the directory that the selected file resides in.

Viewing Charts and Statistics

Viewing Charts

Charts provide a graphical representation of selected data. There are a number of standard charts
provided by Analysis Workbench to help visualize various data splits. The standard charts include
the variation in scan age, the Scanner used and the split of recognition levels.

In addition, there are two bar charts which plot the number of recognized and unrecognized files
against the frequency of their occurrences. The frequency is expressed as a percentage to allow for
different numbers of machines loaded.

Charts are available from two sources:
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o By selecting an option from the View menu.

o By right-clicking on a column header and clicking the Chart option. These displays a summary
count of the column contents with a graphical representation of the results. This option is only
available if there is text in that particular column.

Chart Buttons
The following buttons are available in all charts:
Button Function

Save The chart can be saved to three different file formats:

As
¢ Enhanced metdfile: .emf

¢ Windows Metafile: .wmf

e Windows Bitmap: .bmp

Copy This button has a drop-down list menu. The chart can be copied to the clipboard in
following formats:

o Enhanced metafile: .emf
o Windows Metafile: .wmf

e Windows Bitmap: .bmp
Print Displays a print preview of the chart and allows you to set various print settings.

Options | Displays the Chart Options dialog box, where various options and filters can be set for
the chart.

Refresh = Refreshes the chart to show any updated information. The chart can be viewed while
data is being loaded.

OK Click this button to return to the Analysis Workbench workspace.
Chart Options
The following options are available in all charts:
Option Function
Options
3D chart Displays the chart in three dimensional graphical form.
Show Marks Displays percentage labels for each segment in the chart.
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Option Function

Show Legend Displays a key to the chart. This allows you to identify what each of the
segments or bars represent.

Show User- Allows you to enter a title of your choice for the chart. Enter the text in the

defined Title User-defined Chart Title box.

Pie Chart

Circular Displays the statistics as a circular pie chart, otherwise the chart is
displayed as an ellipse.

Use patterns Uses a patterned fill for the segments of the pie chart.

Explode largest The largest segment is offset from the main body of the pie chart for
emphasis.

Other group, % Combines the segments less than the defined percentage into one group
called Other.

Use the arrows to increase or decrease the Other group sections.

Legend Position

Left Positions the legend to the left of the chart
Right Positions the legend to the right of the chart
Top Positions the legend to the top of the chart
Bottom Positions the legend to the bottom of the chart

Data Filter (Filters can be applied to reduce the amount of data reported)

Machines Applies a machines filter to the chart data.
Applications Applies an applications filter to the chart data.
Files Applies afiles filter to the chart data.
Directories Applies a directories filter to the chart data.
Local Applies a local tag filter to the chart data.

Background Color = Allows you to select a background color from the drop-down list.

User-defined Allows you to configure the chart titles as required. This option is only
Chart Title available if the Shown User-defined Title option is checked.
Auto Apply If checked, all changes are applied to the chart as soon as you make them.

Otherwise, they are applied when the OK or Apply button is click.
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Scan File Age Chart

This chart is displayed by selecting the Charts > Scan file Age option from the View main menu.

The Time since data collected, in months chart is displayed which shows the date of the loaded
scan files.

Time since data collected, in months

Il 1 Current
Il 5 1 month
i

12 monthz

Current 12 montha

The X axis shows the age of the scan files (in months). The Y axis shows the number of scan files.

The legend (shown in the left corner) allows you to identify the number of scans that belong in an
age category.

This example shows:

¢ One scan (14.29% of the scan files loaded) is 12 months old.

o Five scans (71.43% of the scan files loaded) are 1 month old.

¢ One scans (14.29%of the scan files loaded) is current (less than 1 month old).

Filters can also be used in the scan file age chart to narrow down and highlight items of particular

interest. These filters are set from the Chart options page (click the Options button to access the
filters).

Example:
To view the age of the scan for selected machines:
1. Tag the machines in the Machines page.

2. Apply a Machines filter to the chart data. The chart will display the age of the selected
scans only.

The legend shows the number of scans that belong in an age category and the color of the bar
that represents it.
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Scan Method Chart

This chart is displayed by selecting the Charts > Scan Method option from the View main menu.

This displays a chart of the Scanners used for collecting data chart. For example:

Scanner used for collecting data

I 7 VWindows (xB6) Scanner
I Z HP-UX (HPP&) Scanner
[ 2 AlX (POVWER) Scannsr
B 1 Linux (x85) Scanner

Windows (x85) Scanner |

HP-UX (HPPA) Scanner |

Linux (x85) Scanner |

| AD (POWER) Scanner

This example shows four segments of a pie chart. It indicates that four types of Scanner have been
used to created the scans loaded in Analysis Workbench.

The legend (shown in the left corner) enables you to identify the type of Scanner, the number of
scans created using that Scanner and the color of the segment that represents it.

This example shows:
e Two scans have been created using a Windows (x86) Scanner.

e Two scans have been created using an HP-UX (HPPA) Scanner.

Two scans have been created using a AIX (POWER) Scanner.
¢ One scan has been created using a Linux (x86) Scanner

Filters can also be used in the Scan method chart to narrow down and highlight items of particular
interest. These filters are set from the Chart options page (click the Options button).

Example:
To view the method used for scanning a machine that contains a particular application:
1. Tag the application in the Applications page.

2. Apply an Applications filter to the chart data. The chart will display the Scanner that was
used to scan the machine containing that application.
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The legend shows the type of Scanner used, the number of scans created using that Scanner
and the color of the segment that represents it.

Recognition Chart

This chart is displayed by selecting the Charts > Recognition option from the View main menu.

This displays the Recognition statistics chart which shows Main, Associated, 3rd Party and
Unknown files.

Recognition statistics

ain
Azzpciated
ard Party
Unknown
 Checkver

This example shows a pie chart with five segments.

The legend (shown in the left corner) enables you to identify the type of files recognized, the number
of files in that category and the segments that represents them.

This example shows:
o 25files (0.69%) have been recognized as Main files.

3,059 files (84.06%) are Associated files.

o 118files (3.24%) are 3rd Party files.

250 files (6.87%) have been recognized as Unknown files.

187 files (5.14%) are CheckVer files.

For more information, see the section describing Display/Storage Filter for descriptions of these file
recognition categories.

Filters can also be used in the Recognition chart to narrow down and highlight items of particular
interest. These filters are set from the Chart options page (click the Options button).
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Example:

To view the recognition statistics for all Main files recognized:

1. Inthe Files window, locate an entry that has Status of 1 Main. This is the status setting for
Main files.

2. Right-click on this entry in the Status column and select the Tag > Status is 1 Main option.
A Global tag is applied to all files in this window that are Main files.

3. Apply aFiles filter to the chart data. The chart will display the Scanner that was used to
scan the machine containing that application.

The legend (shown in the left corner) allows you to identify the type of files recognized, the
number of files in that category and the color of the segments that represents them.

Unrecognized/File Frequency

This chart is displayed by selecting the Charts > Unrecognized/File frequency option from the View
main menu.

This displays a bar chart that can be used to determine the quality of recognition on a population.

Unrecognized files are shown split by the number of copies.

Unrecognised / File frequency

O fa 00

ra g o
MJ == ©f N L 0 0N

ra

Unrecognized

______ N nNEE
10 20 30 40 50 60 70 a0

Fileg occur on % of machines

The X axis shows number of files that occur on a given percentage of machines loaded.

The Y axis shows the number of unrecognized files. It is an absolute count of different,
unrecognized file entries.

The legend (shown in the left corner) enables you to identify the number of unrecognized files.
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Filters can also be used in the Unrecognized/File Frequency chart to narrow down and highlight
items of particular interest. These filters are set from the Chart options page (click the Options
button).

Viewing Charts From Individual Windows

Other charts are available by right-clicking on a column header and clicking the Chart option.

These charts display a summary count of the column contents with a graphical representation of
the results. This option is only available if there is text in that particular column.

To display a chart for a particular column:
1. Right-click on a column header

2. Select the Chart option

Example

To view the version of the Universal Discovery software that was used to create the scans:

1. Inthe Machines window. Click on the Columns button to display the Select columns to
display dialog box.

2. Click on the + sign next to the Scan file category.

3. Select Scan file version. The Scan file version column will now be displayed in the
Machines window.

4. Right-click on the Scan file Version column header and select the Chart option.

A chart is displayed, which shows the versions of the software that was used to create the
scans.

The legend shows the number of scans created by a particular version and the color of the
segment that represents the version.

Viewing Inventory Statistics

The Audit statistics option in the View menu displays the Audit Statistics dialog box.

Audit statistics present summary information about the loading and recognition data as well as
memory consumption. The statistics are:

e Files scanned

o Files loaded

Files recognized

Different files loaded
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Different directories loaded

Machines loaded

o Dynamic memory in use

Operating System memory committed

Note: If one or more scan files have been unloaded, the audit statistics are no longer available
until Analysis Workbench has been closed down and restarted.

Tagging

An important part of the analysis process is the ability to intelligently select subsets of the
population and perform further analysis on this subset only.

Tagging is a process which allows the volume of data being viewed to be narrowed down and
allows items of particular interest (files, directories, applications and machines) to be highlighted.

Analysis Workbench implements several methods for tagging and filtering, all of which are based
on the tagging mechanism.

Every file, machine, application and directory can be ‘tagged’, that is, selected. Visually, this is
indicated by a check box next to each item in the window.

The simplest mechanism is to tag one or more items manually by selecting the tag check box next
to the item (or by hitting the Space bar).

Tag Types

Two different types of tags are available:
¢ Local tags: Impact only the window they are applied in (the local window).

« Global tags: Canimpact other windows. Only global tags can be used to teach entries to the
SAl.

Filters are used in conjunction with these tags to limit the amount of data displayed in a window.

Tagging Data in the Information Windows

Tagging a File
Globally tagging a file has the following effect:

o It causes afile tag to be set for the file itself.

o It causes afile tag to be set for all machines on which it occurs.
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o It causes afile tag to be set for all applications that contain an instance of this file.

o It causes afile tag to be set for all directories in which an instance of this file can be found.

Tagging a Directory
Globally tagging a directory has the following effect:

o It causes a directory tag to be set for the directory itself.
o It causes a directory tag to be set for all files in any instance of the directory.
o It causes a directory tag to be set for all applications in any instance of the directory.

o It causes a directory tag to be set for all machines on which the directory occurs.

Tagging a Machine

Globally Tagging a machine has the following effect:
o It causes a machine tag to be set for the machine itself.

It causes a machine tag to be set for all the files on the machine.

o It causes a machine tag to be set for all the applications on the machine.

o It causes a machine tag to be set for all the directories on the machine.

Tagging an Application

Tagging an application has the following effect:
o It causes an application tag to be set for the application itself.

o It causes an application tag to be set for all directories in which an instance of this application
can be found.

o It causes an application tag to be set for all machines on which the application occurs.

e It causes an application tag to be set for all the files that are contained in that application.

Methods for Applying Tags

Edit Menu

Global and Local tag options are available in the Edit main menu.

Setting a tag from this level will impact all the tag settings, both Local and Global. In addition, any
filters that have been set, can be closed. This is a good start point.

Information Window Toolbar

The information window toolbars are used for setting the tag type (Local or Global) as well as
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window specific options.

Column Header

Options in the column header shortcut menu can be used to tag unique (only one) or duplicate (more
than one) entries. They also have a Contains function used to select items that match a substring
search.

Column Contents

Options in the column shortcut menu tag entries above, below a particular row or matching a
specific row-column combination.

Using SHIFT + right-click in the window area has the effect of inverting the tag selection for the
current row. For example, instead of a right-click in the Version column giving Version is 95, SHIFT
+ right-click gives Version is not 95.

Clearing and Setting Tags for All ltems in All Windows

The Edit menu has options for globally tagging and untagging entries in all information windows.
This can be very useful when you have large volumes of data and you want to ensure that none of
the items in any of the information windows are tagged (even if the windows are not displayed).

To do this:

1. Select Tag All > Both from the Edit menu. This sets both Global and Local tags in all the
information windows (even if they are not displayed).

The status bar now indicates that all files in all windows are tagged. Information similar to the
following will be shown:

Machines 6/6 Applications 31/31 Directories 121/121 Files 1211/1211

2. Select Untag All > Both from the Edit menu. This clears all the Global and Local tags in all the
windows (even if they are not displayed).

The status bar now indicates that all files in all windows are untagged. Information similar to the
following will be shown:

Machines 0/6 Applications 0/31 Directories 0/121 Files 0/1211

All information windows (Files/Directories/Applications/Machines) contain no tagged items.

Tag Lists in the Machines Window

In the Machines window, you can load and store lists of tagged machines.

A .tagfile is a text file containing the asset numbers of the tagged machines. It is saved with a .tag
extension.

This can be very useful for saving time in situations where you have carried out complicated tagging
procedures and have reached a subset of machines that are of particular interest.

Rather than having to redo the complicated tagging procedures when you reload the data or you re-
inventory your population, you can load a machines tag list and those particular machines will
automatically be tagged.
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Any machines that no longer exists will be ignored in the tag list file.

To save a current machine tagging list
1. InaMachines window tag the required machines.
2. Select the Save Tags List from the Tag drop-down toolbar menu.
The asset numbers of the currently tagged Machines are saved in a .tag file.
Toload a tag file:
1. Select the Load Tags List from the Tag drop-down toolbar menu.
2. Navigate to the .tagfile, select it and click Open.

The file will be loaded and matching machines will be tagged.

Filtering

You can use filters to narrow down and highlight items of particular interest.

Each of the main windows in the Analysis Workbench can have one or more filters applied to them.
Each window can have one or more filters applied to them. Filters are used for the following
purposes:

To limit the number of items that are displayed in a window.

To view the impact of a selection in another window. This is done in conjunction with Global tags.
For example, if a file has been tagged with a Global tag in the Files window, then to see which
directory it is located in, you can apply a File filter to the Directory window.

To narrow down and highlight items of particular interest in charts and exports.

Setting a Filter for a Window

Select the filter to be applied to the window from the Filters toolbar drop-down menu, or select one
of the icons on the window toolbar to apply the following:

o Files filter

o Directories filter
o Application filter
¢ Machines filter
o Local Tags filter

When afilter is active in a window, visually this is indicated as by a check mark in the Filters toolbar
menu and on the icon. The exception to this is the Local Tags filter icon, which is highlighted in
yellow.
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To deactivate a filter either click on the icon again or deselect the filter from the Filters toolbar drop-
down menu. The appropriate check marks are cleared.

Machines Window Filter

The following filters can be applied from within the Machines window:

Machine Select - Displays any tagged machines in the Machines window.

o Application Select - Displays any machines that contain tagged applications. It shows any
machines that have the application installed.

It does not show machines that have a partial installation (in other words, machines where a
license is not needed).

« Directory Select - Displays any machines that contain tagged directories.
o File Select - Displays any machines that contain tagged files.

¢ Local Select - Displays only those entries in the Machines window that have Local tags
enabled.

Applications Window Filter

The following filters can be applied from within the Applications window:

« Machine Select - Displays any applications that are contained on tagged machines.
o Application Select - Displays any tagged applications in the Applications window.
« Directory Select - Displays any applications that occur in tagged directories.

« Main File Select - Displays any applications that contain tagged main files.

o Local Select- Displays only those entries that have Local tags enabled in the Applications
window.

Files Window Filter

The following filters can be applied from within the Files window:

« Machine Select - Displays any files that are contained on tagged machines.

Application Select - Displays any files that are contained in tagged applications.

Directory Select - Displays any files contained in tagged directories.
o File Select - Displays any tagged files in the Files window.
o Local Select - Displays only those entries that have Local tags enabled in the Files window.

Directories Window Filter

The following filters can be applied from within the Directories window:
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Machine Select - Displays any directories that occur on tagged machines.
Application Select - Displays any directories that contain tagged applications.
Directory Select - Displays any tagged directories in the active window.

File Select - Displays any directories that contain tagged files.

Local Select - Displays only those entries that have Local tags enabled in the active window.

Clearing Every Filter in All Windows

The Edit menu has a Clear all filters option for globally clearing the filters for all information
windows. This can be very useful when you do not have all the windows displayed in the
workspace, and you want to ensure that none of the items in any of the information windows are
filtered (even if the windows are not displayed).

Tagging and Filtering Examples
The Effects of Global Tags, Local Tags and Filters
Preliminary Settings

1. Equalize all the windows (files, Directories, Machines and Applications, by selecting the
Equalize command from the Window menu.

2. Ineach of the windows, select the LTag column from the Columns toolbar menu. This ensures
that the local tag column is displayed in each window.

3. From the Edit menu select the Untag All|Both option. This will clears any existing tags (both
global and Local) in each window.

4. Select the Clear all filters option from the Edit menu. This ensures that no filters have been
applied to any of the windows.

Tag Selection
e Part1

This part of the example shows the effect of applying a filter to reduce the display information.

a. Inthe Files window, select the Use Local Tags from the Tag toolbar menu.
b. Apply aLocal tag to afile which has a Status of 1 Main.

Note the number of files in the top left comer of the Files window in square brackets [ ].

c. Apply alocal filterin the Files window, either by clicking the icon or by selecting the Local
select option from the Filters toolbar menu.

The result is that the number of files displayed is reduced to a single entry (that is, the one file that
you tagged).
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o Part2

This part of the example shows that Local tags do not affect the other windows.

Apply a File filter to the other windows, either by clicking the icon or by selecting the File Select
option from the Filters toolbar menu in each window. All windows now become empty.

In the Applications window, this option is actually Main File Select.
o Part3

This part of the example shows that removing a filter will restore the window to it’s previous state.
Remove the File filter in the Files window only.

The selected file reappears in the Files window.
e Part4

This part of the example demonstrates how a Global tag affects the other windows.

a. Inthe Files window, set the Use Global Tags option in the Tags toolbar menu.

b. Now set a Global tag on the file. The Directories, Machines and Applications windows all now
display entries:

o Directories window displays the directories containing the file.
o Machines window displays the machines containing the file.
o Applications window displays the applications which contain the Main file.

o If the Local tag is removed from the Files window, while the Local filter is still active, the file
disappears. The Local filter has to be removed for the file to be redisplayed. The other
windows remain unaffected.

Common Tasks using Filtering and Tagging

How Do | Get a List of All Files Not Known by the Application Library?

Make sure that a Files window is visible (use Window > Create > Files if not).
1. Using the Columns drop-down menu of the Files window, show the Status column.

2. Sort on the Status column by left clicking on it, or by right-clicking on the column header and
selecting one of the sort options available.

3. Scroll down until an entry showing 5 Unknown is visible. Alteratively, type 5 on the keyboard
to select the first entry of this type.
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If you cannot locate a 5 Unknown file, it could be that your display filter options have been set up to
not display unknown files. See Configuring Display Filter Settings on page 77 for more information
about how to include Unknown files.

1. Right-click on a 5 Unknown entry, and select the menu item Status is 5 Unknown > Tag.
2. Apply aFile filter on the Files window.

Alternatively:
1. Using the Columns drop-down menu of the Files window, show the Status column.

2. Right-click on the column header of the Status column, and select the Tag|Contains menu
item.

3. Enter 5inthe Search string box, select Anywhere in the String Position group box and select
Tag in the Action group box.

4. Click OK.

5. Apply aFile filter on the Files window.

How Do | Get a List of Machines Containing Unknown Files?

Assuming that the tags from the previous question are still in place, apply a File filter to a Machine
window.

All machines now shown contain one or more tagged files, all of which are unknown.

How Do | Get a List of All Machines That Do Not Conform to the Company
Standard Desktop?

This answer assumes a scan of a standard desktop is available.
1. Inthe Machines window, tag the standard machine.
2. Apply a Machine filter to an Application window.
3. Tag all the applications shown. Now, all standard applications are tagged.
4. Remove the Machine filter from the Applications window.
5. Toggle all tags in the Applications window. Now all non-standard applications are tagged.

6. Apply an Application filter in the Machines window. All machines containing any non-standard
applications are shown.

How Can | See Which Machines Contain the Most Non Standard
Applications?

Assuming no tags have been changed from the previous question
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1. Using the Columns drop-down menu of the Machines window, show the Tagged Apps column.

2. Sort descending on this column, either by left clicking on the Tagged Apps column header or by
right-clicking and selecting Sort Descending.

The machines at the top of the list now are the ones containing the most non-standard applications.

How Can | See What Files Appear in a Certain Directory?

Make sure that a Directory window is visible (use Window > Create > Directory if not)
1. Tag the directory or directories of interest.
2. Apply a Directory filter to a Files window.

If you cannot see any directories, it could be that your memory options have been set up to not
display directory data. See Configuring Memory Settings for more information about how to include
directory data.

How Can | See in How Many Different Directories a File Occurs?

When no filters are applied to the Files window, the Copies column displays the total number of
occurrences of each file entry. This includes multiple copies on the same machine in different
directories.

When a Directory filter or Machine filter is applied to a Files window, the Copies value will always
be 1. If two directories are tagged, the count will be 1 for those files that occur in only one of the
directories, and 2 for those files that occur in both.

The same logic applies for tagged machines when a Machine filter is applied to a Files window.

How Can | Verify That The Data in an Asset Field is Unique Across the
Population?

This question is important for asset or hardware fields that contain information unique to a single
computer, such as MAC addresses, and Asset numbers.

1. Show the column of interest in a Machines window.
2. Use the Tag menu item of the shortcut menu of the column header, and select Duplicates.

3. Apply a Machine filter to the Machines window. Any items shown are not unique across the
population.

How Can | See Which Machines Contain Microsoft Applications?

Make sure an Applications and a Machine window are visible.

1. Inthe Applications window, right-click on Microsoft in the Publishers column, and select the
Publisher is Microsoft > Tag menu item.

2. Alternatively, use the Tags > Contains menu item from the Publishers column header shortcut
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3.

menu and use Microsoft as the search string.

In the Machines window, apply an Application filter.

How Can | See Which Machines Have Less Than 32MB of Memory?

Make sure a Machine window is visible.

1.

5.

OR

In the Machines window, click the Columns button. In the Select columns to display dialog
box, expand the Memory category in the Available columns list, and check the Total Memory
(Mb) item.

Sort by the Total Memory (Mb) column in ascending order.

Type 32 which moves focus to the first item with 32Mb or memory or more. Press the Up arrow
to select the previous item in the list.

Right-click the highlighted item, and select Tag -> Rows Above.

Apply a Machine filter to the window. All machines visible have less than 32 Mb of memory

Make sure a Machine window is visible.

1.

2.

3.

4.

From the Tag menu, select Query

From the Query form shown, expand the Memory item and double-click the Total memory
(Mb) item.

From the drop-down list of choices, select is less than. Type 32 in the entry field.

Click OK to execute the query.

How Can | See Which of the Machines with Less Than 32MB of Memory
Contain Microsoft Applications?

1.

2.

3.

Follow the steps in the previous question to tag machines and applications and applying filters.
Show the LTags column in the Machines window by it from the Columns toolbar menu.

From the Tag toolbar menu of the Machines window, select Use Local Tags Once.

This instructs Analysis Workbench to use Local Tags for the next tag operation.

4. Again using the Tag toolbar menu of the Machines window, select Tag All.

This will give all items currently visible, a Local tag.

5. Remove all filters from the Machines window. All machines are now shown.
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6. Using the Tag toolbar menu, select Untag All.

This will remove all of the Global machine tags set previously — but the information needed is
stored in the Local tags so this is fine.

7. Apply a Local filter to the Machines window (or available from the Filters drop-down menu). The
same machine selection as before step 1 is now visible.

8. Tagall visible machines (Use the Tag menu, for example).
9. Apply a Machine filter to the Applications window.

The applications now visible occur on machines with less than 32Mb of memory that contain at
least one Microsoft application.

Is There Any Way of Just Navigating the Data, Without Setting Any Tags?
1. Inall windows, enable the Link to Details options in the Configure drop-down menu.
2. Inthe Details window now shown in the right side of the screen, click the little ¢ (Configure).

Make sure all four check boxes in the Detail window Links group are selected. Optionally, set
the other controls to specify which details are shown for each window.

3. Click OK.

Now, whenever an item is clicked in one of the main windows, details for that item are displayed in
the Details window. Because the Detail window Links are selected, clicking on items in the Details
window moves the focused line in the main windows when items are clicked here.

For example, click on afile. A list of machines and directories where the files occur, along with
various details of each occurrence of the file, is shown in the Details window. Click on one of these
occurrences, and focus in all Machines windows is moved to the machine for this occurrence; the
same happens for the directory in which it occurs. This logic extends to Machines, Directories and
Applications as well.

How Can | Get a List of Files Occurring in the Same Directory as One or
More Files | Have Tagged?

This is typically the first step of application recognition —an unknown file is tagged, and all files in
the same directory should be added to the library at the same time.

1. Apply a File filter to a Directories window. Now, all directories with tagged files in them are
shown.

2. Tag the directory or directories that are of interest.

3. Apply a Directory filter to a File window. This now shows all files occurring in the tagged
directories.
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How Do | Get a Complete List of Machines with Full or Partial Installations
of a Set of Applications?

1. Clear all file tags in all windows.

2. Inthe Applications window, tag the applications in question.
3. Apply an Application filter to the Files window.

4. Tag all the visible files.

5. Apply aFile filter to the Machine window.

Machine Queries

Machine queries target and tag machines based on criteria such as asset data, hardware or
configuration information.

You can perform a query to focus on any combination of hardware, and asset information collected
for a computer population during an inventory.

As a result of any query, a number of machines, applications, files or directories can receive a
number of tags.

Queries to identify particular machines using specified criteria are defined using a special query
grid. This allows multiple query criteria to be specified from a section of categories, which are
defined by the information collected across the computer population.

When the query criteria are fully specified, the query is invoked and all machines within the
population that match the query criteria are tagged. The query grid also allows defined queries to be
saved so that they can be loaded and used again.

How to Perform a Machine Query

Machine queries are available from the Machines information window.

To begin creating a query, you need to display the query grid used to specify the search criteria.
In the Machines window select the Query option from the Tag drop-down toolbar menu.

The Complex Query dialog box is displayed.

Complex Query Dialog Box

This dialog box has two tabs:

o Queries - Displays the hardware and asset fields and allows you to build up the query.

o Options - Sets up the logic, actions and format of the query.

Differences Between Scan File Queries and Machine Queries

The method of performing a machine query is almost identical to that for selecting scan files for
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specific machines (complex query). There is however, one difference to note:

An extra option is made available for Machine queries. This is on the Options tab page and is the
Tagging group box.

o Affect local tags - Only Local tags are set or cleared.

Teaching an Unidentified Application

While teaching files to your User SAl it is convenient to use SAl Teaching Mode. This provides you
with the possibility of setting Publisher/Application/Version information and file status for the files
that are about to be added to the User SAIl before opening the User SAl window. See Using SAl
Teaching Mode for further information about how to use it.

Step 1: Tag Files Belonging to the Unidentified Application

1.

Open Analysis Workbench and select the Application Teaching mode from the Quick Config
dialog box.

Load the scan file with the application in question.

If you already know the main directory where the unidentified application resides, tag a
directory and skip the next three steps.

Sort files by the Status column, so that <Unknowns> and <Checkvers> are near the beginning
of the list.

Looking through the list of Unknown files try to find files that belong to the unidentified
application that needs to be taught.

Sometimes you can search for clues in the Version Data columns in the Details windows on the
left side and in the Directory Window. In many cases the directory name can be very
descriptive.

If you have now identified the directory, set a Global tag for the directory.

Set a directory filter in the Files window. You will now see only the files belonging to that
specific directory.

Check whether all the files in the Files Windows belong to the application. Set Global tags for
these files.

Step 2: Specify the Application Details

1.

In the Tag menu of the File window select Add to SAI. The New Publisher/Application/Version
Setup dialog box is displayed.
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2. Now choose the appropriate Publisher, Application, Release, Version, Operating system and
language details.

3. Select a publisher from the Publisher drop-down list, or specify a new one by clicking the New
button next to the field. This will display a New Publisher dialog box.

4. Fillin the Publisher Name (the Description field is optional) and click the OK button.
The new application publisher will now appear in the Publisher drop-down list.

5. Afterapublisher has been selected or a new one created, the Application field becomes
enabled. Select an application from the Application drop-down list box or specify a new one by
clicking the New button next to the field. This will display the New Application dialog box.

6. Fillinthe Application name (the Description field is optional) and click the OK button.
The new application now appears in the Application drop-down list.

7. If you have created a new publisher or application, the Application Type field becomes enabled
(otherwise the field automatically preselects a type for the application). From the Application
Type drop-down list box, select a predefined type for the application.

8. Select a Release from the Release Label drop-down list, or specify a new one by clicking the
New button next to the field. This will display a New Release dialog box.

9. Fillinthe Release Name and click the OK button.

When a publisher releases updates for an existing version of one of their products, they typically
don't change the name of that version. Any particular version of a product could have several
updates to it. In this scenario, the umbrella version is referred to as the Release Label, or simply as
Release. It is not necessary that every version of software has a release label. In fact, most of
them do not. Every version without a release label is associated to a virtual Stand-alone Releases
label.

10. Select a software version identifier from the Version Identifier drop-down list box, or specify a
new one by clicking the New button next to the field. The New Version dialog box is displayed.

11. Fill in the Version Name field.

12. Inthe Description field, type in a brief description of the application selected for the existing
Version. This field is optional.

13. Select the checkbox next to the install strings that apply. Install strings are added to the list in
Control Panel > Add/Remove programs (prior to Windows Vista) or Control Panel >
Programs and Features (Windows Vista and above) when a program gets installed. The
list of install strings is taken from the scan data loaded into Analysis Workbench. The install
string match will be done during software application recognition if all of the selected install
strings are available in the scan file.
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14.

Click the OK button. The new version data now appears in the Version Identifier, Version
Install Strings, and Version Description fields.

A version is defined by its name, application, language and operating system. So, for one
application, it is possible to have many different versions with the same name, provided that they
have different combinations of Operating System and Language.

15.

16.

Select the operating system that the application works under, from the Version OS drop-down
list.

Select the language of the application, from the Version Language drop-down list.

Step 3: Specify Files to be Included

1.

2.

Click on the Files tab.

Select (check) the files that are to be included. When afile is selected, the bottom pane
displays the Machines and Directories that the file is located on.

If you want to disregard the file size when the file is taught click Ignore file size. The Size and
Signature fields become disabled. Otherwise:

Specify the size of the selected file if needed. Enter the value in the Size field.
Specify file Signature by typing directly into the Signature field.

Specify the type of executable file by selecting a predefined type from the Exe Type drop-down
list box.

Go through the list of files and check file characteristics. Make sure that the correct files are
labelled as ‘Main’.

Double check files that are given status ‘Main’ by default; they might be carrying this status
from previously taught applications.

You can change the status of the files (if required) by selecting the file and then selecting one of
the option buttons in the Relation to Application group:

= Main - This is a key application file, that is, it is a file without which the application could not
be running. It should always be present whenever the application is installed regardless of
whether it is a minimum or complete installation.

= Associated - This is a non-key file that is part of the application and is written by the
publisher that developed the product.

» 3rd party - This is a file written by another Publisher (3rd Party) and is used in the current
application. An example of a 3rd party files is some DLL files that are technically used by the
application, but are also distributed freely and can be used by other applications.
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The VerDLL field shows a concatenation of a set group of version data fields. Do not change the
entry in this field unless absolutely necessary.

The drop-down lists are produced from a combination of data in both Master.zsai and User.zsai.
Before an entry is committed to the User.zsai a number of options are available. These can either
be set up under options and selected as default, or the default setting can be left off and you will be
prompted each time to select the information. See Step 5: Set Teaching Options.

Step 4: Select the User SAIl File and Commit the Changes
1. Click onthe SAI Selection tab.

This tab page shows a list of User SAl files available for teaching applications to. A file can be
either or both of the following:

» Selected - Any changes made to the SAl are saved to the Selected file only - not the Default
file.

» Default - The Default file is automatically selected when the dialog box is next opened. You
can set afile to be Default and specify another one to be Selected.

2. Tochange the automatically selected SAI file, select another one from the list and click the
Select button. The status in the Selected column is shown as Yes.

3. Tochange the default SAIl to use, select the SAI file and click the Set Default button. The
status is shown as Yes in the Default column.

4. Confirm your choices by clicking OK. You are prompted to set SAl teaching options. See Step
5: Set Teaching Options.

When you have done this, the information in the Software Application Index file is updated. You can
view the newly added application by using the SAI Editor. See the SAl Editor Chapter for more
information on how to do this.

Step 5: Set Teaching Options

1. Select the Options button in the New Publisher/Application/Version Setup dialog box. The SAl
Teaching Options dialog box is displayed.

2. Set the options as follows:
¢ Recognition
= Directory Level: teaching a single file will cause all files in all directory/ machine

combinations where the file occurs to be re-recognized

= Use Level 3 heuristics: teaching a single file will reprocess all files on all machines on which
the file occurs

= No recognition: No re-recognition will be performed. The recognition status of the added
files will not be changed.
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In most cases, the Directory Level setting is appropriate as it is the best compromise between the
accuracy of recognition results and the speed of re-recognition.

The No Recognition setting should only be used in special cases when working with a very large
number of scan files at the same time. In these cases the re-recognition time may be very high
even if the Directory Level setting is used.

To initiate up to date recognition of all files and applications when using the No Recognition setting
(and to see the effect of the application teaching) is to reload all scan files.

This setting should be set to the same as when the scans were loaded. If the scans are loaded
with Level 3 heuristics enabled and re-recognition after teaching is done without it, recognition
results can change significantly.

e Save changes to SAI
= When AW exits: Any changes to the SAI are saved when you exit from the Analysis
Workbench application.
= Immediately: Any changes to the SAIl are saved immediately.

e Tagchanged items

Selecting this option enables the following further options:
» Files - Any files that are affected by the SAIl teaching are tagged.

= Applications - Any applications that are affected by the SAl teaching are tagged.

= Directories - Any directories that are affected by the SAIl teaching are tagged.

= Machines - Any machines that are affected by the SAI teaching are tagged.

n Set Local Tags - If this option button is selected, then Local Tags are used for the operations.

= Set Global Tags - If this option button is selected, then Global Tags are used for the
operations.

o Set options as default

Select this check box to retain these settings as the default.

Using the SAI Editor Overview

The SAI Editor presents a view of the SAl files (Master and User) that have been used for
recognition in Analysis Workbench.

This tool is available either as a standalone tool or from the Analysis Workbench User Interface.
o To start the SAI Editor from the Analysis Workbench User Interface:

Select the View/Edit SAls option from the Recognition menu.

e To Start the SAI Editor as a standalone tool:
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From the Windows Start menu select Programs > HP UCMDB > Inventory Tools > SAl Editor
Further Information

For more information, see the section describing the SAI Editor.

Using SAl Teaching Mode

Al Teaching Mode provides a scratch pad for information to be fed into the User.zsai. Entries are
taken from existing values and stored temporarily. These values can then be inserted automatically
when teaching entries to the SAI. This greatly simplifies the procedure outlined in the previous
section Teaching an Unidentified Application.

To use SAl teaching mode
1. Tagthefiles to be taught to the SAl with Global Tags.

2. Select SAl Teaching mode from the Recognition menu. A non-modal window is displayed —
this is the SAI Teaching Holding Area.

3. Now, in the main area of the Files window, right-click on a file that has been identified.

4. The shortcut menu now contains an enabled Publisher menu item, with likely choices listed as
submenu items.

5. Select the correct publisher. The SAI Teaching Holding Area is updated to display the selected
publisher.

6. Again, right-click on a file; the Application menu item is now enabled, and can be used to select
the application name.

7. Select the correct application. The SAl Teaching Holding Area is updated to display the
selected application.

8. Right-click on afile; the Release menu item is now enabled and can be used to select an
application release.

The SAI Teaching Holding Area is updated to display the selected release.

Finally, the Version menu item becomes available and can be used to select the version identifier.

9. Select the correct version. The SAI Teaching Holding Area is updated to display the selected
version.

There is no requirement to select Publisher, Application, Release or Version if the data presented is
incorrect or not applicable.

As each of the Publisher/Application/Release/Version fields of the Holding Area are populated in
this manner, the data becomes editable to facilitate major or minor changes to the data displayed.

10. Inthe Files window, locate the file(s) to be added as identifying, licensable files of the
application.
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11. For each of these files, right-click and select the Main menu item. Each of the file names
selected appear in the Main files column of the holding area.

12. Locate those files, if any, that are shipped with the application but are 3rd party files (such as
vbrun*.dll).

Vbrun200.dIl and Vbrun300.dll will have 3rd party status only for non-Microsoft applications. For
all Microsoft applications they will be considered associated files. Mark these as 3rd party files
using the 3rd Party Files shortcut menu item. The holding area is updated accordingly.

13. Select the Add to SAI option from the Tag menu of a Files window. The New
Publisher/Application/Version Setup window is displayed.

The Publisher, Application and Version fields are now pre-filled with data from the holding area. If an
item does not already exist in the SAl, it is added automatically by this process. The File Type for
each file is automatically updated based on the file names in the Main Files and 3rd Party Files lists
of the Holding Area.
Teaching a Directory with Main, Associated and 3rd Party Files

1. Select the Main file and any 3rd party files and store in the Holding area.

2. Tag the multiple Associated files using tagging from a Directory window for example.

3. Open the New Publisher/Application/Version Setup dialog box from the Tag menu of a Files
window.

The tagged files and the files in the Holding area are displayed with the Publisher, Application and
Version from the Holding Area already entered.

Populating the SAl Teaching Mode Automatically

In a Files window, right-click on a file that has been identified.
The shortcut menu now contains an enabled Automatic menu item.

Selecting this item is equivalent to:

« Right-clicking, selecting Publisher and choosing the first menu item.
¢ Right-clicking, selecting Application and choosing the first menu item.
« Right-clicking, selecting Version and choosing the first menu item.

¢ Right-clicking and selecting the Main file.

Teaching Applications to the User SAl

A User.zsai file is an editable Software Application Index (SAI) that can be updated using Analysis
Workbench. You can use the Analysis Workbench to ‘teach’ the library how to recognize files which
it previously did not recognize.
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The teaching of applications to your User.zsai file is usually done with scan files that have many
installed applications included in them.

Note: If the information from many machines has been loaded, it can take a significant time to
re-recognize all of the affected files after new entries have been taught to the SAI. Itis
therefore recommended that no more than 50 scans be loaded when teaching the SAI.

Creating a New User SAI
1. Start Analysis Workbench. Do not load any data.

2. Select Load Options from the File menu. The Analysis Workbench Load Configuration dialog
box is displayed.

3. Click onthe Recognition tab.

4. Select the Software Application Index (SAl) option and click the Advanced button. The
Advanced configuration - Software Application Index dialog box is displayed.

5. Select the SAls tab.

6. Click the Create button. The Create a User SAI dialog box is displayed.
7. Enter or navigate to the directory where the SAl file is to be created.

8. Enter a description for the file.

9. Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAl with the
same filename. If so, a confirmation message is displayed.

Click Yes if you want to overwrite the existing SAl file or click No to return to the dialog box and
assign a new ID to the SAl file.

If you have made modifications to the cfgNextSAIID setting in the Analysis Workbench ini file, you
may see the following message.

The next User SAI ID cannot be found in the settings file.

This happens when the value for the ID in the ini file is missing or lower than the highest ID in the
user SAls currently loaded. This message is for information only - the Universal Discovery
components will correct this situation automatically by inserting the correct ID value into the ini file.

This probably means that you are using User SAls created with a different version of the software,
or created on a different machine.

Tip: Please take care to set the new ID to a value that is unique across your organization.

The New Publisher/Application/Version Setup Dialog Box

This dialog box allows you to teach entries to the User SAl file.
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To display the New Publisher/Application/Version Setup dialog box:

1. Inan Analysis Workbench Files window select the Add to SAI option from the Tag drop-down
toolbar menu.

This option is only enabled if the following conditions have been fulfilled:

= A User editable SAl file is being used
= SAl recognition is enabled
» Files have been tagged (with Global tags).

2. The New Publisher/Application/Version Setup dialog box is displayed.

Tip: The best way to introduce all the various fields and functions in this dialog box is to go
through the steps for teaching files.

License Relations and Application Suites

Each identified file is categorized as either Main, Associated, or 3rd Party. The recognition library
can contain any number of files in a particular version as belonging to either category.

When at least one Main file is identified on a machine, a license is required for the application,
unless another application on the machine assumes license responsibility for the application.

License relations are part of the Application Library. When two interdependent applications are
identified on a machine, one application can assume license ownership on that particular machine.
The chain of license relations can be any number of levels deep.

License relations solve the problem of Suite licensing simply and effectively, and are applicable to
license relationships outside what would normally be considered a software suite.

For example, MS Office 2000 licenses MS Access, Word, Excel, PowerPoint, Outlook and is a well
known software suite. In addition Outlook 2000 licenses MS Data Access Components (ADO) 2.1
sp1 - if Outlook or another licensing application is not present on the machine, a license is required
for the software, but if Outlook is installed on the machine, Outlook assumes license ownership.
Different versions of Outlook license different versions of MS Data Access Components.

License relations are also useful when an application has a complex component structure. If
application components can be installed on their own, they should be treated as independent
applications, but the connection with the application should be reflected in license relations for that
application.

The SAI Editor allows license relationships to be established and immediately be applied to the
application data loaded. This application is available via the Analysis Workbench User Interface or
as a stand-alone utility from the Start menu.

Adding License Relations

License relations allow a particular version of an application to contain licenses for one or more
versions of other applications.
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A single version of an application can assume responsibility for any number of other application
versions, and this can be extended to any number of levels of nesting.

The new relations are stored in a user editable SAI and are used the next time the data is loaded.

Each version entry has two lists that can be filled separately:
« Owning Release - The application that contains versions of other applications.
o Licensed Release - The applications that are contained in the Owning Application.

License relations are set up using the SAIl Editor. This tool is available either as a standalone tool or
from the Analysis Workbench User Interface.

For further information, see the section describing the SAI Editor.

Displaying Licensed by and Licenses Entries in Analysis Workbench

In an Applications window, it is possible to have the Detail window selected with Licensed By and
Licenses windows displayed. When an application is selected, the Licenses Apps and Licensed by
columns display the count of files and the details window will report the machines on which the files
occur

To display the Application window Details pane:

1. Inan Applications window, select the Detail window link option from the Configure drop-down
toolbar menu, or

2. Select the Configuration option from the Window menu and check the Application Windows
box in the Detail Window Link group.

3. Theinformation that is displayed in the Applications Details window can be selected by:
a. Clicking the configure icon in the Details window

b. Selecting the Detail window option from the Configure drop-down toolbar menu. This will
display a Window Layout dialog box.

4. Select the following options:

o Licensed by. The details of the Application Suite that licenses the highlighted application (if
applicable). For example, Word 2007 is licensed by Microsoft Office 2007.

o Licenses. The details of any applications that the highlighted application licenses, for example,
Office 2007 licenses Microsoft Photo Editor.

The Applications Details — Licensed by or Licenses information links back to the Applications
window and the Machines window, showing details for that selected application and the machine
it is located on.
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Recognition Objectives

Recognition Objectives are designed to ensure that the following can be achieved with the least
amount of effort:

« No machine has alarge percentage of unrecognized files on it.
o Files that occur often in the population are recognized.
o Files that occur only on a few machines may not be recognized.

Based on this principle, Recognition Objectives help you set achievable goals for the recognition
process, measure how far you are from those goals, and provide assistance in achieving them.

The objectives engine allows you to define as many objectives as you need. By default, only a
single objective for the entire Enterprise is defined, although this can be extended by setting up
objectives that apply to subsets of the population as well.

To set Recognition Objectives options:

Click the Objectives Options item in the Recognition menu.
A dialog box is displayed with the Startup tab page showing.
The Startup Tab

You can specify the following:
¢ File containing default Objectives

To load a default set of objectives when Analysis Workbench starts, type in the name of the file
containing the objectives here.

By default, Analysis Workbench uses the file objectives.xml.
o Startup Options

To automatically show the Objective Summary dialog box when new scan data has been loaded,
check the option to do so.

You can set up when automatic recalculation of objective compliance should take place. When
many scan files are loaded, this may take significant time to do and you may wish to disable some
of the automatic calculation options on this page. Objectives can be manually recalculated from
the Recognition Objectives dialog box.

The Logging Tab

You can specify which log files to use to log teaching activity, if any.

The two log files that can be created are both CSV (Comma-separated variable) files that can be
imported into other tools for further analysis.
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The Ignored Files Tab

This page can contain a list of file names that are to be ignored when calculating objective
compliance.

This may be useful if a set of files are known to be of no interest.

Type the file names into the list pane and they will not count when the Applied objectives are
evaluated.

Adding Tagged Files
You can also add files that have been tagged in a Files window in the Analysis Workbench

workspace.

Note: You will have to close this dialog box first if you forgot to tag the files.

1. InaFiles window, tag the files you want to add to the Ignored Files list.
2. Click the Add tagged files button. The files are added to the list.

3. Toclear the contents of the list, click the Clear button.

The Excluded Directories Tab

This page can contain a list of directories that are to be ignored when calculating objective
compliance.

Directories with names in this list are ignored when using the SAl Teaching Wizard. The list will
include directories that commonly contain files from multiple applications.

The SAI Teaching Wizard can only help teach applications installed in their own directories.

Exampile of directories you may want to include in this list are:
e C:\tmp

C:\Windows

C:AWINNT\system32
e /usr/bin

Type the directory name and path into the list pane and files that occur only in the listed directories
will not be chosen for teaching in the SAI Teaching Wizard. Files in these directories are not
excluded when evaluating objectives.

Adding Tagged Directories

You can also add directories that have been tagged in a Directories window in the Analysis
Workbench workspace.

Note: You will have to close this dialog box first if you forgot to tag the directories.
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In a Directories window, tag the directories you want to add to the Ignored Excluded
Directories list.

Click the Add tagged dirs button. The directories are added to the list.

To clear the contents of the list, click the Clear button.

Define and Review Objectives

Starting the Define and Review Objectives Dialog Box

Select Objectives from the Recognition menu. The Define and review Objectives dialog box is
displayed with the Summary tab showing.

This dialog box is non-modal. This means you can have it displayed while working in the Analysis
Workbench workspace. Position the two dialog boxes on your screen so that you can work with
both dialog boxes at the same time.

If the dialog box becomes hidden behind the main Analysis Workbench windows, it can be
accessed through the Windows menu.

The Define and Review Objectives Dialog Box Properties Tab Page

Click on the Properties tab.

The top left pane shows the Applied Objectives. These are used to measure progress and assist
in the teaching progress. In the previous screen image, four such objectives are defined.

The top Applied Objective, Entire Enterprise, always applies to all machines loaded and is the
only Objective that is defined by default. The next objective groups the loaded machines by Host
OS Category. This allows you to specify different objectives for your Windows machines, UNIX
machines and all other operating systems.

The Default Objective (Entire Enterprise) specifies a Machine criteria of 80% and the File criteria
uses the Standard graph. These can be changed as required.

The bottom left pane shows the Unused Objective. These fields are available for selection. Click
on an entry in this list and a list of Objective group fields for the Objective is shown on the right.

Adding an Applied Objective

1.

2.

In the Define and review Objectives dialog box select the Unused Objective you want to add
fields from. In our example, we are using the Host OS Category.

In the Objective group fields pane, check the box next to the fields to which the objectives will
apply. In this example, the following fields will be applied

HP Universal CMDB (10.10) Page 128 of 311



Inventory Tools User Guide
Contents

= All other values
= Microsoft Windows
= UNIX
3. Click the Apply button. The entries are moved to the Applied Objectives pane.

The Objective group fields for the Asset fields (For example, Cost Center, Division) are based on
data available from the currently loaded scan files. If no scan files are loaded, or if no scan files
define a particular field, the Objective group fields for that field will be empty perhaps except for the
Any other values entry.

Removing an Applied Objective

1. Toremove an Applied Objective:

2. Select the Objective in the top left pane.

3. Uncheck the relevant Objective group fields in the right pane.
4. Click Apply.

The Applied Objective will be removed.

Loading and Saving Recognition Objectives

Recognition Objectives are stored in XML format.

Recognition Objectives are automatically saved when the Define and review objectives dialog box
is closed. They are saved to the location you specified in the Startup tab of the Recognition
Objective Options dialog box. See page 143 for further information.

The Applied objectives have a pop-up menu associated with it that can be activated by right-
clicking on the item.

o Load Objectives

Use this to replace the currently defined Objectives with a previously saved set of Objectives.
o Save Objectives

Use this to save the currently defined Objectives.
o Save Objectives As

Use this to save the currently defined Objectives to a file other than the one specified in the
Startup tab of the Recognition Objectives Options dialog box.

Displaying a Summary of the Recognition Objectives

To display a summary of the Recognition Objectives:
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In Analysis Workbench, select Objectives Summary from the Recognition menu.

A Summary chart is displayed.

Recognition Objective Summany

[ B 2 Achieved I 1 Mot Achisved T 1 Undefined ||

Review... ” Impraove. .. ]

This example shows that four Applied Objectives have been defined. Two of those have been
achieved, one has not been achieved and one is undefined.

The undefined section of the chart (usually displayed in grey) implies that the objective compliance
has not been calculated.

To rectify this:

Return to the Define and Review Objectives dialog box (select Objectives from the Recognition
menu) and click the Calculate button or click the Recalculate Objectives menuitem in the
Recognition menu.

Buttons in the Chart Page

There are three buttons in the Chart page:

« Click the Review button to get a more detailed view of the state of the objectives. See
Reviewing Recognition Objectives for further details.

o Click the Improve button to start the SAlI Teaching Wizard that can help achieve those

objectives that still need some work. See Using Objectives to Improve Recognition - The SAI
Teaching Wizard or further details.
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o Click the Options button to launch the Recognition Objectives Options dialog box. See Setting
Recognition Objectives Options for further details.

Reviewing Recognition Objectives

In Analysis Workbench, select Objectives from the Recognition menu, or click the Review button
when the Objective Summary screen is shown.

Click the Summary tab.

The Define and review Objectives window is displayed.

® Define and review Objectives

Applied Objectives Jummary | Machine Criteria | File Criteria | Properties

? Entire Enterprise M achine criteria compliance
= ByHost O5 Categony . .
v Al ather values E“"* Only 7 of 10 machines meet the machine
. Microzoft Windows }: objective.
v Unix 3 machines are lzzs than 75% compliant and
probably require significant work to meet the
ohjective.

File criteria compliance

T| 3 files zhould be added to the library to
a achieve compliance.

Unuzed Objectives [# total of 5340 of 17600 files are unrecognized)

Chaszziz Type
Cost Center
Drivizion
Department
Qffice Location
Building

[ Calculate ” Fefrezh ]

You can see from the tree view on the left that one of the Applied objectives has not been achieved
(indicated by the icon) and two have been achieved (indicated by the icon).

The red X on the Machine criteria compliance icon shows that the machine criteria was not met, and
the text explains that 3 of the 4 machines loaded meet the criteria. In order for the objective to be
achieved, all of the machines must meet this criteria.

The green tick on the files icon shows that the file criteria was met (and this is in spite of the fact
that more than 19000 files are unrecognized).

To manually recalculate objective compliance (which may be necessary if some of the automatic
options are disabled and circumstances have changed):
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Click the Calculate button in the Objective Review dialog box.

Reviewing Machine Criteria

To get more detail about the Machine criteria:

Click on the Machine Criteria tab, which shows a pie chart of the machines.

7 machines (70.0%)
100% Compliant

3 machines (30.0%)
S50-74% Compliant

In this example:

o Seven of the machines are compliant (Green). In this example, 80% of the files on a machine
must be recognized for that machine to be considered compliant.

e Three machines are not compliant (Magenta).

The percentages show how close the machines are to achieving the criteria. The machines
(Magenta) that are 50-74% compliant have a recognition rate of 50-74% of the target 80%. That is,
the recognition rate is between 60% and 79%.

If you move the mouse over the pie chart, the individual slices of the chart are highlighted.

Right-click to get a pop-up menu that applies to a slice of the pie chart. From the pop-up menu, you
can do the following:

o Tag the machine(s) related to the pie slice to investigate it further in the normal Analysis
Workbench windows.

« Untag those machine(s) related to the pie slice.

o Copy the Chart to the clipboard.

Reviewing File Criteria
Click on the File Criteria tab.

This shows a bar chart containing both the desired (allowed) shape of the unrecognized/frequency
chart as well as the actual shape of it.
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Unrecognized files by freguency of file in population
100
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[ ] Highlight non-compliant items

¢ Actual values are shown in green.

o Allowed values are shown in blue.

For this objective, the File criteria is not met — all of the green Actual values are not lower than the
blue Allowed values.

When only a few machines are loaded, not all of the categories are used, but the File criteria graph
always shows 20 bars evenly distributed between 0 and 100%, irrespective of the number of
machines loaded.

Moving the mouse over the Actual values shows a pop-up label with details of the data point in
question.

For example, the bar spanning 30-35% on the Y-axis shows the following text in the pop-up:
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Unrecognized files by frequency of file in population
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This means that 7280 files occur on 30-35% of the loaded machines, and that 3435 of these (47.2%)
have not been recognized.

This also demonstrates how it is possible for the file criteria to be met, even though thousands of
files are unrecognized. The majority of unrecognized files probably occur on just a few machines
and are therefore not as important as the common ones.

When teaching, you will want to start with the unrecognized files that occur on the largest
percentage of machines rather those that occur on just a few machines.

An Example of File Criteria Not Met

Here is an example where the File criteria is not met.

Unrecognized files by frequency of file in population
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In this example:

o The File criteria has been set to Strict in the Properties tab page and is not met by the scan files
loaded.

o The Highlight noncompliant items option is checked, which is why some of the Actual values are
red instead of green. This is to indicate that the Actual value is higher than the Allowed one.

This chart has a pop-up menu that is shown when right-clicking on one of the Actual bars.

From the pop-up menu, you can perform the following:
o Tag or Untag the files in question, and Tag the machines to which the objective applies.

For the Entire Enterprise objective, this means that all machines are tagged when a set of files
are tagged from this pop-up menu.

o Copy the chart to the clipboard.

Using Objectives to Improve Recognition - The SAl
Teaching Wizard

Having defined a set of objectives, the SAl Teaching Wizard can make use of the objective
information to choose which files to teach.

When the teaching wizard is run, all global tags are cleared.
To start the SAl Teaching Wizard:
1. Select the SAI teaching Wizard option from the Recognition menu.
The Teaching Assistant is displayed.

2. Click Next to continue.

Choosing an Objective to Improve

The next page of the wizard allows you to choose which of the Applied objectives should be
improved.

The objectives are shown in a tree view and when an objective is selected, a summary of the
objective is shown on the right.

1. Select the objective.

2. Click Next to continue.

Selecting an Unrecognized File

On this page, the wizard constructs a list of unrecognized files that occur on machines related to
the selected objective. It suggests the file that occurs on most machines.
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SAl Teaching Wizard

Select File

wihich unrecognized file should be used?

The following file hag been chozen for recognition. To zelect another file, click Skip.

(2

Attribute Yalue
File name Y292 ene
Size 516,781
Signature BFEO-2505
b odified 2008-08-01 03:29:34
Alttributes ®oa 1
Type Win 32 Exe
Accessed 2003-08
[tilization A%
Onmachines 6
Skip
< Back ][ et »

This page shows details of the selected file. The details are similar to those found in the Files

window, as well as the number of machines on which it is found.

If the selected file is not one that you wish to teach at this time, click the Skip button or click the
Next button to select the file shown for teaching. The wizard will choose the next candidate for

teaching until there are no more unrecognized files to teach.

The following page is displayed if there are no more files from the selected objectives that can be

taught.
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Mo more files 6
The wizard cannot find a file bo keach F

Mo maore filez from the selected objective can be taught uzing this wizard.

If more unrecognized files exist, they probably exist only in directones that have been excluded in
the Recognition Optionz dialog.

If thiz iz the caze. the remaining teaching waork, must be done withaut the aid of the Teaching
Wizard.

Click Back to zelect another objective, or Cancel to cloze this wizard.

You may need to manually teach the remaining unrecognized files. For more information about
manually teaching a file to the User SAI, see Teaching an Unidentified Application.

Automatic Selection of a Set of Files

Because most files do not exist alone, but are installed along with a group of other files making up
an application, it rarely makes sense to teach files individually.

For this reason, the teaching wizard automatically performs the following steps at this point:
o Tags the file selected for teaching.

o Tags all machines (in the objective) on which it occurs.

« Applies a machine and file filter to the Directories window.

o Tags the first directory in the Directories window (that is, the first directory that has not been
excluded).

o Applies a machine and directory filter to the Files window.
o Tags all files in the Files window.

In other words, this set of steps tags all files that occur in the same directory as the selected file,
because these are all files that are likely to belong to the same application.

The wizard shows a confirmation dialog box.
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At this stage, you can switch back to the Analysis Workbench Files, Machines and Directories
windows view to review the automatic selection.

Review each of the tagged files to ensure the selection is valid. You can untag some files, tag some
more and so on, before proceeding.

« When you are satisfied with the selection of files, click the Finish button.

The New Publisher/Application/Version Setup dialog box is displayed. Here you can enter details
about the application to which the tagged files belong. See The SAIl Editor for more information
about how to fill in these details.

Exporting Inventory Data

Various combinations of hardware, software and asset data can be exported. The facilities used to
define the level of detail for exported data provide a means of refining the selection of data exported.

When a suitable data file containing the exported data has been created, it can be imported to
populate a variety of third party systems including spreadsheets, databases, asset management
and help desk systems, which support the configurable data formats automatically created by the
Analysis Workbench.

Data can be exported directly from the Analysis Workbench either in standard ASCII text form and
CSV format (Comma Separated Variable).

Exporting Data Directly From the Analysis Workbench

From the Exports drop-down menu select one of the following options:
o Machines - Generates a machines export.

o Applications - Generates an applications export.

o Directories - Generates a directories export.

o Files - Generates a files export.

« Relational - Relational exports combine hardware, application and file exports in a manner that
allows the data to be imported into an external database application with little effort. If the
relational export option is chosen, then this provides the opportunity to combine columns from a
particular window with link columns from other windows.

« Stored Files Export - This type of export allows one or more named files to be extracted from
all scan files and stored in a number of different ways.

Exporting the Contents of Individual Windows

Select the Export from window option from the Output button drop-down menu.

This will display the Export to file dialog box which allows you to export the contents of the window
based on the current column selection and filter settings.
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Layout of the Export

An item group is what is represented as a line in one of the main windows. It is known as a group
because one of these line items may represent several occurrences of similar or identical items.

For Applications, Directories and Files exports the results can be presented in one of two formats:
e One line per item group
This presents the results in a format that is same as the active Window.

e One line per item

One line in the export shows details for each item. Each occurrence is shown. That is, every line
in the window is exported and shown as a row in the results.
Export Layout - Example

The Details window can be helpful in demonstrating the concept of item and item groups.

1. Ensure that the Details window link is enabled for a Files window (selected from the Configure
toolbar menu in a Files window).

2. Configure the Details window so that it displays the Asset Number and Directory columns. To
do this use the Detail window command in the Configure toolbar menu.

3. Now click on an entry in a Files window.

Files with the same name are grouped together, if they are recognized as belonging to the same
application/version, are of the same recognition type (for example, Main/Associated) and so on.

If two files with the same name are both unrecognized, they are only grouped together if they have
the same size. If they are recognized (and otherwise grouped), the size is ignored and can be
different.

If the exact file has been located in multiple places (either on the same machine or on different
machines), each occurrence will be displayed in the Asset Number column as a separate row and
the location will be displayed in the Directories column, hence it is part of a ‘group’.

If the file has only been located on one machine, then only one row will be displayed in the Asset
Number column (in this case select another file to use for the example).

Fiters~ | O ™= 3 1| &l || EColumns~ [ Tal |winvnc.exe

»
Marne Azzet Number | Size Sighature  |Aftibutes | Tepe

Winwnc. exe Wwindows 95 05 . F

Wwinvnc.exe Windows 93 5E 335,872 CD42BRA3 X a Win 32 Exe
Wik class
winx.class

ik rlase

The file winvnc.exe occurs in two places. In this case on two different machines.
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In the export results, one line in the export will represent the information for this group of entries. For
instance, the number in the Copies column of an export represents the number of occurrences of
the file. This number is equal to the number of rows that are displayed in the Asset Number column
for a particular file.

One Line Per Item Group

This presents a detailed view which has the same contents as the active Window.

One line in the export shows details for a group of items.

=h Files.csv ['- | ['D | f'5_<|
A B C D E FIGHE
. - . s o
1 |Hame Publisher Application Version Release & =
2 |winverexs |Microsoft Windows Server 2003 ent 2003 1] 1
3 |WINVER.exe |Microsoft Windows SSo=r2 95 0SR2) 1| 1
4 |WINVER.exs |Microsoft Windows NT 40=rvepba | 405rv| 1| 1
5 |WINVER.exe |Microsoft Windows 58 898 1| 1
6 |winverexe |Microsoft Windows NT Terminal Server (4.0 2p6 4 1] 1
T |winvnc.exe |ATAT Labs Cambridge |WMNC Server 3.36 I 2 1
8 |winvnc.exe |ATAT Labs Cambridge |WMNC Server 3.3.7 I 1] 1
g w
4 4 » M} Files / | ¢ ]

In this example, rows 7 and 8 represent the data for the winvnc.exe file group. In row 7, the number
in the Copies column is 2, which corresponds to the number of occurrences of this file displayed in
the Details window.

One Line Per Item

One line in the export shows details for each item. Each occurrence is shown. That is, every line in
the Window is exported and shown as a row in the results.

Setting Default Options for Exports

The default settings allow you to specify the directory the export results will be saved to, the format
of the export file (CSV or TXT) and actions to be taken if an export file of the same name already
exists in that location.

To select default options for exports:

1. Select the export option from the Exports main menu (depending on the type of export that you
want to make), or

2. Select the Export from window option in the Output button drop-down menu in the window
(Machines, Applications, Directories, Files exports only).

The Export to file dialog box is displayed.
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3. Click the Default Settings tab in the Export to file dialog box.

4. Inthe Default export directory field, specify the name and path of the directory (or use standard
Windows navigation methods) to where the export file will be saved by default.

5. Inthe Export format group, select one of the following default export format options:
s Comma separated (.CSV)
= TAB delimited (.TXT)

This option is not available for Stored Files exports.

6. Choose an option to specify how the data will be exported if the specified target data file
already exists. The following options are provided:

= Overwrite. Overwrites the existing file with the new data.
= Append. Appends the new data to the existing data.

= Prompt. A prompt is displayed if the target data field already exists. Prompts to create a new
datafile.

7. Click OK to set the default options or Cancel to exit without making any changes.

Exporting Machine Data

There are two ways in which you can export the contents of the Machines window.

o Select the Machines option from the Exports main menu.

o Select the Export from window option in the Output button drop-down menu in the Machines
window. This allows you to export the contents of the Machines window based on the current

column selection and filter settings.

The Export to file dialog box is displayed.
Configuring the Machine Export

1. Click the Export Machines tab in the Export to file dialog box.

2. Select the columns to export by checking the boxes as required in the list box.
= Toselect all items in the Column list, click the All items button.
= To select the default column selection. Click the Default button.

= Toadd more columns to the list, click the Select button. This displays the Select columns to
display dialog box.

HP Universal CMDB (10.10) Page 141 of 311



Inventory Tools User Guide
Contents

B Select columns to export E@@

Availlable Calumnz Selected Columnz
= [ Hardware Data ~ Tatal memary [Mb]
E fizset Data Es;;tﬂ_rpaegr?ltgg System Mame
[+ CPU Data CRU
" BusData Sian D ate
[+ BIOS Data Azzet Tag
& Memaory Data Last Mame
[ Operating System [
[T “ideo data
[ Mebwark data Del &l
[T Keyboard and Mous
[T Disk data
[ Spstem data
[ Part data " -
= Doy
. s 7 [Loomn |
[ ] Show anly tems in use
’ Load ] [ Save ] ak. ] [ Cancel

The left list shows all column categories. Click on the + sign to expand the relevant category
and list all possible columns. If the check box next to the category is displayed as a dotted line,
then this means that the not all fields in that category have been selected.

The Show only items in use option will ensure that only hardware items that actually exist in one
of the loaded scan files are shown in this tree.

Either drag a category from the left list to the Currently selected columns list, or select the
check box next to the category and click the >Add button. The functions of the other buttons are
as follows:

= To add all the available columns to the Currently selected columns list click the >>Add
button.

= Toremove an entry from the Currently selected columns list click the Delete button.
= Todelete all entries in the Currently selected columns list click the Del All button.

= You can move the position of entries in the Currently selected columns list using the Up and
Down buttons.

» Click OK after you have selected the columns. You are returned to the Export to file dialog
box.

3. Select the Export option in the Column Headers group if you want the column heading (title) to
be included in the export.
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4. Specify the filters that you want to apply to the data, by selecting the check boxes as follows in
the Data Source Filter group:

» Machines - Applies a Machines filter to the data source.

» Directories - Applies a Directories filter to the data source.
» Local - Applies a Local tag filter to the data source.

= Application - Applies a Application filter to the data source.
» Files - Applies a Files filter to the data source.

5. Inthe Export to File box, specify the name of the file that the export is going to be saved to. The
path displayed here is the one that you defined in the Default Settings tab.

To modify the location used to store the data exported from the scan files, use the Default
Settings tab.

6. Click OK to export or Cancel to exit without making the export.
7. If an earlier export file created with the same name and in the same path is open in another

application (such as Excel) a file sharing violation error message is displayed. Close the file
and attempt the export again.

Exporting Application, Directory or File Data

There are two ways in which you can export the contents of these windows.

o Select the Applications, Directories or Files option from the Exports main menu.

o Select the Export from window option in the Output button drop-down menu in the window itself.
This allows you to export the contents of the window based on the current column selection and
filter settings.

o Select the Applications, Directories or Files option from the Exports main menu.

o Select the Export from window option in the Output button drop-down menu in the window itself.
This allows you to export the contents of the window based on the current column selection and

filter settings.

The Export to file dialog box is displayed for the Applications or Directories or Files option.

Configuring the Export
1. Click the Export Applications/Directories/Files tab in the Export to file dialog box.
2. Select the columns to export by checking the boxes as required in the list box.
= Toselect all items in the Column list, click the All items button.

= To select the default column selection, click the Default button.

HP Universal CMDB (10.10) Page 143 of 311



Inventory Tools User Guide
Contents

3. Select the Export option in the Column Headers group if you want the column heading (title) to
be included in the export.

4. Specify the filters that you want to apply to the data, by selecting the check boxes as follows in
the Data Source Filter group:

» Machines - Applies a Machines filter to the data source.
» Directories - Applies a Directories filter to the data source.
= Local - Applies a Local tag filter to the data source.
= Application - Applies a Application filter to the data source.
» Files - Applies a Files filter to the data source.
5. Select the type of export
= One line per item group
= One line peritem

6. Inthe Export to File box, specify the name of the file that the export is going to be saved to. The
path displayed here is the one that you defined in the Default Settings tab.

To modify the location used to store the data exported from the scan files, use the Default
Settings tab.

7. Click OK to export or Cancel to exit without making the export.

If an earlier export file created with the same name and in the same path is open in another
application (such as Excel) a file sharing violation error message is displayed. Close the file and
attempt the export again.

Exporting Stored File Data

Stored files are embedded in the scan file during scanning. Typically these are system configuration
files, for example, Autoexec.bat, Config.sys.

This type of export allows one or more named files to be extracted from all scan files and stored ina
number of different ways.

The naming conventions for the extracted files allow for multiple instances of the files.

If only one stored file is required from one scan file, then it is more efficient to save the stored file
from Viewer.
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To export stored file data, perform this following:
Step 1: Configure the Stored File Export

1. Select the Stored Files command from the Exports menu.
2. Click the Export Stored Files tab in the Export to file dialog box.
This page is used to set up various options for the stored files export.
Step 2: Select Data Filters

1. Select the data source filters that you want to apply to the data. In the Data Source Filter group,
select one of the following:

» Machines - Applies a Machines filter to the data source.
» Directories - Applies a Directories filter to the data source.
= Local - Applies a Local tag filter to the data source.
= Application - Applies a Application filter to the data source.
» Files - Applies a Files filter to the data source.

See Filtering for more information about using filters.

Step 3: Specify the Stored Files to Export

Specify whether you want to export all stored files or specific stored files.

1. Toexport all stored files select the Export All Stored Files check box (located on the left side of
the dialog box above the list box).

When this check box is selected, the Add and Remove buttons are disabled in the Export Files
group.

2. To specify stored files for export, use the grid in the Export Files group to configure which files
are to be exported. This grid contains two columns: File Name (the name of the file to be
exported) and Found Where (the location of the file).

3. Click the Add button to add a stored file to the list. The Specify Stored File dialog box is
displayed.

4. Specify the file name in the File Name box. Select the file name from the drop-down list (this
list maintains a history of previously entered file names) or type the file name directly in to the
box.

5. Specify where this file can be located. The options are:
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= In Any Root Dir - Thefile is located in a root directory, for example in the E:\DOS directory.

= In Root Dir of Boot Drive - The file is located in a root directory on the boot drive, for
example in the C:\Windows directory.

= Anywhere - The file can be located anywhere in the directory structure.

» As specified - This option is only enabled if the path to the file is entered in the File Name
field. The path must start with a backslash (\).

6. Click OK.

Step 4: Specify the Name of the Extract Export

To specify the format the extract export file name, select an option from the Extract drop-down list:

o Allfiles to <AssetNumber>.txt - The export is made to a text file that has the name of the
AssetNumber. For example, if the AssetNumber is 23567 then the export file will be called
23567.txt. The files are saved to the location specified in the Default Settings tab.

o Todirectory named as file - The export is made to a directory that has the name of the stored file
and has subdirectories for the drive that the file was located in.

For example:

= A stored file System.ini was extracted from a scan file called XSF014.xsf.
= The location of the file was b:\Win95.
= The location for the results has been specified in the Default Setting tab as H:\Stored Files
= The export result will therefore be located in the following directory structure:
H:\Stored Files\ Autoexec.bat\b\Win95\XSF014.txt

o Todirectory <AssetNumber> - The export is made to a directory that has the name of the scan
file and has subdirectories for the drive that the file was located in. This location will contain the
stored files.

For example

= A stored file Boot.ini was extracted from a scan file called XSF02.xsf.

= Thelocation of the file was c:\1386.

= The location for the results has been specified in the Default Setting tab as H:\Stored Files
= The export result will be located in the following directory structure:

H:\stored Files\ XSF02\C\1386\Boot.ini
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e Thereis a separate option to create a CSV file of name mapping. This creates a CSV file
(ExportFilenames.csv) with path information for extracted files.

The ExportFilenames.csv file produces a CSV list with the following fields:

Field Purpose

Exported to File Path of the export file created

Asset number Asset number of the source scan file
Original File Name Name and path of stored file

Step 5: Specify the Types of Files to Extract

To specify the type of files to export, select the following options as required:

o Export text files only - This extracts ASCII text files only. This option is available for all extract
formats.

¢ Hex dump binary files - This extracts any binary files in hexadecimal. This option is available
for the To directory named as file or To directory <AssetNumber> extract formats.

Step 6: Specify the Options for the Extract Format Directories
You can specify the options for the directories that are to be used in the location of the results.
Select the options in the Directories group.

This group is only enabled if the To directory named as file or To directory <AssetNumber> have
been selected as the extract format:

o Ignore directory names - The drive letter and subdirectories will not be included. The following
two additional options are made available.

« Ignore duplicate files - If duplicate files are encountered, then the latest file will be extracted.

o Add number to filenames - When directories of the asset names are created, multiple instances
of the file are numbered starting at 000. For example:

= FP0214.000.txt
= FP0214.001.txt
= FP0214.002.txt

o Use directory names - The directory name will be used in the extract file name. The following
additional option is made available.

Substitute \’ with ‘.’

The directory path is indicated in the file name by ‘.’ For example, the result:
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H:\stored Files\ XSF02\E\I386\Boot.ini

Will be represented as a file called

E.I386.Boot.ini

Located in the XSF02 directory. That is, the results can be found in;
H:\stored Files\E.I386.Boot.ini

Loading and Saving Exports

You can save your export layout to a .awrcl file in the Analysis Workbench/Column Layout directory
by clicking the Save button in the export wizard.

You can load a previously saved export configuration by clicking the Load button in the export
wizard and selecting an export file (with an .awrcl extension) from the load dialog box. Exports are
saved to the Analysis Workbench/Column Layout directory.

Older .rcl files will not work in this version of Universal Discovery.

Exporting Relational Data

The Relational Export facility enables data to be exported in a format that is supported by Relational
Database Management Systems (RDMS).

Data exported from the Analysis Workbench using these facilities is divided into three main areas:
o Software information, including file data and information.

o Machine/scan file information, including asset and hardware data and information about each
scan file.

¢ Linking information to relate each software file to specific scan files.

The exported data is organized into tables, which include specific items of data that are repeated for
each scan file read into Analysis Workbench. The relational export facility includes options to
export data to three different tables which are related or linked by common fields known as key
fields. The three tables are:

o Hardware and Configuration Table
o Applications Data Table

o Files Data Table

Performing the Relational Export

Select the Relational option from the Exports menu to display the relational Export to file dialog box.

Step 1 Configure the Default Settings
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The procedure for setting the default options is identical to that of the other types of exports. See
Setting Default Options for Exports for more information about how to do this.

Step 2 Include the Data Tables to Be Exported

In the Relational Export tab page, select the data tables to be exported.
o Hardware and Configuration table

The information for this table is configured on the Export Machines tab page.

o Applications table

The information for this table is configured on the Export Applications tab page.

o Files table
The information for this table is configured on the Export Files tab page.

Step 3 Select the Information to Be Included in the Data Tables

The Export Applications/Export Files/Export Machines tab pages in the Export to file dialog box
provide options that are used to select the contents of the data tables to be exported.

For each data table you choose to export, a file name (with a .csv extension and including the full
path) must be entered.

To select the information to be included in the data tables:
1. Click the appropriate tab:
= Export Files
= Export Machine
= Export Application
2. Select the pages to export using the check boxes.
3. Enter the page and set the column preferences
4. Choose toinclude or exclude column headers with the exported data. If the Column Headers
option is selected, column header fields are included in the exported data file to identify the
data items exported.

5. Choose OK to export data to the selected data tables.

Applications and Files under Relational Exports do not have choice of Export type — only one
line peritem.

Step 4 Preview the Relational Export Setup

The data tables and the columns exported for each one can be previewed by clicking the Preview
button in the Relational Export tab page. The Relational View window is displayed:

HP Universal CMDB (10.10) Page 149 of 311



Inventory Tools User Guide
Contents

R Relational View

Relational Export - Overview
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This window shows the tables of relational data which are related by key fields. Key fields are
shown with an asterisk (*) next to them.

Data tables that have not been selected for the export are disabled.

Each table includes at least one key field. The key fields are used to relate data so that when data is
exported, the information you want to view from the tables can be combined using a relational
database system.

Other items of data are indicated as optional fields, which means that these items of data are only
exported if you choose to export them.

o The contents of the File, Application and Hardware and Configuration tables are specified on the
other tab pages as follows:

= The contents of the File Data table are specified on the Export Files tab page.
= The contents of the Application Data table are specified on the Export Applications tab page.

= The contents of the Hardware and Configuration table are specified on the Export Machines tab
page.

o Click the Close button to return to the Export to file dialog box.

HP Universal CMDB (10.10) Page 150 of 311



Inventory Tools User Guide
Contents

The Export Results

The results of a relational export are saved to a file name (.csv). To specify the file names for
applications, machines and files, select the specific tab in the Export to File dialog box and specify
the file name.

Analysis Workbench Scripting

The Analysis Workbench provides command script options that facilitate the automation of various
settings which are manually set within the application (for example, loading, processing and
outputting of information from Analysis Workbench).

The scripts are standard ASCI| text files, similar in layout to Windows ini files, except that they do
not use equals ‘=’ in the key lines in each section within the script. The scripts make use of the
various configuration lists (load options, stored queries and so on) which can be stored as part of
Analysis Workbench.

By using scripts which can call these stored configuration lists, different options and sequences
can be predefined and run as required for regular exporting activities. Sample files have been
provided with the Analysis Workbench. The scripts have an AWCS extension to the file name.

There are four script sections (if they exist) and are processed in the following order:
o Startup section

o Variables section

¢ Process section

¢ Endsection

Any number of other sections can be added to the script. Other sections are not processed unless
they are called for specifically by the script.

These sections do not have to be in this order in the script file and do not have to exist.
A sample script is supplied with Universal Discovery in the following location:

c:\hp\UCMDB\DataFlowProbe\tools\InventoryTools\AnalysisWorkbench\Scripts
Executing the Script

o Scripts are executed by one of three methods:

= Including the script name on the command line in Analysis Workbench (for example Analysis
Workbench.exe script.awcs.

= Opening Analysis Workbench and then dragging the script file name to the Analysis
Workbench workspace.

= Using the Run script file... option File menu.
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o Having these three options allows:
= The script to run on a scheduled basis if using a Windows utility such as AT.

» Different scripts to be run when the Analysis Workbench is opened under user control.

¢ Do not use any commands in the [Variables] section. This section is used for declaring
variables only.

e Do not call any of the standard sections with the RUN_PROCESS command. (Startup,
Variables, Process, End).

o Do not name any variables with the same name as a reserved word (either a command
name or a string used internally by the scripting engine).

e Do not call a section that is a list of files or directories.

Writing Scripts

o Create scripts in a text editor or in a Word processor without formatting.

o Do not use any equal ‘=" characters in the command line.

o Save the script file with the extension AWCS.

All commands must have spaces between the command and its parameters. If there are multiple

parameters, then these are separated by just a comma (for example, SAVE_STATE filename,
description).

Group Commands into Sections

o Sections have a section header written between square brackets, for example, [sectionname].

o Section names must not begin or end with space characters and must not be preceded by a
space before the name.

e There are four reserved section names, STARTUP, VARIABLES, PROCESS and END.

o Sections can be stored in any order, but the four reserved sections, if they exist, are processed
in the order STARTUP-VARIABLES - PROCESS —END.

Add Comments to Scripts

Comments can be added to the scripts to improve readability, either by using a section headed
[Comments] to describe the overall function of the script or by using a semicolon (*;’) at the start of
the line to indicate a comment line, to describe specific activity.
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Analysis Workbench Script Contents

Five script sections if they exist are processed in the order:

Comments Section

Startup Section

e Variables Section

Process Section

e End Section

They do not have to be in this order in the script file and do not have to exist.

You do not need to call any of these sections. The script engine calls these sections automatically.
The script engine does not call any other section that has been created unless it has been specified
inaRUN_PROCESS command.

Any other sections in the script can be created and the lines do not have to be commented out if the
section is not called by the script.

Comments Section

This section is usually placed at the beginning of the script file. The comments section does not
have to exist and is normally used for comments such as the author, date written. It is
recommended that a comments section is used. It may be useful to include the name of the author,
the purpose of the script, and the date it was written. A version number should also be included so
that it can be incremented every time changes are made to the script.

Any other comments made in other sections of the script are made using a semicolon (*;’) at the
start of the line.

The description in the Run script form is taken from the first valid line in the Comments section.

Startup Section

This section is used to set up initial load conditions for the script. Variables are not available in this
section or any sections called by this section.

Commands that do not require variables can be used in this section. Typically, this section would
be used to make sure that the Analysis Workbench was in the ‘condition’ expected before the main
[Process] section was called by the script engine.

An Example of Typical [Startup] Code

[Startup]

BREAK_ON_ERROR ON

LOG_CLEAR
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LOG_SCRIPT ON
DISPLAY_PROGRESS ON
UNLOAD ALL
SET_BUSINESS

Variables Section

This section is available to any section of the script apart from the [Startup] section and any
sections called from the [Startup] section.

Variables are also available in a command script if declared in a subscript called by that script. They
are ‘Global’ variables. Do not try to use a variable before it is declared.

This can occur if variables are declared in a sub script but are used in a different script. (It is
recommended that you declare all variables in a main script file).

An Example of Typical [Variable] Section Code:
[Variables]
TestInt1 : integer
GatewayDirectory : string
Statelmage : string
Note: No assignments can be made to the variables in this section. This section is only

for instructing the script engine to make these variables available to the script. The
restrictions on variables are as follows:

Strings are limited to 64 characters in length.

Integer variables are valid from zero to over 2,000,000,000.

Process Section

This section is used for the main script loop or program. Any variables declared, are available in this
section or any processes called from this section. All commands are available in this section.

Any sections created in the script have the same functionality as this section, except that they
must be called in the script.

The different sections of the script should be named logically, so that the script makes sense when
read as a text file.

A typical [Process] section does not have to be very long, because normally other sections would
be called from the script in this section.

An Example of Typical [Process] Section Code:
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[Process]

RUN_PROCESS SetupVariables

IF EXIST $Statelmage THEN RUN_PROCESS LoadState

RUN_PROCESS LoadScanFiles

; load the machine export setup file - this sets up the files and columns to export
EXPORT_LOAD Gateway

; do the export

EXPORT_RUN

End Section

This section is used to tidy up after the script has finished, unload scan files from the program, save
the script log file and so on. Variables are still available in this section.

When the main command script has finished, all variables are wiped from the memory, so if any
results need to be saved, this should be done before the main script finishes.

Variables and Commands

To set variable commands:

To set the variables use := (colon + equals sign)

Example

TestInt1:=5

GatewayDirectory := c:\gateway\

Statelmage := $GatewayDirectory + GatewayState. AWS
The dollar sign in front of the string variable indicates that one variable can use another variable. In
this case the Statelmage variable will have the value c:\gateway\GatewayState. AWS

You can space the assignment operator where you want as long as there is at least one space
between each part of the statement.

(VariableName),(at least one space),( :=),(at least one space), (variable value)

A variable can be assigned as a mixture of strings and variables. Integer variables can be used in
the assignment statement and these will be translated to strings.

Example

FOR TestlInt1 := 1000 to 1999 do
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LoadFile := $GatewayDirectory + TEST + $TestInt1 + . XSF

GET_INI_VARIABLE
$VariableName,INIFileName,SectionName,KeyName,DefaultValue

This command can be used to set a variable that has been declared, to a value retrieved from an INI
file.

The five parameters needed for GET_INI_VARIABLE are:
Variable name with or without a '$' in front of it.

INI file to get variable from.

Section name to get variable from.

Key name to get variable from.

A default value to use if key is not found - defaults to empty string if not specified.

Example

GET_INI_VARIABLE $GatewayDir, Gateway.INI, AWScript, GatewayDirectory, c:\Gateway\

GET_ENV_VARIABLE $VariableName,EnvironmentVariable,DefaultValue

This command can be used to set a variable that has been declared, to a value retrieved from an
environment variable.

The three parameters needed for GET_ENV_VARIABLE are:
¢ Variable name with'$' in front of it.
e Environment variable to read from.

o A default value to use if variable is not found - defaults to empty string if not specified.
Commands for Calling Other Processes

RUN_PROCESS Section Name

Calls another section of the command script. It takes a section name as a parameter. Do not call
any of the standard sections Startup, Variables, Process and End.

Example

RUN_PROCESS ClearAW

RUN_SCRIPT ScriptFileName

Run another Analysis Workbench command script. It takes a script file name as a parameter.
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Example

RUN_SCRIPT TestScript. AWCS

Commands for Loading Data into Analysis Workbench

LOAD_STATE Filename

Loads an Analysis workbench state image file into Analysis Workbench.

Example

LOAD_STATE TestState. AWS

LOAD_SCAN SCANName

Loads one scan file into Analysis Workbench. It has a single scan file name as a parameter.

Example
LOAD_SCAN c:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples
LOAD_SCAN $XSFDirectory + aix52.xsf

LOAD_SCAN_LIST SectionName

Has a single section name as a parameter to load a list of scan file names from. This procedure
calls the LOAD_SCAN procedure for each file in the list.
Example

LOAD_SCAN_LIST FileList

LOAD_DIRECTORY DirectoryName

Loads a single directory specified, as a parameter to this command. Optionally, specify the /SUB
parameter to load all scan files in the specified directory and all subdirectories of that directory.
Example
; Load all files from the Samples directory
LOAD_DIRECTORY C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples
; Load all files from all the sample directories in Analysis Workbench.

LOAD_DIRECTORY c:\/SUB

LOAD_DIRECTORY_LIST SectionName

Loads a list of directories from a section of the script file. This procedure calls the LOAD _
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DIRECTORY procedure for each directory in the list. (The /SUB parameter can also be used in the
directory list).
Example

LOAD_DIRECTORY_LIST TestDirList

Commands for Unloading Data from the Analysis Workbench

UNLOAD
Unloads scan file data from Analysis Workbench. Uses a parameter ALL, TAGGED, or

UNTAGGED. Assumes ALL if no parameter is specified.
Example
UNLOAD UNTAGGED

; Unloads from Analysis Workbench all scan files that are not tagged.

Commands for Setting the Load Options

SET_BUSINESS

Sets business mode if no scan files have been loaded.

SET_OPERATIONAL

Sets operational mode if no scan files have been loaded.

LOAD_DUP_OPTION

Instructs Analysis Workbench how to treat duplicate scan files. This overrides and changes the
current setting of Analysis Workbench. The settings are available in the File Load Options dialog
box called from the scan file load form Options button.

Valid combinations are:

o LOAD _DUP_OPTION NEWEST (load the newest of the duplicate files)

o LOAD_DUP_OPTION ASK (Ask what to do if duplicate files detected)

o LOAD_DUP_OPTION LOAD (load the duplicate file, remove the previously loaded one)

o LOAD_DUP_OPTION IGNORE (Leave the file already loaded, ignore the attempt to load
another file with the same name)

LOAD_OLD_OPTION

Instructs Analysis Workbench how to treat old scan files. This overrides and changes the current
setting of Analysis Workbench.
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Valid combinations are:
e LOAD_OLD_OPTION LOAD (Load old files even if they are older than the limit).
o LOAD_OLD_OPTION Ask (Ask what to do if old scan files are detected).

e LOAD_OLD_OPTION IGNORE (Ignore files older than the limit).

LOAD_CONFIG FileName

Require a load configuration file as a parameter, to load an INI file saved by the Analysis
Workbench Load Configuration dialog box. This sets up recognition, display filter, asset fields,
duplicate and old scan file options and so on.

Example

LOAD_CONFIG ScriptLoadOptions.ini

LOAD_EXCLUDE_DIR DirList.txt

Allows a list of directories to ignore to be specified, when loading scan files. The list can be set and
saved using the Load Filter tab of the Analysis Workbench Load Configuration dialog box.

Example

LOAD_EXCLUDE_DIR c:\hp\UCMDB\DataFlowProbe
\tools\Inventory Tools\AnalysisWorkbench\ExcludedDirs.txt

Commands for Running Tag Queries

QUERY_CLEAR

Clear the current Analysis Workbench query from memory, this is not necessary if you are loading a
query from afile.

QUERY_LOAD Filename

Load a tag query into Analysis Workbench. Takes a query file as a parameter.

Example
QUERY_LOAD NT4WS
QUERY_RUN
Run the tag query currently loaded into Analysis Workbench. Ensure that you load the correct query

file before running the query. Typically you would call the QUERY_RUN procedure immediately
aftera QUERY_LOAD.

QUERY_SET_OPTION TAG Switch
Overrides the tagging option set by the loaded query in Analysis Workbench.
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Uses the parameters SET, CLEAR, TOGGLE.

Valid combinations are:
e QUERY_SET OPTION TAGSET
e QUERY_SET OPTION TAG CLEAR

e QUERY_SET_OPTION TAG TOGGLE

QUERY_SET_OPTION PREQUERY
Overrides the pre-query option set by the loaded query in Analysis Workbench.

Uses the parameters NONE, CLEARALL, SETALL.

Valid combinations are:
e QUERY_SET OPTION PREQUERY NONE
e QUERY_SET _OPTION PREQUERY CLEARALL

o QUERY_SET_OPTION PREQUERY SETALL
Commands for Tagging

LOAD_TAGS

Loads a list of tagged machines from a .tag text file. This file contains the asset numbers of the
tagged machines. It takes one argument, the fully qualified name of the tags file to load.

Example

LOAD_TAGS
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\Machines 15March
2012.tag

SAVE_TAGS

Saves the asset numbers of the machines tagged in a Machines window to a .tag text file. It takes
one argument, the fully qualified name of the tags file to save.
Example

SAVE_TAGS
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\Machines 15March
2012.tag TAG_ALL

Used to tag or untag all items of a particular type.

The syntax of the command is
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TAG_ALL (Tag|Untag) (Local|Global) (File|Dir|]App|Mach)
TAG_CONTAINS

Tags files, directories and applications from a script. The syntax is:

TAG_CONTAINS (Tag|Untag)(File|Dir|]App) ColumnName Value

Where (x]y) means x ory.

Example 1

This will tag all of the unrecognized (Checkver and Unknown) files:

TAG_CONTAINS Tag File Status Check TAG_CONTAINS Tag File Status Unknown
Example 2

This will tag all MS apps except Outlook

TAG_CONTAINS Tag App Publisher Microsoft

TAG_CONTAINS Untag App Application Outlook

Commands for Exporting Data from Analysis Workbench

EXPORT_LOAD ExportLayoutFileName

Loads a saved export layout file. This can be configured using any of the exports available from the
main Analysis Workbench menu. Simply set up the export as required for exporting the data and
save it to the file name used in your script.

Example

EXPORT_LOAD TestScript.awrcl

EXPORT_RUN

Runs the currently loaded export layout file. This will export the data to the files specified in the
AWRCL file.

EXPORT_SETDIR

Allows you to change the directory that the files are exported.

Example

EXPORT_SETDIR C:\Gateway

Note: Older .rcl files will not work in this version of Universal Discovery.

HP Universal CMDB (10.10) Page 161 of 311



Inventory Tools User Guide
Contents

Commands for Script Debugging
Pressing the Pause|Break key will stop the script at the next command and display a dialog box — it
will not interrupt a running command apart from the WAIT command.

It only needs to be pressed once, however, it may appear that nothing is happening if a whole
directory of scan files is being loaded.

BREAK_ON_ERROR ON | OFF | TOGGLE
Setting BREAK_ON_ERROR ON will stop the script if any errors occur.

SINGLE_STEP ON | OFF | TOGGLE

Puts up a dialog box for every command when switched on, allowing the script to quit, skip the
current command or turn off the single stepping.

DISPLAY_PROGRESS ON | OFF | TOGGLE

Shows a window with currently processing script line added to a list
Commands for Script Logging

LOG_CLEAR

Clears the Analysis Workbench error log. (this is not recommended unless you are saving the error
log to a file each time a script is run).

LOG_SCRIPT ON | OFF | TOGGLE

Writes command lines to the log as they are processed

LOG_WRITE StringToWrite

Writes the specified string to the log file and log window if turned on.

LOG_DISPLAY

Displays the Analysis Workbench main log window to show errors and messages as the
commands in the script are processed.

LOG_SAVE SaveToFile

Saves the log to a file specified as a parameter.

Example
LOG_SAVE $ScriptFile
LOG_SAVE c:\ScriptFile.txt
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Miscellaneous Commands

IF Expression THEN Command

This statement performs the command only if the preceding expression is true.

Example

IF $SLOOP = 10 THEN TERMINATE_PROGRAM

EXIST Filename

Used in conjunction with the IF... THEN command.

IF EXIST FileName THEN Command

Allows a command to be repeated a number of times. The command can be a normal one line
command or a whole process section.

The syntax is FOR (variable) := Start TO end DO (command)

Start and end can be numbers or variables, end must be greater than start.
FOR TestInt1:=1to 10 DO LOG_WRITE HELLO WORLD

FOR $loop := $start TO $end DO RUN_PROCESS HelloWorld
SAVE_STATE FileName, Description

Saves the current Analysis Workbench data to a state image file. Takes two parameters —
Filename and Description. The state image description is optional and a default description will be
used if one is not specified.

The state image files are compressed and decompressed on the fly.

Example

SAVE_STATE TestState. AWS, Test state image saved by command script

TERMINATE_PROGRAM

Shuts down the Analysis Workbench program.

Will not prompt for shutdown

PAUSE Message

Will display a dialog box prompting for action - optionally you can include a message that will be
displayed in the dialog box.

Example 1

PAUSE load has finished
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WAIT n

Wait n seconds
Example 2
WAIT 100

Will wait 100 seconds - only checks for times greater than 1 hour — Do not use large numbers
for the wait time. This will lock the program until the time limit is reached or the Pause|Break
key is pressed.

STD_DATES ON | OFF | TOGGLE

Displays and outputs all date fields in a standard format to aid in exporting data to other
applications.
Example

STD_DATES ON

Sample Script

A sample script is supplied with Universal Discovery in the following location:
C:\hp\UCMDB\DataFlowProbe\tools\InventoryTools\AnalysisWorkbench\Scripts
Section names must not begin or end with space characters. Sections can be in any order.
[Comments]

*** SAMPLE SCRIPT ***

This section is ignored — There is no need to comment out lines.

[Startup]

; This section contains information which will be used to configure

; Analysis Workbench on starting the script and does not have to exist

LOG_CLEAR

DISPLAY_PROGRESS ON

RUN_PROCESS ClearAW

[Process]

LOAD_DIRECTORY_LIST TestDirList

RUN_PROCESS Business5

RUN_PROCESS BusinessAll
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RUN_PROCESS Operational5
RUN_PROCESS OperationalAll

QUERY_LOAD
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\Queries\nt4ws

QUERY_RUN

[ClearAW]

UNLOAD ALL

[Business5]

RUN_PROCESS ClearAW
SET_BUSINESS
LOAD_SCAN_LIST 5XSFListLondon

SAVE_STATE C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Analysis\Workbench\State
Images\Business5.aws

Business5.AWS,Demo state containing 5 scans from the London office in Business mode
[BusinessAll]

RUN_PROCESS ClearAW

SET_BUSINESS

LOAD_DIRECTORY C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples\s

SAVE_STATE C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\State
Images,Demo state containing all scans from the London and Frankfurt offices in Business mode

[Operational5]

RUN_PROCESS ClearAW
SET_OPERATIONAL
LOAD_SCAN_LIST 5XSFListLondon

SAVE_STATE C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\State
Images\Operational5.AWS,Demo state containing 5 scans from the London office in Operational
mode

[OperationalAll]

RUN_PROCESS ClearAW

SET_OPERATIONAL

LOAD_DIRECTORY C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples

SAVE_STATE C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\AnalysisWorkbench\State
Images\OperationalAll.AWS,Demo state containing all scans from the London and Frankfurt
offices in Operational mode
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[5XSFListLondon]

C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples\London\LND1000.xsf
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples\London\LND1002.xsf
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples\London\LND 1006.xsf
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples\London\LND1028.xsf
C:\hp\UCMDB\DataFlowProbe\tools\Inventory Tools\Samples\London\LND 1038.xsf
[TestDirlList]

; This section contains a test list of directories to load

; note c:\ /sub will attempt to load ALL Scan Files on drive C

; d:\scan files will load only scan files in that directory - subdirectories would be ignored
c:\/sub

d:\scan files

e:\/sub

f:/sub

[End]

; This section contains commands to be run before script finishes and does not have to exist
;LOG_SAVE c:\AWScriptLogFile.txt

;TERMINATE_PROGRAM

Viewing Software Utilization Data in Analysis
Workbench

Before you can view and analyze the data in Analysis Workbench you will need to set memory load
options.

Setting Load Options for Software Utilization

Ensure that the Software Utilization Data option is enabled in this dialog box.
1. Select the Load Options command from the File menu.
2. Enable the Software Utilization Data option.
3. Click the Memory tab.
4. Click OK.

Viewing Software Utilization Data in the Windows
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Software Utilization Data can be viewed in the Files and Applications Windows. In addition a link is
provided to the Details Window.

Applications Window

Two columns are available:

Column  Description

Utilization = This shows the number of days that the application was used (as a percentage) over
a period of time.

Usedon  The machine the application was used on.

You can drill down to the detail level to see the individual results in the Details window.
Files Window

Two columns are available:

Column  Description

Utilization = This shows the number of days that the application was used (as a percentage) over
a period of time.This shows the first instance of the value. If an asterisk is shown
next to the value then it means that more than one instance of the file was found and
you can see further details in the Files Details window.

Attribute = A u (Utilized file) attributes indicates that this file was executed and the application
was used.

SAl Editor Overview

This guide describes the features of the SAI Editor and explains how to explore and modify the
contents of a User SAI. For more detailed information about using the SAI Editor to “teach” new
applications, see Application Teaching.

The SAl editor is a standalone tool. If the SAls change on the Data Flow Probe, the Administrator
must update the SAls on all systems where the client tools installed.

Starting the SAI Editor
The SAI Editor can be started in the following ways:

¢ From the Recognition > View/Edit SAls menu item in the Analysis Workbench

o As a standalone utility from the Windows Start menu
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SAIl Editor User Interface

The Overview tab

Shows the SAls loaded and details of the data items contained in them.

Note: The Overview tab is only visible when you start the SAI Editor from within the Analysis
Workbench application.

The following details are shown for each of the SAl files loaded:
o SAI File—Name of the SAl file.

o SAI ID—Unique ID for the SAl file. This is relevant to User SAl files only. Master SAls do not
have an ID.

¢ File Names—Number of file names contained in the SAI.
¢ Versions—Number of software versions in the SAI.

o Applications—Number of applications in the SAI.

o Publishers—Number of publishers in the SAI.

¢ Relations—Number of license relations in the SAI.

Right-Click Menus

If you right-click an entry on the Overview tab, the Export summary to XML option is available.
The XML summary is saved to the following file:
<DataFlowProbelnstallation>\runtime\probeManager\discoverySaiResources\saiRuntime
where <dataflowprobeinstallation> is the location where the Data Flow Probe is installed.
Buttons on the Overview Tab

There are three buttons on this tab:
« Save—Saves any modifications made to the User SAls.

+ Reload—Discards any unsaved changes to the User SAls, reloads the existing ones from disk,
and re-organizes all affected file entries.

e Close—Closes the application and causes re-recognition to occur.

Editor Tab

The Editor tab is where you can see the contents of the SAl files in detail. In addition, you can
perform many tasks here.
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Note: The main menu bar is not available in the built-in SAI Editor of the Analysis Workbench.
However, this bar is available in the standalone version.
The Left Navigation Pane

The left navigation pane for this tab shows an icon list of the SAl files that can be viewed. The
following icons are used to represent User and Master SAl files.

Icon Description
_:D This icon represents a User SAl file.
_: This icon represents a Master SAl file.

Click the icon to view the contents of that particular SAl file.
Right-click Options for the Left Navigation Pane

The following menu items are available when you right-click an SAl file icon in the left navigation
pane.

Menu Item Description

New User | Enables you to create a new empty User SAl file.
SAI

Export SAl | Opens the SAlI XML Export dialog box, which enables you to export the contents of
to XML the selected User SAl file to XML format.

Unload SAlI ' Unloads the selected SAI from the SAI Editor.

Edit This option is only available for User SAl files. It enables you to change the label
Description = associated with this file.

The Editor Tab Toolbar

The following toolbar icons enable you to access various SAl Editor commands. When the mouse
pointer passes over anicon, a tool tip indicates the command that corresponds to that icon.

Icon Description

= Create a new empty User SAI

= Save changes made to User SAl files

&y Export the contents of a User SAl in XML format
a) Search for entries in an SAI file

E Set SAI Editor options
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Sub-Tabs on the Editor Tab

The Editor tab consists of the following eight sub-tabs:
o All Contents

o Files

o Application Types
¢ Operating Systems
¢ Languages

o License Relations
o Package Rules

o Version Data Rules
o All Contents

o Files

o Application Types
¢ Operating Systems
¢ Languages

o License Relations
o Package Rules

o Version Data Rules

The Application Types, Operating Systems and Languages sub-tabs are static pages and are pre-
populated by Hewlett Packard. You can, however, add new items to the Application Types and
Operating Systems sub tabs for your User SAI.

Icons Used on the Editor Tab

The SAI Editor displays a hierarchical structure of software publishers, application names,
releases, application versions, and files contained in the SAl files. The following icons are used to
represent these items.

Icon Description

All Contents Tab
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Icon Description

& Software Publisher

This is the name of the company or corporation that released the software application.
For example, Hewlett-Packard is a software publisher.

| Application Name
This is the name of the software program.
(3 Release

When a publisher releases updates for an existing version of one of their products, they

typically don't change the name of that version. Any particular version of a product could
have several updates toit. In this scenario, the SAI Editor refers to the umbrella version

as the Release, and to each of the updates as an application Version.

= Application Version
See description above

[y File

Each file is categorized as Main, Associated, or 3rd Party.

Files Tab

[ File
Eachfile is categorized as Main, Associated, or 3rd Party.
[m) Main File

This is a key application file—that is, a file without which the application could not be
running. It should always be present whenever the application is installed regardless of
whether it is a minimum or complete installation.

) Associated File

This is a non-key file that is part of the application and is written by the publisher that
developed the product.

3 3rd Party File

This is a file written by another Publisher (3rd Party) and is used in the current
application. An example of 3rd party files is some DLL files that are technically used by
the application but are also distributed freely and can be used by other applications.

Application Types Tab

This icon represents the different applications software categories (for example, word
processor and spreadsheet).
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Icon Description

Operating Systems Tab

Pt

(& This icon represents Operating Systems.
Languages Tab
@‘j This icon represents languages.

License Relations Tab

{';_'j Indicates that this application also licenses another application.
{l_"j Indicates that this application is licensed by another application.
g‘] Indicates that this application both licenses and is licensed by another application.

Package Rules Tab
8 This icon represents installed package rules.
Version Data Rules Tab

| This icon represents version data rules.

Icon Description
All Contents Tab

s Software Publisher

This is the name of the company or corporation that released the software application.
For example, Hewlett-Packard is a software publisher.

| Application Name
This is the name of the software program.
[ Release

When a publisher releases updates for an existing version of one of their products, they

typically don't change the name of that version. Any particular version of a product could
have several updates toit. In this scenario, the SAI Editor refers to the umbrella version

as the Release, and to each of the updates as an application Version.

',f'_:-aj Application Version

See description above

[ File

Each file is categorized as Main, Associated, or 3rd Party.
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Icon Description
Files Tab
[ File
Each file is categorized as Main, Associated, or 3rd Party.
[m] Main File

This is a key application file—that is, a file without which the application could not be
running. It should always be present whenever the application is installed regardless of
whether it is a minimum or complete installation.

B Associated File

This is a non-key file that is part of the application and is written by the publisher that
developed the product.

3 3rd Party File

This is a file written by another Publisher (3rd Party) and is used in the current
application. An example of 3rd party files is some DLL files that are technically used by
the application but are also distributed freely and can be used by other applications.

Application Types Tab

This icon represents the different applications software categories (for example, word
processor and spreadsheet).

Operating Systems Tab

@ This icon represents Operating Systems.
Languages Tab
@? This icon represents languages.

License Relations Tab

{';_'j Indicates that this application also licenses another application.
f?j Indicates that this application is licensed by another application.
g‘] Indicates that this application both licenses and is licensed by another application.

Package Rules Tab
| This icon represents installed package rules.
Version Data Rules Tab

| This icon represents version data rules.

Buttons on the Editor Tab
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The following buttons are available only when you start the SAI Editor from the Analysis
Workbench.

Button Function
Save Saves any modifications made to the User SAI.

Reload Discards any unsaved changes to the User SAl, reloads the existing one from disk,
and re-organizes all affected file entries.

Close | Closes the SAI Editor. If you have made any changes, the SAI Teaching Options dialog
box is displayed. Set the teaching options as follows:

o Recognition
» Uselevel 3 heuristics—SAl teaching uses the same recognition method that is
used during the loading process.
o If Level 3 heuristics are enabled, teaching a single file will reprocess all files
on all machines on which that file occurs.

o If Level 3 heuristics are disabled, teaching a single file will cause all files in all
directory/machine combinations where the file occurs to be re-recognized.

e Save changes to SAI
= When AW exits—Any changes to the SAl are saved when you exit the Analysis
Workbench application.
= Immediately—Any changes to the SAl are saved immediately.
e Tagchanged items
Selecting this option makes the following further options available:

= Files—Any files that are affected by the SAIl teaching are tagged.

= Applications—Any applications that are affected by the SAl teaching are
tagged.

= Directories—Any directories that are affected by the SAl teaching are tagged.
= Machines—Any machines that are affected by the SAl teaching are tagged.

= Set Local Tags—If this option is selected, Local Tags are used for the
operations.

= Set Global Tags—If this option is selected, Global Tags are used for the
operations.

o Set options as default

Select this box to retain these settings as the default for future Close operations.
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Incremental Searching, Sorting, and Moving Columns

Incremental Search

You can use the incremental search feature to locate an entry in the tree. To perform an incremental
search, click the tab that you want to search, and type the word(s) or number(s) that make up the
entry that you want to locate. The window automatically locates the closest existing value in the
currently visible nodes in the tree.

For example, highlight the Master SAI file in the left navigation pane. Click the All Contents tab, and
type Microsoft. The Microsoft publisher node is located and highlighted.

The entry that you want to locate must be visible in the tree—it cannot be in a branch that is
currently collapsed. For example, if only Publisher nodes are visible in the tree on the All Contents
tab, you can only search for publishers. If you expand a Publisher node, you can also search for
applications associated with that publisher.

It is necessary to type quickly to perform an incremental search. If you type too slowly, the search
may not produce the result you expect. For example, if you type M and then wait a second or two,
the first publisher beginning with “M” will be highlighted. If you then type I, the first publisher starting
with “I” will be highlighted.

Sorting Entries in a Column

Click the column heading to sort the contents of that column. The default sort order is ascending.
This command sorts text alphabetically, numerically, or by date in ascending or descending order.
Click the column heading to toggle the sort order.

Moving Columns to a New Position

Columns on the Editor tab can be moved to any position on the page. To do this, drag the column
heading to the location you want.

The Operating Systems Tab

Note: You can only edit User SAl files.

Viewing Data in the Operating System Tab

The Operating Systems tab shows a view of the different operating systems you can allocate to
entries in the SAl files. Examples of these categories are:

e Windows Vista
e Solaris 10
e Linux 2.6

These entries are pre-populated by Hewlett-Packard. However, you can add new items to this tab
for your User SAI.

The following information is shown for each entry in this tab:
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o Operating System—the name of the Operating System.

o Short Name—the abbreviated name for the Operating System. For example, Windows Vista is
represented as Vista.

o ID—the unique identifier for this operating system type entry. This column is only shown if the
Show ID Column option was enabled in the SAI Editor Options dialog. See Setting Properties for
the SAI Editor for more information.

Adding a New Operating System

This procedure is used to add a new operating system to a User SAI.

To add a new operating system to a User SAI:
1. Right-click the root User SAl entry in the tree. It is the first entry (the root) of the tree.
2. Select the New Item option.

The Operating System Properties box is displayed.
Enter the following details for the new operating system.

= Name. Name of the new operating system (must be entered)

= Shortname. The abbreviated name for the Operating System. For example, Windows Vista
is represented as Vista.

3. Click OK to add the new operating system to the SAlI file.

Note: Before adding an operating system to the file, check to see whether the entry already
exists.

Deleting an Existing Operating System

This procedure is used to delete an existing operating system from a User SAI.

To delete an existing operating system:
1. Inthe tree, right-click the operating system to be deleted.
2. Select the Delete option or hit the Delete key on your keyboard.

A confirmation message is displayed.

3. Click Yes to delete the operating system.

Editing the Properties for an Existing Operating System

This procedure is used to edit the properties for an operating system.

To edit the properties for an existing operating system:
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1. Inthe tree, right-click the operating system to be edited.
2. Select the Properties option.

The Operating System Properties box appears.
Edit the details as required.

= Name. Name of the new operating system (must be entered)

= Short Name. The abbreviated name for the Operating System. For example, Windows Vista
is represented as Vista.

3. Click the OK button to complete the edit.

After the operating system details have been edited, the amended details are displayed in the
tree.

The Application Types Tab

Note: You can only edit User SAl files.

Viewing Data in the Application Type Tab

The Application Type tab shows a view of the different types of software application categories you
allocate to entries in the SAI files. Examples of these categories are:

o Database
e Developer Tools
o Word Processing

o Web Servers

These entries are pre-populated by Hewlett-Packard. However, you can add new items to this tab
for your User SAl.

The following information is shown for each entry in this tab:
o Application Type—the category of software

o ID—the unique identifier for this application type entry. The application type IDs supplied in the
master SAI correspond to UNSPSC standard codes for these application types.

This column is only visible if the Show ID Column option was enabled in the SAl Editor Options
dialog. See Setting Properties for the SAl Editor for more information.
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Adding a New Application Type
This procedure is used to add a new application type to a User SAI.

To add a new application type to a User SAI:
1. Right-click the root User SAl entry in the tree. It is the first entry (the root) of the tree.
2. Select the New Item option.

The Application Type Properties box is displayed.

3. Enter the name of the new application type (must be entered).

4. Click OK to add the new application type to the SAl file.

Note: Before adding an application type to the file, check to see whether the entry already
exists.

Deleting an Existing Application Type
This procedure is used to delete an existing application type from a User SAI.

To delete an existing application type:
1. Inthe tree, right-click the application type to be deleted.
2. Select the Delete option or hit the Delete key on your keyboard.

A confirmation message is displayed.

3. Click Yes to delete the application type.

Editing the Properties for an Existing Application Type

This procedure is used to edit the properties for an application type.

To edit the properties for an existing application type:
1. Inthe tree, right-click the application type to be edited.
2. Select the Properties option.

The Application Type Properties box appears.
3. Edit the details as required.

4. Click the OK button to complete the edit.

After the details have been edited they are displayed in the tree.
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The Files Tab

Note: You can only edit User SAl files.

Viewing Information on the Files Tab

Click the + (plus) sign next to a File to expand the tree.
All the instances of that file in the SAl are shown:

The following information is shown in the columns:
o The relation of the file to the application. This is indicated by the following icons:
= Main File[n]
This is a key application file, that is, it is a file without which the application could not be running. It

should always be present whenever the application is installed regardless of whetheritis a
minimum or complete installation.

= Associated FiIeEI

This is a non-key file that is part of the application and is written by the publisher that developed
the product.

= Third Party File &

This is a file written by another Publisher (3rd Party) and is used in the current application. An
example of a 3rd party files is some DLL files that are technically used by the application, but are
also distributed freely and can be used by other applications.

o Filename—the name of the file.
o Size—the size of thefile.
« Signature—the signature is a checksum of the first 8 Kilobytes of afile.

« Exe Type—the type of executable file (for example, Win32 exe, Linux x86 ELF, or SPARC
ELF).

o ID—the unique identifier for the file entry. This column is only shown if the Show ID Column
option was enabled in the SAI Editor Options dialog. See Setting Properties for the SAI Editor for
more information.

o Publisher—the publisher of this file.

« Application—the application that this file belongs to.

o App Type—the type of the application (for example, Word Processor or Spreadsheet).

+ Release—the software release that this file belongs to.
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o Version—the software version that this file belongs to
o Language—the language of the application version that this file belongs to.
o 0OS —the operating system on which the application version that this file belongs to runs.

o Version Data—The combination of key version data fields of the file. It is automatically
populated.

Editing the Properties for Files in the Files Tab

Only one option is available for the Files tab. This is the Properties option.

To edit the properties for a file:
1. Expand the tree to select the instance of the file.
2. Right-click the file to be edited, and select the Properties option.

The File Properties box appears.
Edit the details as required.

s Size
= The size of the file
= Care about Size

When this option is enabled, the size of the file is used as a recognition criteria. When
disabled, file size will not be used in recognition and N/A will be displayed in the size column.

Note: Be careful when disabling this setting, especially for main files. If the setting is
disabled, only the match on the file name is needed to produce a good file match — and if the
file is main, simply the presence of the file in the scan file will cause the application to be
recognized.

= Relation to App

The Relation to App shows whether the file is a Main, Associated or 3rd Party file. See Viewing
Information on the Files Tab for definitions of these terms.

= Signature

The signature is a checksum of the first 8 Kilobytes of a file.

= ExeFile Type

The type of executable file (for example, Win32 exe, Linux x86 ELF, or SPARC ELF).

= Version Data
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The combination of key version data fields of the file. It is automatically populated and you are
not recommended to modify it manually.

3. Click the OK button to complete the edit.

Once the details have been edited, the amended details are displayed in the tree.

The All Contents Tab

The All Contents tab displays a a hierarchical structure of software publishers, application names,
releases, application versions, and files contained in the SAl file.

Viewing Information in the All Contents Tab
1. Click the + (plus) sign next to a Publisher to expand the tree.

All the Applications by that software publisher are shown.

2. Expand an Application to display the Releases for it.

3. Expand a Release to display the Versions of that particular software application release that
are in the database.

4. Expand a Version of the software to display the Files for that version.
The following information is shown in the columns:

o Size-The size of the file

Signature - The signature is a checksum of the first 8 Kilobytes of afile.
« Exe Type - This indicates the type of the executable (for example, Win32 exe).

« Relation - Whether the file is a Main, Associated, or 3rd Party file. See Viewing Information on
the Files Tab for definitions of these terms.

o ID - The unique identifier for that particular entry. This column is only shown if you selected the
Show ID Column option in the SAI Editor Options dialog box. See page Setting Properties for the
SAl Editor for further information.

Note: If none of the files identified for a particular version has the relation of Main file for that
version, the version will be displayed in red in the SAI Editor to highlight this fact. The reason to
flag this condition is that if a version does not have one or more Main files, the application will
not be recognized. So you must identify one or more files with the relation of Main if you want
application recognition to occur. There are only a few cases when it makes sense to teach an
application without a Main file. These would include, for example, a set of drivers or internal
utilities for which it is convenient to have corresponding files recognized, but it is not important
to report them as individual applications.

Right-Click Menus
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Different right-click menus are available for different nodes of the Publisher tree.

Node
Root - the User SAI

Publisher

Application

Release

Version

File

Node
Root - the User SAI

Publisher

HP Universal CMDB (10.10)

Menus Available

New Item

Delete
New ltem

Properties

Edit Application
Rules

Delete

New ltem

Properties

Explore License Relations
Delete
New Item

Properties

Delete
New ltem

Properties

Delete
Properties

Relationship to Application

Menus Available

New Item

Delete
New ltem

Properties
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Node Menus Available

Application o Edit Application
e Rules
o Delete
o New Item

e Properties

Release e Explore License Relations
e Delete
e New ltem

e Properties

Version o Delete
e New ltem

o Properties

File e Delete
e Properties

¢ Relationship to Application

Note: Master SAls are read-only, so menu items relating to editing the SAl content are
disabled for Master SAls.

Adding a New Publisher

This procedure is used to add a new software publisher to a User SAI.

To add a new software publisher to a User SAI:
1. Right-click the root User SAI File entry in the tree. It is the first entry (the root) of the tree
2. Select the New Item option.

The Publisher Properties box is displayed.

3. Enterthe Name and Description for the new software publisher.

Note: Ensure that the Publisher Name is spelled correctly. Before adding a publisher name
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to the file, check whether the entry for the publisher already exists in the Master SAl file.

4. If the publisher already exists in the Master SAI, copy it from the Master SAl to your User SAI.

Deleting an Existing Publisher

This procedure is used to delete an existing software publisher from a User SAI.

To delete an existing publisher:
1. Inthe tree, right-click the software publisher to be deleted.
2. Select the Delete option or hit the Delete key on your keyboard.

A confirmation message is displayed.

3. Click Yes to delete the software publisher and all its associated sub-items.

Editing the Properties for an Existing Publisher

This procedure is used to edit the properties for a software publisher.
1. Inthe tree, right-click the software publisher to be edited.
2. Select the Properties option.

The Publisher Properties box appears.

3. Edit the details as required.
4. Click the OK button to complete the edit.

Once the publisher details have been edited, the amended details are displayed in the tree.

Merging the Contents of Publishers

You can merge the contents of a software publisher with another publisher within the same SAI so
that they are contained under the same entry. You would do this, for example, if a software
publisher has been acquired by another company.

To merge the contents of publishers:
1. Drag and drop the publisher to another publisher entry in the tree.

A confirmation dialog box is displayed.

2. Click the OK button to accept the merge.

Copying Publisher Contents to Another User SAI

You can merge the contents of a software publisher to a different User SAI.

To copy a publisher to another SAI:
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Drag and drop the publisher into the appropriate User SAl entry in the left hand pane of the Editor.

The publisher entry is copied to the other SAI. This will only copy the publisher information. If you
want to copy the file-level data to the other User SAI, you should select the files that you want to
copy and then drag and drop the data into the appropriate User SAI.

Alternatively, you can hold down the CTRL key and drag the publisher to another SAI. This will
result in a “deep” copy that will copy the publisher and all of its child items (applications, releases,
versions, and files).

Moving the Contents of a Publisher to Another Publisher Within the Same
SAl

You can move the contents of a publisher to another publisher within the same SAI.

To move the contents of a publisher to another publisher within the same SAI:

1. Select the applications under the publisher and drag them to the publisher to which you want to
move them.

A confirmation dialog box is displayed.

2. Click the OK button to accept the move.

Adding a New Application

This procedure is used to add a new software application to a User SAI.

To add a new software application to a User SAI:
1. Right-click the appropriate software publisher entry in the tree.
2. Select the New Item option.

The Application Properties box is displayed.

3. Enterthe Name and Description for the new software publisher.

4. From the Application Type drop-down list, select the software category that the application
falls under (for example, word processor software or spreadsheet software).

Ensure that the Application Name is spelled correctly. Before adding an application name to the
file, check whether the entry for the application already exists in the SAI file.

Deleting an Existing Application

This procedure is used to delete an existing software application from a User SAI.

To delete an existing application:
1. Inthe tree, right-click the software application to be deleted.

2. Select the Delete option or press the DELETE key on your keyboard.
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A confirmation message is displayed.

3. Click Yes to delete the software application and all its associated sub-items.

Editing the Properties for an Existing Application

This procedure is used to edit the properties for a software application.

To edit the properties for an existing application:
1. Inthe tree, right-click the software application to be edited.
2. Select the Properties option.

The Application Properties box appears.

3. Edit the details as required.
4. Click the OK button to complete the edit.

After the application details have been edited, the amended details are displayed in the tree.

Editing the Application Rules

Application rules are used for software recognition. You can teach Universal Discovery how to
recognize a new application — or a new version of an existing application — by creating recognition
rules.

To edit an application’s rules:
1. Inthe tree, right-click the software application that you want to work with.
2. Select Edit Application Rules. The Application Rules Editor opens.
3. Choose one of the following actions:
= To modify an existing rule, select the rule, and click Edit.
= Tocreate a new rule, click Add.
= Todelete an existing rule, select the rule, and click Remove.

See the Rule-Based Application Teaching on page 348 for information about creating and modifying
recognition rules.

Merging Applications Within the Same SAI

You can merge the contents of an application with another application within the same SAI so that
they are contained under the same entry.

To merge the contents of applications:
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1. Drag and drop the application onto another application entry in the tree.

A confirmation dialog box is displayed.

2. Click the OK button to accept the merge.

Copying an Application to Another User SAI

You can copy a software application to a different User SAI.
To copy a software application to another SAI:
Drag and drop the application into the appropriate User SAI entry in the left hand pane of the Editor.

The application and the publisher entries are copied to the other SAI. If the publisher for this
application does not already exist in new User SAl, it will be copied into it automatically.

Alternatively, you can hold down the CTRL key and drag the application to another SAI. This will
result in a “deep” copy that will copy the application and all of its child items (releases, versions, and
files).

Moving an Application to Another Publisher Within the Same SAI

You can move an application to another application publisher within the same SAI.

To move an application to another publisher within the same SAl:
1. Select the application and drag it to the publisher you want it moved to.

A confirmation dialog box is displayed.

2. Click the OK button to accept the move.

Adding a New Release

This procedure is used to add a new software release to a User SAI.

To add a new software release to a User SAI:
1. Right-click the appropriate software application entry in the tree.
2. Select the New Item option.

The Release Properties box is displayed.

3. Enterthe Name for the new software release.

Note: Ensure that the Release is spelled correctly. Before adding a release to the file,
check whether the entry for the release already exists in the SAl file.

Deleting an Existing Release

This procedure is used to delete an existing software release from a User SAI.

To delete an existing release:
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1. Inthe tree, right-click the software release to be deleted.
2. Select the Delete option or hit the Delete key on your keyboard.

A confirmation message is displayed.

3. Click Yes to delete the software release and all its associated sub-items.

Editing the Properties for an Existing Release

This procedure is used to edit the properties for a software application.

To edit the properties for an existing release:
1. Inthe tree, right-click the software release to be edited.
2. Select the Properties option.

The Release Properties box appears.

3. Edit the details as required.
4. Click the OK button to complete the edit.

After the release details have been edited, the amended details are displayed in the tree.

Merging Releases

You can merge the contents of a release with another release within the same SAl so that they are
contained under the same entry.

To merge the contents of releases:
1. Drag and drop the release onto another release entry in the tree.

A confirmation dialog box is displayed.

2. Click the OK button to accept the merge.

Copying a Release to Another User SAI

You can copy a software release to a different User SAL.
To copy a software release to another SAI:
Drag and drop the release into the appropriate User SAl entry in the left hand pane of the Editor.

The release, application name and publisher are copied to the other SAI. If the publisher and
application for this release do not already exist in new User SAI, they will be copied into it
automatically.

Alternatively, you can hold down the CTRL key and drag the release to another SAI. This will result
in a “deep” copy that will copy the release and all of its child items (versions and files).
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Moving a Release to Another Application Within the Same SAlI

You can move a software release to another application within the same SAI.

To move a software release to another application within the same SAI:

1. Select the release, and drag it to the application to which you want it moved.

A confirmation dialog box is displayed.

2. Click the OK button to accept the move.

Adding a New Version

This procedure is used to add a new software version to a User SAI.

To add a new software version to a User SAI:

1. Right-click the appropriate software release entry in the tree.

2. Select the New Item option.

The Version Properties box is displayed.

Enter the following details for the new software version.

= Name. Name of the new version (must be entered)

= Description. This is a user defined field that can contain any text.

= Install Strings

o This is the text that the installer of the program uses to describe the software in the Control

Panel > Add/Remove programs (Windows prior to Windows Vista), Control Panel >
Programs and Features (Windows Vista and above), or the operating system package
manager (UNIX/Mac OS X).

Normally there is only one install string, which is entered on the first line of the entry field.
Occasionally, it may be necessary to make a match based on multiple install strings. For
example, if you add a service pack for a product, there may be an install string for the
service pack, in addition to the install string for the product itself. In this case, the install
string match should be based on both install strings. You can enter additional install strings
on the subsequent lines of this entry field.

The install strings can also be found from the Hardware and Configuration tab and the
Operating System Data and Operating System Installed Application Description columns
for the Windows applications.

= Operating System

The Base Operating System of the application version (for example, Windows Vista). Select
the Base OS from the drop-down list.
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= Language

Select the language of the application version from the drop-down list.

3. Click OK to add the new software version to the SAl file.

Note: Before adding a software version, check whether the entry already exists in the SAI
file.

1. Right-click the appropriate software release entry in the tree.
2. Select the New Item option.

The Version Properties box is displayed.
Enter the following details for the new software version.

= Name. Name of the new version (must be entered)
» Description. This is a user defined field that can contain any text.
= Install Strings

o This is the text that the installer of the program uses to describe the software in the Control
Panel > Add/Remove programs (Windows prior to Windows Vista), Control Panel >
Programs and Features (Windows Vista and above), or the operating system package
manager (UNIX/Mac OS X).

o Normally there is only one install string, which is entered on the first line of the entry field.
Occasionally, it may be necessary to make a match based on multiple install strings. For
example, if you add a service pack for a product, there may be an install string for the
service pack, in addition to the install string for the product itself. In this case, the install
string match should be based on both install strings. You can enter additional install strings
on the subsequent lines of this entry field.

o Theinstall strings can also be found from the Hardware and Configuration tab and the
Operating System Data and Operating System Installed Application Description columns
for the Windows applications.

= Operating System

The Base Operating System of the application version (for example, Windows Vista). Select
the Base OS from the drop-down list.

= Language

Select the language of the application version from the drop-down list.

3. Click OK to add the new software version to the SAl file.
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Note: Before adding a software version, check whether the entry already exists in the SAI
file.

Deleting an Existing Version

This procedure is used to delete an existing software version from a User SAI.

To delete an existing version:
1. Inthe tree, right-click the software version to be deleted.
2. Select the Delete option or hit the Delete key on your keyboard.

A confirmation message is displayed.

3. Click Yes to delete the software version and all its associated sub-items.

Editing the Properties for an Existing Version

This procedure is used to edit the properties for a software version.

To edit the properties for an existing version:
1. Inthe tree, right-click the software version to be edited.
2. Select the Properties option.

The Version Properties box appears.

3. Edit the details as required.
4. Click the OK button to complete the edit.

After the version details have been edited, the amended details are displayed in the tree.

Merging Versions

You can merge the contents of a version with another version within the same SAI so that they are
contained under the same entry.

To merge the contents of versions:
1. Drag and drop the version onto another version entry in the tree.

A confirmation dialog box is displayed.

2. Click the OK button to accept the merge.

Copying a Version to Another User SAI

You can copy a software version to a different User SAI.

To copy a software version to another SAI:

HP Universal CMDB (10.10) Page 191 of 311



Inventory Tools User Guide
Contents

Drag and drop the version into the appropriate User SAl entry in the left hand pane of the Editor.

The version, release, application name and publisher are copied to the other SAI. If the publisher,
application and release for this version do not already exist in new User SAl, they will be copied into
it automatically.

Alternatively, you can hold down the CTRL key and drag the version to another SAI. This will result
in a “deep” copy that will copy the version and all of its child items (files).

Moving a Version to Another Release Within the Same SAI

You can move a software version to another release within the same SAI.

To move a software version to another release within the same SAI:
1. Select the version entry and drag it to the release you want it moved to.

A confirmation dialog box is displayed.

2. Click the OK button to accept the move.

Adding a File

There are two methods of adding a new file to a User SAI.

Method 1—Add a new file to a User SAIl using the Editor:
1. Right-click the appropriate software version entry in the tree.
2. Select the New Item option.

The Filename box is displayed.

3. Enterthe name of the file and click the OK button. The File Properties dialog box is displayed.
4. Enter the following details for the file:

» Size

= The size of the file

= Care about Size

When this option is enabled, the size of the file is used as a recognition criterion. When
disabled, file size will not be used in recognition, and N/A will be displayed in the size column.

Note: Be careful when disabling this setting, especially for main files. If the setting is
disabled, only the match on the file name is needed to produce a good file match — and if
the file is main, simply the presence of the file in the scan file will cause the application to
be recognized.

= Relation to App
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Whether the file is a Main, Associated or 3rd Party file. See Viewing Information on the Files
Tab for definitions of these terms.

= Signature

The signature is a checksum of the first 8 Kilobytes of a file.
Note: If the signature is unknown, use FFFF-FFFF.

n Exe File Type

The type of executable file (for example, Win 32 exe or Archive).

5. Click OK to add the new file to the SAI.

Note: Ensure that the file name is spelled correctly. Before adding the file, check whether it
already exists for this version.

Method 2—Add a new file to a User SAl using Windows Explorer:
Using Windows Explorer you can automatically add the file to the software version.
In Windows Explorer, navigate to the file you want to add.

Drag the file onto the version in the SAI Editor. The file will be added to the version automatically
with the properties details filled in. These properties can be amended as necessary - see Editing the
Properties for Files in the Files Tab on page 279 for information on how to do this.

Deleting an Existing File

This procedure is used to delete an existing file from a User SAI.

To delete an existing file:
1. Inthe tree, right-click the file to be deleted.
2. Select the Delete option or hit the Delete key on your keyboard.

A confirmation message is displayed.

3. Click Yes to delete the file.

Editing the Properties for an Existing File

This procedure is used to edit the properties for a file. For more information, see Editing the
Properties for Files in the Files Tab.

Copying a File to Another User SAI

You can copy afile to a different User SAI.

To copy afile to another SAI:
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Drag and drop the file into the appropriate User SAl entry in the left hand pane of the Editor.

The file is copied to the other SAIl. If the publisher, application, release and version for this file do
not already exist in new User SAl, they will be copied into it automatically.

Note: You can select multiple files by pressing the SHIFT key and clicking on the files.

Moving a File to Another Version Within the Same SAI

You can move a file to another version within the same SAI.

To move afile to another version within the same SAI:
1. Select thefile entry and drag it to the version you want it moved to.

A confirmation dialog box is displayed.

2. Click the OK button to accept the move.

Setting Relationship to Application

This procedure enables you to change the relationship of multiple files to the application. To change
the relationship of one file to the application, see the Editing the Properties for Files in the Files Tab.

To set relationship to application:

1. Inthe tree, right-click the file(s) to be edited. To select multiple files, hold the SHIFT key while
clicking on the files.

2. Select the Relationship to Application option.

3. Select one relationship from the Main, Associated, and 3rd Party options.

Note: See Viewing Information on the Files Tab for definitions of these terms.

After you edit the file details, the amended details are displayed in the tree.

The Language Tab

Note: You can only edit User SAl files.

Viewing Data in the Languages Tab

The Languages tab shows a view of the different languages you can allocate to entries in the SAl
files. Examples of these categories are:

e Dutch

e English
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o French

These entries are pre-populated by Hewlett-Packard. You cannot add new items to this tab.

The following information is shown for each entry in this tab

« Language - The name of the language.

e Code - The ISO standard code for the language.

« ID - The unique identifier for this language type entry. This column is only shown if the Show ID

Column option was enabled in the SAI Editor Options dialog. See Setting Properties for the SAI
Editor for more information.

Viewing Properties for a Language

This procedure is used to view the properties for a language.

To view the properties for a language:
1. Inthe tree, right-click the language.
2. Select the Properties option.

The Language Properties box is displayed.

The License Relations Tab

Note: You can only edit User SAl files.

Viewing Data in the License Relations Tab

This tab provides a view of the license relationships that exist in the SAI.

Click the + (plus) sign next to a License Relation to expand the tree. All applications contained in
the suite are shown along with their license relationship to the suite.

Icons represent the relationship of the various applications to the application suite as follows:
. {'?I Indicates that this application also licenses another application.
. Ehl Indicates that this application is licensed by another application.

. gl?l Indicates that this application both licenses and is licensed by another application.
The following information is shown about each application in the license relationship.

« Item—the name of the publisher, application, and release.
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o ID—the unique identifier for this entry. This column is only shown if the Show ID Column option
was enabled in the SAI Editor Options dialog. See Setting Properties for the SAI Editor for more
information.

Viewing Details for a License Relation

To view more details for a license relationship:
1. Right-click an application in the License Relation tab, and select the Go To option.

The application release will be automatically selected and displayed on the All Contents tab.

2. Onthe All Contents tab, right-click the entry, and select Explore license relations.

This will display the license relationship editor. Here you can view the relationship in greater
detail or you can make changes to the relationship as required.

See The License Relations Tab for further information about setting up and editing a license
relationship.

Editing the Properties for an Existing License Relation

This procedure is used to edit the properties for a release.

To edit the properties for an existing release:
1. Inthe tree, right-click the release to be edited.
2. Select the Properties option.

The Release Properties box appears.

3. Edit the Name of the release (must be entered)
4. Click the OK button to complete the edit.

Once the details have been edited they are displayed in the tree.

Setting Properties for the SAI Editor

Opening the SAI Editor Options Dialog Box

To open the SAI Editor Options dialog box, click the SAl Editor Options button on the toolbar on
the Editor tab.

The General Tab

The General tab enables you to set the following options:
¢ Show ID Column

Checking this option will display an ID column in all the tabs. IDs are assigned to each entry in the
User SAL. When you copy or create an entry, anew ID is assigned to that entry.
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o Hide items without files (in read-only SAls)

This option provides you with a cleaner view. It hides any entries that are empty—that is, entries
that do not have files in them. This option is for the Master SAI only.

o Automatically save modified SAls on exit

All modifications made to the User SAls will be automatically saved when you exit the SAI Editor
application.

¢ Re-enable all error messages

Checking this option will re-enable all error messages that you have previously disabled.

The SAl List Tab
The options on the SAI List tab enable you to:

o Add anew SAl file to be viewed or edited.
¢ Remove an existing SAl file.
o Create a new empty User SAl file.

The list box on this tab displays the following information for all currently loaded SAls:

Column

Name Contents

SAl file The path to source files for the SAl—both read-only Master SAls and User SAI
files.

SAI ID The SAI ID number for User SAl files. Master SAI files do not have an ID.

Description A description of the SAl files.

Size/kB The size of each SAl file (in kilobytes).
Versions The number of application versions in each SAl.
Type The type of SAl file:

o Master SAI - Read-only SAI

o User SAI - Editable SAI

Date The creation date for a Master SAl file or for a User SAI, the date the file was
last saved.
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Column
Name Contents
SAl file The path to source files for the SAl—both read-only Master SAls and User SAI
files.
SAI ID The SAI ID number for User SAl files. Master SAI files do not have an ID.

Description A description of the SAl files.

Size/kB The size of each SAl file (in kilobytes).
Versions The number of application versions in each SAl.
Type The type of SAl file:

o Master SAI - Read-only SAI

o User SAI - Editable SAI

Date The creation date for a Master SAl file or for a User SAI, the date the file was
last saved.

Storing Rule-Created Items

Any items encountered by the SAI Editor that were created by rules will be added to the SAl file
specified in the SAls used to store rule-created items box. These rules are present within the SAI
files themselves. You can add more rules by using the SAI Editor.

To specify the SAI file used to store rules that you create:

Select the SAl file from the drop-down list. The drop-down list contains a list of the SAls currently
loaded.

If this field is left blank, the SAI Editor will create a file called Auto.zsai and put this in the same
location as the first Master SAl.

For information about application teaching using rules, see Rule-Based Application Teaching.
Adding a New SAI File for Application Recognition

In addition to any SAl files already listed on the SAI List tab in the SAI Options dialog box, you can
specify one or more other SAl files to use for application recognition.

To add a new SAl file for application recognition:
1. Inthe SAI Editor Options dialog box, select the SAI List tab.
2. Click the Add button on this tab.
3. Navigate to and select the SAI file (Master or User) that you want to load.

The SAl file is added to the list box which means the file will be included in the SAI Editor ready for
you to view or edit.
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Note: To import new SAl files, uncompress the SAl.zip archive file that is contained in the
content pack and copy it on the client machine that is running Inventory Tools. Alternatively,
you can export the SAl.zip archive file by using the package manager.

Removing an Existing SAIl File

You can remove any of the SAl files listed on the SAl List tab in the SAI Options dialog box. When
you remove an SAl file, it is no longer available in the SAI Editor.

To remove an existing SAl file:
1. Inthe SAI Editor Options dialog box, select the SAI List tab.
2. Inthelist box, select the SAI file that you want to remove.
3. Click the Remove button.
1. Inthe SAI Editor Options dialog box, select the SAI List tab.
2. Inthelist box, select the SAI file that you want to remove.
3. Click the Remove button.

Creating a New Empty User SAI

By using the SAI Options dialog box, you can create a new and empty User SAl file. This file will
then be available for editing in the SAI Editor.

To create a new empty User.zsai file:
1. Inthe SAI Editor Options dialog box, select the SAI List tab.
2. Click the Create button. The Create a User SAI dialog box opens.
3. Enteror navigate to the directory where the SAl file is to be created.
4. Enter a description for the file.
5. Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAl with the
same filename. If so, a confirmation message will be displayed. If this happens, choose one of
the following options:

a. Click Yes if you want to overwrite the existing SAl file.
b. Click No to return to the dialog box and assign a new ID to the SAl file.

6. If you have made modifications to the cfgNextSAIID setting in the Analysis Workbench.ini file,
you may see the following message:

The next User SAI ID cannot be found in the settings file.
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This probably means that you are using User SAls created with a different version of the
software, or created on a different machine.

Please take care to set the new ID to a value that is unique across your organization.

This may happen when the value for the ID in the Analysis Workbench.ini file is missing or lower
than the highest ID in the user SAls currently loaded. This message is for information only—the
Universal Discovery components will correct this situation automatically by inserting the correct
ID value into the Analysis Workbench.ini file.

License Relationships

License relations solve the problem of suite licensing simply and effectively. They are applicable to
license relationships outside of what would normally be considered a software suite.

For example, Microsoft Office 2003 licenses Access, Word, Excel, PowerPoint and Outlook and is
a well-known software suite. In addition, Outlook licenses MS Data Access Components (ADO)
2.1 SP1. If Outlook or another licensing application is not present on the machine, alicense is
required for the software; if Outlook is installed on the machine, however, Outlook assumes license
ownership.

License relationships for a application release are represented by icons in the SAI Editor All
Contents tab.

Icon Description

{';j Indicates that the application also licenses another application.
f‘j Indicates that the application is licensed by another application.
gﬁ Indicates that the application both licenses and is licensed by another application.

Viewing License Relationships

The License Relationship Editor is a non modal dialog box. This means you can have it displayed
while working in the SAI Editor. Position the two dialog boxes on your screen so that you can work
with both at the same time.

To explore license relationships:

1. Inthe All Contents tab, right-click a Release and select Explore License Relations. The
License Relationship Editor is displayed.

There are three panes in this dialog box.

= Licensing Releases

The applications listed in this pane are those that license the selected application.

= <Selected Application>

This is the application that was selected in the SAI Editor All Contents tab.
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» Licensed Releases

The applications listed in this pane are those that are licensed by the selected application.

‘ Licenze Helationzhip Editor

f’] Licensing Releases

fMicrosoft OFFice Accountind
Microsoft Office SharePoint
Microsoft Office Accounting
Hewlett-Packard HP Openhi
Microsoft Office Accounting
Sage Group Ack! 2007

Sage Graup Ack! Premium Fr
Manticello The Paper Tiger «
Acresso Software (Macrowic

rr ...

Microsoft SOQL Server 2005

- Licenses: §

E----Licensed Ey: 2

- Release Details
Publisher: Microsoft
Application: SQL Server
- Release: 2005

gj Licensed Releases

Microsoft Diaka Access Compor
Microsaft Microsoft. MET Frane
Microsaft 0L Server Mative C
Microsoft SQL Server Analvsis
Microsaft 0L Server Reparkin
Microsoft 0L Server Naokificati
Microsoft SOL Server Integrati
Microsoft S0L Server Workstal

KN — H

In this example, Microsoft SQL Server 2005 was selected in the SAl Editor All Contents tab.
The center pane contains details for this particular application release.

= The left hand pane shows any applications that license Microsoft SQL Server 2005.

= The right hand pane shows any applications that Microsoft SQL Server 2005 licenses.

2. Double click an entry in the left hand pane. This application becomes the focus in the center
pane. For this example, Microsoft Office SharePoint Portal Server 2007 has been used.

= The left hand pane does not contain any data because Microsoft Office SharePoint Portal
Server 2007 is not licensed by any other application.

= The right hand pane now shows the applications that Microsoft Office SharePoint Portal
Server 2007 licenses (including the original Microsoft SQL Server 2005)

‘ Licenze Helationzhip Editor

E-j Licensing Releases

Microsoft Office SharePoinkt
Portal Server 2007

o Licenses: 2

Licensed By: 0

- Release Details
Publisher: Microsoft
- Application: OFfice Share
‘. Release: 2007

1 | +

gj Licensed Releases

Microsoft Sgl Server 2005
Microsoft Sql Server 2005 expi
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3. Toreturn focus to the original application (Microsoft SQL Server 2005), double click the
Microsoft SQL Server 2005 entry in the right hand pane. The center pane focus is now returned
to this application.

By double clicking through various entries in the License Relationship Editor you can explore
how these applications relate to each other regarding licensing.

1. Inthe All Contents tab, right-click a Release and select Explore License Relations. The
License Relationship Editor is displayed.

There are three panes in this dialog box.

= Licensing Releases

The applications listed in this pane are those that license the selected application.

» <Selected Application>

This is the application that was selected in the SAI Editor All Contents tab.

= Licensed Releases

The applications listed in this pane are those that are licensed by the selected application.

l Licenze Relationzhip Editor

f‘j Licensing Releases

fMicrosoft Office Accounting
Microsoft Office SharePoint
Microsoft Office Accounting
Hewilett-Packard HP Open'yi
Microsoft Office Accounting
Sage Group Ack! 2007

Sage Group Ack! Premium o
Monticello The Paper Tiger
Arresso Software (Macrowi

rr 1.0

Microsoft SQL Server 2005

- Licenses: &

E----Licensed By 9

- Release Details
Publisher: Microsaft
Application: SOL Server
. Release: 2005

gj Licensed Releases

Microsaft Daka Access Compor
Mlicrosoft Microsoft. MET Frarme
Microsoft SQL Server Mative C
Microsoft S0L Server Analysis
Microsaft 0L Server Reparkin
Microsoft S0L Server Motificati
Microsoft S0L Server Integrati
Microsoft 0L Server Workstal

KN i

In this example, Microsoft SQL Server 2005 was selected in the SAl Editor All Contents tab.
The center pane contains details for this particular application release.

= The left hand pane shows any applications that license Microsoft SQL Server 2005.

= The right hand pane shows any applications that Microsoft SQL Server 2005 licenses.

2. Double click an entry in the left hand pane. This application becomes the focus in the center
pane. For this example, Microsoft Office SharePoint Portal Server 2007 has been used.

= The left hand pane does not contain any data because Microsoft Office SharePoint Portal
Server 2007 is not licensed by any other application.
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= The right hand pane now shows the applications that Microsoft Office SharePoint Portal
Server 2007 licenses (including the original Microsoft SQL Server 2005)

l Licenze Helationzhip Editor M=l

E‘ﬂl Licensing Releases Microsoft Office SharePoint

e S BT gj Licensed Releases

Micrasaoft Sql Server 2005
— Licenses: 2 Microsoft Sgl Server 2005 expl

Licensed By: 0

- Release Details
Publisher: Microsoft
Application: OFfice Share
‘. Release: 2007

1 | | | | o

3. Toreturn focus to the original application (Microsoft SQL Server 2005), double click the
Microsoft SQL Server 2005 entry in the right hand pane. The center pane focus is now returned
to this application.

By double clicking through various entries in the License Relationship Editor you can explore
how these applications relate to each other regarding licensing.

e You can also right-click an entry and select the Explore Relations option instead of double-
clicking.

¢ Right-clicking an entry and selecting the Go To option will show the License Relations page
in the SAI Editor with the application selected.

e You can also right-click an entry and select the Explore Relations option instead of double-
clicking.

¢ Right-clicking an entry and selecting the Go To option will show the License Relations page
in the SAI Editor with the application selected.

Setting up a New License Relationship

This procedure shows you how to set up a new license relationship.

To set up a new license relationship between two or more applications:

1. Position the License Relationship Editor and the SAI Editor on your screen so that you can
work with both at the same time.

2. Right-click the release of the application you want to set up the relationship for, and select the
Explore License Relations option.
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5.

The License Relationship Editor is displayed with the center pane showing details for the
selected application.

Return the focus to the main SAI Editor All Contents tab and navigate to the release for the
application that you want to add.

Drag and drop the release entry from the SAI Editor explorer tree view to the left or right pane
either of these panes as follows:

= Left hand pane—This will be alicensing release. The application that you drag and drop will
license the application in the center pane.

= Right hand pane—This will be a licensed release. The application that you drag and drop
will be licensed by the application in the center pane.

If you make a mistake, you can remove the entry by right- clicking on it and selecting the Delete
option.

Continue these steps as required.

Creating a License Relationship Using the Master SAI

You can use entries in a Master SAl file to create a new license relationship. Once created it will
automatically be copied to a specified User SAl file.

The Master SAI will not be edited in any way.

The procedure for doing this is similar to that shown in Setting up a New License Relationship.

1.

2.

Position the License Relationship Editor and the SAI Editor on your screen so that you can
work with both at the same time.

In the Master SAl file, right-click the release of the application you want to set up the
relationship for and select the Explore License Relations option.

The License Relationship Editor is displayed with the center pane showing details for the
selected application.

Return the focus to the main SAI Editor All Contents tab and navigate to the release in the
Master SAIl for the application that you want to add.

Drag and drop the release entry from the SAI Editor explorer tree view to the left or right pane
either of these panes as follows:

Left hand pane—This will be a licensing release. The application will license the application in
the center pane.

Right hand pane—This will be a licensed release. The application will be licensed by the
application in the center pane.

A Select User SAl dialog is displayed if you have multiple User SAls:
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5. Select the User SAl you want to create the license relationship in and click the OK button.

6. Continue these steps as required.

The Package Rules Tab

Viewing Package Rules

The Package rules tab shows a view of the package rules for an SAL.
For Master SAls, the rules are pre-populated by HP and are not editable.

For User SAls, you create the rules manually. For more information, see Example of a Recognition
Rule Using Installed Package Information.

The following information is shown for each entry in this tab.
+ Package Name - The name of the package.

o Package Type - The types of the installed packages (such as MSI, RPM, etc.) to which the rule
applies.

o OS - The operating system on which the application runs.

o Language - The language for the application.

o Publisher - The publisher of the application to which the package rule belongs
o Application - The application to which the package rule belongs

o Description - The brief description of the package rule.

+ Release Match - The regular expression for the release name.

¢ Release Format - The format of the release name.

¢ Version Match - The regular expression for the version name.

¢ Version Format - The format of the version name.

o Extra - The extra regular expressions used in the rule.

Note: You can view the total number of the package rules in the current SAl in the status bar.

Editing the Properties of a Package Rule

This procedure is used to edit the properties for a package rule.

Note: You can only edit the package rule properties for User SAl files.
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To edit the properties of an existing package rule:
1. Right-click the package rule to be edited and select the Properties option.

The Application Rule Wizard box appears.

Alternatively, you can also access the Application Rule Wizard by double-clicking the package
rule to be edited.

2. Edit the details as required.

See Editing the Application Rules for more information.

3. Click the Finish button to complete the edit.

After you edit the package rule details, the amended details are displayed in the tree.

Navigating to the Application
This procedure is used to navigate to the application to which the package rule belongs.

To navigate to the application:
1. Right-click a package rule.
2. Select the Go to Application option.

You are led to the application to which the package rule belongs in the Application tab.

The Version Data Rules Tab

Viewing Version Data Rules

The Version Data rules tab shows a view of the version data rules for an SAI.
For Master SAls, the rules are pre-populated by Hewlett-Packard and are not editable.

For User SAls, you create the rules manually. For more information, see Example of a Recognition
Rule Using Version Data.

The following information is shown for each entry in this tab.

o File Name - The name of the version data rule.

OS - The operating system on which the application runs.

Language - The language for the application.

Publisher - The publisher of the application to which the version data rule belongs.

Application - The application to which the version data rule belongs.

Description - A brief description of the version data rule.
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Release Match - The regular expression for the release name.

Release Format - The format of the release name.

o Version Match - The regular expression for the version name.

Version Format - The format of the version name.

Extra - The extra regular expressions used in the rule.

Note: You can view the total number of the version data rules in the current SAI in the status
bar.

Editing the Properties of a Version Data Rule

This procedure is used to edit the properties for a version data rule.
Note: You can only edit the properties of version dates rules for User SAl files

To edit the properties of an existing version data rule:
1. Inthe tree, right-click the version data rule to be edited and select the Properties option.

The Application Rule Wizard box appears.

Alternatively, you can access the Application Rule Wizard by double-clicking the version data
rule to be edited.

2. Edit the details as required.

See Editing the Application Rules for more information.

3. Click the Finish button to complete the edit.

After you edit the version data rule details, the amended details are displayed in the tree.

Navigating to the Application

This procedure is used to navigate to the application to which the version data rule belongs.

To navigate to the application:
1. Right-click a version data rule.
2. Select the Go to Application option.

You are led to the application to which the version data rule belongs in the Application tab.
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Searching for Items in the SAI

How to Search for Iltems in the SAI

You can search for any item contained in the SAl using the Search in SAI dialog.

To search for a file in an SAl:

1. Click the @ icon in the toolbar. The Search in SAl window opens.

2. Inthe Search for items with a name containing field, type all or part of the item you want to
find. A history of search items is maintained and can be accessed from the drop down list.

3. Check the Use Regular Expression option if you have specified a regular expression in the
name field above.

4. Check the Limit to items also available in other SAls option if you want to limit the search
to only those items that are also available in other SAls. If an item exists in only one SAl, it will
be ignored. This is useful for finding all items that appear in more than one SAI. This option is
especially of interest with regard to application versions.

5. Inthe Search in pane, check the box next to those areas you want to include in your search.
You can narrow your search by specifying the areas in which the search will be carried out. The
default settings is that all criteria are selected - the entire SAl is searched.

6. Click Search. The results are shown in the bottom pane and are presented in a tree view.
7. Double click an entry to go directly to that item in the All Contents window.

In addition, you can use the local menu command, Copy to Clipboard, in the search dialogue. It
allows you to copy the content of the search results into the Windows clipboard. The content is
copied in a tab separated format, so that it can be pasted into another external application, such as
Microsoft Excel, Windows Notepad, and others.

How to Use the “Limit to items also available in other SAls” Option

There are some very good reasons why you would want to use this option when searching the SAls
that you create.

Consider the case of the user SAls that you create for the applications that are not currently
included in the master SAIl. When a new monthly SAI update for master SAl files is available, you
will want to search the user SAls to show all versions in the user SAl that are also available in the
new master set. This would highlight any possible clashes with the new master data. It is useful to
know about these clashes because in such cases an application that previously was recognized
from a user SAI might change its recognition to be recognized as a master SAl version instead.

Another case to consider is the rule-based recognition applications that are created when you define
rules in the user SAI. When these rules are triggered, they create applications in the auto.zsai (or
whatever SAl file that you have designated to receive automatically generated versions). When you
receive a new master SAl, you will want to search the content of the auto.zsai to find out if any of
the new master SAI data include versions that were created by the rule-based recognition. Again,
you want to track the cases when the recognition might change from a version in the auto.zsai file
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to a version in a master SAI. It is important to track these recognition changes only if the recognition
datais linked to some external systems, such HP Asset Manager using the version IDs.

In both cases, the search procedure to identify these items is the following:
1. From the SAl list on the left, select the user SAI that you want to search.
2. Inthe Search for items with a name containing field, enter .*

3. Check the Use Regular Expression option indicating that all items will be found since the .*
regular expression matches all items.

4. Check the Limit to items also available in other SAls option.
5. Inthe Search in pane, check only the Version Names check box.

The result of this search shows all versions in the user SAI that are also available in the new master
set.

Exporting the Contents of a User SAl to XML Format

e Only User SAl files can be exported.

o The XML file format is an easy way to share the SAIl information with an external system.
Since XML is a standard, open text-based markup language, there are many tools available
that can parse it. For example, one can create a simple XSLT transform and convert this
XML to an HTML web page, an XML document of a different format, or even a simple text
file.

Exporting the Contents of a User SAI File
1. Inthe left hand pane of the SAI Editor, select the User SAl file you want to export.

2. Click the Export SAl &% icon on the toolbar.

The SAI XML Export dialog opens.

3. You can select either Export SAl Summary only or Export Complete SAIl. Samples of both
types of export are shown in the following sections.

If you select Export SAl Summary only, you have the following options:

= Include IDs: If checked, the summary SAl includes item IDs in the exported XML. If
unchecked, the IDs are not included.

= Include release relationships: If checked, the summary SAl includes the release
relationships in the exported XML. If unchecked, the release relationship information is
omitted.
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4. You can select the Include items with no file data option.

If checked, the export will also include items in the User SAl that are empty - that is, they do not
have any files in them.

5. Inthe Export to file field, you can browse to or type in the location where you want the file
saved. By default, the XML export is saved to the following file:

<DataFlowProbelnstallation>\runtime\probeManager\discoverySaiResources\saiRuntim
e

where <dataflowprobeinstallation> is the location where the Data Flow Probe is installed.

6. Select the Open file in default XML viewer option if you have an XML viewer already installed
on your machine and it has been associated to XML file types. This option automatically opens
the file with that application once the export has been completed.

7. Click Export to complete the procedure.

Examples of XML Export

Example of a Summary XML Export

The Summary export shows details of the application only:
<?xml version="1.0" encoding="UTF-8" 7>

<sai description="User SAI File" type="User" id="0" version="281" revision="0"
timeStamp="2004-05-20 10:28:55" exportType="Data for items without files is included">

<publisher name="3Com">

<application name="3+open/lan Manager" applicationType="Ultilities">
<release name="Standalone Releases">

<version name="x.x" operatingSystem="<generic>" language="English" />
</release>

</application>

</publisher>

</sai>

Example of a Complete XML Export

This type of export is a complete dump of the User SAl contents. All items are displayed showing
their IDs. The Application Types, Operating Systems and Languages contained in the SAl are also
shown with IDs.

<sai description="User SAl File" type="User" id="0" version="281" revision="0"
timeStamp="2004-05-20

<application id="2334" name="3+open/lan Manager" apptypeld="8">
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<release id="4330" nhame="Standalone Releases">

<version id="6799" name="x.x" osld="0" languageld="2304">
<file name="3comemm.com" type="Associated" size="4289" />
</version>

</release>

</application>

</publisher>

</sai>

Importing Data

Importing Data from Recognition Resulit

The SAI Editor has a feature that allows you to load in a scan file and check what the recognition
results will be. You can also use this feature to add files from the scan file directly to User SAI.

To check scan file recognition:

1. Select the Import Data from Recognition Result option from the Tools menu. The Recognition
Verification window is displayed.

2. Navigate to the scan file to perform recognition on. You can also apply filters on files to be
passed to the recognition engine.

= By extension

= Executable files

= Files within archives
3. Click the OK button.

The Recognition Result Import dialog is displayed with the Files tab showing.

This tab shows how files were recognized in the scan file. Icons are used to indicate the
following:

Ilcon Description
Has been recognized with a high degree of confidence.
0 Has been recognized, but the recognition cannot be guaranteed 100%.

Y Does not exist in the Master SAl and has not been recognized.

The right hand pane shows the SAls to which you can add files.
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8.

9.

Note: You cannot add files to the Master SAI.

In the right hand pane, select the SAl file to which you want to add the file(s), and navigate to
the applicable Application version.

In the left hand pane, select the file(s) to be added to that Application version. Multiple files can
be selected by holding down the SHIFT/CTRL key while clicking on the files.

Before you select the files to be added, you can sort the files displayed by clicking on a column
heading. For example, you can click on the Package column on the Files tab to sort files by
package. All files belonging to a particular package will then be grouped together, even though
they may be located in different directories scattered throughout the file system. The ability to
sort files based on their package allows you to easily teach all files belonging to a particular
package. Simply select all of the grouped files belonging to that package.

Drag and drop the file(s) directly onto the application version in the right hand pane

Alternatively, select both the files in the left hand pane and the Application version in the right
hand pane. Then click the Add button.

An Importing Files dialog box is displayed.

Right-click the file(s) to be set the relationship to the application. Multiple files can be selected
by holding down the SHIFT/CTRL key while clicking on the files.

Select the relationships from the Main, Associated, and 3rd Party options.

Click the OK button.

The files are now added to the selected application version in the SAI.

Importing Data from a Scan File Comparison

Before you start this procedure, ensure that you have done the following:

o Started with a scan of the machine before the application is installed.

o Installed the application.

o Taken a scan of the machine after the application has been installed.

To import data from a scan file comparison;

1.

Create a new version for the application in your SAl file, unless you want to add files to an
existing version.

Click the version in the tree view, and select the Import data from Scanfile comparison option
from the Tools menu. The Scanfile Comparison Teaching Configuration dialog appears.
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The wizard requires two scan files. The first scan file (pre-installation scan file) is the result of a
scan performed on a machine prior to the installation of the program and the second (Post-
installation scan file) is the result of the scan of the same machine after the new version was
installed.

= Enter the path to the pre-installation scan file.

= Enter the post-installation scan files. Click the Add button and navigate to the file. You can
specify more than one file for cases where patches need to be installed too.

3. Click the Load Filter tab.

Set options in this dialog to specify which files should be loaded and optionally passed to the
recognition engine.

4. Inthe Files tab, select the Load filter, and choose one of the following options:
= All files—Loads all files.
= No files—Nofiles are loaded. For example, for hardware only analysis.
= Some files—Enables the Some files options:

o By extension... This allows you to specify the extensions of any files that you want to be
included. Select the extensions from the drop-down list (this list maintains a history of
previously entered extensions) or type the extension directly in to the box. Multiple
extension must be separated by semi colons.

o Executable files—This will allow all executable files to be processed against the
recognition engine. Executable files include *.exe, *.dll, and other files containing
executable code.

o Files within Archives—This will process any files in archive files (for example, Zip files,
CAB, LZH). When this option is checked, any files matching the other criteria (extension
and/or executable) are loaded, even if they are inside an archive. If the option is cleared, no
files within archives are loaded.

If this is the only option enabled, nothing is loaded - it is not possible to load only files within
archives.

5. Inthe Directories tab, specify the directories to exclude.
6. Select the Exclude files in these directories check box.

7. Place the cursorin the list box and type in the path (do not include the drive letter) of the
directories to be excluded. An example of the format is as follows:

\WinNT\$NTServicePackUninstall$

8. You can save the current list displayed in the list box. To do this, click the Save list button and
specify the filename and path of the text file to save to. The default filename is dirlist.txt.
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9. Youcan load a previously saved text list file by clicking the Load list button to display a dialog
box. Enter the filename and path or navigate to the file to be loaded.

10. Click the OK button.

The Scanfile Comparison Import dialog is displayed.

The right hand pane shows an explorer-like tree view of the SAl files loaded. Expand the tree
down to the version you want to add the files to.

Three tabs are available in the left hand pane:

= New Files

This page shows new files added by the installation.

= Changed Files

This page shows files that have been picked up that differ between the two scan files.

= Unchanged Files
This list shows those files that were unchanged by the upgrade of the named version but are
nonetheless part of the new version. You can change the version named by clicking the ‘Click

here to change’. An SAl Browser dialog is displayed. Navigate to the new version and click
OK.

11. Drag and drop any files to be taught onto the correct version in the right hand pane.

12. Click the Close button when you have finished.

Importing Data from an MSI File

This section describes how to use the MSI Importer to import applications from an MSl file into a
User SAl without having to install them or perform and scans of machines.

Overview of the MSI Importer

The MSI Importer can be used to teach any application that was packaged using the MSI Installer.
This module allows software teaching based on an MSI file, which removes the need to install and
scan software in order to add it to a User SAI.

MSiI is short for Microsoft Installer and was introduced with Windows 2000, although Microsoft
provides MSI as a separately deployable piece of software that can be added to older Windows
operating systems.

To distribute an installer for a piece of software, a publisher no longer has to rely on proprietary
installer packages for managing creation of directories, registry entries, copying of files, or
uninstallation. If instead the installer is distributed as one or more MSI files, the MSI process in
Windows takes care of the details.

The MSI Importer is an SAI Editor module that uses this standard to add applications packaged in
MSI-based installers directly to User SAI files without having to install them first.

To teach the contents of an MSI files in the SAI Editor
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Use the MSI Importer to view the structure and contents of the file. See Components of a Software
Installation.

Once you have become familiar with the structure of the MSI file, teach the contents of the MSI file
to a User SAl. See An Example of Teaching an MSI Based Installer to the User SAI.

The MSI Importer supports standalone msi files, Microsoft's self-extracting installers, and installers
that were generated using some versions of the Wise for Windows Installer. For handling
InstallShield generated MSI installers, see How to Open an InstallShield MSI Installer in the MSI
Browser.

Further Information
You can find comprehensive information about the MSI standard at:
http://msdn.microsoft.com

The Advantages of Using the MSI Importer
e Speed

The overhead of having to install the software and scan the machine is removed.

o Convenience

The teaching is accomplished using only one computer, as the need for a separate ‘clean’
computer to install the software is removed.

o Completeness

An installer often contains files that are only installed under certain conditions. For example, an
application might require certain extra libraries under older operating systems to make up for
missing functionality available under newer versions of Windows. Using the traditional method of
installing software before teaching it, these extra files would only be found if the correct
combination of software and operating system was used during installation. The MSI Importer, on
the other hand, retrieves all of the files available in the installer.

The Challenges of Using the MSI Importer
¢ Understanding MSI structure

With MSI, every installation is different. It is necessary to browse the MSI Installer (and its
associated directories) to understand how the installer has been structured before teaching the
application.

It is also necessary to understand what components the application has. For example, the same
installer might contain application Server and Client components. While browsing, special
attention should be paid to shared components included in the MSI installer. Some of them may
already exist in the Microsoft library applications, such as MSDE (Microsoft SQL Server Desktop
Engine) or DAO components.

e Lack of MSI installations
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More and more software companies are adopting MSI as their installer platform. However, it will
be some time before all software companies ship their products in MSI Installers. For these
products, the traditional method of scan-install-scan-teach will still have to be used.

o Hybrid MSI Installers
Some MSI installers invoke legacy proprietary installers to install some components of the

product. The files in the invoked legacy installers will not be available for teaching from the MSI
Importer.

Components of a Software Installation

A software publisher must provide three components when publishing an application:
e The MSI System installer

e The .msifile

e The Setup.exefile

MSI was introduced with Windows 2000. Consequently, some computers will not be able to install
MSI-based installers if they are provided only as .msi files.

It is for this reason that most MS| based installers are still invoked by running an executable file
usually named Setup.exe.

The Setup.exe file:
1. Checks to see if the MSI system is installed
2. Installs it, if necessary
3. Once it has done the previous two steps, invokes the installation of the .msi file.

The MSI system is available as a downloadable module from Microsoft. This module can be
installed for the purpose of MSI installation.

Locating the MSI and Setup Files for Different Application Installations

There are two ways in which a software application can be made available:
o Applications Shipped ona CD
o Applications Downloaded from the Internet

o Applications Shipped ona CD

Note: When loading such an installer into the MSI Importer, load the .msi file.

If the application is shipped on a CD, all three of the components will normally be placed
separately on the CD. An installer packaged in this way may be identified by the following:
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= A .msifile will be found in the same directory as the Setup.exe file.
» The Setup.exe file will normally be no larger than 1 MB
= Aninstaller for the MSI system will be located either in the same directory or in a subdirectory.

Applications Downloaded from the Internet

When importing a self-extracting installer to the MSI Importer, load the Setup.exe. The MSI
Importer will display an error message if you attempt to load an unsupported installer package.

If the application is downloaded from the Internet, a publisher will typically provide a single-file
download. The Setup.exe file will be a sophisticated self-extracting archive containing the other two
components.

You can identify this type of installer by the following:
o There is no associated MSI file
o The Setup.exe file will be several MB in size.

Other MSI Files on the Install Media

Often a search of the install media (the CD) will reveal a number of additional .msi files in
subdirectories. These .msi files are usually installers for additional components the publisher
provides with the application. Examples of these are required system updates and third-party
database engines.

You will need to examine these .msi files to determine whether their contents should be added to
the application in the User SAl file.

o If the MSI appears in the nested installers tab, it should be taught - but only once.

o If the .msifile was provided by another publisher then its contents should either be added to the
application as third party files or, in case when a component exists as a separate application, the
MSiI file data should be taught to the respective application. The connection between the two
applications should be established through License Relations (see License Relationships on
page 286).

o If the software publisher has provided one of the additional .msi files themselves, then its
contents should either be added to the application as associated files or, in the case when the
supplied component exists as a separate application, the data should be taught to the respective
application. The connection between the two applications should be established through License
Relations (see License Relationships on page 286).

MSI Installers and External Files

Some of the files referenced by an MSI file might be outside the MSI Installer package itself. This
may take the form of a relative path directory structure or an Cab file outside of the MSI.

If an MSI file is moved, for example, it might cause a problem if external files are referenced.
Always check the MS| Reading Log page to see if a CAB Missing Error has been displayed. If this
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is the case, ensure that all the files are in the correct locations. If you have copied a file from a CD,
ensure that all the external files have been copied too.

Identifying Main Files

The Main file will probably be pointed to by a Windows shortcut installed in the Start menu. Use the
list of shortcuts to identify and add the Main files. Bear in mind that an application may have more
than one shortcut, and that not all of those shortcuts will point to Main files. You will need to
examine the file and its internal version information to determine whether it is a Main file.

You can view more information about the list of shortcuts on the Summary page of the MSI
Importer. See Summary Tab on page 307 for further information.

Identifying Third Party Files

Third Party files can be identified by checking the name of the publisher in the version information
contained in most executable files. If the publisher name specified differs from the publisher of the
product, the file is a third party file.

You can view the version information in the MSI Database page of the MSI Importer. See MSI
Database Tab for further information.

The Structure of an Application Packaged in an MSI Installer

An application packaged in an MSI-based installer is divided up by the software publisher into:
o Features
e Components

A Feature can contain any number of Components. Essentially, when you decide to install a
feature, you are deciding to install all of the Components that comprise that Feature.

Features

A Feature is a part of an application’s overall functionality that is user recognizable and can be
installed independently.

For example, a Feature could be a spell-checker, a thesaurus, or a group of clip art. Hierarchical
relationships of parent and child Features commonly exist such that if a child Feature is installed,
the parent Feature is automatically included as well.

Every, MSI-based installer contains a tree-like structure of Features. Each Feature could potentially
contain children. If you decide to install a Feature then you could further decide whether or not to
install its children.

Components

A Component is a piece of the application or product to be installed. Example of Components
included single files, a group of related files, COM objects, registration, registry keys, shortcuts,
resources, libraries grouped into a directory, or shared pieces of code such as MFC or DAO.

Components can appear in more than one Feature.

How to Open an InstallShield MSI Installer in the MSI Browser
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InstallShield is a popular installer authoring tool, used by many people worldwide. While the SAI
Editor is unable to extract MSl files directly from InstallShield installers, it is possible to use the
installer itself to extract the required files.

How Can You Tell if an Installer is Built Using Installshield?

When installing the application, the words “preparing the InstallShield wizard” appear somewhere in
the text of the opening page.

How Can You Tell if an Installer is MSI Based?

Very shortly after starting the installer, the Windows Installer screen will be shown. The graphic on
the left hand side is characteristic of MSI based installers.

Importing the InstallShield MSI Based Installer

The process to import an InstallShield based MSI installer takes advantage of the fact that
InstallShield extracts the MSl in its entirety to the TEMP directory when it runs.

Start the installer and leave it open while you import the MSI and cancel it afterwards. When the
installer closes it will delete the MSI and associated files that it extracted to the TEMP directory.

1. Start the installer.

2. Wait until the installer stops and waits for user interaction. This could be the Welcome page of
the installer, or even an error message indicating that the installer cannot continue, like the
following:

Another version of this product is already installed. Installation of this version cannot continue.
To configure or remove the existing version of this product, use Add/Remove Programs on the
Control Panel.

3. Leave the installer open and waiting for interaction until you have finished this process. If you
close the installer it will delete the MSI file that you are attempting to import.

4. Determine where your temp directory is on the system. You can do this by opening a command
prompt, and typing the following:

echo %temp%

For example:
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¢ [Command Prompt

Microsoft Windows [Uersion 5.2.37781
CGC» Copyright 1985-2803 Microsoft Corp.

C:wDocuments and Settings~Adminiztrator>echo =tempx
C =S DOCUME™1~ADHINI “1~LOCALS ~1~Temp

C:sDocuments and SettingssAdministratori_

5. Select Import Data from MSI from the Tools menu

6. Enter (copy and paste or type in) the TEMP location revealed above.

7. Look for a directory named _is* where * is any combination of alphanumerical characters.
8. You will find the extracted MSI file in this directory. Select it.

9. When you have finished importing the appropriate files, the installer can be closed. You can
also cancel the installation (you do not need to install the application).

The MSI Importer Workspace

Note: To emphasize the MSI file detail, the screen images shown in this section do not include
the Destination SAI pane on the far right of the MSI Import window.

Launching the MSI Importer
To launch the MSI Importer:

1. Inthe SAI Editor, select the Import Data from MSI from the Tools menu.

A File Open dialog is displayed.

2. Navigate to and select the installer file (this is either the setup.exe or the .msi file depending on
how the publisher published the application).

For further information on which file to choose, see Locating the MSI and Setup Files for Different
Application Installations.

The Import MSI Installer workspace is displayed.

The Import MSI Installer window is non-modal. This means you can have it displayed while working
in the SAI Editor. Position the two windows on your screen so that you can work with both at the
same time.

The MSI Importer window consists of four tabs.
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1. Summary

2. MSI Database
3. Actions

4. MSI Reading Log

Note: The Actions and MSI Reading Log tabs are optional and will be visible only if there is
something to show in them. Whether they appear or not depends on a particular MSI used.

Summary Tab

The Summary page shows information extracted from the MSI file.

Product Details
e Product Code

The product code is an ID that is the main identifier for an application or product.

e Upgrade Code

This is an identifier used by the MSI system to determine which installed products are affected by
agiven upgrade.

e Manufacturer

The software application publisher

o Name

The name of the application. This is the application’s install string.

e Version

The version of the application

o Package Code

The package code is an ID identifying a particular Windows Installer package. It associates an
.msi file with an application or product.

e Product Code

The product code is an ID that is the main identifier for an application or product.

e Upgrade Code

This is an identifier used by the MSI system to determine which installed products are affected by
agiven upgrade.

e Manufacturer
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The software application publisher

o Name

The name of the application. This is the application’s install string.

e Version

The version of the application

o Package Code

The package code is an ID identifying a particular Windows Installer package. It associates an
.msi file with an application or product.

Shortcut information
Lists the shortcuts this installer created and shows the targets under each shortcut.

The following information about the shortcut is given:
¢ Name of the shortcut

o The Directory the shortcut points to

e Thefile pointed to

e The Component to which the file belongs

o A description of the shortcut command

o Any arguments applied if relevant

o The Working directory

The Go to button is only enabled when you select a Feature or if a shortcut’s target exists in only
one feature and you select the shortcut. If you select a shortcut in this pane and click the Go to
button you will be automatically redirected to the MSI Database tab and the file will be highlighted.

Warnings

Warnings are provided whenever actions are found that require further examination. You will need to
examine the entries associated with the action warnings and decide whether they are files that need
to be taught to the application and what relationship they have with the application. Examine the
warnings by clicking on the links in the bottom pane. You will be automatically directed to the
appropriate place in the Actions tab.

MSI Database Tab

The MSI Database tab has several components:
e The Features and Components tree

e The Files pane
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e The Version Information pane
e Toolbar
e The Features and Components Tree

The Features and Components tree displays a tree view of the features and (optionally) their child
components.

@@| B a

. Digoovendgents ; Discoverny Adgents ;I
. Decibel : Topology Corverter
: Cagzandra : Cassandra
: Authd : MewFeature
- [E] Adaz: Atlas
: Ariadne : Ariadne
. Apache ; Apache "Web Server
: Ahbby : Event kM anager
] - [2] AbbyBin
Feature Node§— AbbyConf

: Scanner_Generator : Scanner Generator

. Sal_Update_wizard : 54l Update Wizard
F5F_Converter : FSF Corvverter
Analysiz_Workbench ; Analysis Workbench
SHMP : MewFeaturel

#ML_Enricher_Service : #ML Ennicher Service
iewer : Viewer

Tomcat : Tomeat Servlet Container

Sal: SAls

Pellib : Perllib

Hudra : Digcovery Engine

Common : Common Features [Fequired by all compone
: - ACS : Agent Comrunication Server

Jcoi Nodeg- G loons

This displays a tree structure of the features and (optionally) components contained in the installer.
The following icons are used to differentiate between the three types of node:

e Feature Node El
e Component Node

e |con Node@

HP Universal CMDB (10.10) Page 223 of 311



Inventory Tools User Guide
Contents

Icons are stored in different locations. They are extracted and placed into the Icon node.

A pop-up menu item (Import Files) is displayed when you right-click the selected Feature Node.
This option allows you to import the files contained in the Feature Node into the version selected in
the SAI Editor.

The Files Pane

The Files pane lists the files contained in the Feature or Component currently selected in the
Features and Components tree.

The Files pane displays a list of the files belonging to the currently selected node.

If the node is a Feature and the Show Component Node toolbar option is not selected, the Feature
will contain the files that belong to all of its (now invisible) Component nodes. You can find further
information about the toolbar options on page 310.

Due to the legacy of MS DOS, the file name is stored in the MSI in two versions.

e The old-style MSDOS 8.3 format (with eight characters, a full stop, and then a three character
extension)

o The more recent mixed-case long version

Both of these names are displayed in the Files pane separated by a ‘|'. For example:
IMAGES~1.EXE|ImageSlicer.exe

If the MSI Importer was unable to extract a file from the installer in order to scan it then that file’s
icon will have ared ‘No Entry’ Symbol superimposed on it to indicate this.

You can find more information about why the file could not be extracted in the Messages tab.
Pop-Up Menu
Two pop-up menu items (Find Files and Import Files) are displayed when you right-click afile.

o FindFile

The SAI Editor will search its database for other occurrences of the selected file. The SAl Editor's
Search in SAl dialog is displayed.

o Import Files
This option allows you to import selected files into the version selected in the SAl Editor.

The Version Information Pane
The Version Information pane displays the version information from the currently selected file.

The Version Information pane displays data that the MSI Importer has extracted from the file
currently selected in the Files pane. If no information was extracted from the file, this pane will be
blank.

The information in this pane is exactly the same as the version information that the Scanners
extract from a file during a normal scan of a computer. It is commonly used to determine the original
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publisher of the file so that the file relationship to the application (main, associated or third party)
can be determined.

Toolbar

There are two types of buttons available from the toolbar:
o Functional Buttons
o Option Buttons

Functional Buttons
There are two functional buttons in the MSI Importer toolbar:

Find File

Clicking the Find File button @ while a file is highlighted will cause the SAI Editor to search for
other occurrences of the selected file. The Search for Files window is displayed.

Add Selected Files to a Version

Clicking the #] button imports the selected files into the version selected in the SAI Editor.

It has the same effect as dragging the currently selected item from the Features and Components
tree or the Files pane (whichever was last clicked) to the currently selected version node. If no
version node is selected, this button will appear greyed out.

When the mouse pointer passes over an icon, a tooltip appears indicating the command
corresponding to the icon.

Option Buttons

Three option buttons are also available from the toolbar. All three of the option buttons are sticky
buttons.

o If the option is selected the button appears depressed
o Tode-select the option, click the button again and the button retumns to its normal state

Hide Features With No Files

Enabling this option causes the SAl Editor to only show those Features that contain files. Features
without files in an installer are typically containers for registry entries, shortcuts and services, and
as such are not used to teach to the application library. They therefore appear empty in the tree and
can safely be ignored. This option makes them invisible.

When enabled, the MSI importer queries the information on all Features and Components before it
displays the tree. This could take some time on larger installers.

The option to remove empty Features is carried out before the option to Show only executable files.
This means that if a node has only non-executable files, it will still appear in the tree even though
the Show Only Executable Files option has caused it to be empty.

Show Only Executable Files
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When this option is enabled only those files that were identified as executable are visible. Further,
only the files displayed will be added during imports. This is the default setting, as non-executable
files should not be added.

Show Component Nodes

When this option is enabled, the Features and Components tree will contain a node for every
Component. This is a true reflection of how the MSl-based Installer is structured internally. That is,
a Feature does not contain files directly when this option is applied. All of the Features contain
Components, and those Components in turn contain the files. This is useful for determining the
origin of a particular file.

When the Show Component Nodes option is disabled, the Component nodes are not shown. All
of the files contained in the Component nodes are placed directly under the Feature node. While this
is a less accurate view of the installer, it is more user-readable. You do not have to click the
hundreds of Component nodes to view the files a Feature would install.

M5I Daka

Summary M5! Database |.¢‘-.u:tiu::ns| k5| Reading Lu:ugl

) whgents D ery Agents Filzname
Decibel : Topalogy Corverter AGENTG™.ExElagent Generat
- [ Cassandra : Cassandra AGENTU™1.EXEgentl ) parade.
- E] Authd : NewFeaturel COMPIESS. ERE
B Aflas - Aflas libeay32 dl
Anadne : Anadne openssl exe

i zeleaps2.dl
LIBEAY™1.DLLIIbeay32-dizc-w09

= Scanner_Generatar : Scanner Gener DVEDSE:‘l.EXE|D'-.-'E:E|SCE|F|.S'-.-'C.E
- B 54l Update ‘Wizard - 541 Update W/ SSLEAT™.DlLIssleay32-disc-vl
FSF_Corverter : FSF Converter LI_I _'I
Analpziz_wiorkbench : Analysis Work
~ E] SNMP: NewFeatursl

#ML_Enricher_Service : =ML Ennche

Viewer : Wiewer -
T | _’|_I

Apache : Apache Web Server
Abby - Event Manager

In the example above, note how the files that were shown for each individual component now
appear with the parent feature of those components.

Actions Tab
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This page lists the actions that the MSI Installer invokes during the installation process. It is
necessary to examine these actions in order to determine whether any of them will install files not
contained in the MSI.

¢ Nested Installers
A nested installation action installs another Windows Installer package during a currently running

installation. A nested installation action can only reinstall or remove an application that has been
installed by the current application's installation package.

e Called Executables

This page shows any actions that may install some other executable files.

e DLL Calls

This page shows any dll calls that may have been made.

o Invoked Scripts
This page shows any scripts that may have been invoked

MSI Reading Log Tab

The MSI Reading Log tab is used to view the log. It displays messages generated by the MSI
Importer when reading the MSl-based Installer.

An Example of Teaching an MSI Based Installer to the
User SAIl

Step 1 Importing the MSI Installer Package
1. Select Tools > Import data from MSI.

2. From the Open dialog, navigate to and select the MSI file to use. The file will have an extension
of .msi or .exe.

3. Click the MSI Database tab to examine the contents of the MSI file.
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MSI Daka
Summary MS1 Database | .ﬁ.ctinnsl 51 Reading L-:ugl
SRR
T E] &gt . oa ﬂ
i [E] Aviadne : Ariadne _ g
-- Apache : Apache Web Server
-- Abby : Event Manager
= Scanner_Generator : Scanner
E} Sample_Scanners : Sampl
SG_Samples
- [£] FSFDela
t [#] MSPs
- S&l_Update wWizard ; SA Upe 1 | _'I
FSF_Conwerter : FSF Corvverte - —
y . _ . FileDescription:  Inventory Scanner ;I
- Analvziz_warkbench : Analysi Fileversian: 7 7009276
- SHMP : MewFeature OriginalFilename: Win32Scanner. exe
-- #ML_Erricher_Service | XML
Iﬂ E Wiewer - Viewer x j
4 I 3 -
fdd

In this example, there are several features. Features are displayed in the following way and are
indicated by the Elicon.

Unique Name Key: Display name

If we look at the Scanner Generator Feature entry we can see that the Unique Name Key is
Scanner_Generator, while the display name has no underscore.

Looking through the MSI structure, look for the components of the application that can be
installed separately and therefore should be taught as individual applications. For example
Client/Server parts (see the example below) or some shared applications that are also packaged
in the installer, for example MSDE or DAO components.
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El- ﬁ?;! k51 Installer Filenarme | Size | Signature | Exelype | -
Client : Client rrgvephl. dll 401452 BADF-CAES ‘Wi 32 Ene
- [E] Server: Server mavert.dl 266293 23DC-EVDF  ‘Win 32 Exe
@ leohs rnzxrnl 3. dll 1110528 ABAF-0169  'win 32 Exe
rnzsml3r. dll 43520 BFV3-EDEBE  Win32Exe |
mzxml3a.dll 24064 CAFE-DART  Win 32 Exe
MLEWIZ™1 EXEMLE W izard exe 19384 C4431B44  “win 32 Exe
MLEUMI™1 EXEMLBUninst exe 13760 2933-5E65  Win 32 Exe
QEMSetup.exe Fea0 FIA0FCAF Win 32 Exe
i whernDC. dllwbemD C.dl 29184 DOE4-BS1T Win 32 Exe
Winidead. dibvmidead. dll 241152 20C8-B038  Win 32 Exe
vrnitilz. dllfverniutilz. dll 150112 AACS-FADE  “win 32 Exe
SETCLE™ .EXE|SetCLEIdentity... 24064 0A56-4DFE  Win 32 Exe
Al exe 211968 F4DD-FE54  'Win 32 Exe
Achdmin exe 409600  BFS1-CCAE  “Win 32 Exe
Actdrminp. dll a19z 230B-93EE  Win 32 Exe
ACCLUS™ ExElaccluster exe 343040 34346236 “Win 32 Exe
Ancount. exe 22016 48C-C235  Win 32 Exe
AcCPIEnm.DLL Be016 D790-AE92  Win 32 Exe
AcDSMEnm.DLL 79360 JIBE-EIC Win 32 Ene
acernmag. dll a0Eea 8491081 Win 32 Exe
r‘h M ACIE wen Tl | o1 4N 770 a2n e VL LI
d |+

This example displays the contents of the Microsoft Applications Center 2000 SP2 installer.
The same installer contains both Server and Client components of the application.

4. Click the Show Only Executable Files button on the toolbar and make sure that all other toolbar
buttons have been deselected. Now you will see only executable files.

5. Check the Company Name and see if it is the same as the Manufacturer entry in the Summary
tab.

6. You can do this by clicking on the executable file name in the Files pane and looking at the
Version Information displayed in the pane below. In this case the Company Name is the same
as the Manufacturer entry in the Summary tab.

7. However, had it not been the same, you would then add the file as a third party file. An example
is shown below.
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MsI Data

Summary  MS1 Databasze |.-’-'-.-:tiu::ns| M5l Reading Lu:ugl

Blal B &

: E‘ Llecibel . [ apolagy Lnnverterﬂ I Size
Cassandra: Cassandra _ 2401
Authd : HewFeaturel icude20.dl a4
- [E] Atlas : Atlas HMLVAL™T EXEMLValidate eve 11468
Ariadne : Ariadne ®ERCES™1.DLLI4ercesc 1 B Odl 1597

Apache : Apache 'Web Serve MSISCA™1 EXElmsizcanner. exe 7439]

Abby : Event Manager

= Scanner_Generatar : Scanne
Sample_Scanners 1 Samp

SAl_Update “Wizard : 541 Up

FSF_Corverter : FSF Convert r | | ﬂ

Analyziz_WwWorkbench : Analys Version Information "
- [E] SMMP : NewFeature] —
- B] ®ML_Enricher_Service : ¥ML | |Lanauage Code: O

. e Comments:
Wigwer : Yiewer http: /fosz. zoftware.ibm. comdicu
Tamcat - Tomcat Servlet Con FroductMame:  International
= ) Components for Unicode

54l : SAls ] ComparnyMame:  1BM Corporation and

Perlib : Perllib athiars
Hydra : Discavery Engine LegalCopyright:  Copyright [C] 2007,

4 C F International Business Machines =
ammar : Lomman Features Corporation and otherz. All Rights
ACS : Agent Communication £ Reserved.
- @l lcons = | Productiersion: 2,0,0,0

FileDezcrption: 1Bk [CU Caraman DLL
ll —I LI_ FrivateBuild: j

fdd

Here we can see that the Company Name is IBM Corporation.
1. Select Tools > Import data from MSI.

2. From the Open dialog, navigate to and select the MSI file to use. The file will have an extension
of .msi or .exe.

3. Click the MSI| Database tab to examine the contents of the MSI file.
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MSI Daka
Summary MS1 Database | .ﬁ.ctinnsl 51 Reading L-:ugl
SRR
T E] &gt . oa ﬂ
i [E] Aviadne : Ariadne _ g
-- Apache : Apache Web Server
-- Abby : Event Manager
= Scanner_Generator : Scanner
E} Sample_Scanners : Sampl
SG_Samples
- [£] FSFDela
t [#] MSPs
- S&l_Update wWizard ; SA Upe 1 | _'I
FSF_Conwerter : FSF Corvverte - —
y . _ . FileDescription:  Inventory Scanner ;I
- Analvziz_warkbench : Analysi Fileversian: 7 7009276
- SHMP : MewFeature OriginalFilename: Win32Scanner. exe
-- #ML_Erricher_Service | XML
Iﬂ E Wiewer - Viewer x j
4 I 3 -
fdd

In this example, there are several features. Features are displayed in the following way and are
indicated by the Elicon.

Unique Name Key: Display name

If we look at the Scanner Generator Feature entry we can see that the Unique Name Key is
Scanner_Generator, while the display name has no underscore.

Looking through the MSI structure, look for the components of the application that can be
installed separately and therefore should be taught as individual applications. For example
Client/Server parts (see the example below) or some shared applications that are also packaged
in the installer, for example MSDE or DAO components.
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El- ﬁ?;! k51 Installer Filenarme | Size | Signature | Exelype | -
Client : Client rrgvephl. dll 401452 BADF-CAES ‘Wi 32 Ene
- [E] Server: Server mavert.dl 266293 23DC-EVDF  ‘Win 32 Exe
@ leohs rnzxrnl 3. dll 1110528 ABAF-0169  'win 32 Exe
rnzsml3r. dll 43520 BFV3-EDEBE  Win32Exe |
mzxml3a.dll 24064 CAFE-DART  Win 32 Exe
MLEWIZ™1 EXEMLE W izard exe 19384 C4431B44  “win 32 Exe
MLEUMI™1 EXEMLBUninst exe 13760 2933-5E65  Win 32 Exe
QEMSetup.exe Fea0 FIA0FCAF Win 32 Exe
i whernDC. dllwbemD C.dl 29184 DOE4-BS1T Win 32 Exe
Winidead. dibvmidead. dll 241152 20C8-B038  Win 32 Exe
vrnitilz. dllfverniutilz. dll 150112 AACS-FADE  “win 32 Exe
SETCLE™ .EXE|SetCLEIdentity... 24064 0A56-4DFE  Win 32 Exe
Al exe 211968 F4DD-FE54  'Win 32 Exe
Achdmin exe 409600  BFS1-CCAE  “Win 32 Exe
Actdrminp. dll a19z 230B-93EE  Win 32 Exe
ACCLUS™ ExElaccluster exe 343040 34346236 “Win 32 Exe
Ancount. exe 22016 48C-C235  Win 32 Exe
AcCPIEnm.DLL Be016 D790-AE92  Win 32 Exe
AcDSMEnm.DLL 79360 JIBE-EIC Win 32 Ene
acernmag. dll a0Eea 8491081 Win 32 Exe
r‘h M ACIE wen Tl | o1 4N 770 a2n e VL LI
d |+

This example displays the contents of the Microsoft Applications Center 2000 SP2 installer.
The same installer contains both Server and Client components of the application.

4. Click the Show Only Executable Files button on the toolbar and make sure that all other toolbar
buttons have been deselected. Now you will see only executable files.

5. Check the Company Name and see if it is the same as the Manufacturer entry in the Summary
tab.

6. You can do this by clicking on the executable file name in the Files pane and looking at the
Version Information displayed in the pane below. In this case the Company Name is the same
as the Manufacturer entry in the Summary tab.

7. However, had it not been the same, you would then add the file as a third party file. An example
is shown below.
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MsI Data

Summary  MS1 Databasze |.-’-'-.-:tiu::ns| M5l Reading Lu:ugl

Blal B &

: E‘ Llecibel . [ apolagy Lnnverterﬂ I Size
Cassandra: Cassandra _ 2401
Authd : HewFeaturel icude20.dl a4
- [E] Atlas : Atlas HMLVAL™T EXEMLValidate eve 11468
Ariadne : Ariadne ®ERCES™1.DLLI4ercesc 1 B Odl 1597

Apache : Apache 'Web Serve MSISCA™1 EXElmsizcanner. exe 7439]

Abby : Event Manager

= Scanner_Generatar : Scanne
Sample_Scanners 1 Samp

SAl_Update “Wizard : 541 Up

FSF_Corverter : FSF Convert r | | ﬂ

Analyziz_WwWorkbench : Analys Version Information "
- [E] SMMP : NewFeature] —
- B] ®ML_Enricher_Service : ¥ML | |Lanauage Code: O

. e Comments:
Wigwer : Yiewer http: /fosz. zoftware.ibm. comdicu
Tamcat - Tomcat Servlet Con FroductMame:  International
= ) Components for Unicode

54l : SAls ] ComparnyMame:  1BM Corporation and

Perlib : Perllib athiars
Hydra : Discavery Engine LegalCopyright:  Copyright [C] 2007,

4 C F International Business Machines =
ammar : Lomman Features Corporation and otherz. All Rights
ACS : Agent Communication £ Reserved.
- @l lcons = | Productiersion: 2,0,0,0

FileDezcrption: 1Bk [CU Caraman DLL
ll —I LI_ FrivateBuild: j

fdd

Here we can see that the Company Name is IBM Corporation.

Step 2 Teaching Files to a Version of the Software

To teach files to a version of the software:
1. Inthe SAI Editor main window, select a User SAl, and navigate to the pertinent release.

For this example, we will create a new Version under the following release:
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:.. _. & Ui i 17 SRRCHENREHES .
‘:j Hewlett-Packard )
) =- =] HP DDM [ventany Server
P
|- BRI Py .

2. Inthe MSI Importer, examine the Version entry on the Summary tab.

For example:

F"n:u:lu-:t g BB e 5
Property Walle
FroductCode {365E 428441 79-442E -ACBE-7561BCI2CE1E}
|JpgradeCode {32FBCBAF-4484-4278-A70C-FATOFEOSOFE 7} :

1 | Manufacturer Hewlett-Fackard Development Comparny, LF. i
M ame HF Dizcoverny and D ependency Mapping [nventary 9.30.000 :
Y erzion 9.30.000. 2216
PackageCode {E9742960-DERV-426E -BEE1-16C518230 144}

3. Inthe SAI Editor main window, create a new Version (if necessary) to match the MSI version:

a. Select the release to which the new Version belongs.

b. Click theElicon. The Version Properties dialog is displayed.
c. Fillinthe details, and leave the Install string blank (it gets imported later).

d. Click OK.

For this example, we will create version 9.30.000 under release 9:

= = User Sal File c:hdocumentz and:

= a‘:j Hewlett-Packard )
=- ] HP DDM Inventom Server

= |__‘=| g :

||j_-§| 9.30.000 [E nglish - Windows Sre 20032002

4. Go back to the Summary tab of the MSI Importer.

a. Inthe Destination SAl box, select the version that you just created. You will need to expand
the tree to do this.

b. Inthe Product Details box, select the Version listed.

The version that you selected in the Destination SAI box will now be highlighted in gray.

5. Switch to the MSI Database tab of the MSI Importer.

6. Select a Feature or Component node in the tree.
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7. Choose one of the following methods to import its files into the User SAI:
= Method 1: Click the Add button.

= Method 2: Drag the whole Feature (or individual files) onto the Version node in the
Destination SAI box. You can select multiple files by using the SHIFT/CTRL key while
clicking the files.

If you drag a Component node on to a Version, the files in that node will be imported. If you
drag a Feature node onto a version, the files in that Feature and all of that feature’s
descendants will be imported.

= Method 3: Right-click the feature or component, and choose Import Files from the shortcut
menu.

= Method 4: Right-click files in the Files pane, and choose Import Files from the shortcut
menu.

The Importing Files dialog opens

8. Right-click the file(s) and select the relationship of the file(s) to the application from the Main,
Associated, and 3rd Party options

Tip: You can select multiple files holding down the SHIFT/CTRL key while clicking on the
files.

Main files are generally pointed to by a shortcut. Any files pointed to by shortcuts will be marked as
Main. Double-check that these files should really be given the Main rating.
After you have specified the correct relationship for each file, click OK.

The new file is now included in the User SAI and will be recognized as scan files are processed in
the future.

Step 3 Examining Warnings and Messages

Examine the warnings and messages by clicking on the links in the bottom pane of the Summary
tab.

You will be automatically directed to the appropriate place in the Actions tab. You will need to
examine the entries associated with the action warnings and decide whether they are files that need
to be taught to the application and what relationship they have with the application.

Nested Installer Tab

A nested installation is where another MSI resides inside the MSI. You will need to choose one of
the following ways to handle this situation:

¢ Is the nested installation a standalone application that can also be released—either as part of
another application or standalone? If so, it needs to be taught as a separate application and
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linked with the current application using a release relationship.
o If not, the files need to be added to the same application as associated files.

Called Executables tab

You will have to examine whether the called executable is going to install some other executable
files. For example, look at the command-line column—if it says install.exe or setup.exe this would
indicate that an executable file is being installed. You could get clues from the Name of the Action.
A Called Executable Actions could be for example,

Install <name of the executable>

In the following example, the Called Executables are not installing other files, they are merely
sending commands to run SQL scripts.

DLL Calls tab
This tab lists all DIl calls made.
Invoked scripts tab

This tab shows any scripts that would be invoked. Once you have examined the files, return to the
MSI Database tab.

The MSI Scanner Command Line Utility

Overview of the MSI Scanner

For situations where the installation media is not accessible, the MSI Scanner can be used. This is
a command line utility that takes as input an MSl file. This is then analyzed. The result of the
analysis is an XML file containing a summary of the MSI.

In a large enterprise it may not be feasible to have remote offices send their software install media
to central locations to be added to the corporation’s central application library. In this case, the MSI
Scanner may be of some use.

The MSI Scanner is a command line utility used to scan an MSI based installer, extract all required
file information and write an XML file describing the installer and its contents. This XML file can then
be sent to the central office where the person maintaining the application library can load it into the
SAI Editor exactly as if it was the original MSI based Installer.

Starting the MSI Scanner
To start the MSI Scanner:
From the command prompt, type the following

C:\hp\UCMDB\DataFlowProbe\tools\InventoryTools\Common\bin\msiscanner.cmd
<setup_package> <output_file>

Where:
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<setup_package> is the path and filename of the MSI-based installer.
<output_file> is the path and filename of the output XML file.

Note: Note that if the specified filename does not end in .xml, the MSI Scanner will append a
.xml extension toit.

Opening the MSI Scanner Output File in the MSI Importer

The output from the MSI Scanner is usable in the MSI Importer so that you can browse the MSI and
teach from the XML file in the same way as directly from the MSI file.

To open the MSI Scanner output file:
1. Select the Import data from MSI option from the Tools menu.

The File Open dialog box is displayed.
2. Inthe Files of Type dropdown box, select the MSI Scanner output file.

3. Navigate to the file to be opened.
4. Click OK.

The file is opened in the same way as any MSI-based installer.

MSI Scanner Error Level Codes

The MSI Scanner produces error level codes which can be used to handle situations if the Scanner
terminates without producing an XML output file.

These error codes can, for example, be used in a batch file so that specified actions can be carried
out in the event that particular error codes are returned.

These can be used to control re-scan activities when a scan has not completed successfully.

Error Level Description

6 Unexpected error

5 Unable to open the output file

4 Insufficient space available in the Temp directory.
3 Unable to open input MSI

2 Unrecognized package

1 Incorrect parameters

0 Success
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Application Teaching Overview

Application Teaching is a process that you can use to increase the number of applications (or
versions of existing applications) that Universal Discovery recognizes on your scanned devices.

There are four methods that you can use to “teach” new applications to Universal Discovery:
*» Teaching Using Scan Files

* Rule-Based Application Teaching

» Teaching Using Recognition Objectives

The first method is currently supported for Windows platforms only. The last three methods are
supported for both Windows and UNIX platforms.

Caveats When Creating and Modifying User SAl Files

It is extremely important to follow sound and consistent practices when you are creating or
modifying User SAl files in your environment.

You can create and modify User SAl files with the analysis tools. When you create or modify User
SAl files, consider issues that may arise regarding potential ID and content clashes.

Problems are likely to occur in the following situations:

e There is more than one librarian teaching applications.

o The SAl files are maintained in more than one location.

o The SAl files need to be deployed to more than one Data Flow Probe.
The following guidelines should help you avoid these problems:

o Provide unique SAI IDs and file names across the entire organization. You cannot deploy
different SAls that have the same ID.

o Configure the same set of SAl files for all Data Flow Probes to provide consistent recognition.

o Modify SAl files in one place regardless of the teaching method. You can modify the SAI file on
an administrator's computer or on a Data Flow Probe that is using the client analysis tools.

o Afteran SAl file is modified in one place, do not modify it on another machine. Instead, replicate
the file regularly so that new changes are available on all machines.

The use cases presented in the following sections reinforce the problems that can occur and the

best practices to use to avoid these problems.

Teaching on Different Client Machines

You can create more than one User SAl file for a Data Flow Probe. Each User SAl file must have a
unigue name and ID across the entire organization. When you create a new User SAl file, a new
and unique ID is automatically generated. This mechanism can be compromised, however, if you
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are teaching applications on more than one machine—a practice you should avoid.

Analysis Workbench and the SAI Editor are client analysis tools that are usually installed on a
machine that is distinct from the Data Flow Probe because of performance issues. If you create
User SAl files on multiple client machines, while the ID will be unique for the machine on which it is
created, it will not be unique with regard to the ID of a User SAl file created on another machine
where the client tools are also installed. This can lead to a potential clash of User SAI IDs for the
User SAl files that you want to deploy to a single Data Flow Probe.

To prevent this situation from occurring, you should only create User SAls on a single computer to
make sure that all user SAI files have unique IDs.

Teaching Using Scan Files (Windows)

You can use scan files to teach applications for Windows.

Overview of an Application Recognition and Teaching Project

Application teaching is the process of showing Data Flow Probe how to recognize new applications
—or new versions of applications that are already included in an active SAI. An application consists
of one or more files. Information about these file can exist either in the Master SAl provided by HP
or it can be added to the User SAI.

In a Windows environment, files belonging to an application typically contain embedded Publisher,
Application, and Version information. In both Windows and UNIX environments, certain installed
package properties contain this type of information.

Questions to Ask Yourself

There are two key questions you must ask yourself when starting software recognition projects:
What is an acceptable level of recognition?

How long will it take to achieve the required recognition level?

Determining an Acceptable Level of Recognition

The Unrecognized/File frequency chart available from the Analysis Workbench can be used to help
you determine an acceptable level of recognition.

Displaying the Unrecognized/File Frequency Chart

In Analysis Workbench, after you have loaded your data, select the Charts > Unrecognized/File
frequency option from the View main menu.

The Unrecognized/File frequency chart is a simplistic representation of the distribution of the
number of files with a particular name compared with the number of times this file occurs across a
sample of computers.
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Interpreting the Chart

What is shown in the example chart is that the bulk of the files requiring recognition will exist on
several machines within a sample, whereas the largest number of files to be recognized may only
occur once or twice across the whole sample of computers.

If the computers on which these files were found can be identified, you can check them to see if
they fit into the business critical category of machines needing attention.

This graph holds true for most situations where the number of copies and number of files vary with a
particular sample of machines and the amount of recognition work carried on these same machines.

Using the graph, you can realistically assess the file recognition level required to achieve the goals
for a particular project.

With these restrictions, 100% recognition is usually unrealistic.
Defining the Cut-Off

By looking at the typical profile of unknown files versus the number of times they occur, it can be
seen that typically there are a large number of files that only occur once or twice across the sample
of scan files.

This file count drops rapidly as files that occur multiple times are encountered. Therefore it is
sensible to define a cut-off level in the file count to keep the number of files manageable. The cut-off
may start at the 10% off level and progressively be reduced to 5% off or lower, depending on the
number of known files that need to be handled and the target recognition level.

The exception to this is when there are business critical or special applications that only occur once
or twice across the scan file sample. In this case, these applications are targeted and added to the
SAl.
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In many instances a cut-off of 95% of installed files is seen as a realistic target.

Estimating How Long the Recognition Project Will Take

Estimating the time required for software recognition is based largely on experience. Factors that
can play a big part are:

o Familiarity with Analysis Workbench.

¢ The number of scan files available.

o The quality of the scan file data — does it include valid header information in the files?
e The cut-off point required.

o The availability of local contacts — accessibility and responsiveness.

« Availability of personnel to visit machines or to investigate particular software.

o Thefile types to be included in the recognition. It is usual to restrict the types to COM, EXE and
DLL files when teaching from scan files.

As a rule-of-thumb, over the project period an average of 100 files per day can be taught to your
User.zsai file. This equates to 10-12 files per hour or roughly one every 5 minutes.

In the early stages of the project, you will need time to become familiar with the data set and to
select a subset of scan files for teaching.

The most productive stage is when you have lots of files that can be quickly analyzed and taught. In
particular, if it is possible to cluster a number of files together, it may be possible to achieve a better
result than 100 files a day.

However as the project progresses, the amount of useful data available from Analysis Workbench
can diminish. It becomes necessary to spend time contacting people who have specialist
knowledge of the products or physically visit the machines and check the applications manually.

This can have a significant impact on recognition productivity.

Example Recognition Information from a Small Project

The following are recognition statistics from a software recognition project.

The project used 900 scan files that contained 19,680 file names with 448,991 occurrences. The
percentage of unrecognized files and occurrences is shown in the following table:

Start Finish
Recognized file names 45% 54%
Unrecognized file names 55% 46%
Recognized occurrences 82% 95%
Unrecognized occurrences 18% 5%

HP Universal CMDB (10.10) Page 241 of 311



Inventory Tools User Guide
Contents

Around 1,820 files were taught over the duration of the project. The result was a 9% increase in
recognition and 13% changes in occurrences.

Specifying the Scope of Teaching from Scan Files

It is important that you make all parties involved in the project aware of the scope of the teaching
process before the project commences so that expectations are correctly set and met.

This is due to the difference in methods between using scan files for information and using
installations of applications.

With application installations, it is possible to perform typical installations and see where all files
are being deployed.

In the case of using the information available from scan files, the information relating to an
application may be incomplete or different from other databases. This may be because:

« Available scan files may have incomplete installations.
o License relationships may be incomplete again due to incomplete installations.

Getting the Best Results

As discussed, scan files of users’ machines are not an ideal source of data for teaching, although it
often is the only source of data.

For applications where it is imperative that they be recognized as accurately as possible, it is
recommended that you follow these steps where possible:

1. Use an “empty” machine with just the operating system installed. The best way is to install the
machine once and generate an image of it that can be restored to this state for every
application.

2. Scan the machine and store the result as the “reference” scan.

3. Install the application to be recognized.

4. Scanthe machine again, storing the result as the “application” scan.
5. Use both scanfiles in an import in the SAI Editor.

When used in this fashion, the SAI Editor can “subtract” the reference scan from the application
scan. This allows a very accurate degree of teaching as all files affected by the installation can be
automatically added to the library.

However, this method is more time consuming than when using scan files of users’ machines and
requires a dedicated machine for the teaching work as well as access to the installation media for
the applications.

The HP Application Librarians use this methodology for almost all applications that are added to the
Master Library. MSI files are added to the Library using the MSI Importer in the SAI Editor.

Selecting Scan Files for the Project

Although a large number of scan files may be available, the only time that they all need to be loaded
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is when you need to produce progress statistics.

For teaching purposes, the smaller the subset of scan files loaded the better. This is because the
recognition algorithm has fewer files and directories to scan, hence producing recognition results
faster.

When choosing scan files for the project, consider the following:
o Particular location or department

Certain departments such as Finance or Personnel may be the only users of a certain type of
application (for example, invoicing software).

o Machines types —server or laptop

These may contain special software (for example, communications software). Servers may
contain server components of an application.

¢ Specific scan files by name

These may contain specific applications — such as a bank payment transfer — that only occur on a
particular machine. Alternatively, the scan file may be an example of a much larger set of scan
files that contain particular files.

Using Analysis Workbench to Pick Scan Files to Load

Choosing a few scan files from a list of several thousand can be time consuming. The following
steps show two different methods of different complexity that can be used to single out the scans
that would be best for a teaching session.

Simple method: Use an Analysis Workbench Load Query

1. Use the query option when loading scan files and generate a query that includes the desired
assets.

2. The selected Query will check all entries, which in alarge list of scan files can be time
consuming. If you need to load the same list of assets repeatedly, the more complicated
method may be more appropriate.

Complex method: Load all scan files to locate the best ones to use
1. Load your scan files into Analysis Workbench
2. Inthe Files window, tag all CheckVer and Unknown files.
3. Select the Files option from the Export menu. The Export to Files dialog box is displayed.
4. Inthe Export to Files dialog box, click the Export Files tab.
5. Select the One line per item option.

6. Make sure you have selected the Asset Number and Name options in the list.
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7. Click the OK button.
8. Import the exported data into a database program such as Microsoft Access 2000.

9. Run a query that groups on the first instance of a file name. This provides alist of scan files
that contain files of interest. The following is a sample SQL query:

SELECT DISTINCTROW Files.Name, First(Files.[Asset Number]) AS [FirstOfAsset Number],
Count(Files.[Asset Number]) AS [CountOfAssetNumber], Files.Directory, Files.Publisher,
Files.Application, Files.Version, Files.Size

FROM Files

Group BY Files.Name, Files.Directory, Files.Publisher, Files.Application, Files.Version,
Files.Size

HAVING (((Files.Name) In (SELECT [Name] FROM [Files] As Tmp GROUP BY [Name]
HAVING Count(*)>1))

ORDER BY Files.Name, Count(Files.[Asset Number]);

10. Take the output from this query and edit it into a script file under a section heading. Ensure that
the full path is loaded. This can be defined with a variable for the path. Then use the Analysis
Workbench LOAD_SCANFILE_LIST script to select the section.

11. Run the script and this will load the defined scan files without having to wait for the user
interface.
Grouping Files

Having selected the scan files to work with for a particular session, the next thing you need to
consider is the grouping of files based on specific criteria of interest.

This method is preferable to just examining files individually as it may lead to multiple files being
selected for teaching at one time. The following sections discuss the benefits of particular
selections.

Group Files by Date Without Selecting by Type

This method allows files (recognized and unrecognized) to be grouped together. This can help pick
up stray files that may have been stored in directories away from the main application directory.

Date and Time Stamp in Windows

The file date and time stamp in Windows 200x/XP/Vista/7 usually depends on daylight savings
time. This means that if a file was originally installed under GMT with a time stamp of 4:50, if the
time is changed to BST (GMT+1), then the files’s time stamp becomes 5:50.

Vice versa, if an application was installed under BST and then the clocks were put back, the time
stamp would change to 3:50.

This also means that using the date to cluster files when the machine is running Windows
200x/XP/Vistal/7 could give different results if machines have been scanned with installations either
side of a time change.
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This effect does not occur with UNIX.
Group Files by Name

Products such as HP printer drivers often start with the same letters (that is, HP). Also files starting
DC or DD may in fact be deleted files in the RECYCLE directories.

Group Files by Header Information

There are a number of files which are in archives or Cabinet files. It may be necessary to create a
special Scanner which stores archives as directories.

Examine Directory Names

This can include Publisher, Application and even Version in some cases. Look for more than one
directory with subdirectories off it. Look particularly under Program Files as often this is the default
base directory for an application.

Look at Entries in Installed Applications

In Analysis Workbench you can select a machine and right-click it to display the scan file in Viewer.
By looking in the Hardware and Configuration Data > Operating System > Installed Applications
folder, the applications that have been registered in the System Registry will be displayed.

This information is also available in Analysis Workbench in the Machine Window under Windows
Installed Apps. The column entries are not necessarily in alphabetical order.

Use Applications Window in Operational View
The Operational View displays all applications with partial or full identification.

In this view, Checkvers are displayed for an item. This reflects the fact that the file(s) is Checkver.
Use this to recheck files and directory information. Often the grouping yields some information
about a version.

To set Operational view:
1. In Analysis Workbench select the Load Options command from the File menu.

The Analysis Workbench Load Configuration—Advanced dialog box appears.

2. Click the Display Filter tab
3. Select the Load Operational View option.
Activities During Recognition Project

Teaching Recognition

After files have been selected, the teaching can be performed. This is the process of converting
Checkver and Unknown files into recognized files in the Main or Associated categories.

Logging Your Progress

There are several ways that you can log your process:

HP Universal CMDB (10.10) Page 245 of 311



Inventory Tools User Guide
Contents

o Checking the number of files that have been added to the User.zsai file.

This must be done manually from the beginning each time, because files added later to an existing
application are absorbed into the existing application.

o Checking the number of applications in the User.zsai file.

This is useful but does not reflect the number of files contained in each application.

o Loading a set of scan files against the User.zsai file.

This is the most reliable way of tracking progress.

This is one of the few times that all the scan files need to be loaded. To keep the memory
requirement down, only load *.exe and *.com files, and ignore Directories and Hardware data. This
cuts down the amount of data to store in memory. This is a valid file selection, as it is unusual to
teach *.dll files, for example, when just using scan files.

If the number of scan files gets too large for the available memory, then it will be necessary to split
the load sets into more manageable chunks. Produce an export of all files using Name, Copy
Count, and Status. These exports can be appended to produce one file. Then import the file into a
database, and perform the necessary query on the data having first produced a query to eliminate
duplicate file names.

Although the bulk of Main files are *.exe files, some applications are only identified by specific *.dll
files or some other executable. In this case, all executable files will need to be loaded with the
consequent impact on memory.

Finishing the Teaching Project

The project objective is to produce a clean User SAl that has recognized files to the defined cut-off
level. The quality of the data will only be assessed as the information is being used. Issues that
may compromise the data quality can occur for a number of reasons. Remember that when
teaching from scan file based information only, the data available may be incomplete. The following
section shows some examples of possible errors that may occur.

Recognition Errors

Here are some common recognition error scenarios:

e Headerinformation is at a variance with the actual product. This can happen with OEM or 3rd
party support products. The product version is often different from the file version (in this case,
use the product version).

o Versions have not been applied correctly. Scan files may not include version information if the
Scanner has not been set up to collect internal file identification data. Another reason might be
that the application version reported in interal file data does not match the marketing version of
the product. For example, Windows NT5 is packaged as Windows 2000. Microsoft Publisher
2000 has an internal version number of 6.0.

« Orphan files may be assigned incorrectly. These may be files that are not part of the main
directory list for an application. They often reside in the \Windows or \Winnt directories.
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o User recognition of application is incorrect. An application may be given a working name that is
different from its official title.

o Aversionis installed that is different from the current license. Newer versions may have to be
purchased for license purposes, but copies of the older version are deployed for compatibility
reasons.

Input Errors

Here are some common input error scenarios:

« Vendor or application name is not consistent. This needs to be edited to ensure consistency for
reports and exports.

o Product name does not match invoices or packaging. This would not be identified purely from
the scan file content.

e The wrong version has been applied to a particular file. This could be caused by multiple
versions being installed in the same directory.

o A space has been left in front of the text entry. This can happen if the entry is taken from
teaching mode straight from the header.

Situations Where the Recognition Information Does Not Match the Client’s Software
Invoice Details

If a client already has a database of software purchases, there can be a number of situations where
the information taught to the SAI does not match software invoice details.

o Theinformation in the SAl is incorrect. This may be due to incorrect descriptions obtained from
file headers or the effect of misallocation of files in a mixed directory.

o Theinformation in the SAl is out of date. Often for marketing reasons a product is rebranded.
Edit the SAI to reflect the change. For example, Dr Solomon’s Antivirus becomes Total Virus
Defence.

e The application is a device driver that needs hardware to be present. Therefore, the hardware
effectively is the license and so there may not be a Main file.

o If after a Service Pack, Service release, or Hotfix is applied, only some associated files of the
original application — but not the main file — are changed, the application itself will be reported as
it was before the update. In this case, there might not be a Main file associated with a particular
Service Pack, Service release, or Hotfix.

Dealing with Specific Groups of Software

The following items should not be regarded as a definitive list of recognition methods, but rather
they show the types of decisions that need to be taken when interpreting the available data. It is up
to the individual to define a scheme that meets the needs of a particular situation.

Install/Uninstall Programs
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Unless they can be tied to specific applications, use a generic setting of:
o Publisher = Various

o Application = Installation Program

¢ Version = Generic

Compressed Files

Often these come as part of the application, but they can sometimes be located in directories away
from the application.

For a zip or Microsoft Cabinet file, use the archive option in the Scanner to capture the directory list
of compressed files, and then compare with the other files on the machine.

Run-Time Files from Applications

Products such as Macromedia Director, Flash, etc., can produce run-time executables. It is not
always possible to identify the content of the file, as the header will usually relate only to the
generating application.

¢ Publisher = Name of the Publisher of the generating application
o Application = Name of the generating application
o Version = Version of the generating application (if known) otherwise use date of run-time file.

Files in Recycle Bins

Files in Recycle Bins will have file names such as DC1, DC9, DD1, etc. To remove them from the
Unknown count, either:

¢ In Analysis Workbench, set load options to exclude recycle directories so that the contents do
not appear in file counts.

e Teach the files in the directories with a generic description. For example
= Publisher = Various
= Application = Recycle Bin
= Version = Generic

It is important to check that the file name is not being used by a valid application. This means that
any file not in arecycle directory still needs to be taught separately. This also means that it is
dangerous to set a wide range of file sizes, as this range might encompass valid files.

The best approach would be to first load with the Recycle Bin directories included to produce a list
of files in these directories. Then, reload the data with the load options set to exclude the recycle
directories from normal teaching.

Zero Length Files
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Files of zero length do occur as a result of uninstalling applications. Because these will never be
executable files, then there is no recognition to be done. Therefore, just produce a report of zero
length files for record purposes. Typically in a batch of 3000 files, there may be 10 to 20 such files.

Windows Hotfix

These are the intermediary fixes that are available between service releases. |dentify:
o Publisher = name of publisher issuing the fix

o Application = name of application + HOTFIX

o Version = Date of file unless version details supplied

Applications That Are Available on Different Platforms

Some applications have the same name irrespective of which platform they appear on. Two
approaches can be used, either:

o Consolidate all the files from all the different platforms into one application. This could lead to a
range of file sizes for a particular file name.

o Teach each platform separately, and add the platform detail in the OS field of the application
version.

Creating a List of Files Not Requiring Detailed Recognition

This may be alist of files not requiring detailed analysis for some reason. It may be that you wish to
highlight internal use of applications (such as games) or that an application is internal and does not
need detail version information.

¢ Publisher = Dummy or some other generic name
o Application = Dummy or some other generic name
« Version = Dummy or some other generic name to save having to use separate dates.

This activity should only be used as a last resort, otherwise everything will be added to this list
without proper analysis. You may be tempted to do this thinking that if you move files from
unrecognized to some form of recognition, then the recognition job is done. The problem will
become apparent when you start to produce reports.

Why Applications May Be Taught Without a Main File

One situation where an application can be taught without a Main file is when the applicationis a
device driver that requires hardware to be present. Therefore the hardware effectively is the license.

Using States

Rather than loading large numbers of scan files each time for a session, using States can
considerably reduce the time to access data, provided that States and SAls are kept synchronized.
If the User SAl is updated, then a new state needs to be stored before exiting Analysis Workbench.
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Components of Applications

Some examples of groups of applications are given in this section:

¢ Microsoft Office 95 has Word 6

o Office 2000 is packaged as Office 2000 but has an internal version numbers of 9.x.
¢ Microsoft Publisher 2000 has internal version of 6.0

Components of the Different Editions

Office 2003
Office 2003 Professional Enterprise 2003: Office 2003 Standard:
Office Word 2003 Office Word 2003
Office PowerPoint 2003 Office PowerPoint 2003
Office Excel 2003 Office Excel 2003
Office Publisher 2003 Office Outlook 2003
Office Outlook 2003

Office Outlook 2003 with Business Contact Manager (US)
Office Access 2003

Office InfoPath 2003

Lotus SmartSuite Release 9 (or ver.9.8)

Name Application type

WordPro Wordprocessing software

1-2-3 Spreadsheet software

Approach Database management system software
Freelance Graphics Graphics or photo imaging software
Organizer Calendar and scheduling software
FastSite Web page creation and editing software
ScreenCam Video creation and editing software

How to Handle Special Groups of Files
o WinZip Self Extractor

Use the Scanner with ZIP extension
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Abbreviations

e ZAK - Zero administration Kit from Microsoft

e ZEN - Novell

e TVD - Total Virus Defence - Network Associates
¢ SMS - Systems Management Server - Microsoft

Tracking Your Progress

When using a large number of scan files for recognition, the bulk of the time is spent with a subset
of the total scan files available. Usually, the total number of scan files only need to be loaded to
produce figures relating to the split of Recognized and Unrecognized files.

The easiest way to track your progress is to:
1. Load the scanfiles into Analysis Workbench.
2. Locate the Status column in a Files window.
3. Right-click the column header, and select the Chart option.

This produces a chart showing the necessary split of the status of files—that is, Main,
Associated, 3rd Party, checkVer, Unknown, Unprocessed and Auto-identified.

You can also:
1. Select the Copies column.
2. Left click the column header.

This ranks the files in copy order.

3. Use a Global tag to tag all.
4. Untag selections to deselect unwanted types and/or chop count cut-off.

If a tag selection is made of Unknown and Checkver above a certain number of copies, then a
file filter can be applied to the machines window to select the scan files where these occur.

5. To prioritize the work, just select the scan files with the most tagged files. This is done by
ensuring that the Tagged Field column (from the scan file section) is displayed.

6. Sort on the number of tagged files and select a small group of scan files from this selection.

7. These can be added to an OR query when loading scan files. Or, for a faster response without
the user interface, use scripts to load a list of scan files.
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Teaching Using Scan Files (UNIX)

Special Considerations for UNIX Teaching

This section is for users who are not familiar with the UNIX OS environment and some of the issues
associated with dealing with UNIX files.

These are guidelines for best practice rather than hard and fast rules. As you gain familiarity with
the various data analysis tools supplied with Universal Discovery, you can develop new ways of
clustering files to meet specific needs.

The mechanics of teaching UNIX applications to a User SAI are exactly the same as for Windows
applications. For example, Publisher, Application, Application Type, Release, Version, etc. need to
be identified and applied to one or more files.

However, the information gathering exercise required for UNIX teaching can be challenging, since
the files themselves do not provide the same richness of information as in Windows.

Teaching software under the UNIX operating system relying only on scan files requires a slightly
different approach than that used with Windows. Here are some of the points to consider:

¢ No version data is available from the files. This means there is no direct confirmation as to the
source of the file.

o There is alimited amount of information available from the OS installed application list. This is
assuming built-in UNIX software install tools (such as, SWTOOLS) have been used for
installation. Many applications like Oracle can use their own installer and, hence, do not appear
in the OS installed applications list.

e More communication with local knowledge specialists (site administrators or staff who are
familiar with the on-site applications) may be needed than with Windows. Ideally, these people
should have solid UNIX systems-level knowledge.

« Analysis Workbench is used in a different way from Windows data analysis. The main
difference is that rather than concentrate on files and their properties, the emphasis is on
clustering files from the directories into an application.

o There is no single version of UNIX. See Flavors of UNIX for the different UNIX platforms that
are supported by Universal Discovery.

Recommendations

Here are some recommendations you can consider incorporating into your teaching project:
Use Separate User SAI Files for UNIX Entries

It is preferable to use a separate User SAl for UNIX entries. The reasons for this are:
o Clearly identifies UNIX specific applications.

o Itis quite likely that UNIX machines will be processed separately from Windows based
machines so this allows a separate set of load options to be set.
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Use Separate User SAI Files for Different UNIX Flavors

If there are numerous UNIX flavors on site, then it may be preferable to have separate SAls for
each of them (for example, Solaris, HP-UX, AIX).

Scan a Base Machine that has Only UNIX On It

Since UNIX installations can be highly configurable, the ideal situation would be to scan a base
machine that only has the operating system installed on it. This provides a base line from which to
work. This should be considered even when the Operating System is included in the UNIX Master,
since site specific patches may have been applied.

However, it may not always be possible to scan a machine that has only been installed with the
Operating System and no other applications. If one is available then this should be used to teach as
many Operating System related files (for example, patches) as possible. This should be dealt with
first.

o Tag the target machine and the selected files, and teach these files as the base operating
system build. This then removes the files from the unknown list.

o If aclean build is not available, then files normally found within the Operating System directories
should be selected for teaching first.

From a file recognition perspective, the binary executable types for each UNIX platform are distinct
and easily recognizable (e.g., HP/PA Coff for HP-UX, SPARC ELF for Solaris, AIX Coff for AlX,
x86 ELF for Linux). Directory structures and file names are typically the same across different
UNIX platforms for a given application.

UNIX Teaching Process Overview

An overview of the process of UNIX Teaching using Analysis Workbench follows:

1. From discussions with local specialists, identify a range of applications that are known to be on
the scanned machines.

2. Since the number of applications is likely to be much smaller than for Windows, it is useful to
track the clustering of files by machine selected and base directories included in the cluster.

This can be used in further discussions with local specialists to determine and confirm the
application details.

3. Determine the number of unknown files to discover from the scanned files. To do this:
» Load afull set of scan files into Analysis Workbench with the Master UNIX SAI.
= Select the Status column, right-click the header, and choose the Chart option.

This will give an indication of the level of unknown files.

4. Select machines with the largest number of unknowns. To do this:

a. InaMachines Window, create a column from System Data > Application Recognition >
Unrecognized Files
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b. Sort on this column, and then Tag machines with the largest unrecognized files counts.
Save these machines as a Tag list for further use.

5. Unload the scans.

6. Take a selection of sample machines from each flavor of UNIX in tumn.

7. Create a user SAl for each flavor of UNIX

8. Select and load a target scan file — use entries in the previously saved Tag list
OS Files

1. ldentify the OS version on the target machine:

Hardware > Operating System Data > UNIX type and Host OS
2. Tagthe OS directories

3. Teach the unknown files found in these directories using the OS details

Installed Applications

View the OS installed applications list in the Hardware tab of the Viewer.

If there are any that can be identified then teach these.

Recognized Applications

When a UNIX Master SAl is available, use this to identify as many of the files as possible.

If there are some recognized applications do the following:

1. In Analysis Workbench, select an application, tag it, and then check the Files Window and
Directories Window to see if the are any sub directories that contain Unknown or Checkver
files.

2. If they do contain such files, then a reasonable assumption is that the Unknown and Checkver
files are from the same application—possibly patches, for example.

3. Clusterthe files and add them to the SAIl using same details as the existing files.

Directories

Having worked on these applications, turn your attention to the directories.

1. Check environment paths for execution paths (for example, PATH). These are likely to be the
directories where the main applications are located.

2. Select directories for file clustering.
3. Clusterfiles and add them to the SAI.

Selection Techniques
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Identify OS Version on the Target Machine

Use one of the following methods to identify the OS version on the target machine:

1. InViewer, use the selection Hardware > Operating System Data > Host OS Name and Host
OS Version

2. Inan Analysis Workbench Machine window, select the appropriate column to display. This is
used to establish the version for the files in the main operating system directories.

Tag OS Directories — See OS Directories List
Select main OS directories and cluster files to an application.

Select known applications and select their directories and check for unknown or Checkver files
mixed in the same directory as known files.

View the OS Installed Applications List
Some UNIX flavors contain directory paths of the OS Installed applications.

In the Viewer Hardware tab, go to Operating System Data/OS Installed Applications to see which
applications are logged under the Operating System.

Check Environment Paths for Execution Paths

On the Hardware and Configuration tab in the Viewer, use the Operating System Data >
Environment information to check specific paths.

These will point to directories containing executable applications.
Choosing Directories to Target for File Clustering

In Analysis Workbench, select directories for file clustering using the following criteria:
o Directories with recognizable descriptions in the path name

o Directories with the largest number of unknown files

How to Find Directories with a Specific Name

1. Inan Analysis Workbench Directories Window, right-click the Name column heading, and
select Tag > Contains.

2. Enterthe name or partial name in the Search String box.
3. Select Anywhere for the String Position.
How to Determine Which Directories Have the Most Unknown Files

1. In Analysis Workbench, ensure that the Directories Window has the Tagged Files column
displayed.
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2. Goto aFiles Window, and tag files with Status = Unknown or Checkver.
3. GotoaDirectories Window, and sort on the Tagged Files Column.

The result may appear confusing, because the file counts do not always display in file count order.
This is because the directory displays the total count of files but is placed in the order of the tagged
files. To obtain a total count of the files, right-click the Tagged Files column heading, and choose
Sum.

The screen does not refresh the tagged files count correctly if the file tags are removed.
File Details

If there are multiple versions of an application that have shared files in the same directory, choose
the oldest version first and then progressively teach the newer versions in order. This is on the
basis that the older files have carried forward into the newer versions.

Check that the main file selection is consistent in order to count licenses. This may require more
than one Main file to be selected.

Look for consistency under the same date for the same version of the application

Group the files under the known application. There may be more than one version of the application
sitting in the same directory. In this case it will be necessary to try and allocate the files to each
version based on date.

Recommendations

o Never use a script file type as a Main file because these can appear in different operating
environments or not used on a particular machine. This could lead to incorrect license counts.

o Load one UNIX operating system flavor at a time. This is to ensure that if an application exists
for different environments, that they are taught for the specific operating system. This is
because the same file name can have widely differing file sizes depending on the operating
system. The binary executable file types will also vary from one UNIX platform to another. For
example, HP/PA Coff files should only exist in HP-UX applications, not in Solaris versions.

¢ Version numbers may need to be approximated e.g. 4.3.3.79, 4.3.3.12 and 4.3.3.26 etc. may
need to be consolidated as 4.3.3.x

File Clustering Notes
1. Identify a machine with the sample applications onit.
2. Select the base directory.

To tag all sub directories off a base directory:

a. Select base directory in Directory Window.

b. Go to Details pane display path.
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c. Click on path and use Ctrl C to copy all or part of the path string.
d. Goto Directories Window and right-click the “Name” column header.
e. Select Tag > Contains > search string and Ctrl V to copy path string.
f. Click OK. This will tag all the directories with the base path string.

3. Tag the directory and sub-directories.

4. Apply directory filter to Files window.

5. Tag All files displayed in filtered display.

6. Addto SAL

File Identification

Use web search facilities to identify applications and publishers. It may be sufficient to enter the
name of a file and it can be found in an on-line document that relates to an application.

It may be necessary to become familiar with the various acronyms associated with a product in
order to identify it.

Information Stored in Installed Applications Lists on UNIX

You can find the installed applications for different operating systems in the Hardware tab of the
Viewer.

The installed applications are listed under:
Operating System Data>O0S Installed Applications

The amount of detail provided varies between UNIX flavors. These mainly refer to OS drivers etc.
but can be useful in determining version numbers when teaching OS support files and libraries.

Standard UNIX Directories in System V Release 4 (SVR4)
The following table lists all standard UNIX directories in System V Release 4 (SVR4).

Directory Description

/ The Root directory, which is always present and is the parent of all the files
in the file system.

/dev Contains device files including terminals, printers and hard disks

letc Contains system administration and configuration files, the most important
of which is /etc/passwd

/home Directory containing the home directories for all the users

/opt Root directory for file systems used by add-on applications
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Directory
/sbin

/spool
/spool/lp
/spool/uucp
/spool/uucppublic
/stand

/tmp

lusr
/usr/bin
Jusr/ucb
/usr/games
Jusr/lib

/var
/var/admin
/var/mail
Ivar/news
/var/opt
/var/tmp

/var/uucp

Directory
/

/dev

letc

/home

/opt
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Description

Programs used when booting the system

Contains the directories for spooling files

Spooling files for the printer

Files queued for UUCP

Files placed by UUCP

Standard programs and configuration files used when booting
Contains temporary files created by UNIX

User accessible programs

Executable programs and utilities

Contains the BSD compatibility package

UNIX games

Libraries for programs and programming languages

Contains files whose content vary as the system runs

Description

The Root directory, which is always present and is the parent of all the files
in the file system.

Contains device files including terminals, printers and hard disks

Contains system administration and configuration files, the most important
of which is /etc/passwd

Directory containing the home directories for all the users

Root directory for file systems used by add-on applications
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Directory Description
/sbin Programs used when booting the system
/spool Contains the directories for spooling files
/spool/lp Spooling files for the printer
/spool/uucp Files queued for UUCP

Files placed by UUCP

/stand Standard programs and configuration files used when booting
/tmp Contains temporary files created by UNIX

lusr User accessible programs

{usr/bin Executable programs and utilities

/usr/ucb Contains the BSD compatibility package

/usr/games UNIX games

{usr/lib Libraries for programs and programming languages
Ivar Contains files whose content vary as the system runs
/var/admin

/var/mail

Ivar/news

/var/opt

/var/tmp

/var/uucp

Other UNIX systems may contain other key directories

Directory Description
/kernel Contains OS kernel and related files for Solaris.
/X1 Contains files for the X Window windowing system.

Directories such as /opt or /var may be used for customer installations in the same way that
Program Files directory is used in Windows. However, some applications choose their own
directory structure and local configurations of applications may override the default directory paths.
Again, local knowledge is useful here.

Configuring Data Flow Probe for UNIX Application Recognition and Teaching

Scanner Configuration for UNIX Scanning
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For scanning, include signature to assist with uniquely identifying the first 8K of a file.

The file details are to save UNIX executables (binary and script). File extensions can be included
but this may lead to spurious recognition.

Selected directories can be ignored provided they are known to be data directories only. This can be
included in the scanner generator, otherwise create an .override.ini file that contains the directory
exclusions.

Setting up XML Enricher to Include the UNIX User SAI for Recognition

Follow these steps:
1. Goto Server > Administration > System Configuration > Scan processing > SAls

2. Make sure that unix.zsai as well as the User SAl used for UNIX teaching are in the SAl list and
that they are enabled.

Load Options in Analysis Workbench

The key load options are set as follows:

Option Description
Load Either Load ALL files. This includes non executables.

Or Load Executable and Archived only. This will reduce the number of files to load
and needing recognition may not include script files.

Recognition = Recognition method - SAI
Recognition Settings — Use level 3 heuristics.
Either Apply recognition to ALL files.
Or Executable and Archived only. This will reduce the load time.
In either case the SAl libraries to use are as follows:
master.zsai contains key information for Operating System etc.

unix.zsai this contains a mixture of Solaris, AIX, HP-UX, and Linux applications.
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Option Description

Display Applications
Either Operational View.
Or Business View.

Business view only displays applications in the Applications window that have a
Main file in the Files window, while the Operational view displays ALL application
entries found in the SAI. These may be just be Associated files or Check ver.

Recommendation
Use Operational View for teaching to see all the entries.

Use Business view when reporting to concentrate on Applications that are

licensable.
Option Description
Load Either Load ALL files. This includes non executables.

Or Load Executable and Archived only. This will reduce the number of files to load
and needing recognition may not include script files.

Recognition = Recognition method - SAI

Recognition Settings — Use level 3 heuristics.

Either Apply recognition to ALL files.

Or Executable and Archived only. This will reduce the load time.

In either case the SAl libraries to use are as follows:

master.zsai contains key information for Operating System etc.

unix.zsai this contains a mixture of Solaris, AlX, HP-UX, and Linux applications.
Display Applications

Either Operational View.

Or Business View.

Business view only displays applications in the Applications window that have a
Main file in the Files window, while the Operational view displays ALL application
entries found in the SAI. These may be just be Associated files or Check ver.

Recommendation
Use Operational View for teaching to see all the entries.

Use Business view when reporting to concentrate on Applications that are
licensable.
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Flavors of UNIX
AIX

Acronym for Advanced Interactive Executive. A version of UNIX from IBM that runs on its Power
Systems, including System p and Systemi.

Although AlXis derived from System V Release 4, it is POSIX-compliant and meets the Trusted
Computer Base (TCB) Level C2 security.

One of the major enhancements AIX offers is Visual System Management (VSM), a graphical
interface into the older System Management Interface Tool (SMIT). VSM contains four main
elements: Print Manager, Device Manager, Storage Manager and Users and Groups Manager.

HP-UX

A version of UNIX for HP computers. HP-UX includes BSD extensions, including the networking
commands, the Korn shell, and a version of emacs. VUE (Visual User Environment) is HP’s GUI
with individual workspaces for different tasks, drag-and-drop functions, a text editor, coloricon
editor, as well as other productivity tools.

HP-UX also includes SAM (System Administration Manager) for common administration tasks,
such as adding new users, installing and configuring peripherals, managing processes and
scheduling jobs. Diskless computers, either clients or servers, can boot from the server and can
support locally mounted file systems, so that each client has access to its own data files as well as
being able to share files with others.

Solaris

A version of UNIX from Sun Microsystems that runs on Intel/ AMD based computers and Sun
SPARC workstations and servers.

Solaris is based on UNIX System V Release 4, and includes networking support. The latest version
features Java Desktop System based on GNOME that comes with a large set of applications,
including StarOffice.

Linux

A UNIX-compatible operating system originally developed for Intel-based PCs. It now exists for
many other platforms as well, including PowerPC, and Sun SPARC.

Strictly speaking, Linux is the name of the operating system kernel. Other parts of the operating
system are part of the GNU Project. Linux is a complete UNIX clone and supports the X Window
system.

Mac OS X

Mac OS X is a UNIX based operating system from Apple. The core of the system is a POSIX
compliant operating system named Darwin that provides the standard UNIX command line
interface. On top of it, higher levels of the Mac OS X system are built, including the Aqua user
interface. Mac OS X is the most popular general-purpose UNIX-like operating system currently in
use.
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UNIX File Types

Operating

System File Type

All Script

Solaris ELF

(SPARC/x86)

AIX Coff

HP-UX ELF

(HPPA, ia64)

HP-UX Coff

(HPPA)

Linux x86 ELF,

x86-64 ELF Executable and Linking
format is the binary output
produced by gcc compilers. It
replaced an earlier format to
take advantage of shared
libraries.

Mac OS X Mach-O

Description

List of commands in a text file to be executed
by an interpreter. The term script and shell
program are often used interchangeably.

Executable and Linking format is the binary
output produced by gcc compilers. It replaced
an earlier format to take advantage of shared
libraries.

Common Object File Format. A revision to the
format of executable and object files to provide
support for dynamically linked libraries. The
COFF definition was replaced by the
Executable and Link Format(ELF) in SVR4

Executable and Linking format is the binary
output produced by gcc compilers. It replaced
an earlier format to take advantage of shared
libraries.

Common Object File Format. A revision to the
format of executable and object files to provide
support for dynamically linked libraries. The
COFF definition was replaced by the
Executable and Link Format(ELF) in SVR4

Mach-O is short for Mach Object file format, the
executable file format used on Mac OS X for
executables and shared libraries. Itis a
derivation of the a.out format that offers more
extensibility and faster access to information.

Rule-Based Application Teaching

In addition to traditional scan file based recognition — where file details of executable files that make
up a particular application version are added to the software application library — Universal
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Discovery offers an easier and more flexible way of teaching some applications to the SAI by
means of rule-based recognition.

By creating a flexible recognition rule, many versions of the same application can be recognized
without the need to keep file details for all executable files that make up the application. There are
two kinds of rules currently supported.

« Version data based rules: These rules can be used to recognize simpler Windows applications
that have consistent publisher and version information reported in the version data inside its
executable files.

o Installed packages based rules: These rules can be used to recognize applications that are
packaged in the standard operating system package format.

Creating arule is usually much simpler and faster than teaching scan file data for different versions
of the corresponding application to the SAI.

You can create recognition rules by using the SAI Editor. In order to use this feature successfully,
you must have a good understanding of regular expressions. This chapter provides several
examples of regular expressions, but it is not a comprehensive reference. You also need a good
understanding of Universal Discovery’s recognition and teaching processes.

The Version Data Rules Tab and The Package Rules Tab of the SAI Editor show the available
installed package rules and version data rules in the selected SAI.

Teaching a New Application to the User SAI

Each of the steps in the following procedure are documented in SAl Editor documentation located in
this guide.

¢ Add a new Publisher if it doesn’t already exist in the SAI

o Add anew Application

¢ Addthe new Release

¢ Addanew Version

o Addfiles to the version — either from scratch or by dragging them from Windows Explorer
¢ Set the main file for the application

¢ Set up any license relationships for the application

Version Data Based Recognition Rules

Overview

A version data based recognition rule provides a rule-based extension to the software recognition in
the User SAI by using the embedded version data information in Windows executable files.
Recognition rules, if triggered, create entries in a separate rule-based SAI (by default, auto.zsai)
that sits alongside the standard User SAls.
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This rule-based recognition feature helps Universal Discovery anticipate new versions of the
applications already installed on your scanned devices and already saved in your User SAI. By
looking at the current data for an application, you can create a rule (based on a series of regular
expressions) that will provide automatic recognition of any new versions of that application.

This means that you will not have to teach each new version of an application. The rule should
automatically recognize an application upgrade.

Prerequisites:

Rule-based recognition using version data works on a unique file found in only one directory on each
machine. If this directory contains files that can also belong to other applications (libraries, for
example), then the rule may not trigger the recognition. This is because the recognition level from
the other applications may swamp the recognition level of this one target file.

For Windows devices, the Scanners must be configured to collect file signatures, identify Windows
executable files, and collect internal file identification from them. See:

Scanner Generator Wizard > Software Details > File Scanning > File Identification

Examples Where a Rule-Based Entry Could Augment the Standard Recognition Algorithm

Example 1: For the prediction of the format of a future version of a product

If an entry in the Product Version field of the version data had the format 1.2.345, for example, a rule
could be created based on a release and version having the format 1 and 1.2 respectively. The
release rule would take the portion of the string before the decimal point and classify it as the
release, the version would take the string up to the second decimal point and ignore the remaining
digits.

Example 2: For translation of the Version information associated with a file

This could be mapped to a marketing version name. For example, the file version is 9.0 but the
marketing name is 2009.

What Happens When You Have Created a Rule Entry

After the rule entry has been created, it must go through the recognition process to produce an entry
in the rule-based SAI.

Universal Discovery locates the rule-based SAIl as follows:

If a file name appears in the SAl used to store rule-created items box at the bottom of the SAI List
tab in the SAI Editor Options dialog, this file is used.

To open this dialog, click Edit > Options in the SAI Editor, and go to the SAI List tab.

If no file name appears in the SAl used to store rule-created items box, the auto.zsai file located in
the same directory as the first Master SAl file is used.

Note: The XML Enricher is also impacted and updated when a rule is created.

Creating a Recognition Rule

The rule needs to have enough information to create the release and version for the selected
application.
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When you create a rule by using the embedded version information in a Windows executable file,
the names for the release and the version are extracted from one of the version fields collected by
the scanner from that file.

The version fields include:
o CompanyName

o FileDescription

o FileVersion

¢ InternalName

o LegalCopyright

o OriginalFilename

o ProductName

¢ ProductVersion

When you create a rule by using installed package information, the names for the release and
version are extracted from various package properties, including hardware fields.

In either case, aregular expression is defined that can match against the version data of a target
file. The rules relating to these entries are stored in the current SAI selected by the SAI Editor. If
there is a match between the regular expression and the information in the target file, an entry is

triggered and written to the rule-based SAl file.

This file is defined on the SAI List tab in the SAI Editor Options dialog or created as auto.zsai in the
same directory as the first Master SAI.

If mapping is invoked, the result of the trigger may be mapped to a different output value. For
example, if a mapping has been defined as 9 = 2003, then when there is a successful match, it
produces a result of 9. However, instead of reporting the value as 9, it is reported as 2003. This is
used in situations where a publisher uses version descriptions for marketing purposes that are
different from those used by the software development team.

It is possible to perform the match using the full field value or to match on just part of the field,
known as Regular Expressions (Regex) Group. To create a Regex Group, it is necessary to insert
parentheses () around the chosen expression. These groups allow part of the string to be extracted
and used for naming the release and version.

Example of a Recognition Rule Using Version Data

The following procedure shows you how to set up a recognition rule that matches a regular
expression against embedded version data in a Windows executable file.

To set up a Recognition Rule using version data:
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Open the Viewer and the SAI Editor.
To create a rule for a specific application, you want to see the current data in the Viewer. This

enables you to build an appropriate rule so that Universal Discovery can immediately recognize
future versions of that application.

2. Inthe Viewer, open the scan file that contains the application for which you want to create a
recognition rule. You can add rules only to a User SAI.

3. Alsointhe Viewer, locate the file that you want to teach using the Directories and Files tab. In
this example, we will use the WinRAR.exe file.

4. Openthe SAI Editor.
5. Inthe User SAl file, locate the application for which you want to create a rule.

If the application is not yet present in the file, you will need to add it.

6. Inthe SAI Editor, create a placeholder Release (for example, “X”) and placeholder Version (for
example, “XX”) for the application. If the application has not previously been taught, it is also
necessary to add the main file to the application. You can do this by dragging the main file from
Windows Explorer to the SAI Editor.

7. Find the application to teach (in this example, WinRAR Archiver), and right-click it.
8. Select Edit Application Rules. The Application Rules Editor opens.

9. If the rule that you want to work with already exists, select it and click Edit. Otherwise, click
Add.

The Application Rule Wizard window opens

10. Select File version data rule (Windows), and click Next.
11. Follow these steps to specify the file name, operating system, and language:

a. Specify a Filename for a new rule or change the Filename as desired for an existing rule. In
this example, we use WinRAR .exe.

b. Specify the Operating System on which the application runs.
c. Specify the Language for the application.
d. Specify the Commercial license type for the application.
12. Click Next to proceed to the next page
13. To specify how the release name will be obtained, follow these steps:

a. Inthe Field box, specify the Version Data Field from which the release name will be
extracted.
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b. Inthe Regular expression box, specify the regular expression to use. If the same field will be
used to extract both the Release and the Version, the regular expression needs to be
generic enough to provide groups that can match both names. For example, if the value is
3.80in the File Version field, the Release is 3, and the Version is 3.80

The regular expression we will use for this example is as follows:
(([0-9]+)\.[0-9]+)

This expression represents two groups of digits separated by a period (dot). For additional
information about and examples of regular expressions, see the section about Regular
Expressions in the Analysis Workbench section of this guide.

Examples of Regular Expression Constructions

RegEXx Description

([0-91+)\.([0-9]+) This will recognize a variety of version numbers with two digits
divided by a dot. For example, 2.4, 5.6, etc.

([0-9]+)\.([0-9]+)\. Similar to the one above, this will recognize a version number with
([0-9]+)\.([0-9]+) four digits, such as 1.2.2.3, 3.4.4.4, etc.

M[A-Za-z]*)( )([A-Za- = This will recognize any text that may appear, in upper or lower-
z]*) case letters.

c. Inthe Format field, specify how the extracted field will be formatted. You can enter a
combination of text and any of the following macros.

Examples of Macros

Macro Description

${fieldvalue} Covers whatever text appears in the field. Cannot be used for Application
Name, Publisher Name, or Release.

${appname} = Application Name (returns the complete value of the Application Name,
including all formatting).

${pubname} Publisher Name (returns the complete value of the Publisher Name,
including all formatting).

${rlsname} = Release (returns the complete value of the Release, including all
formatting).

${group<n>} Returns the regex group referred to by its index <n>, where <n> is an
integer number. For example, ${group1} refers to the regex group 1.

d. Forthe Regex Group Index, select the group from which the release will be taken—or the
entire field if the entire version field value is required.
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When the Regex Group Index is N, it points to the group (sub-expression) delimited by the
Nth left parenthesis in the regular expression.

In this regular expression, for example, there are five choices: 1, 2, 3, 4 or Entire field:

Here, both 1 and Entire field specify the whole regular expression. An index of 2 matches the
leading digits to the left of the first period. An index of 3 matches the digits between the first
and second periods.

In our WinRAR.exe example, the Regex Group Index for the release will be 2 (the leading
digits before the period).

The Regex Group Index for the Version will be 1 (leading digits, then period, then digits).

For Mapping, you can enter some extra rules that will help identify applications. For
example, you can enter the following to recognize different marketing names for the
applications:

5.1=Windows XP
5.2=Windows Server 2003
6.0=Windows Vista

In our example, we do not use this capability, as the Release is a numeric value that does
not require a mapping.

f. Click Next to go to the next page

14. To specify how the main file is defined, follow these steps:

a. Select The first file belonging to the package is the Main if you want the first file selected as

the main file. The list is sorted alphabetically. Then, click Next to move to the next screen.

Select Specify the Rule for the Main File if you want to create custom rules to define which
file and which file type is defined as the main file.
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15.

16.

17.

b. Onthe Include Rule tab, type the file name and file directory for the file that you want to
include in the rule.

In the File Name field, type the name of the file that you want to include in the rule. You can
also type a wildcard to include all files.

In the File Directory field, type the directory path where the file is located.

c. Toselect the file types to use to define the main file, select one of the following options:

Any (including non-executables)- Includes all file types that are contained in the package.
Any executable- Includes all file types that are contained in the package.

Any executable selected- Includes the file types that you select.

Any executable not selected- Includes the file types that are not selected.

d. On the Exclude Rule tab, type the name of the file that you want to exclude from the rule.
You can also type a wildcard to exclude all files.

In the File Name field, type the name of the file that you want to exclude from the rule. You
can also type a wildcard to include all files.

In the File Directory field, type the directory path where the file is located.

e. Click Next to move to the next screen, or click Back to return to a previous screen.
Follow the same procedure to specify how the version will be obtained.

The Regular expression box is only enabled if the version data field specified in the Field box is
different from the one used to determine the release. If it is the same and you need to amend the
regular expression, click Back and edit it on the previous screen.

When you are finished, click Next to proceed to the next page.

On this page the Finish button becomes enabled. When no further matches are required, leave
the radio button in the No further matches state, and click Finish to complete the wizard.
Normally, however, it is necessary to specify extra conditions to ensure that the file comes
from the expected publisher.

In our example, we want to make sure that the CompanyName field refers to Alexander Roshal,
which is the company we expect. If WinRAR.exe happens to be used in another unconnected
application for which the CompanyName is different, the rule will not be triggered. Another
useful option is to match is the ProductName field.

Note that the Field drop-down list only includes fields that have not previously been used either
for Release, Version, or extra matches.

Click Finish to complete the rule configuration or Next to add another extra match.

Your new rule is now ready to be used for recognition. See View Your New Rule on page 366 to
determine whether it successfully detected the application. The Version Data Rules tab shows all
of the available version data rules in the current SAI.
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Example of a Recognition Rule Using Installed Package
Information

When the Scanner is configured to collect Installed Applications file data, the Scanner can collect
information as to which files belong to which installed packages. Using installed package
recognition rules, files belonging to a particular package can be automatically recognized as
belonging to a particular version of an application.

For more information, see the section describing the Hardware Data page in the Scanner Generator
Wizard in the Data Flow Management Guide.

The following procedure shows you how to set up a recognition rule that matches a regular
expression against installed package information.

To set up a Recognition Rule using installed package information:
1. Open the SAI Editor.

2. Inthe User SAl file, locate the application for which you want to create a rule—in this example,
we will create a rule for tcl from ActiveState Software.

If the application is not yet present in the file, you will need to add it.

3. Right-click the application that you want to teach, and select Edit Application Rules.

The Application Rules Editor opens.

4. If the rule that you want to work with already exists, select it and click Edit. Otherwise, click
Add.

The Application Rule Wizard window opens

5. Select Installed Package and click Next. The Application Rule Wizard opens.
6. Follow these steps to specify the package name, type, and properties:

a. Specify a Package name for a new rule or change the Installed Package Name as desired
for an existing rule. The string you enter must match the package name exactly and is case
sensitive. In this example, we use tcl.

b. Select the Installed Package Type for this application. This is determined by the operating
system on which the application runs.

Oracle. If you want Universal Discovery to recognize Oracle components installed by the

Oracle Universal Installer, click to select the Oracle check box, regardless of what
operating system the Oracle components are installed on.
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Patch. If you want Universal Discovery to recognize patches, click to select the Patch
check box. If you want Universal Discovery to recognize Windows APP package types,
click to select the APP (Windows) check box.

Note: If you select the APP (Windows) option, you cannot edit the Recognize the
application even if the package has no files option.

App-V. If you want Universal Discovery to recognize virtual applications that are running
under Microsoft Application Virtualization ("App-V"), select the App-V check box.

c. Specify the Operating System for the application.

d. Specify the Language for the application.

e. Specify the Commercial license type for the application.

f. Select Recognize the application even if the package has no files to recognize a
package that does not contain files.

7. Click Next. The Package Rule page opens.
8. Follow these steps to specify the regular expression for the release name:
a. Inthe Field box, select the hardware field from which the release name will be obtained.

b. Inthe Regular expression box, specify the regular expression to use. If the same field will be
used to extract both the release and the version, the regular expression needs to be generic
enough to provide groups that can match both names.

The regular expression we will use for this example is as follows:
([0-9]+)\..*

This expression represents a group of digits, followed by a period (dot), followed by any
string. For additional information about and examples of regular expressions, see the section
describing regular expressions in the Analysis Workbench part of this guide.

c. Inthe Format field, specify how the release name will be formatted. You can entera
combination of text. For more macros, see the section on Macros in this guide.

d. Forthe Regex Group Index, select the group from which the release name will be taken—or
the entire field if the entire version field value is required. See Example of a Recognition
Rule Using Version Data, step d in this guide for information about how to choose this value.

e. ForMapping, you can enter some extra rules that will help identify applications. For
example, you can enter the following to recognize different marketing names for the
applications:

5.1=Windows XP
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5.2=Windows Server 2003
6.0=Windows Vista

In our example, we do not use this capability, as the release is a numeric value that does not
require a mapping.

9. Click Next to proceed.
10. Follow the same procedure to specify the regular expression for the version name.

The Regular expression box is only enabled if the version data field specified in the Field box is
different from the one used to determine the release name. If it is the same and you need to
amend the regular expression, click Back and edit it on the previous screen.

11. Click Next. The following page will open if you have selected the Recognize the application
even if the package has no files check box in step 6:

12. Follow these steps to specify how the main file will be selected:

You can specify the rule for the main file. Otherwise, the first file that is contained in the
package is marked as the main file.

In the Include Rule tab, you can specify file name, directory, and type to be included being
selected as main file.

Similarly, you can specify file name and directory to be excluded from being selected as main
file in the Exclude Rule tab.

Click Next to proceed

13. On this page the Finish button becomes enabled. When no further matches are required, leave
the radio button in the No further matches state, and click Finish to complete the wizard.
Normally, however, it is necessary to specify extra conditions to ensure that the file comes
from the expected publisher.

In our example, we want to make sure that the publisher field refers to Red Hat Inc., which is the
company we expect. If the tcl package happens to be used in another unconnected application
for which the publisher is different, the rule will not be triggered.

Note that the Field drop-down list only includes fields that have not previously been used for the
release name, version name, or other extra matches.

14. Click Finish to complete the rule configuration or Next to add another extra match.
Your new rule is now ready to be used for recognition. See the section entitled View Your New Rule

to determine whether it successfully detected the installed package. The Package Rules tab shows
all of the available installed package rules in the currently selected SAI.

HP Universal CMDB (10.10) Page 273 of 311



Inventory Tools User Guide
Contents

Viewing Your New Rule

After you create a new rule for application recognition, you can use the SAIl Editor to view the
results of adding that rule.

1. Inthe SAI Editor, click Tools > Import Data from Recognition Result
2. Select your scan file, and click OK.

The Recognition Result Import window appears, and it will process the scan data for a few
seconds.

w

Right-click the file or package that you were teaching, and select View File Properties. You can
see the latest version data or installed package information as seen in the scan file.

4. Inthe SAI Editor, click Edit > Options.
5. Click the SAl List tab.

6. From the SAIl used to store rule-created items list, select the file that you specified for rule-
based recognition (by default, auto.zsai) and click OK.

7. Inthis file, expand the entry for the application to which your rule applies, and you will see the
latest data available for this application, based on the rules that you created.

Rules Section in the XML Import

The rules section is added to end of the SAI.

</publisher>

- <rules>

- <rule appid="1500000000" filename="default.exe">

<fieldmatch field="ProductName" regex="" />

<fieldmatch field="ProductVersion" regex="[1-9].[0-9]" />

<fieldmatch field="CompanyName" regex="" />

<releasefield field="CompanyName" format="${fieldvalue}" groupindex="0" />
<versionfield field="ProductName" format="${fieldvalue}" groupindex="0" />
</rule>

- <rule appid="1500000001" filename="SshClient.exe">

<fieldmatch field="ProductVersion" regex="[1-9]\." />

<fieldmatch field="FileVersion" regex="\.[1-9]*" />
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<fieldmatch field="CompanyName" regex="("Ssh)($h)" />

<fieldmatch field="LegalCopyright" regex="(Comm)" />

<releasefield field="CompanyName" format="${fieldvalue}" groupindex="1" />
<versionfield field="CompanyName" format="${fieldvalue}" groupindex="2" />
</rule>

- <rule appid="1500000001" filename="ssh2.exe">

<fieldmatch field="ProductName" regex="([ssh])" />

<fieldmatch field="ProductVersion" regex="[1-9]" />

<releasefield field="ProductName" format="${fieldvalue}" groupindex="1" />
<versionfield field="ProductVersion" format="${fieldvalue}" groupindex="0" />
</rule>

- <rule appid="3904" filename="iftlsnr.exe">

<fieldmatch field="ProductVersion" regex="([0-9]\.[0-9])" />

<fieldmatch field="FileVersion" regex="([0-9]\.[0-9]\.[0-9])" />

<fieldmatch field="ProductName" regex="${appname}" />

<releasefield field="ProductName" format="${fieldvalue}" groupindex="0" />
<versionfield field="FileVersion" format="${fieldvalue}" groupindex="1" />
</rule>

</rules>

</sai>

Viewer Overview

Viewer allows you to view the detailed information contained within a scan file (.xsf). This provides
a convenient way of displaying software, hardware and asset information collected for an individual
computer. The Viewer is aimed at technical support and help desk staff who need detailed
configuration analysis and diagnostics.

You can also view other information, such as the characteristics of software files stored during the
inventory, applications and the environment variables.

In summary, the Viewer displays:
o Detailed and summarized hardware configuration information.
o Assetinformation.

o Details of all software scanned.
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o Contents of key files collected during the inventory, such as system configuration files
(Config.sys and Autoexec.bat etc.).

¢ Environment variables.

o Details of all logical drives scanned.

o Details of any applications recognized.

o Alist of installed applications as reported by the operating system.

o Alist of running software processes.

Starting Viewer

To start Viewer on your Windows workstation:

From the Windows Start menu select Programs > HP UCMDB > > Inventory Tools > Viewer.

Exiting Viewer
To exit Viewer on your Windows workstation use one of the following methods:
¢ Select the Exit command from the File menu.

o Usethe close icon in the top right of the workspace.

Viewer User Interface
The Menu Bar

Viewer commands are accessible from the menu bar. Commands are grouped by function (‘File’,
‘Edit’, ‘View’, ‘Window’, ‘Help’). Each function has its own entry (command) in the menus. Menu
commands may be activated with the mouse or the keyboard.

o To open amenu, perform one of the following:

¢ Use the mouse. Click the menu name (for example, File) and then click the command you want
(for example, Open Scan File).

o Use the shortcut keys. Shortcut keys are shown to the right of the command in the menus. For
example, CTRL+o is a shortcut used to open a scan file.

o Usethe access key. Access keys are indicated by an underscore on the active letter. For
example, the Open Scan File command in the File menu is accessed by pressing Alt-F and then
0.

Note: Most menus invoke commands, however, some menu commands display a dialog box.
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This is indicated by an ellipses (...) after the menu command.

Shortcut Menus

You can access a shortcut menu related to your current activity by positioning the mouse cursor on

the appropriate area of the workspace and clicking on the right mouse button.

Toolbars

Toolbars allow you to access various commands without using the menu.

Click the toolbar icon to activate the function associated with it.

Buttons in the toolbar offer the following functionality:

=
[=}

"~

Arrange Icons

Help

Icon Name Function

& OpenScanFile  Loads inventory data from an XSF file.

¢  Options Displays the Viewer Options dialog box.

Copy Copies the information in the currently selected tab to the clipboard.
E =] Copy to File Copies the information in the currently selected tab to a file.
Compare Compares two scans.

#h  FindFile Finds a file within a scan.

= Tile Horizontally = Tiles windows horizontally.

K| Tile Vertically Tiles windows vertically.

= Cascade Cascades windows.

Aligns all icons of minimized windows.

Displays the help text for Viewer.

Tip: When the mouse pointer passes over an icon, a tooltip appears indicating the command

corresponding to the icon.

Moving a Toolbar

The toolbar can be dragged and positioned to be aligned to the top of the window, the left of the
window or into a floating state.

To move a toolbar:

Click the “move” handle on a docked toolbar (one that is attached to one edge of the program
window), and drag it to a new location.

When you drag a toolbar to the edge of a window, the toolbar outline snaps into place along the
length of the window edge.
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You can dock a floating toolbar by double-clicking on the title bar.
Resizing a Toolbar
To resize a floating toolbar:

Move the pointer over any edge until it changes to a double-headed arrow, and then drag the edge of
the toolbar.

Note: You cannot resize a docked toolbar.

Tab Pages

Tab pages in Viewer allow you to examine the data from aloaded scan file. You can select the
following tab pages:

e Summary

o Hardware and Configuration
¢ Directories and Files

o Stored Files

o Software Applications (only displayed if Application Recognition was set as an option). See
Configuring Recognition Settings for further information.

Status Bar

A status bar at the bottom of the Viewer workspace displays information about the current loaded
scanfile.

The status bar has three panels:
o Thefirst panel displays the current system date and time.
o The second panel displays the number of scans currently loaded.

o The third panel displays the name of the scan file currently displayed along with a brief

description.
Shortcut Keys
You can quickly accomplish tasks you perform frequently by using shortcut keys.
Task Keyboard Shortcut
Open Scan File CTRL+o0
Close CTRL+F4
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Task Keyboard Shortcut
Options CTRL+t
Exit Viewer ALT+x
Copy CTRL+c
Compare CTRL+m
Find File CTRL+f
Show Advanced Hardware View CTRL+v
Sorting Lists

Click on a column list header to sort and reverse sort the order of the information, alphabetically or
numerically in ascending order (A to Z, a to z or zero to 9) or descending order (Zto A, ztoaor9to
zero).

Double-clicking on the splitter icon between columns will expand the column width to the
maximum cell width.

Copying the Contents of a Tab Page

You can save or copy the contents of all tab pages.

To copy the contents of a tab page to the clipboard:
1. Select the Copy command from the Edit menu, or click the iconin the Viewer.
2. Paste the contents to an editor of your choice.

To save the contents of a tab page to afile:

1. Select the Copy to file... command from the Edit menu (text files only), or click the iconin the
Viewer.

2. Use standard Windows navigation methods to select or enter a file and the location where the
file is to be saved.

Searching for Files

You can locate a file from any point within Viewer. This can facilitate the location of files for a
machine across multiple drives.

To locate a file from any point:

1. Select the Find File command in the Edit menu, or click the icon. The Find File dialog box
appears.

2. Inthe Name box, type the name of the file you want to find. You can use DOS wildcard
characters, (using * and ?) as well as normal alphanumeric characters.
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3. Click the Find Now button.

If files matching the file name or mask are located, they are displayed in the Search Results list
box.

If the search is lengthy, you can abort the search (with partial results being displayed) by
clicking the Stop button.

4. Highlight a file entry in the Search Results list.
5. Click the Goto button or double-click on a file entry.

The Directories and Files tab of Viewer is displayed in the background showing the located file.

6. To clearthe entries and carry out a new search, click the New Search button.

Configuring Recognition Setting

The Viewer is able to perform application recognition on the software scanned, while the data is
being loaded from a scan file.

When the application recognition is enabled, a Software Applications tab is available in the Viewer
workspace. This tab shows a summary of identified applications on the selected machine. When
recognition is disabled, loading is slightly faster but no application information is available.

There are three recognition methods: No recognition, Installed applications, and Software
application index (SAI). By default, the Viewer uses the SAI recognition configured with the Master
SAl files (Master.zsai) to perform application recognition. The Master SAl files are read-only files
that contain a library of software applications.

There are multiple Master SAl files that can be used at the same time for recognition purposes:
o Master.zsai

French.zsai

German.zsai

e Unix.zsai
e BaseUnixOS.zsai

All of these files can be found by default in the following location:

C:\Hp\UCMDB\DataFlowProbe\Runtime\ProbeManager\DiscoverySaiResources\SaiRuntim
e

By default, the Viewer is also configured to use the User.zsai file. A User.zsai file is one that you,
the customer, have customized with applications you have taught using Analysis Workbench or
SAI Editor.

You can use multiple User SAl files for recognition purposes. Each User SAl created has a unique
identifier assigned to it.
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Note: Backward compatibility has been maintained in this version of Universal Discovery.

To display the Viewer recognition options tab:
1. Select the Options command from the Files menu. The Viewer Options dialog box appears.

2. Click the Recognition tab.

Note: Utilization data shows you how much a particular software application is being
used. Of the three available options, only the SAIl option will produce utilization data.

Disabling Application Recognition

This option is used to disable any application recognition. When recognition is disabled, loading is
slightly faster but no application information is available.

To disable application recognition:

In the Recognition Method group box, select the No recognition option.

Selecting the Installed Applications List as the Recognition Method

This method of recognition is based on the operating system’s internal list of applications. As such,
it is not recommended as the preferred recognition method, except for data from UNIX Scanners.

To select installed applications for the recognition method:
In the Recognition Method group box, select the Installed Applications option.

The Use Enriched application data if available option is then activated. If you select this option,
Viewer uses the application data from the enriched scan file instead of running “real” recognition.

Selecting the SAl as the Recognition Method
1. Inthe Recognition Method group box, select the Software Application Index (SAI) option.

2. Click the Advanced button to set further options if required. The Advanced Configuration -
Software Application Index dialog box is displayed.

Setting Level of Recognition Used

To set the level of recognition used:
1. Select the General tab in the Advanced Configuration - Software Application Index dialog box.
2. Inthe Miscellaneous group, select options for the level of recognition used.
= Level 3 recognition heuristics

If this option is enabled, the recognition engine defers its final recognition decision until all the
files in all the directories on the machine have been read. If disabled, machine-based recognition
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does not take place and recognition data is returned after each directory is loaded. A time
overhead of about 10% is normal when Level 3 Recognition is enabled.

= Auto-identify unrecognized device driver files

When enabled (by default), files that cannot be identified by standard SAI recognition and have
the Device Driver attribute will be marked as recognized. Files used as Device Drivers
represent a large portion of the files that are not identified by the Application Library. Being able
to identify these automatically can significantly reduce the effort required to achieve good
recognition rates.

Setting the Preferred Language

If you are using a national SAl file, for example, German.zsai or French.zsai together with the
Master.zsai, you will want to set this option.

Preferred language is used for cases when the recognition engine encounters two or more versions
within a directory that are identically matched. It will give preference to the one in the selected
language.

Note: This will only work if exactly one of the versions matches the language.

To set the language options:
1. Select a language from the drop-down list.
2. Check the Override OS Language box if you want the recognition engine to overlook the
operating system locale setting and take the setting you specified in the Preferred Language

box.

Summary of the Recognition Process

The process can be summarized as follows:

o Arating is obtained for all versions that are possible matches.

o The version(s) with the best rating are found.

« If there is only one version, then the process goes no further. Otherwise, the version whose
language matches the OS locale is selected. If no version matches this language, then the

version matching the setting in the Preferred Language box is selected.

o If the operating system locale setting is not available, it takes the setting you specified here in
the Preferred Language box.

Adding, Creating or Removing SAls

The options on the SAls tab page allow you to:

Add a new SAl file to be used for application recognition.
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1.

Remove an existing SAl file.

2. Create a new empty User.zsai file.

The list box on this tab page displays the following information:

The path to source files for the SAI — both read-only Master SAls and editable User SAls.
The SAI ID number for User SAl files. Master SAl files do not have an ID.

A description of the SAl files.

The size of each SAl file (in kilobytes).

The number of application versions in each SAI.

The type of SAl file:

Master SAl — Read-only SAIl

User SAI - Editable

The creation date for a Master SAl file or for a User SAI, the date the file was last saved.

SAls Used to Store Rule-Created Items

Any items encountered by Viewer that were created by rules will be added to the SAl file specified
here. These rules are present within the SAl files themselves and additional rules can be added
using SAI Editor.

Select the SAl file from the drop down list. The drop down list contains a list of the SAls currently
loaded.

If this field is left blank, Viewer will create a file called Auto.zsai and put this in the same location as
the first SAl in the list.

Adding, Removing, or Creating a New SAIl File for Application Recognition

To add a new SAl file for application recognition:

1.

Select the SAls tab in the Advanced Configuration - Software Application Index dialog box.

2. Click the Add button on this tab page.

3. Navigate to and select the SAI file (Master or User) you want to use for recognition.

The SAl file is added to the list box which means the file will be included in for application
recognition.

Removing an Existing SAIl File

To remove an existing SAlI file:

Select the file in the list box and click the Remove button.

HP Universal CMDB (10.10) Page 283 of 311



Inventory Tools User Guide
Contents

Creating a New Empty User SAI

To create a new empty User SAI:
1. Click the Create... button. The Create a User SAI dialog box is displayed.
2. Enter or navigate to the directory where the SAl file is to be created.
3. Enter a description for the file.
4. Click the OK button.

The file is automatically assigned a unique ID. However, you may already have an SAl with the
same filename. If so, a confirmation message will be displayed.

5. Click Yes if you want to overwrite the existing SAl file or click No to return to the dialog box
and assign a new ID to the SAl file.

6. If you have made modifications to the cfgNextSAIID setting in the SAL.ini file, you may see
the following message. This happens when the value for the ID in the ini file is missing or lower
than the highest ID in the user SAls currently loaded. This message is for information only —
the Data Flow Probe components will correct this situation automatically by inserting the
correct ID value into the ini file.

The next User SAI ID cannot be found in the settings file.

This probably means that you are using User SAls created with a different version of the software,
or created on a different machine.

Please take care to set the new ID to a value that is unique across your organization.

Setting Filtering Options for the SAI
1. Select the Filtering tab in the Advanced Configuration - Software Application Index dialog box.
2. Select the options as required:

Apply recognition to selected files only

This is a recognition filter that determines which of the files are sent to the recognition engine for
processing. Sending too many files can make it slightly slower.

= By extensions

Allows you to type in the extensions of any files that you want processed against the recognition
engine. Select the extension from the drop-down list (this list maintains a history of previously
entered extensions) or type the extension directly in to the box. Multiple file extensions must be
separated by a semicolon.

= Executable files

All executable files will be processed against the recognition engine. Executable files include
*.exe, *.com, *.dll and other files containing executable code.
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» Files within Archives

Processes any files in archive files. The following archive file types are supported:

ARJ, ZIP v1, ZIP v2, LHA, LZH, ARC, CAB, TAR, GZIP, TAR/GZIP and PAK

Note: For the best application recognition, select the Executable Files option.

Junk Files

Some files may be executable but are of no interest for licensing or other purposes. These files are
often identifiable via the file name for example, TMP[0-9]*\.\$\$\$.

The Treat Files matching the following regular expressions as junk option is a way for the
recognition engine to ignore such files, by allowing one or more file name masks to be specified as
junk.

These files are not passed to the recognition engine and will be marked as junk. This is available in
the Display Filters tab page so junk files can be discarded and not shown.

Note: When matching the junk file name against the junk filter regular expression, the file name
is first converted to lower-case. For this reason, all letters entered as part of the regular
expression must be in lower-case for a match to successfully occur. To enter multiple regular
expressions, enter each regular express on its own line.

To set junk filters:
1. Select the Treat Files matching the following regular expressions as junk option.
2. Type the file name masks you want to treat as junk.

For more information about regular expressions refer to the Analysis Workbench section.

Configuring Asset Field Settings

Asset Field Settings Overview

The Viewer can be configured to construct any number of additional read-only named asset fields.
These asset fields are constructed based on data collected at scan time. The analysis asset fields
defined here are automatically displayed as entries in the Asset Data folder in the Hardware and
Configuration tab page.

To configure the asset field extract settings:

1. From the File menu, select Options, or click the & icon. The Viewer Options dialog box is
displayed.

2. Click the Asset Fields tab. This tab contains a pane with five columns:
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= Caption - The caption as specified in the Asset Data page of the Scanner Generator.
» Field - The number of the Analysis field (1 to 28).
» Field Type - The type of field to extract the information.
= Field Data - The source of the field information.
» Default - Any default value that has been set.
3. Right-click anywhere in the pane to display a menu with the following options:
= Add - Adds a new analysis asset field.
» Edit- Enables you to modify an existing asset field.

= Remove - Removes an existing asset field from the list.

Adding an Asset Extract Field

The fields are set up in a manner similar to that found in the Scanner Generator. Five different types
of fields can be constructed:

o Text file Extract

Takes data from a plain text file (similar to File Extract Field of Scanner).

e Ini Field Extract

Takes data from an ini file (no equivalent in Scanner).

o CSVFile

Takes data from CSV files such as peripheral sheets (allows an external CSV file, containing a list
of data associated with asset numbers to be parsed and loaded along side the other data).

¢ Environment Field

Takes data from environment strings (equivalent to same field in Scanner).

e Sequence Field

Takes data from a sequence of asset fields (equivalent to same field in Scanner).
To add a new asset field extract:

1. Click the Add button. A New Analysis Asset Field dialog box appears.

2. Inthe Field Type group, select the type of field to be extracted.

3. Use the controls on this page to configure the desired fields.
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Extract Field Types

Text File Extract Asset Field

This field type extracts information from a single line in a named text file.

A useful file extracts include the predefined SMS file which extracts the SMS Unique Machine ID.

The file you wish to extract from must be a file that is included in the Stored Files section. If the file
is not there it will not work. In other words, the Scanner has to be set up to store the file before you
can extract from it in Viewer.

To set up a new text file extract asset field:

1.

2.

Select Text File Extract as the field type

In the File Name box, specify the name of the text file that the information is to be extracted
from.

In the Search String box, specify the text string that is going to be located.
Assign the number for the analysis field by selecting it from the Field drop-down list.
Assign a caption for the field if required, by typing it in the Caption field.

Check the Remove leading blanks box, to remove blank spaces (if there are any) before the
search string located in the text file.

Check the Remove trailing blanks box, to remove blank spaces (if there are any) after the
search string located in the text file.

In the File Directory group box specify where to look for the file. This is a prioritized search
sequence list. Select one of the following options:

= Use first occurrence — Viewer uses the first match of the file that it encounters.

= Use prioritized directory list — A list box is enabled, which allows you to specify the priority

of directories where the file might be located.

%BASEOS% (the base operating system directory). For example:
C:\Winnt

This location will have the highest priority, that is, if the file is located in this directory, then this
file will be used.

%BASEOS%\System (the System directory in the base operating system directory). For
example:

C:\Winnt\System

HP Universal CMDB (10.10) Page 287 of 311



Inventory Tools User Guide
Contents

If the file is not located in the %BASEOS% directory and is encountered in the
%BASEOS%\System location, then this location will have priority as the source for the text
file, and so on.

9. Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables for information
about how to do this.

Ini File Extract Asset Field

Initialization files (.ini files) contain a number of different sections. Each section contains lines of
settings (Key Names) applicable to that section. The format of the ini file is as follows:

[Section Name1] - (The name of the first section)

Key Name1 = Value (The first setting)

Key Name2 = Value (The second setting)

[Section Name?2] - (The name of the next section)

Key Name1 = Value (The first setting)

Key Name2 = Value (The second setting)

The advantage of using this type of asset field instead of using a text file extract asset field, is that

it is possible to pinpoint precisely the Key Name you require and in the section in which it resides.

Note: The ini file you wish to extract from must be a file that is included in the Stored Files
section. If the file is not there it will not work. In other words, the Scanner has to be set up to
store the file before you can extract from it in Viewer.

To set up anini file extract asset field:
1. Select Ini File Extract as the field type.

2. Inthe File Name box, specify the name of the ini file that the information is to be extracted
from.

3. Assign the number for the analysis field by selecting it from the Field drop-down list.
4. Assign a caption for the field if required, by typing it in the Caption field.

5. Inthe File Directory group box, specify where to look for the file. This is a prioritized search
sequence list. Select one of the following options:

= Use first occurrence — Viewer will use the first match of the file that is encountered.

» Use prioritized directory list — Selecting this option enables a list box, which is used to
specify the priority of directories where the file might be located. For example:

%BASEOS% (the base operating system directory). For example:
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10.

C:\Winnt

This location will have the highest priority, that is, if the file is located in this directory, then this
file will be used.

%BASEOS%\System (the System directory in the base operating system directory) for
example, C:\Winnt\System

If the file is not located in the %BASEOS% directory and is encountered in the
%BASEOS%\System location, then this location will have priority as the source for the text
file, and so on.

In the Ini file section box, specify the section of the ini file that the asset field extract is located
in. This is the section identifier in the ini file (surrounded by square brackets []). Do not include
the brackets [].

In the Key Name box, specify the Key Name contained in the specified section of the ini file.
This is the start of the string before the equals (=) sign. Do not include the = sign.

Check the Remove leading blanks box to remove blank spaces (if there are any) before the
Key Name located in the ini file.

Check the Remove trailing blanks box to remove blank spaces (if there are any) after the Key
Name located in the ini file.

Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables for information
about how to do this.

CSV File Asset Field

This type of field allows an external Comma Separated Variable (CSV) file, containing a list of data
associated with asset numbers to be parsed and loaded along side the other data.

To set up a CSV file extract asset field:

1.

2.

Select CSV File as the field type.
Inthe CSV File box, navigate to the CSV file.

The first row of this file must contain column headers.

3. Enter the number of the column that contains the machine asset number (that is, the primary

identifier field). As the number changes so does the fields selection. For example, if the primary
identifier is column 2 in the CSV file, then specify this as the number ‘2’ by either typing it
directly into the field or by using the arrows.

The fields contained in the CSV file are displayed in the Fields list box. Select the fields to be
included by selecting the check boxes next to the field names.

The primary identifier column (asset number field) check box is disabled and cannot be
selected. This is because it is necessary to load this field.
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4. Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables for information
about how to do this.

Environment Variable Asset Field

This type of field accepts data from a specified environment variable. This can be checked by
looking in the Operating System data > Environment folder in the Hardware and Configuration tab

page.

To set up an environment variable extract asset field:
1. Select Environment as the field type.

2. Enter the variable name in the Environment variable name field. An example of an environment
variable is:

ComSpec
Where ComSpec could be C:\WinNT\System32\cmd.exe

3. Assign the number for the analysis field by selecting it from the Field drop-down list.
4. Assign a caption for the field if required, by typing it in the Caption field.

5. Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables for information
about how to do this.

Sequence Asset Field

This field type extracts information from one of up to ten specified fields. The value returned as the
results of the sequence field, will be the first of these fields which contains a non-blank value.

To set up a sequence asset field:
1. Select Sequence as the field type.

2. Inthe Field Sequence box, click in the Field Name column, and from the drop-down list, select
the desired field.

3. Inthe Ignore strings group box, specify the criteria for a blank field using one or all of the
following methods:

4. Inthe Matching box, enter a sequence of strings (case-sensitive) separated by semicolons.

If the content of the field matches (is equal to) any of the strings specified here, the field is
considered to be blank. For example, if the text string “Not Found” is entered here, then a field
that has the value “Not Found” is considered to be blank.

Multiple entries must be separated by semicolons ( ;), for example:

‘Unknown;Not Tested’
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5. You cantype a string in the form: *STRING*

Here the asterisks (*) are ignored and any string that contains the text between the two
asterisks will be ignored too.

Specify ignore strings that are less than ‘n’ characters.

In the Shorter than box, use the arrow keys or type in a number to specify the maximum length
of text strings that are to be used to define a blank field (between 1 and 255). If the string is
shorter than the specified number, then the field will be considered blank.

Assign the number for the analysis field by selecting it from the Field drop-down list.
Assign a caption for the field if required, by typing it in the Caption field.

Specify any extract options as required by clicking the Options... button. See Specifying
Extract Options for Text Files, INI Files, CSV Files and Environment Variables for information
about how to do this.

Specifying Extract Options for Text Files, INI Files, CSV Files and
Environment Variables

Text file, ini file and environment variable asset fields can be set up so that only part of the string is
extracted instead of the entire string.

They can also be set up, for example, to use the last part rather than the first part of the string. This
can be very useful for obtaining the last part of an automatic field that is too long.

In addition, a default value can be specified for situations where no matching data has been found.

To specify extract options for text, ini and environment variables:

1.

3.

Click the Options button in the New Analysis Asset Field dialog box. The Asset Field Extract
Options dialog box appears.

In the Extract characters from group box, specify whether you want to use the last part or the
first part of the string. Select one of the following options:

s Start

Uses the first part of the string. Use the arrows in the Skip characters box to specify how many
characters you want to skip from the beginning of the string.

= End

Uses the last part of the string. Use the arrows in the Skip characters box to specify how many
characters you want to skip from the end of the string.

In the Options group box, select the options you want:
= Convert to upper case

Select this option to convert the alphabetic characters to upper case.
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= Treat field as File Name

Select this option to treat the string in the asset field as a file name. Some characters are
however invalid in file names, so any invalid characters can be replaced with the character
specified in the Replace invalid characters with box.

For example, underscore ‘ ’ is a valid file name character and can be used to replace invalid
characters.

Alternatively, invalid characters can be deleted by checking the Delete invalid characters box.

If the extracted field is empty or is not found (that is, there is no matching data), then a default
value for the string can be specified in the Default Value box.

For example, if the text string ‘Not Found’ is entered in this box, then an empty field or a field
that has not been found will be displayed with this text.

Loading Data from a Scan File

Each scan file is loaded into a new window. This allows you to view multiple files at the same time.

You can load files from the processed directory. Enriched scan files are created here. By default the
directory is in the following location on the Data Flow Probe:

C:\Hp\UCMDB\DataFlowProbe\Runtime\Xmlenricher\Scans\Processed

To load scan files in the Viewer:
1. Select the Open Scan File command from the File menu, or click the (= button in the toolbar.

The Open Scan file dialog box appears.
This dialog box is split into two viewing areas (panes):

= The top pane is an explorer type directory tree that allows you to navigate to the directory
containing the scan files.

= The bottom pane displays all scan files that are available in the selected directory.

2. Inthe top pane, navigate to the directory that you want to load the scan files from. Any scan
files found in that directory are displayed in the bottom pane.

Details are displayed in the status panel when you place the mouse pointer over the scan file.

3. Check the box next to the scan file to include it for loading (you can also use the space bar to
check and clear the box). Checking options can also be set by using the shortcut menu which
is available by right-clicking anywhere in this pane.

4. Click the OK button to load the scan files.

You can also use drag-and-drop to load scan files. Drop any number of scan files onto the Viewer
window to load them directly.
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Viewing Summary Data

The Summary tab displays a small summary of key hardware, software, user and asset information
derived from the other tab pages in Viewer.

Navigation in the Summary Tab

To go directly to the tab page from which the summary information was derived:

¢ Right-click and select the option from the menu or double-click on an item.

The following table shows the items on the Summary page, a short description and the tab page
displayed when you double-click or right-click on the item:

Item

Machine

Scan date

Scanner version

CPU

Memory

HD Capacity

0S

MachinelD

Scanned volumes

Scanned files
Stored files

Fully Recognized
Applications

Partially Recognized
Applications

HP Universal CMDB (10.10)

Description

Description field

Date the scan file was produced

Scanner used to create the scan file

CPU description

Memory size

Disk size

Operating system

Network name of the scanned
machine

Drive letters scanned

Number of scanned files
Number of stored files

Number of fully recognized
applications

Number of partially recognized
applications

Page Displayed

Hardware and
Configuration

Hardware and
Configuration

Hardware and
Configuration

Hardware and
Configuration

Hardware and
Configuration

Hardware and
Configuration

Hardware and
Configuration

Hardware and
Configuration

Hardware and
Configuration

Directories and Files
Stored Files

Software Applications

Software Applications
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Viewing Hardware and Configuration Data

Hardware and Configuration Data Page Overview

The Hardware and Configuration tab displays:

¢ Userand asset information collected using the asset questionnaire during the inventory.
« High level hardware information scanned during the inventory.

¢ Running software processes.

Further Information

¢ Forinformation about the SMBIOS details, refer to the “System Management BIOS (SMBIOS)
Version 2.4 Reference Specification,” which can be found at the DMTF Web site
(http://www.dmtf.org).

The Hardware and Configuration Tab Page Layout

The Hardware and Configuration tab page consists of four panes. By default when you first start
Viewer, only the first three are shown (Simple mode):

Category tree

Category description

1st level data

2nd level data

The following screen shot shows the Hardware and Configuration tab page in Advanced mode.
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éProvides a description of the currently selected category. §
Advanced and Simple Display Mode

By default, when you first start the Viewer, the Hardware and Configuration data page is displayed
in Simple mode.

You can display this information in a Advanced mode (hyperlinks shown and all four panes are
displayed):

To switch between Advanced and Simple mode in the Hardware and Configuration data page:
Select or clear the Advanced Hardware View option in the View menu.
Category Tree

The left side of this tab page shows a tree. This tree contains folders for each of the Asset and
Hardware data items. You can click on a folder to expand it and reveal further items in the category.

The @ icon indicates that multiple instances of that particular item may exist. In the following
example, the multiple folder icon indicates that multiple Buses are supported (these being ISA and
PCI).

Category Description

This pane provides a description about the data category you have selected from the tree.
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A detailed list of all the hardware items scanned and descriptions for all of these can be found in the
document entitled ‘Hardware and configuration data’.

1st Level Data

When you have selected a category in the tree, information is shown for it in this pane. In the
previous example, the Buses supported were shown.

2nd Level Data

You will note that some entries in the 1st level pane may have hyperlinks. When clicked, further
information for that instance of the item is show in the 2nd level data pane. In our example, the
Cards (2) hyperlink was clicked and further information about the PCI card is displayed in 2nd level
pane.

In... Buz M. .. Cardz
L@l 154 Cards [1
r 2 Lards [

Index Buz Clazz Wendor M arne
21 PCl Sypstem [ntel Intel[R] E7¥505 Chipzet Host Contraller - 2850
210 FCl Sywsham [ntel Intel[R] 3280108 LPC Interface Contraller - 24C0
211 FCI Digk. Intel IntellR] 3280108 Ultra ATA Storage Controller-24CB
212 FCl Sernial Bus Cantraller  [rtel Intel[R] 32801 DB/DEBM SkBus Contraller - 24C3
213 FCl Multimedia Intel Corporation Multimedia Audio Controller
214 PCI Dizplay MDA, MYIDLA Cuadrod 380 =GL
215 FCl Baze Spztem Pernp... [ntel Intel[R] PE4HZ 10 Advanced Programmable Intermpt Conl
216 PCI Syztem Intel Intel[R) PE4HZ PCI ta PCI Bridge - 1460
217 PCl Base Svgtem Pernip... kel Intel[R] PE4HZ 140 Advanced Programmable Intermupt Conl
218 PCI Syztem Intel Intel[R) PE4HZ PCI to PCI Bridge - 1460
2119 FCI Digk. LSl Logic Ine. LSI Logic PCl== Ulra220 SCS1 Host Adapter
22 FCl [k rotr [rtel Intel(R] E7O00 Series RAS Contraller - 2551
220 FCl Disgk, L5l Logic Ine. LS Logic PCl Ulra220 SC51 Host Adapter
224 PCl Serial Bus Cantraller - Teraz Instrum...  Texas Instrumentz OHCI Compliant IEEE 1394 Host Cantra
222 FCl M etwark, [ntel Intel[R]PROA000 BT Metwark, Connection
23 FCI System Intel Intel[R] E7O00 Seres Processor to AGP Controller - 2552
24 PCl Sypstem [ntel [ntel(R] E7O00 Series Hub Interface B PCl-to-PCl Bridge - &
25 FCl Sernial Bus Cantraller - [rtel Intel[R] 3280 DB/DBM USE Univerzal Host Controller - 24
26 FCI Senal Bus Controller  |ntel IntellR] 828010B/DEBM USE Univerzal Host Controller - 24
27 FCl Sernial Bus Cantraller  [rtel Intel[R] 3280 DB/DEBM USE Univerzal Host Controller - 24
2.8 FCl Senal Bus Controller  |ntel IntellR] 32801 0EB/DEM USE 2.0 Enhanced Host Controlle
249 PCI Syzter Irtel Intel[R] 82801 PCI Bridae - 244E

Viewing Directories and Files Data

Directories and Files Page Overview

This page is displayed by clicking the Directories and Files tab after you have loaded the inventory
data into Viewer.

The Directories and Files tab page is split into four viewing areas (panes):
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Directory tree

File list

o Directory information

File information

The Directory Tree

The directory tree is located on the left of the page. It shows the structure of the current drives
displayed as a directory tree.

To obtain information about the drive or directory:

Right-click on the directory and select the Properties option. The Properties dialog box appears.
If the drive is a shared drive, then a Sharing tab is also made available.

Icons Used in the Viewer to Denote Directory Status

Different icons are used to denote directory status as follows:

Icon Directory status

=) Indicates a drive

¥  Indicates a shared drive

@ Indicates a normal directory

ad Indicates a shared directory.

Indicates filtered or ignored directories (as specified in the Scanner Generator). Data in the
filtered directories is not stored in the scan file.
This icon also represents mount points in Windows 2000 or UNIX scans. Mount points are
automatically filtered.

[ | In UNIX scans, files (and directories) may be located on several different file systems. To
link files that are in different file systems a symbolic link is made.
This icon is displayed for directories that are symbolic links. You can follow the link by
right-clicking on the directory and selecting the Follow Link to <link> option.

The File List

The file list is located in the top right of the page. It shows a list of files in the selected directory.
The file list has incremental column search.

To use incremental column search to locate an entry in a column directly:

Click on any row, and type the word(s) or number(s) that you want to find.

The name is displayed on the status bar.

HP Universal CMDB (10.10) Page 297 of 311



Inventory Tools User Guide
Contents

You can obtain information about a file by right-clicking the file and selecting the Properties option.
You can also do this by double-clicking on the file.

For files that belong to packages, you can use the Go to installed package menu item on the right-
click shortcut menu to view information about the package. This is displayed on the Hardware and
Configuration tab.

Archive Files

The contents of archive files are displayed, but no signatures are shown. However, if a checksum
is shown, this refers to the archive checksum.

UNIX Scans

For files in UNIX scans, you can obtain link information about the file by right-clicking on the file and
selecting the Follow link option.

This option is only available for files with the L attribute (indicates a symbolic link file). You can also
do this by double-clicking on the file. The link information is displayed in the file information pane.

Parameters Displayed for Each File

The parameters displayed for each file are:

File Name — the name of the scanned file.

Size —the size of the scanned file.

¢ Modified —the last modified date and time that is stored for the file in the file system.
o Attribute —file attributes (see Table 44).
o Exe/Arc —the type of the executable or archive file.

« Signature —a number that is calculated from the first 8 Kbytes of a file (usually sufficient to
uniquely identify a file).

¢ Created — date and time when this file was created.
o Last Accessed —date and time when this file was last accessed on this system.

« Package — name and version of the package to which this file belongs.

Attribute Meaning
r Read-only files

Files that are marked read-only are protected from modification or deletion.
h Hidden files

Windows Explorer does not show hidden files by default unless you tell it to do so.
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Attribute Meaning
s System files
u Used/Executed files
This flag shows that this file was executed and the application was used.
v Volume Label

This contains no data and no more than one may exist on a disk volume (and only in
the root directory).

a If it has the archive attribute of DOS or Windows

The Archive attribute is used to provide an automatic record of what files have been
modified since the last backup.

c Compressed files

These are compressed files and folders. For example, if it is a file on a compressed
NTFS volume.

X Ina UNIX system this represents a file with the executable attribute set.

| Internal data available

That is, if it has version data available for it. Version data (as per Windows Explorer)
is displayed for all files having this attribute.

L Symbolic link in UNIX

Files (and directories) may be located on several different file systems. To link files
that are in different file systems a symboalic link is made.

Symbolic links to files are not scanned but are stored with this attribute and are
displayed in the directory tree of the Directories and Files page with a shortcut icon.

s This is special case for UNIX for SetUid files.

In UNIX scans, certain files have special attributes that mean that they run with root
privilege. Such files are potentially a security risk and the Scanner assigns them the
system attribute - s

This file has been identified as an archive.
This file has been identified inside an archive.

This file has been identified as an executable file.

o X o »r

This file has been identified as a device driver

Directory Information

The directory information pane beneath the directory tree displays information about the selected
directory. It shows the number of files in the directory and the total size of the files.
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File Information

Beneath the file list is the file information pane, which displays additional information for the
executable files, where internal version information is included in the file header.

Viewing Stored Files Data

Stored Files Page Overview

This page is displayed by clicking the Stored Files tab after you have loaded the inventory data into
the Viewer.

This page displays the contents of key files collected during the inventory, that is, files stored in the
scan file during scan time. Typically these are system configuration files, for example
Autoexec.bat and Win.ini.

The Stored File tab page is split into two viewing areas:

o Storedfile list — The top pane displays a list of stored files. You can sort (in ascending and
descending order) the contents of a column by clicking on a column header.

o Stored file contents — The bottom pane displays the contents of a selected stored file. Text files
are displayed as text, other files are displayed in a combined HEX- and ACSIlI-views.
Toggling the Display Mode

By default, the Viewer tries to determine the type of the file and select the appropriate mode of
display. However, some text files that have unusually long lines (longer that 255 characters) are
displayed in hex view as binary files.

Using the Toggle Display mode option it is possible to change the view from hex to text (and vice
versa).

To use the Toggle Display mode option in the Viewer:
1. Inthe storedfile list (top pane), click on the file that you want to view.

2. Inthe bottom pane, select the Toggle Display Mode command from the right-click menu. The
display mode switches between hex and text display.

Saving or Copying the Contents of a Stored File

The contents of a stored file can be saved to a file for future reference or for restoring the original
files if they have been lost.

To save the contents of a stored file in the Viewer:

1. Right-click on the file name, or in the stored file contents (bottom pane) right-click anywhere in
the pane.

2. Select the Save To command (text and hex files) from the shortcut menu. Use the standard
Windows navigation methods to select or enter a file and the location where the file is to be
saved.
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To copy the contents of a stored file to the clipboard:

1. Right-click on the file name, orin the stored file contents (bottom pane) right-click anywhere in
the pane.

2. Select the Copy to Clipboard command or click the icon and paste the content of the file to an
editor of your choice.

Locating the Directory of a Stored File
To locate the directory of a displayed file (this will be displayed on the Software page):

Right-click anywhere in the top pane and select the Go to Directory command from the shortcut
menu, or double-click on the file.

The software page is displayed, with the file highlighted.

o This will only work if the directory/file is available.

o The stored file will only appear in the directory if the Scanner has been configured to store
the file type.

Viewing Software Application Data

The Software Applications tab displays applications that have been recognized by the SAI
recognition or the Installed applications recognition. It is not displayed when the application list is
empty even if a recognition method was specified.

See Configuring Recognition Settings for information about how to set up the recognition method.

Navigation

Double-clicking on an application in the list or right-clicking on an entry and selecting the Goto
command will display the Directories and Files tab with the application highlighted. The Directories
and Files tab shows the file/directory identifying the application.

The following additional commands are also available by right-clicking on an application entry.
o Copy

Copies the contents of the Applications tab page to a text format and places it on the clipboard.
You can paste the contents to an editor of your choice.

o Copy toFile

Copies the contents of the Application tab page to a text file.

o Show applications (Only for SAl recognition)
For the SAI recognition, it shows fully recognized applications, partially recognized applications,

or fully and partially recognized applications by selecting the options: Fully recognized, Partially
recognized, or Both.
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Drop-down lists
In addition, there are two drop down lists that allow you to apply filters to the data that is displayed.

The first drop-down list allows you to see data relating to a particular user. Application utilization
data is attributed to the following special users:

e AllUsers

For all users.

e System

For other system processes running on the computer. For example, services running that have no
particular user associated with them.

The second drop-down list allows you to see data relating to whether the application is just running
or actually being used. As a result, you can see software utilization time based on one of the
following:

¢ Running Time

Running time is the total amount of time that an application is open and running.

e Focus Time

Focus time is the total amount of time that an application is running in the foreground, that is, the
application is in focus.

Information shown in the Application data window

The following information is shown about each software application:
Application data
o Application
The name of the software application.
o Recognition

For the SAI recognition, this column displays Full for the fully recognized applications or Partial for
the partially recognized applications.

For the Installed applications recognition, this column displays Installed Applications.

e Release

The application release

e Version

The application version

¢ OS
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The operating system the application was running on.

e Language

The name of the language of the application.

¢ Commercial

The license type of the application. The possible values are:

= Unknown (undefined)

= Commerical

s Free

e Publisher

The name of the software publisher (for example, Microsoft, IBM).
e LastUsed

The last time the file was accessed - (dd/mm/yyyy) (hrs:mins)

o FileName
The path to the file designated as the Main file.

Utilization Data

The Viewer shows two types of utilization data:
o Per-computer application utilization (select All Users)
o Per-user application utilization (select a particular user)

This information is only available if the software utilization agent plug-in was running on the
computer which was scanned.

See the Software Utilization Data chapter in this book for instructions on how to check whether you
have utilization enabled.

To view application utilization data:

1. Select the user you want to see data for from the drop-down list. Alternatively, select All Users
to get the per-computer view).

2. Select which software utilization time you want to see from the drop-down list, namely total
running time or total focus time for the application.

3. Click on the application you want to see data for and the details will be shown in the bottom
pane. This pane shows the utilization statistics for how users utilized a particular application.

Application Utilization Data
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o Days used (last month)

The number of days the application was used in the last month.

o Hours used (last month)

The number of hours the application was used in the last month.

o Days used (last quarter)

The number of days the application was used in the last quarter.

e Hours used (last quarter)

The number of hours the application was used in the last quarter.

o Days used (last year)

The number of days the application was used in the last year.

e Hours used (last year)

The number of hours the application was used in the last year.

o Hours used (average daily)

The daily average in hours over the period configured.

o Hours used (peak daily)

The highest daily number in hours over the period configured.

o Utilization

The number of days that the application was used (as a percentage) over a period of time. The
period is calculated automatically depending on how long the application was used for. As a rough
guideline the time periods are as follows:

= Application used for more than 3 months - utilization is calculated over the year.

If the earliest application usage recorded is more than 3 months old, but less than 1 year (i.e.
there was a record that the application was used more than 3 months ago, but less than a year
ago), an annual figure will be used (number of days used in the last year / 365)

= Application used for less than 3 months but more than 1 month - utilization is calculated over a
quarterly period.

If the earliest usage recorded is less than 3 months, but greater than 1 month, a quarterly figure is
used (number of days used in the last quarter / 90).

= Application used for less than one month - utilization is calculated monthly

A monthly figure is used here (number of days used in the last month/ 31)
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Viewing Software Utilization Data

The Viewer calculates Utilization data based on the current system date.

The Stored Files Tab

You can view the contents of the discusg.cxu.Software Utilization Data file in the Stored Files tab.
In the stored file list (top pane), click on the Software Utilization Data file.

In the bottom pane, select the Toggle Display Mode command from the right-click menu. The
display mode switches between hex and text display.

The Software Application Tab

Utilization information can also be seen in the Viewer Software Application tab page. There are two
drop-down lists that allow you to filter utilization data.

One drop-down list allows you to apply a filter to see data relating to a particular user. Application
utilization data is attributed to the following special users:

o AllUsers
e Forallusers
e System

For other system processes running on the computer. For example, services running that have no
particular user associated with them.

The other drop-down list allows you to see data relating to whether the application is just running or
actually being used. As aresult, you can see software utilization time based on one of the following:

« Running Time. Running time is the total amount of time that an application is open and running.

o Focus Time. Focus time is the total amount of time that an application is running in the
foreground, that is, the application is in focus.

This information is only available if the software utilization agent plug-in was running on the
computer which was scanned.

To view application utilization data:
1. Select the user you want to see data for from the drop-down list.

2. Click on the application you want to see data for and the details will be shown in the bottom
pane. This pane shows the utilization statistics for how users utilized a particular application.

Per Computer Application Utilization

o Days used (last month). The number of days the application was used in the last month of the
configured period.
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o Hours used (last month). The number of hours the application was used in the last month of
the configured period.

« Days used (last quarter). The number of days the application was used in the last quarter of the
configured period.

o Hours used (last quarter). The number of hours the application was used in the last quarter of
the configured period.

« Days used (last year). The number of days the application was used in the last year.

o Hours used (last year). The number of hours the application was used in the last year.
+ Hours used (average daily). The daily average in hours over the period configured.

o Hours used (peak daily). The highest daily number in hours over the period configured.

« Utilization. The number of days that the application was used (as a percentage) over a period of
time. The period is calculated automatically depending on how long the application was used for.
As arough guideline the time periods are as follows:

o Application used for more than 3 months - utilization is calculated over the year. If the
earliest application usage recorded is more than 3 months old, but less than 1 year (i.e. there
was a record that the application was used more than 3 months ago, but less than a year ago),
an annual figure will be used (number of days used in the last year / 365)

o Application used for less than 3 months - utilization is calculated over a quarterly
period. If the earliest usage recorded is less than 3 months, but greater than 1 month, a
quarterly figure is used (number of days used in the last quarter/ 90).

o Application used for less than one month - utilization is calculated monthly. A monthly
figure is used here (number of days used in the last month / 31)

Comparing Scans
Why You Might Want to Compare Scans

The scan compare feature in Viewer can be an ideal tool for support personnel. It provides you with
a direct comparison between two scans. It can be used to:

o Track which files have been accidentally deleted.
o Compare scan files from recently upgraded computers against their original configuration.

Check for adherence to a standard desktop.

Check which files have been added, changed or removed after a software installation had taken
place.

Change management.
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Setting up the Comparison of Two Scan Files

The compare function is only available if more than one scan has been loaded into Viewer. You can
perform multiple comparisons at any one time.

To set up the comparison of two scan files:
1. Select the Compare option from the Edit menu, or click the Compare icon .

The first page of the Compare Scan Files wizard appears.

2. Select the two different scans to be compared from the corresponding drop-down lists.

3. Click Finish to compare the two scans with default options, or customize the options by
clicking the Next button. The Set Options page of the wizard is displayed

4. Customize the options as required:
» Hardware and Configuration data

Compares the information contained in the Hardware and Configuration page for both scans.

» Software Applications

Compares the information contained in the Software Applications page for both scans.

» Directories and Files

Compares the information contained in the Directories and Files page for both scans. Further
options are made available:

o Ignore empty directories — Any empty directories encountered will not be included in the
comparison.

o Show equal Key Hardware Fields — Some of the fields have key fields associated with
them. If any data for the fields in the list has changed, it will be displayed along with the key
field for it. The key fields are displayed in grey to indicate they do not represent a change.

o Ignore Last Accessed Time — The last accessed time stamp is ignored when carrying out
the compare.

o Use Short Dir/File Names — The file names and directories will be displayed in the 8.3
format used by DOS.

For an example of how key fields are used see Key Fields on page 230.

= Scanner Configuration data

Compares the Scanner Configuration (as set up in Scanner Generator) for both scans.

5. Click the Finish button.

The two data sets are compared and a Scan File Comparison window appears showing the
results of the compare operation.
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1. Select the Compare option from the Edit menu, or click the Compare icon .

The first page of the Compare Scan Files wizard appears.

2. Select the two different scans to be compared from the corresponding drop-down lists.

3. Click Finish to compare the two scans with default options, or customize the options by
clicking the Next button. The Set Options page of the wizard is displayed

4. Customize the options as required:
= Hardware and Configuration data

Compares the information contained in the Hardware and Configuration page for both scans.

= Software Applications

Compares the information contained in the Software Applications page for both scans.

s Directories and Files

Compares the information contained in the Directories and Files page for both scans. Further
options are made available:

o Ignore empty directories — Any empty directories encountered will not be included in the
comparison.

o Show equal Key Hardware Fields — Some of the fields have key fields associated with
them. If any data for the fields in the list has changed, it will be displayed along with the key
field for it. The key fields are displayed in grey to indicate they do not represent a change.

o Ignore Last Accessed Time — The last accessed time stamp is ignored when carrying out
the compare.

o Use Short Dir/File Names — The file names and directories will be displayed in the 8.3
format used by DOS.

For an example of how key fields are used see Key Fields on page 230.

= Scanner Configuration data

Compares the Scanner Configuration (as set up in Scanner Generator) for both scans.

5. Click the Finish button.

The two data sets are compared and a Scan File Comparison window appears showing the
results of the compare operation.

Viewing the Comparison Results

The Scan File Comparison window has three columns. The first column shows the compared data
items.
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The results of the comparison depend on the criteria you defined in the wizard. The following
information can be shown in the first column:;

o Hardware Data

o Software Applications
o Directories and Files

e Scanner Configuration

To expand a category, click the + sign next to the icon.

The next two columns show the results for the compared scan files. An example is shown in the
following screen shot:

B Scan file com parison
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CPU Speed [MHz] 236 240
CPU Moaodel 782 aaa
[ Disk data
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[ Metwork data
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[ Storage Data
[ Swstem data w
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Save... ] I Cloze
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In this example, the Actual CPU Speed for the first scan file is 236 MHz and 240 MHz for the
second scan file.

Key Fields

If you enabled the Show equal Key Hardware Fields option on the Set Options page of the compare
wizard, some of the lists of fields will be displayed with key fields associated with them. These key
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fields are shown in grey. If the data for the fields in the list has changed, it is displayed along with
the key field. An example is shown in the following screen shot:

% Scan file comparison
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The Mount Point Volume Name field is a key field (shown in grey) and this is shown even though it
hasn’t changed itself. This indicates that the information changed relates to this particular drive;
without the key field it would not be possible to see on which drive the change had taken place,
merely that it had changed on some drive.

The Go To Option

A Go To option is available for all categories except for Scanner Configuration data.

1. Right-click on afield and select the Go To option.

The appropriate tab page in the Viewer main workspace will be displayed with the entry
highlighted. This will be done for both of the scan files.

2. Select the Tile option from the Window menu to see both scan files with the appropriate entries
highlighted.

Saving the Comparison Results

To save the results to a Comma Separated Variable (.csv) file:
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1. Click the Save button, or right-click anywhere in the results window and select the Save to
.CSV file option.

In the Save Comparison dialog box, specify a file name and path where you want the results to
be saved.

2. Click the Save button.
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